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Limitations on Maintenance Services

The FactorSoft™ application is intended for use in accordance with the standards and processes described within this
documentation. Efforts to investigate and/or repair FactorSoft™ application or data integrity issues caused by activ-
ities or integrations outside of the intended use of the FactorSoft™ platform will be subject to the then-current Jack
Henry Professional Services billable hourly rate.

Standard Maintenance Services (Technical Support) does not include the following:

Investigation and Remediation of errors and data integrity issues caused, contributed to, or by any of
the following:

n a software program that was not originally provided by Jack Henry

l third-party automation, BOT/Screen Scraping technology, custom importers,
or any other integration with FactorSoft™ that was not created by or in con-
junction with Jack Henry.

n any modification not provided by Jack Henry to the software or standard database
schema

l the addition of custom database elements including triggers, stored pro-
cedures, tables, and columns

l the alteration of standard FactorSoft™ triggers, tables, columns, stored pro-
cedures and indexes

l the execution of T-SQL scripts resulting in changes to the data stored within
the FactorSoft™ database

n equipment, software, networks or any other infrastructure in the customer’s envir-
onment that does not meet the minimum requirements described within the then-
current FactorSoft™ product documentation

Please note that if you are exploring possibilities with third-party software providers or considering altering the FactorSoft database
in any way, it is strongly recommended that you discuss your plans with the FactorSoft™ support team before making any com-
mitments or changes. As your software partner, we may be able to help solve your business problem in a way that does not intro-
duce risk, data corruption, or system instability.
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Welcome to FactorSoft

FactorSoft is designed to reduce the time you spend entering data so that you can devote your time to
generating new business and steady, lucrative investments.

This training guide emphasizes the tools FactorSoft provides for monitoring your receivables, managing
portfolio activity, and controlling related paperwork and record keeping.

By the end of the training, you will be able to:

l Navigate FactorSoft

l Define user preferences

l Create new client accounts

l Verify, approve and purchase invoices

l Collect and post payments

l Disburse funds or rebates

l Write checks

l Generate reports

l Fax or email client and debtor statements
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Login

To log into FactorSoft, a user name must be set up for each user, and that user name must be assigned
one or more Security Roles. These functions are typically the responsibility of a System Administrator,
whose user account has Security Roles that allow them to perform these functions. Once properly defined,
these security controls allow users to gain secure access to FactorSoft and perform the tasks associated
with their role in the organization.

When the FactorSoft user name is created, it does not have a password assigned, and the user must spe-
cify the password on their first entry into the application. The first-time login process is described below:
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1. Start the FactorSoft Application Manager from the desktop icon, or from the Factors.exe file in the
common FactorSoft folder (typically C:\FactorSoft).

TIP

If an older version of FactorSoft is being used, the path may be displayed as C:\FactorSoft or
C:\CADENCE.

The FactorSoft Application Manager screen appears.

2. Enter your user name in the User field.

3. Select the Database you wish to log in to.

4. Click the Login button, which looks like a locked padlock.

The Application Manager returns a message indicating that you need to set a password.

NOTE
Use of passwords for entry to the system is controlled by System Preference. If your organization
elects to forgo the password requirement, only the User name and Database is required to
access the applications via the Application Manager.

5. Click OK.

The Change Password icon appears on the Application Manager, as shown in the following illus-
tration.

6. Click the Manage Password link.

The Change Password screen appears.
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7. Complete the New Password and Confirm Password fields.

8. Click the Accept button.

Provided that the New and Confirm entries match and pass all password rules, the following mes-
sage appears.

9. Click OK to clear the message.

You are returned to the Application Manager.

10. Enter your new password in the Password field and click the Login button to display the application
icons for the database in the Application Manager, as shown below.
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After the initial login described above, the FactorSoft user only has to enter their User name, Pass-
word, and Database on the Application Manager and then click the Login button to gain access to
the application icons on the Application Manager.

The user can click the Manage Password link prior to logging in any time they wish to change their
password. If password rules include password expiration, the user will be presented a message on
attempting to log in, and the password update routine is similar to the new log in routine described
above.
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FactorSoft and the Lending Solutions Service Portal

FactorSoft and the Lending Solutions Service Portal provides access to technical support, product doc-
umentation, eLearning, as well as historical support ticket information. It is through this portal that service
tickets may be entered for all Lending Solutions products. The Lending Solutions Service Portal offers three
levels of security:

• Level 1 Service Portal Users may open and view tickets they themselves have entered, but they cannot
view tickets opened by other users.

• Level 2 Service Portal Users may open cases and view any case opened under their Financial Insti-
tution, regardless of who opened the case.

• Level 3 Service Portal Users are considered administrative users. These users may open cases, view all
company cases, and maintain other Service Portal user’s credentials. Level 3 admin users also receive all
client-facing communications, including service level updates and product updates.

Authorized portal contacts may also open a technical support case
by emailing the Lending Solutions Service Desk at LS-Help@Profitstars.com.

NOTE
Service tickets must be opened through the Lending Solutions Service Portal. Tickets opened for sup-
port through the JHA For Clients portal will not be answered in a timely manner and will result in sig-
nificant delays in response time.
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Client & Debtor Activities

This section describes the functions provided in FactorSoft for adding, updating, and viewing client and
customer/debtor records.
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Client List

The Client List screen presents an integrated view of your portfolio, and provides access to the various
views of financial data and to all major transactions that can be performed.

The Client List is a completely integrated interface, displaying (in its Client View mode) each client as a
line-item. Unfolding the client by clicking on the plus sign to the left of the client name reveals all facilities
(FactorSoft's terminology for "types of lending deals") for the client, and beneath each facility, each col-
lateral supporting the deal is displayed as a line-item.

NOTE
The categories are color-coded - Client is black, Facility is blue, and Collateral is green. This color-cod-
ing allows you to quickly differentiate these components.

Display Grid

The Display Grid lists clients, facilities and collaterals as line-items in a color-coded, expanding table view.

NOTE
The line-item view can be varied by the setting of View Type. See Screen Controls for
details.
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Client Grid

By default, the Client Grid displays the following columns. Note that additional columns can be included
using the Columns control tab.

Column Description

Client Name Displays the client name, as defined for the client on the New Client/Client
Information screen.

You can filter client names in the list by entering a character string in the field
below the Client Name heading, but above the first actual client name. Type
"%abcd", where "abcd" is the actual search string, to hide any client names that
do not contain the search string.

(Aging
Categories)

Each aging category is displayed as a separate column, and the outstanding
balance in each of the categories is displayed.

Note: Non-standard aging buckets are determined by the setting of the System
Preferences in the Fields/screen behavior, Non-standard aging folder.

Facility Grid

A facility line-item exists for each facility for a client. By default, the columns on the facility grid are:

Column Description

BOLD Columns are calculated in real-time and may populate with a delay.

Facility Description Displays the facility identifier as created in the Facility Information screen. For
bulk collateral deals, the facility description is established on the New Facility
screen when the facility is created. For detail collateral deals, the description is
always "Factoring".

Currency Type Displays the default currency type for the facility. Currency types are created in
the Currency Denominations Table in the Table module and assigned on the
New Facility screen when the facility is created

Gross Collateral Displays the sum total of the current collateral values used to support the loan
balance.

The sum of Gross Collateral for all facilities is the figure displayed in the optional
Gross Collateral column at the Client level.

Eligible Collateral Displays the sum of the calculated Eligible Collateral amounts used to support
the loan balance. (Current Collateral value - Ineligible values)
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Column Description

Net Collateral Displays the sum of the calculated Net Collateral amounts used to support the
loan balance. (Eligible Collateral * Advance Rate)

The sum of Net Collateral for all facilities is the figure displayed in the optional
Net Collateral column at the Client level.

Loan Limit Displays the loan limit for the facility.

Available Displays the sum of the calculated Available Collateral amounts used to sup-
port the loan balance. (Lower of Loan Limit and Net Collateral amount)

Loan Balance Outstanding facility loan balance amount. Current loan principle amount.

The sum of the Balances for all facilities is the figure displayed in the optional
Loan Balance column at the Client level.

For Factoring facilities, the sum of the Balances at the facility level is the figure
displayed in the optional Net Funds Employed column

Excess/Deficit Displays the current amount that is available to lend to the client.

Collateral Grid

A collateral line-item exists for each collateral for a facility. By default, the columns on the collateral grid
are:

Column Description

BOLD Columns are calculated in real-time and may populate with a delay.

Collateral Description Displays the collateral description. For bulk collateral deals, the collateral
description is established on the New Collateral screen when the collateral is
created. For detail collateral deals, the description is always "Factoring".

Type The collateral type. For Bulk Collaterals, the type is selected on the New Col-
lateral screen when the collateral is created. The available collateral types are:
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Column Description

l A/R Aging

l Bulk A/R

l Bulk H/R

l Bulk Inventory

l Equipment

l Inventory

l LB Detail

l Summary AR

l Other

l Purchase Orders

l Real Estate

l Securities

Currency Type Displays the default currency type for the collateral. Currency types are created
in the Currency Denominations Table in the Table module and assigned on the
New Collateral screen when the collateral is created.

Gross Collateral Displays the current collateral value used to support the loan balance.

Inelig Collateral Displays the current total Ineligible amounts.

Eligible Collateral Displays the current Eligible Collateral amounts used to support the loan bal-
ance. (Current Collateral value - Ineligible values)

Net Collateral Displays the calculated Net Collateral amount used to support the loan bal-
ance. (Eligible Collateral value * Advance Rate)

Available Limit Displays the maximum collateral available amount.

Available Displays the calculated Available Collateral amount used to support the loan
balance. (Lower of Available Limit and Net Collateral Amount)
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Control Tabs

The tabs to the right of the grid provide access to the views and transactions associated with the clients,
facilities, and collaterals.

NOTE
When the System Preference at Client rules/defaults > Rules > Require manager approval before
using is set to True, unapproved clients will only have access to the Client Information screen.

Functions Tab

The Functions tab provides links to the screens used to update client, facility, and collateral values. Note
that the lists vary depending on the type of facility selected and the system-level processing options
established in the Administration module. Only options relevant to the selected deal are presented:

l When a Client line-item is selected, a Client sub-menu list is displayed.

l When a Facility line-item is selected, Client and Facility sub-menu lists are displayed.

l When a Collateral line-item is selected, Client, Facility, and Collateral sub-menu lists are displayed.

Columns Tab

The Columns tab is a list of available columns that can be added to the Client line-item grid. To add any
of the listed columns to the grid, click on the desired column name and then drag and drop it at the
desired location on the client header line at the top of the grid. Should you wish to remove a column from
the grid, open the Columns tab, grab the column header in the grid display, and drag and drop it on the
Columns tab. The optional columns available are detailed in the following table:

CAUTION
The Client List provides the capability to view the list by client, facility, and collateral, and that specific
columns may or may not be available based on their applicability to the selected view type from the
bottom of the screen. Further, while columns can be selected and moved within the Facility and Col-
lateral Views, these views were designed to be used as static views.
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Column Description

BOLD Columns are calculated in real-time and may populate with a delay.

A/E Displays the Account Executive as listed on the Control panel of the Client
Information screen.

Accrued Fees Displays Total Amount of Accrued Client Fees (Additional Fee Accrued + Addi-
tional Fee Tax + Earned Fee Accrued + Earned Fee Tax + NFE Fee Accrued)

Allow New Purchases Displays "YES" or "NO" for Allow New Purchases from Client Information screen.

Allow PO Finance Displays "YES" or "NO" for Allow PO Finance from Client Information screen,
Load/Order Processing panel.

Allow Reserve Release Displays "YES" or "NO" for Allow Reserve Release from Client Information screen,
Credit/no buy panel.

Alternate Name Displays the Alternate Name as listed on the Client Information screen, Identity
panel.

Available Displays the sum of Collateral Available, (Gross Collateral - Ineligibles) *
Advance Rate, unless the system preference is set to ignore the client limit and
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Column Description

the net collateral surpasses the total credit limit, then it is just the total credit
limit.

Client Cap Space Total client credit limit less sum of Loan Balances and NFE (FAC Excess Deficit).

Cash Reserves Displays the dollar amount of cash reserves for the client as seen on the Fund
Employed tab of the Client Summary screen.

Client No Displays the Client Code as defined on the Client Information screen.

Client Terms Displays the Client Terms as viewed within the Client Information screen.

Credit Rating Displays the Client Credit Rating from the Credit/No buy panel of the Client
Information screen.

Credit Available Displays the Total Available Credit (Total Credit Limit - Current Balance)

Currency Type Displays the Currency Type as indicated on the Control panel of the Client
Information screen.

DOT # Displays the Department of Transportation Number (DOT#) as defined on the
Identity panel of the Client Information screen.

Eligible Collateral Displays the total amount of Client's Eligible Collateral amounts.

Escrow Balance Displays Total Escrow (Fee Escrow + Reserve Escrow)

Excess/Deficit Sum of facility amounts available to be disbursed. See system preferences for
display options at System Preferences > Facility/Collateral Rules (Formerly
Asset Based Lending) > Rules > General > Client excess availability.

Factoring NFE Displays Factoring NFE Amount (Current A/R Balance - Fee Escrow - Reserve
Escrow - Cash Reserve Amount)

Fed Tax No Displays the Federal Tax Number from Client Information screen, Identity panel.

Funded A/R Balance Current Total A/R Balance funded.

G/L Group Displays the G/L Group as identified on the Control panel of the Client Inform-
ation screen.

Gross Collateral Displays the total amount of Client's current ineligible collateral amounts.

Held Funds Displays the dollar amount in the Hold Account for the client (if allowed in Sys-
tem Preferences).
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Column Description

Indiv Credit Limit Displays the maximum credit limit for any one of the client's debtors as displays
on the credit/no buy panel of the Client Information screen.

Inelig Collateral Displays the total amount of client's current ineligible collateral amounts.

Ineligible Displays Ineligible Amount (Dispute Recourse Amount + Recourse Short +
Recourse Over + Recourse Days + Basis Dilution + Invoice Ineligible + Tier Ine-
ligible Amount + Gross Ineligible Amount + Dilution Ineligible Amount + Over
Credit Amount + Concentration Amount + Master Concentration Amount +
Master Over Credit Amount)

Limit Displays the client's overall credit limit as defined on the Credit/no buy panel of
the Client Information screen.

Loan Balance Displays sum of Current Loan Balance (Balance - (Current Balance Amount -
Current Reserve Amount - Fee Escrow - Reserve Escrow))

Motor Carr No Displays the Motor Carrier Number as defined on the Identity panel of the Client
Information Screen.

Net Collateral Displays the sum of all calculated net collateral amounts (Eligible Collateral *
Advance Rate)

Non-Funded A/R Bal-
ance

Displays the Total Balance of invoices marked Non-funded which means no
advance is made at time of purchase update, but on which the lender is col-
lecting money.

Office Displays the Office as indicated on the Control panel of the Client Information
screen.

PO/Load Advances Displays the dollar amount of advances made against purchase orders (using
P.O. Financing) or loads (using the Load/Order Processing module).

Total Advance Amt Total Advance amount as shown on the Client Summary Screen (A/R Balance -
Fee Escrow - Reserve Escrow)

Total Balance Due Current Balance Amount or Total A/R also located on the Client Summary
screen.

Total Balance Due % Displays the percentage of Balance Due against Balance Due for All Clients (Cli-
ent Current Balance / Sum of All Client Balances)

Total Funds
Employed

This amount is calculated by subtracting cash reserves, settlement amounts,
simple interest loans, amortized loans, P.O. financed amounts, and held funds
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Column Description

(if allowed in System Preferences) from the Advance Balance as seen on the
Fund Employed tab of the Client Summary.

Note - Settlement amounts (advances made on pending invoices, i.e. invoices
that have not been purchased yet), interest loans, amortized loans, and pur-
chase order finance amounts are available only if using FactorSoft Loan and
Purchase Order modules.

Total Outstanding Displays the client’s total calculated outstanding balance (Funded Balance +
Non-funded Balance - Fee Escrow - Reserve Escrow) + Loan Balance (for ABL)

Warning/Notes Displays Warning message as entered on the Credit/No buy panel of the Client
Information screen.

BOLD Columns are calculated in real-time and may populate with a delay.

Filters Tab

The Filters tab provides filtering options by which to limit the display of clients in the Clients tab grid.

Option Description

Broker Select the broker to which to limit the display in the grid, or leave this field blank
to include all brokers. This list display brokers as follows:

l Broker Code is displayed if available.

l If there is no Broker Code, then first and last name is displayed.

l If there is no Broker Code or first name, then last name is displayed.

l If there is no Broker Code, first or last name, then company name is dis-
played.

l If there is no Broker Code, first, last or company name, then city, phone, or
status are displayed as available.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the
report, or leave blank to include all users. When a user is selected, the report is
limited to clients that have that user selected in the A/E field on the Control
panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E,
use the following System Preference:
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Option Description

l Terminology > Select account executive based on check box: TRUE

Group Select the client group to which to limit the display in the grid. Client Groups are
defined in the Group Code Table.

Value Select the specific client group value to which to limit the display in the grid. Cli-
ent Groups are defined in the Group Code Table.

Office Select the office to which to limit the display in the grid. Offices are defined in
the Office Table.

Currency Select the currency to which to limit the display in the grid. Only clients that
have this Currency selected in the Control panel of the Client Information
screen are listed.

(Active/Inactive Cli-
ents)

Select the filter by which to limit clients to be displayed in the client grid:

l Active clients only: only Active Approved Clients will display on the Client
Information screen

l Inactive clients only: display only clients that have the Inactive option
selected on the Client Information screen

l Unapproved Only: display only unapproved clients on the Client Inform-
ation screen

l All clients: display Approved, Unapproved, and/or Inactive clients on the
Client Information screen

(Master Clients) Select the filter by which to limit the clients to be displayed in the client list:

l Master Clients: display only master clients that have the Master client
option selected on the Client Information screen

l Member Clients: display only member clients that have a master client
selected in the Part of master field on the Client information screen

l Not Master Clients: exclude Master Clients from the list, but not member
clients (this differs from Flagged as member only in that both members
of master clients and clients not associated with a master are included,
but master clients are excluded)

l All clients: display master, member, and not master or member clients
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Option Description

With AR Balance Display only clients with a current A/R balance greater than zero

With Reserve Balance Display only clients with a reserve balance greater than zero

With A/R or Reserve
Balance

Select this option to include clients with either A/R or reserve balances when the
With balances option is selected in the Display field.

Negative Reserves Display clients that have a negative reserve balance in the list, whether or not
they have an A/R balance

No Buy Display clients with a no-buy Warning entered on the Credit/no-by panel of the
Client Information screen.

No Reserve Release Display only clients with Do not allow reserve release selected on the Credit/no-
by panel of the Client Information screen.

Over Limit Display clients that have exceeded their established credit limits.

Restore defaults Click this button to clear all user-entered filtering options and restore the ori-
ginal settings on the Filter tab of the Client List screen

Apply Click this button to apply any changes to Client List display filters.

Options Tab

The Options tab provides miscellaneous display and functional options for the Client List.

Column Description

Include client number
in client name

Select this option to display of the client number in the Client Name column.

Convert all amounts
to system currency

Select this option to convert amounts from the native currency (the currency
selected for the client in the Control panel of the Client Information screen) to
the base currency. The conversion occurs on a client-by-client basis. If the cli-
ent has a currency type set and the currency type is different from the default
currency, FactorSoft looks up the conversion rate using the As of Date in the cur-
rency table for the base currency.

Do not automatically
refresh on refocus

Select this option to turn off automatic refresh of the grid. This may be desirable
for very large portfolios to prevent undesirable wait times while the list loads. If
this option is selected, the list is refreshed manually by clicking the Refresh but-
ton.
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Column Description

Aging style Select the option to control the basis of the aging figures in the grid:

l Invoice amount

l Advance amount

Client Double Click
Action

Select the screen to be displayed when the user double-clicks a line-item in the
grid:

l View Client Aging

l Open Existing Batch

l View Client Information

l View Client Transactions

Apply to Detail AR Cli-
ents only

Select this option to apply the Client Double Click Action to detail collateral cli-
ents only (i.e., not bulk collateral clients).

Screen Controls

Control Description

Scroll Enter a character (number or letter) or combination of characters to advance
the list to the client, facility, or collateral name beginning with that character or
combination of characters. Double-clicking the search text in the scroll field
deletes the text, allowing the user to enter text for a new search.

The scroll field scrolls to the appropriate client by client name or client number,
regardless of whether the “chevron” that indicates the current scroll column is
in the Name or Client No column heading.

Refresh Click this button to update the information in the grid of the Client List screen.

View Type Select the grid view for the Client List screen:
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Control Description

l Client View: default view that displays each client with expanding tree for
each facility, and each facility having an expanding tree for each col-
lateral

l Facility View: displays each facility as a line-item with an expanding tree
for each collateral, with client data displayed as columns in the line-item

l Collateral View: displays each collateral as a line-item, with client and
facility data displayed as columns in the line-item

l v2.x Client View: displays each client as a line-item with no expanding
tree. This view is provided as an analog to the pre-v3.0 Client List, for
those installations that do not desire to utilize facility/collateral views of
their portfolio.

(Print Select) Select the Client List print option:

l Print All: Prints the current view of the grid to the Preview screen, from
which the grid can be printed to a local or network printer, or exported or
emailed in a variety of formats.

l Print Without Details: Prints a summary client report (if the View Type is
set to Client View) or summary facility report (if the View Type is set to
Facility View) to the Preview screen, from which they can be printed to a
local or network printer, or exported or emailed in a variety of formats.
This selection only applies if the View Type is set to Client View or Facility
View).

Print Prints the selected Client List report to the Preview screen, from which the grid
can be printed to a local or network printer, or exported or emailed in a variety
of formats.

Security Role located at Administration Module > Security > Security Roles >
Reports > General > Print Client List (Yes/No).

Age by Note Field Displays the On Screen Aging Preference.

Set at System Preferences > Field/screen behavior> Miscellaneous > On
screen aging is calculated by.

The Age By Note can be turned on using the following system preference: Sys-
tem Preference > Fields/Screen behavior > Miscellaneous > Show aging “ cal-
culate by” option on the Client List (Y/N). The default is No.
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Preview

The Preview screen displays a preview of the Client List report output generated from the Print/Export of
Print without detail buttons, and allows you to select a printer or output/email format for the report.

Control Description

Search. Click this button to open the Find screen, which allows you to search for
text strings within the report, allowing case-sensitive searches and whole or par-
tial word searches.

Customize. Click this button to open the Print Options screen, which allows you
to select or eliminate a variety of format and report screen behavior options.

Open. Opens the Open screen, which allows you to browse to, select, and open
previously saved .PRNX files in the Preview screen.

Save. Opens the Save As screen, which allows you to browse to and select a
folder, and then name and save the current report as a .PRNX file.

Print. Opens the Print screen, from which you can select a local or network print
device on which to print the report.

This option can also be selected from the File menu.

Quick Print. Click this button to print the report on the default printer for the
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Control Description

user's machine.

This option can also be selected from the File menu.

Page Setup. Click this button to open the Page Setup screen, which allows you
to select paper size, printer tray, orientation, and margins.

This option can also be selected from the File menu.

Header and Footer. Click this button to open the Header and Footer screen,
which allows you to define and format header and/or footer text for the report.

Scale. Click this button to open the Scaling screen which allows you to select
the view scale in percentage, and the fit and number of pages display.

These options are also available from the list between the Zoom Out and Zoom
In buttons. You can also scale the view using the slider at the bottom right of the
screen.

Hand Tool. Click this button to enable the Hand tool, which is used to drags the
report image within the Preview screen if the image is larger than the pane. Use
this tool when you zoom in on the image to be able to view sections not cur-
rently visible.

Magnifier. Click this button to enable the Magnifier tool, which toggles between
zoom in and zoom out functions with each mouse-click.

Zoom Out. Click this button to reduce the viewing scale by five percent with
each click.

Zoom In. Click this button to increase the viewing scale by five percent with
each click.

First Page. Click this button (if active) to jump to the first page of the report.

Previous Page. Click this button (if active) to jump to the previous page of the
report.

Next Page. Click this button (if active) to jump to the next page of the report.

Last Page. Click this button (if active) to jump to the last page of the report.

Multiple Pages. Click this button to select the number of pages to display in the
preview screen.
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Control Description

Background Color. Click this button to select a color for the report background.

This option can also be selected from the Background menu.

Watermark. Click this button to open the Watermark screen, from which you
can select a graphic or define text to be used as a watermark for the report.

This option can also be selected from the Background menu.

Export Document. Click the list selector and select from the available output
formats, then click the button to open the Export Options screen to select avail-
able export options for the selected format. When you click OK, the Save As
screen opens to browse to and select a folder, and then name and save the cur-
rent report in the selected format.

Send via Email. Click the list selector and select from the available output
formats, then click the button to open the Export Options screen to select avail-
able export options for the selected format. When you click OK, the Save As
screen opens to browse to and select a folder, and then name and save the cur-
rent report in the selected format. When you have saved the document, an
email message screen from your email client is opened with the document
attached.

Exit. Click this button to close the Preview screen.
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Entering Client Information

The Client Information/Add New Client screen is used to create new clients and enter demographic and
financial details about that client, and for viewing or modifying information about existing clients.

The data contained on this screen serves as the basis for every client transaction. The screen contains
upper fields and a panel list, which provides access to the individual data panels that contain the bulk of
the data associated with the client.

To add a new client, on the File menu, click Add New Client or click the Add Client icon in the toolbar. To
view or modify an existing client, select the client in the Client List and then click the Client Information
link.

Upper Fields

The fields on the top of the Client Information screen are used to enter basic client information, such as
the client’s name and code, UCC Date, Client Terms, and so on.

Field Description

Client Code If you interface with an accounting application that refers to a client by code or
number, enter the numeric or alphanumeric code here.
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Field Description

You can also use client codes to differentiate clients using identical names
within the Client List.

To view the client code column within the Client List, open User Preferences
(from the FactorSoft System menu) and click on the Client List Screen tab.
Select the Client Code option button, then click OK to save the setting.

Inactive Select this option to mark a client as inactive, thereby removing the client from
current and backdated reporting activities. Inactive clients do not appear in
drop-down lists, nor are they included during report computations. To react-
ivate an inactive client, deselect the Inactive option.

To list all current inactive clients, select Client Master List from the Reports
menu, and check Inactive Only in the Select box.

Master Client Select this option to set the client as a Master Client.

FactorSoft gives you the ability to set up a client as a Master Client with various
member clients. For example, you can separate one client dealing with multiple
currencies or international debtors by countries. When generating a combined
aging report for the master client, FactorSoft automatically gathers information
on member clients, and converts currencies to show all transactions for the
master client in US Dollars.

Clients with this option set appear in the Part of master list

Client Name Enter the name used to identify the client throughout the system.

Client Terms drop-down to select the client term to apply to the client. Click the View button
to open the Client Terms screen.

For Client Terms Search Window, available when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Terms Search instead of
dropdowns is set to True.

Select the magnifying glass icon to open the Search window and
begin typing the client name.

Select Contains or Begins with to refine results. Search window will dis-
play up to 500 matches.

Click the red [x] icon to clear the field.
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Field Description

The Client Terms selected here are the base level terms affecting fee cal-
culation for invoice purchases. Alternate terms can be selected for individual
purchase batches. Select the alternate terms in the Terms field on the Cal-
culation / Reserves tab of the Purchase/Schedule Batch screen. These batch-
level alternate terms apply only to the batch in which they are selected - any
other purchases for the client will still be purchased under the Client Terms
selected in this field.

Terms can be overridden at the client/debtor relationship level. The override
terms are defined on the Overrides tab of the Debtor Aging screen for the rela-
tionship. When override terms are defined for a relationship, they override both
the terms selected for the client on the Client Information screen, and batch
level alternate terms selected on the Calculation / Reserves tab of the
Purchase/Schedule Batch screen. See the information about the Debtor Aging
Overrides Tab for more information.

Part of Master Select the Master Client to which to assign this client as a Member Client.

Active client terms
only

Select this option to exclude inactive client term programs from the Client
terms list.

Copy relationships Click this button to copy customer relationships from one client to another,
provided both belong to the same Master Client.

Allow web access Select this option to grant the client access right to ClientWeb and/or Web
Portal.

Non-detail only Select this option to indicate that the client is using FactorSoft to manage bulk
collateral facilities only and to limit the client to Client Information screen pan-
els that pertain to bulk collaterals.

Copy Click this button to create a new client with the same attributes as the currently
displayed client.

The upper fields are cleared and information in the following panels is retained.
All other client information from the source client is cleared:

l Address

l Bank Relationships

l Collections

l Control Contacts
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Field Description

The UCC Date and Signed Date, and the data from the Ineligibility and Veri-
fication panels can be optionally included or excluded, based on the setting of
following System Preferences in the Client rules/defaults, Rules, Copy client
folder:

l Copy ineligibility

l Copy signed date

l Copy UCC date

l Copy verification data

All other client information from the source client is cleared.

This function can be turned off by setting Security Role Client information,
Access, Client copy to No.

UCC date Enter the date on which the client’s Uniform Commercial Code (UCC) or Per-
sonal Property Security Act (PPSA) was filed or became effective.

This field can be PPSA if the UCC/PPSA is option in the System Preferences Ter-
minology folder is set to PPSA, indicating that the client is Canadian or deals
with Canadian customer/debtors.

Signed date Displays the date on which the client signed the Notice of Assignment (NOA).

1st fund Displays the date on which the first funding disbursement was made to the cli-
ent.

This field does not appear on the Add New Client screen, but is present after the
client is created.

Preference Select the default output option for report and statement printing, as well as for
use with reports that use the Preference destination (see Defining a Preference
Destination for more information).

l Select Print to print the report or statement and mail it to the client.

l Select Fax to fax the report or statement to the client.

l Select Email to email the report or statement to the client.

l Select Folder to save the report or statement in PDF format to a user-spe-
cified disk folder.

Bulk Collaterals User Guide
Entering Client Information

28 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

../../../../../../Content/_reports_module/rpts_sql_destination_preference.htm
../../../../../../Content/_reports_module/rpts_sql_destination_preference.htm


Field Description

No preference print
when grouped

Select this option to indicate that the client will not be included in group pref-
erence distribution of reports.

This option allows preference printing for all clients or client groups, while allow-
ing individual clients to be excluded from printing.

1st buy Displays the date on which the first purchase transaction was completed for
the client.

This field does not appear on the Add New Client screen, but is present after the
client is created.

Control Buttons

The buttons at the bottom of the screen are for basic screen control.

Button Description

Modify Click this button to create a new client or to update any changes made to an
existing client.

Audit Click this button to open the Client Audit History screen, which provides a record
of changes made to a client record.

You can generate an Audit Report to view changes made to all clients over a
specific time period. From the Reports module, select Client Audit Report from
the Audit Reports menu.

Letter Click this button to display the Create Client Word Document screen, from
which you can generate letters and facsimiles by merging client or debtor data
into existing Microsoft Word templates.

Labels Click this button to generate the Print Client Labels report, which is a full page of
standard mailing labels for the selected client.

Notes Click this button to open the Client Notes screen, which is used to create new
and view existing notes for the client.

Delete Click this button to delete the selected entry.

Exit Click this button to close the screen.
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Panel List

The list of links in the lower left-hand area of the screen displays the data panels list, whose topics cover
the bulk of the data associated with the client, such as demographic information in address and contacts
and financial data in balances, credit information contact address and Master Debtor, as well as more
complex financial data, such as the debtor’s balances, collections, and credit ratings. Note that, depend-
ing on configuration options and purchased modules, not all panels may be present in your imple-
mentation of FactorSoft.
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l Address

l Analysis

l Auto Cash Rules

l Automatic Expense

l Bank Relationships

l Broker Relationships

l Collections

l Contacts

l Contracts

l Control

l CPT Codes

l Credit & No Buy

l Debtor Charges

l Deferred accruals

l Documents

l Events

l Financial Statements

l Funding Instructions

l Groups

l Import Rules

l Identity

l Ineligibility

l Insurance

l Invoice Confirmation

l Invoice Delivery
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l Invoice Rules

l Liens/monitoring

l Load & Order Processing

l Minimum cash reserves

l Minimum Commissions

l Miscellaneous Data

l Miscellaneous Info

l Participation

l Payment Terms

l Policy Exceptions

l Posted Statements

l Purchase Approvals

l Purchase Info

l Purchase Terms

l Red Flag Rules

l Sales Volume

l Statement Terms

l Termination

l Verification

l Web Users

l Write Invoices

System Preferences

The following system preferences for this function are found in the Administration module, System Prefer-
ences, Client Rules & Defaults, Rules folder.
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Preference Description

Allow Duplicate Client
Names

Set to True to allow duplicate client names. You may wish to use the func-
tionality to use the same name for both master and member-clients, for
instance.

Allow Master Client
Logic

Set to True activate the Master Client functionality in FactorSoft.

Audit Level Select the option for the records to be included in the audit history for the Client
Information screen:

l None: Client Information audit history recording is unavailable.

l Critical: Records entries made to key client data fields, such as the client
name UCC filing date, client terms, and total credit limit. This setting
requires the least amount of storage space.)

l Major: Records entries made to the critical fields mentioned above as well
as other significant data fields, such as the date the client was signed, the
account executive in charge of the client, and the currency in use.

l Most: records entries made to the critical and major fields mentioned
above as well as common data fields, such as the client’s address, city,
state, and zip code, its phone and fax numbers, and its e-mail address.
This setting requires the most amount of storage space.

Do not lightup name
fields

Set to True to not highlight the Client name field when the user clicks in this
field.

The following system preferences for this function are found in the Administration module, System Prefer-
ences, Fields/screen behavior, Screens, Codes folder.

Preference Description

Client Code Select the option to determine the use of the Client Code for the client:

l Optional

l Required

l Never allowed

l Optional - warn on blank
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The following system preferences for this function are found in the Administration module, System Prefer-
ences, Identification/system constants, Interface Parameters, Preference Folder Printing folder.

Preference Description

Folder for saved
reports

To activate the Folder printing option for the Preference option, enter the drive
and folder location in which you want to save the client’s PDF reports.

Additionally, clients must be assigned client codes to be able to use the folder
preference feature. Once saved, the PDF file uses the following name format: Cli-
ent#_ReportID_YYMMDD_SSS.PDF, where Client# is the user-assigned client
code, Report ID is a system-defined report name, and SSS is a system-assigned
sequence.

The following system preference for a client's preference set to email must be set in the Administration
module, System Preferences, Identification/system constants, Performance, Messaging folder.

Preference Description

Messaging folder Enter the fully qualified path to the folder in which the attachment files are writ-
ten. Note that the Engine requires full rights to this folder.
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Client Information – Address Panel

Use this panel to enter the client’s mailing address, phone and fax numbers, and email address.

Field Description

Address Enter the street address (two lines available) for the client.

City Enter the city and state components of the client address in their respective
fields.

Postal code Enter the ZIP Code or postal code for the client address.

Account Monitoring Only appears if the Lien Monitoring is enabled. See the Lien Monitoring User
Guide, which can be accessed from the Client Portal.

Country Select the country for the client address from the list. The country name is dis-
played in the adjacent field.

Phone Enter the primary and secondary contact phone numbers for the client.

If you have Auto Dialer enabled, you can call the client contact by clicking on
the phone icons next to the client’s primary or secondary phone numbers. See
the AutoDialer User Guide, which can be accessed from the Client Portal.

Log Click this button to open the Phone Log for this debtor, which displays a record
of calls made to the client through the TAPI dialer.

Fax Enter the primary and secondary contact phone numbers for the client.

Email Enter the email address for the client. The Email address field is 200 characters
in length.

When email requests are processed in FactorSoft, the logic for Top-level
Domains (or TLD's, the portion of the email address after the domain name, e.g.,
.com, .org, .us, etc.) first edits the TLD against the "standard" names. If the TLD is
not found, then, based on System Preference, the system edits against a
domain name text file (provided by ICANN - Internet Corporation for Assigned
Names and Numbers) in the production data folder, which will be updated and
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Field Description

patched as new names come on line.

Set System Preference Identification/system constants, System constants,
Email domain edit rule to determine how TLDs are edited to the desired
value:

l Validate against original top-level domains & table of ICANN-era
domains (this value is the default)

l Validate against original top-level domains only

l Do not edit top-level domains

Time Zone Select the time zone for the client address.

Note that the capability to have the time zone set automatically exists in Fact-
orSoft. Time zones are automatically set based on the ZIP Code of the client
address. This functionality is enabled by System Preference. To automatically
set time zones for clients, set System Preference Client rules/defaults, Rules,
Update time zone based on zip code to True. Setting the time zone System
Preferences affects client records created going forward, and does not of itself
update existing clients retroactively. Use the Calculate Time Zone utility in the
Administration module to update existing clients' time zones.
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Client Information – Analysis Panel

Use this panel to enter or display the client’s trade details, such as its business type, and Standard Indus-
trial Classification code (SIC). The SIC codes are used to analyze concentration levels by industries, while
the referral source, business type and region fields are used to generate trend analysis reports.

The information contained on this window is used throughout the system for computation and reporting
functions.

Field Description

Business type Select the business type to be associated with the client. Business types are
defined in the Business Type table.

Referral source Select the type of referral or contact method through which the client was
signed. Referral sources are defined in the Referral Source table.

Region Select the region in which the client is located. Regions are defined in the
Region table.

SIC code Enter the Standard Industrial Classification code for the client (up to 10 digits).

NAICS code Enter the North American Industry Classification System (NAICS) code for the cli-
ent. The NAICS codes are a minimum of two and a maximum of six digits,
numeric characters only.
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Client Information – Bank Relationships Panel

This panel is used to enter or display the client’s banking information. The bank information is defined on
the Client/Bank Relationship screen for each of the client's bank accounts and displayed as line-items in
the grid on this panel. Each of your client’s bank names is listed in the grid on this panel.

Field Description

Also show inactive
relationships

Select this option to display inactive bank relationships in the grid.

Grid Displays any bank relationships that have been defined for the client.

View Click this button to open the Client/Bank Relationship screen to view or edit an
existing bank relationship.

New Click this button to open the Client/Bank Relationship screen to add a new bank
relationship.

Delete Click this button to open the Client/Bank Relationship screen to delete an exist-
ing bank relationship for the client.
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Client/Bank Relationship

The Client/Bank Relationship screen allows you to define a new banking relationship for a particular client,
or to view an existing one. Use this function to override the client’s existing payment procedure when a cli-
ent requests a direct payout to its creditors.

Bank Relationship Tab

The Bank Relationship tab is used to enter client bank account information for account held by an outside
financial institution. For new Bank Relationship entries, enter the information in the fields. For View and
Delete functions, the fields display the data previously entered for the entry.

Field Description

Account Name The bank account name.

Payable to (Blank for
client)

The name of the individual or business entity to whom the payment is made for
the bank account. It the payee is the client, leave this field blank. If the payee is
not the client, enter the new payee’s name here.

Depending on the information contained in this field, FactorSoft displays the cli-
ent or payee name when printing a disbursement check.

Bank Name The name of the financial institution on which the account is drawn.

Address The first two lines of the Payable to's street address, if different from Client’s
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Field Description

Address on Address Panel.

City, State, Zip The city, state, and ZIP Code/postal code components of the Payable to's street
address, if different from Client’s Address on Address Panel.

ISO Country Code The country component of the financial institution's street address.

Jack Henry™ strongly recommends setting the ISO Country Code for all bank
records. When using the Bank of America wire interface, an ISO Country Code is
absolutely required for any non-US bank. . If no code is set, FactorSoft assumes
the bank is a US bank, when the file is received at BofA, an ABA# is expected and
the transactions will error when none is found. Therefore, the best policy is to
always provide the ISO Country Code for all bank accounts.

Contact The name of the contact at the financial institution who is responsible for
account administration.

Special Instructions Free-form text field intended for funding and payout instructions and pro-
cedures. This text appears on the instruction field of wire transfer forms.

Phone The financial institution contact's phone number.

Fax The financial institution's fax phone number.

Bank Account# The account number of the client's account.

Bank ABA # The ABA Routing and Transit number of the financial institution on which the
account is drawn. The ABA # is nine digits in length.

Bank Code The bank code of the financial institution on which the account is drawn.

Swift Code The Swift code of the financial institution on which the account is drawn. These
codes are typically 8 or 11 characters in length and are used when transferring
money between banks, particularly for international wire transfers. The codes
can sometimes be found on account statements.

Pay by Select the default payment method for the financial institution. The list reflects
the default Check type and any account set up in the Account Type table with a
Wire pay-by code.

WF Currency Type Enter the Wire File currency type to be used.

Default Bank Account Select this option to indicate that this account is the regular deposit account for
the client.
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Field Description

Reserve Account Select this option to indicate that the account is being used as a reserve
account.

Modify Click this button to save updates made to the bank account information.

Inactivate Click this button to mark the account as inactive and prevent the bank rela-
tionship from being displayed in the Accounts list on transactions that allow
account selection.

Note that the date and user of the inactivation are displayed on the screen, and
that the button label is changed to Re-activate. If this account becomes active
for the client again, you can click this button and then click Modify to reactivate
the account.

Also, note that if an account is marked as the Default Bank Account, it cannot
be inactivated. Conversely, if an account is inactivated, it cannot be marked as
the Default Bank Account.

Inter Bank Tab

The Inter Bank tab is used to enter client bank account information when the lender is also the client's fin-
ancial institution and is the holder of the bank account. In other words, an internal account.

Field Description

Inter Bank Name The account name.

Bank Account # The account number of the client's account.

Bank ABA # Your institution's ABA Routing and Transit number. The ABA # is nine digits in
length.

Swift Code Your institution's Swift code. These codes are typically 8 or 11 characters in
length and are used when transferring money between banks, particularly for
international wire transfers. The codes can sometimes be found on account
statements.

ISO Country Code Your institution's country code.

Special Instructions Free-form text field intended for funding and payout instructions and pro-
cedures. This text appears on the instruction field of wire transfer forms.
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System Preferences

The following system preferences for this function are found in the Administration module, System Prefer-
ences,Client rules/defaults, Rules folder.

Preference Description

Disable bank code on
bank information
screen

Set to True to hide the Bank Code field on the Bank Information tab.
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Client Information – Broker Relationships Panel

Use the Broker Relationships panel to enter or display the client’s brokers, and to establish new rela-
tionships between the client and existing brokers. Brokers are defined in FactorSoft in the Add New Broker
screen.

The panel displays brokers that have a relationship with the client, and their respective commission rates.
It also indicates whether or not the broker is using its standard commission rate as stipulated on the
Broker Information screen.

Field Description

Grid Displays any client/broker relationships that have been defined for the client.

View Click this button to open the View /Update Existing Client/Broker Relationship
screen to view or edit an existing client/broker relationship.

New Click this button to open the Add New Client/Broker Relationship screen to add
a new client/broker relationship.

Delete Click this button to open the Confirm Delete of Client/Broker Relationship screen
to delete an existing client/broker relationship for the client.
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Add/Update/Delete Broker Relationship

The Broker Relationship screen is accessed from the Broker Relationship panel of the Client Information
screen, and is used to define a new broker relationship for a particular client, or to view an existing one.

Field Description

Client Displays the client name and number of the selected client.

Broker Select the broker for the client/broker relationship. This list displays all Active
status brokers.

Effective From/Thru Enter beginning and ending dates to establish the duration of the client/broker
relationship.

Use standard com-
mission rate

Select this option to use the standard rate structure established for the broker
on the Broker Information screen. If this option is selected, the rate fields on this
screen are unavailable.

Non-Standard Commission Rate Tab

Payment on 1st buy Enter the payment due the broker on first purchase, as applicable.

(Commission rate
table)

This table is used to create to create the non-standard commission rate struc-
ture for a broker:
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Field Description

l New: Click to display the Create New Rate screen that is used to add a
month/rate category to the commission rate for the broker or cli-
ent/broker relationship. Note that zero rate

l Cng: Click to display the Update Existing Rate screen that is used to edit
an existing month/rate category for the broker or client/broker rela-
tionship.

l Del: Click this button to delete an existing month/rate category for the
broker or client/broker relationship.

l Grid: Displays the commission rates that have been set up for specified
time periods.

l Thru Month: Displays the number of months through which the rate
applies the broker commission.

l Rate: Displays the rate used to calculate the commission for each time
period entry.

Commission based on Select the option that defines the basis for the commission calculation for the
client/broker relationship:

l Earnings: base commission on fees earned

l Earnings less cost of funds: base the commission on fees earned minus
a percentage of the average daily balance.

l Earnings excluding chargebacks: base the commission on fees earned
that do not include chargeback fees.

l Earnings and fee escrow: base the commission on fees earned including
escrowed fees.

l Earnings excluding purchase fees: base the commission on fees earned
excluding purchase fees.

l Payments applied: base the commission on collections received from
the client’s debtors.

l Invoices purchased: base the commission on invoices purchased per
statement period.

Exclude earnings from Select this option to exclude earnings incurred on Net Funds Employed when
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Field Description

client fee statement calculating a broker’s commission. As a result, earnings posted on the New Cli-
ent Fee Statement are excluded from the broker commission statement.

Exclude earnings from
due day increases

Select this option to exclude earnings incurred from due day increases when
calculating a broker’s commission.

Exclude earnings from
extra debtor fees

Select this option to exclude earnings incurred from extra debtor fees when cal-
culating a broker’s commission.

Purchase fees are
taken when paid

Select this option for earnings to be calculated when invoices are paid.

ABL Tab

Include the following
from ABL state-
ments/postings

Select the fees, unused line, and/or excess/deficit totals from Bulk Collateral
statement postings to be used as the basis for broker commission cal-
culations.

Amount on 1st funding Enter a flat payment due the broker on first funding for the client.

Create/Update/
Verify

This button is used to complete add, update, and delete actions on the Broker
Relationship screen.

l Create: Complete the addition of a new entry.

l Modify: Complete an update to an existing entry.

l Verify: Confirm and complete the deletion of an existing entry.

Exit Click this button to close the screen.

System Preferences

The following system preferences for this function are found in the Administration module, System Prefer-
ences, Reports, Broker commission reports folder.

Preference Description

Earnings do not
include additional
fees

Set to True to exclude any additional fee earnings from the client’s total earn-
ings when calculating a broker’s commission.
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Client Information – Contacts Panel

Use this panel to view any of your client’s existing contact persons, or to create new ones. The contact
information is defined on the Add New Client Contact screen and displayed as line-items in the grid on
this panel.

Field Description

Hide inactive con-
tacts

Select this option to hide inactive contact line-items in the grid.

Grid Displays any client contacts that have been defined for the client.

The Auth column indicates whether the contact has authority --for example to
sign off or verify invoices.

The Attn column indicates whether the contact is included in the distribution of
outgoing reports.

View Click this button to open the View/Update Existing Client Contacts screen to
view or edit an existing client contacts.

New Click this button to open the Add New Client Contact screen to add a new client
contact.

Delete Click this button to open the Confirm Delete of Client Contact screen to delete
an existing contact for the client.
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Client Information – Control Panel

Use this panel to enter or display additional client details, such as assigning the client to a particular office
location, its tax code and currency, and more.

Field Description

Office Select the office to which the client account is assigned. Offices are defined in
the Office Maintenance table.

Tax code Select the tax code definition for the client. Tax codes are defined in the Sales
Tax Rate table.

G/L group Select the G/L Account group definition for the client. G/L account groups are
defined in the G/L Account Groups table.

This option does not appear on ABL Clients if non-detail only is checked, the G/L
Group is set on the Facility Information screen. Note that access to this function
may be limited by Security Role.

AE Select the account executive to which the client account is assigned. Click the
Clear button to remove the A/E selection for the client.

Set System Preference Terminology, Select account executive based on check
box to True to display only users marked as AEs in the list.

OK to perform IDC Select this option to indicate that the client's invoices can be input via Intelligent
Data Capture. This is a separately licensed feature of FactorSoft

This option only appears if IDC is enabled.

Currency Select the default currency for the client. Currencies are defined in the Currency
Denominations table.

Note that access to this function may be limited by Security Role.
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Field Description

Web access P/W Enter the ClientWeb password for the company to allow ClientWeb access for
the client.

This option only appears if Allow web access is selected in the upper fields of
the Client Information screen for the client.

Next Buy # Displays the next purchase batch number for the client.

This option does not appear on ABL Clients if non-detail only is checked.

Next collection batch
#

Displays the next collection batch number for the client.

Do not allow reserve
transfers

Select this option to turn off the Transfer tab of the Client Summary/Reserve
Release screen for the client, thereby preventing reserve release.
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Client Information – Credit/No Buy Panel

The Credit/No Buy panel is used to define information about the client’s financial status.

Field Description

Client credit rating Enter the client's credit rating. This is a free-form text field and you can define
the rating in any terms meaningful to your organization.

Approved by: When Client Approval is required, a user with appropriate Security Role can
approve the client in the system using the Approve button. Once approved, the
fields will display the user who approved the client and date of approval. Client
Approval data elements are available for Audit upon successful approval.

Note: After upgrade to v4.3+, if the System Preference at Client rules/defaults > Rules >
Require manager approval before using (T/F), is set to True and a newly added Client
Record is not approved, the Client record will not populate in any Client Lists throughout
FactorSoft.

Total client credit limit Enter the maximum overall credit limit for the client.

Limit set by: When a Total client credit limit is set, this field will display the user who set the
limit.

Max indiv cus-
tomer/debtor

Enter the maximum credit limit for any single customer/debtor.

% Bal Enter the maximum percentage of the client's total A/R balance to use as a
credit limit for any single customer/debtor.

Warning Enter a warning message for the client. You can enter a warning up to 100 char-
acters in length.

A system preference produce a warning message when attempting to pur-
chase invoices for the client, based on system preference settings.

This warning can be made to appear next to the client name on the Client
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Field Description

Information screen. On the System menu, click User Preferences. Then, on the
Client List Screen tab, select the Warning/Notes option in the Fields group.

Statement text Select the statement text to be included in the debtor statements for this client.
Statement texts are defined in the Statement Text table.

Auto approval rule Select the Auto Approval Rule set to use for automatic credit request approval.
Automatic credit request approval rules are defined in the Auto Credit Approval
Rules table. This list only shows rules that are set as active in the table.

This option is not available if the “Auto Approval Rule Basis” System Preference
(Client Rules/Defaults > Auto Approval) is set to use debtor rules instead of cli-
ent rules.

Do not allow new pur-
chases

Select this option to prohibit invoice purchases regardless of the client’s credit
limit.

If this option is selected, a verification message appears when you attempt to
access the New Purchase/Schedule Batch screen, indicating that you can enter
purchase data, but will not be able to process the purchase until the no-buy
condition is resolved and removed.

Do not allow reserve
release

Select this option to prohibit reserve release for this client.

If this option is selected, a warning message "Reserve Release Not Allowed" is
displayed on the Release tab of the Client Summary/Reserve Release screen.

Do not allow
AutoCredit

Select this check box if you do not want to use auto approval from AutoCredit
with the client.

System Preferences

The following system preferences for this function are found in the Administration module, System Prefer-
ences,Client rules/defaults, Defaults, Credit limits folder.

Preference Description

Maximum individual
debtor limit

Set the system-wide maximum credit limit for any single customer/debtor.

Total client credit
limit

Set the system-wide maximum overall credit limit.
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The following system preferences for Client Approval are found in the Administration module, System
Preferences,Client rules/defaults, Rules folder.

Preference Description

Require manager
approval before
using

Set to True to require that a Manager approve Client records on the Credit/No
Buy panel of the Client Information screen. In order for a User to be considered a
manager, they must be assigned to a Security Role where Client information >
Access > Manager for approval purposes is set to Yes.

Note: After upgrade to v4.3+, if set to True and a newly added Client Record is not
approved, the Client record will not populate in any Client Lists throughout FactorSoft.

Allow new purchase
batch on unap-
proved Client

Set to True, to allow a Purchase batch to be created for manually created unap-
proved clients.

Note: The Client must be approved before the Invoice can be approved/purchased in the
Manage Pending Purchases(F8) screen.
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Client Information – Documents Panel

The Documents panel is used to attach and view client-related documents to the client. Note that the grid
displays each stored document by Description, Date, and File Name within document category.

Field Description

Category Lists the categories defined in the Document Category Maintenance table for
debtor use. Selecting a category displays the documents that have been
added under that category for the client.

Grid Displays the debtor-related documents attached to the client record.

l Description: the document description from the Attach Document to Cli-
ent screen.

l Date: the computer processing date on which the document was
attached to the customer/debtor record.

l File name: the file name of the attached document.

New Click this button to open the Attach Document to Client screen, which is used
to attach documents to the client record.

View Select a document line-item from the grid and click this button to display the
contents of the file in its native application (for instance, a .doc file in Microsoft
Word, or an .xls file in Microsoft Excel).

Delete Select a document line-item from the grid and click this button to remove the
attached document from the customer/debtor record. This does not delete
the document from its source directory.
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Client Information – Events Panel

The Events panel is used to create, update, view, and delete client events for the client. These events dis-
play a tickler note upon login to remind the user of the scheduled task. Use this panel to view any current
client events and their expiration dates, or to create new ones. Client events are defined in the Client Event
Table for selection in the new client event screen.

Field Description

Grid Displays the debtor-related documents attached to the client record.

l Event code: the event code selected for the event on the Add New Client
Event screen.

l Description: the description entered for the event on the Add New Client
Event screen.

l Expires: the expiration date entered for the event on the Add New Client
Event screen.

New Click this button to open the Add New Client Event screen, which is used to add
a new event for the client.

View Select an event line-item from the grid and click this button to display the
View/Update Existing Client Event screen, which is used to view or update a cli-
ent event.

A Security Role, Client information, Events, View events allows users to click the
View button to open the View/Update Client Event screen as view-only. The
screen fields will be for display only and cannot be updated if the Update
events role is set to No.

Delete Select an event line-item from the grid and click this button to delete the client
event. The Delete Existing Client Event screen is displayed. Click the Verify but-
ton to complete the delete.
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Add New Client Event

The Client Event screen is used to schedule a client task that needs to be performed on a regular basis.
Using this screen you can create new client events, or to view or update details or verify delete of an exist-
ing event.

To create a new event, this screen is accessed by clicking the New button on the Events panel of the Client
Information screen. To view or update an existing event, you can click View to access the screen from the
Event panel of the Client Information screen or select the event and click Modify from the Client Events
Expiration screen.

Once the selected event is linked to the client, FactorSoft brings up a tickler note upon login to remind the
user of the scheduled task.

TIP
To view tickler notes upon login, each user must select Bring Up Tickler If There Are Notes To Be
Read on the Bring Up On Login tab of the User Preferences, System menu.

Field Description

Client Displays the client selected for the Client Information screen.

Event Select the event type for the client event. Client event types are defined in the
Client Events table.

Description Displays the event type description.

Event Date Enter the event date for the client event. This could be either the beginning or
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Field Description

ending date of the event, based on how the event type is set up in the Client
Events table.

Expire Days/Months The time period in which the event expires. Could be days or months based on
event type definition. If event type is defined with event type as an ending date,
this field cannot be edited.

Expire date Displays the events expiration date based on the number of days/months
entered.

Memo Enter any event related memo data required.

Exclude from Web
Events

Select this option to exclude certain events by client from displaying on the
Web Portal > Client Dashboard > Events widget.

Create/Modify/
Verify

This button is used to complete add, update, and delete actions on the Add
New/Modify Existing/Delete Existing Client Event screen.

l Create: Complete the addition of a new entry.

l Modify: Complete an update to an entry.

l Verify: Confirm and complete the deletion of an entry.

Cancel Click this button to close the screen.

Security Roles

To control access in this area, the following Security Roles apply:

l Security Roles > Client Information > Events > Update events

l Security Roles > Client Information > Events > View events

l Security Roles > Client Information > Events > Exclude from Web Events (update)
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Client Information – Financial Statements Panel

The Financial Statements panel provides a snapshot of the client's financial information including last
statement date, Assets, Liabilities, Net Worth, and Profit and Loss.

Clicking on an entry in the Financial Statements list opens the corresponding Client Financial Statement
screen, showing Current Credit Limit and Financial Statement Date, Balance Sheet items, and Income
Statement items.

Field Description

Waived Select to indicate that the financial statement requirement is waived for this cli-
ent.

Grid Displays any financial statement that have been recorded for the client.

View Click this button to open the Client Financial Statement screen to view or edit a
financial statement.

New Click this button to open the Client Financial Statement screen to add a new fin-
ancial statement.

Delete Click this button to open the Client Financial Statement screen to delete a fin-
ancial statement entry for the client.
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Client Financial Statement

The Client Financial Statement is used to add new financial statement detail for a client, and to view
and/or update existing financial statements for the client. This screen is accessed from the Financial
Statement panel of the Client Information screen.

Field Description

Current Credit Limit Displays the total client credit limit established for the client on the Credit/no
buy tab of the Client Information screen.

Financial statement
date

Enter the date of the financial statement.

Record created Displays the date on which the financial statement was first entered in Fact-
orSoft.

Record last updated Displays the date on which the financial statement was last updated and saved
in FactorSoft.

Current assets Enter the dollar amount of current assets from the financial statement for the cli-
ent.

Other assets Displays the remainder of Total assets minus Current assets.

Total assets Enter the dollar amount of total assets for the client in this field. The total assets
include current assets and any other assets attributable to the client.

Current Ratio The ratio of Current Assets to Current Liability.
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Field Description

Assets/Liability The ratio of Total Assets to Total Liability.

Working capital The dollar amount of working capital, calculated as the remainder of Current
Assets minus Current Liability.

Net worth/Dlr Enter the dollar amount of net worth for the client.

Current liability Enter the dollar amount of current liability for the client.

Total liability Enter the dollar amount of total liability for the client in this field.

The total liability include current liability and any other liability attributable to
the client.

Long term/other liab-
ility

The dollar amount of long terms or other liability, calculated as the remainder
of Total Liability minus Current Liability.

Notes Enter free-form text notes concerning the client's financial statement.

Net Sales Enter the dollar amount of net sales for the client financial statement.

Net profit or loss Enter the dollar amount of net profit or loss for the client financial statement. If
loss, enter with a minus sign before the dollar amount. The field to the right dis-
plays the ration of net profit or loss to Net Sales.

Create/Modify This button is used to complete add, update, and delete actions on the Client
Financial Statement screen.

l Create: Complete the addition of a new client financial statement.

l Modify: Complete an update to an existing client financial statement.

Cancel Click this button to close the screen without saving.

Bulk Collaterals User Guide
Client Financial Statement

59 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Client Information – Funding Instructions Panel

The Funding Instructions panel is used to enter or view instructions relevant to the purchase process for
this client. The funding instructions entered on this panel appear on the Payout Tab of the
Purchase/Schedule batch screen when disbursing funds.

Field Description

Funding limit Enter the dollar amount to which to limit funding for the client. This is separate
from the purchase limit, and is used to prevent funding on the non-funded
invoices function and in the approval functions when funding the invoice would
exceed this limit. If no amount is entered in this field, no funding limit is
enforced.

Security roles can be configured to allow authorized users the ability to fund
over the funding limit.

Funding instructions Enter free-form text instructions. You can create texts of any size, and create
line breaks using the Enter key.

Modify Click this button to save the instruction texts.

Cancel Click this button to cancel unsaved texts.

Bulk Collaterals User Guide
Client Information – Funding Instructions Panel

60 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Client Information – Groups Panel

The Groups panel lists the Client Groups created in the Client Group Table. Use this panel to set values in
the Client Group Code(s) for the client to allow you to generate reports based on group codes and group
values.

This setting is also used to alert the user assigned to the client when Client Events are configured with the
Remind option set to Member of group, or for notification when money is put into a hold account set up
in the Accounts Tables section.

For example, suppose there is a Client Group set up with a group type of Users, and it is called Group1. In
the Groups panel, you can select Group1 and click Edit to display the Change Client Group Value screen
and then select the user to be alerted for Group1 for this client from the Value list.

Note that access to view and/or update this panel are controlled by Security Role.

Field Description

Edit Click this button to open the Change Client Group Value screen, which you can
use to set the Value for the selected Client Group code for the client.
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Change Client Group Value

The Change Client Group Value screen is used to assign values to a group code for the client selected in
the Client Information screen. You can also change or remove the group value using this screen.

Field Description

Client Displays the client name of the client selected in the Client Information screen.

Code Displays the client group code name of the group code selected in the Group
panel of the Client Information screen.

Description Displays the description of the client group code, defined in the Client Group
Code table.

Value Select the value to be associated with the client group code for this client. The
group code values are defined on the Client Group Code table.

Clear Click this button to clear the contents of the Value field.

Modify Click this button to complete the update to client group code.

Cancel Click this button to close the screen without saving.
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Client Information – Identity Panel

Use this panel to enter or display additional client details, including alternate name and federal tax num-
ber. The information contained on this screen is used throughout the system for computation and report-
ing functions:

Field Description

Alternate name Enter the alternate name for the client, if applicable.

EDI identity Enter the 21-digit client EDI identity code. This code is used in transmitting and
receiving EDI transactions for the client.

Incoming fax Enter the client's fax number on which you would receive faxes from the client.
This field is used with SmartFax interfaces.

Fed tax # Enter the client's nine digit Federal Tax identification.

D&B D-U-N-S Enter the clients D&B D-U-N-S (Data Universal Numbering System) identifier.

Fed Bus # This is an optional field that only appears if the System Preference Terminology,
Federal business number title is completed. You can enter up to 12 characters in
the preference, and the data entered in the preference is the label that appears
on the screen.

Fed Co # This is an optional field that only appears if the System Preference Terminology,
Federal company number title is completed. You can enter up to 12 characters
in the preference, and the data entered in the preference is the label that
appears on the screen.

Motor carrier # Enter the carrier number that uniquely identifies a carrier client in FactorSoft.

DOT # Enter the client's US Department of Transportation number (DOT#) or com-
parable data.
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Field Description

Language Select the client's native language. Language selections are defined in the Lan-
guage Code table.

Translation Select the language file to use to translate the FactorSoft Reporting Services
data entry reports when reprinted from the Reprint Data Entry Reports screen.
This field only contains selections if FactorSoft Multi-Ligual ClientWeb is enabled
for the database.

System Preferences

The following system preferences for this function are found in the Administration module, System Prefer-
ences, Client rules/defaults, Edits folder.

Preference Description

Client DOT edit rule Set to this preference to the desired edit preference for uniqueness of DOT num-
bers:

l Not required to be unique

l Must be unique across clients

l Must be unique across clients and debtors
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Client Information – Liens/Monitoring Panel

The Liens/monitoring panel is used to enter and display liens for which the client is liable. Click the New
button to display the Client Liens screen, on which you can record lien information for the client.

Field Description

Grid Displays any liens that have been defined for the client. Data displayed in the
grid for each entry is:

l Date: date on which the lien was issued or became effective.

l By: lien-holder’s name(the lender or lending institution).

l Amount: the lien amount.

l Expire: date on which the lien subordination to the lender expires.

l Release: the release date of the lien.

Account Monitoring This button opens the Monitor Requests screen and only appears if Lien Mon-
itoring is enabled. See the Lien Monitoring User Guide.
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Client Information – Misc Data Panel

Use this panel to add miscellaneous data elements to the client record for use on letters. The data ele-
ments are created in the Miscellaneous Data Elements table. Click the link for more information about
using Miscellaneous Data Elements.

Field Description

Grid The grid lists the data elements defined in the Miscellaneous Data Element
table for the Client Information screen, and the Value assigned to the data ele-
ment, if applicable.

Modify Click this button to display the Set Element for a Client screen, on which you
can add, change, or clear the value for the data element.
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Client Miscellaneous Data Elements for Letters

Client Miscellaneous Data Elements values have been added for use with letters. Use the Miscellaneous
Data Elements Table to create user-defined data elements for selection on the Client Information Screen:

To create Client Miscellaneous Data Elements and use them in a letter:
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1. Create the Data Element name in the Miscellaneous Data Element Table (in Client & Debtor menu of
the Tables module):

l Click the New button.

l In the Show elements used on the list, select Client information screen.

l In the Element field, enter a unique name for the miscellaneous data element.

This is the exact name that will be used in the Word Document letter template.

l Complete the remaining fields as required.

l Click Create.

2. Create a value for the Miscellaneous Data Element in the Misc Data panel of the Client Information:
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l Select the Element from the list.

l Click Modify.

The Set Element for a Client screen appears.

l In the Value field, enter the value to print in the letter for the miscellaneous data element.

l Click OK to save the value for the data element.

3. In the Word template for the letter, enter the miscellaneous data element name in “angle brackets”
(i.e., less and greater than symbol) in the position where you want the value for the element to print.

For example, you would enter <Client Misc Data> for the above example in the Word template to
print the value “Client Test Value” for client BBS Trucking.
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Client Information – Misc Information Panel

Use this panel to enter or view additional information about the client.

Field Description

Misc Information Enter free-form text for any additional information you wish to record about this
client. This field can contain as many characters as you wish. Press the Enter
key to start a new line within the message box.

Modify Click this button to save changes to the Miscellaneous Information panel.

Cancel Click this button to cancel unsaved changes.
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Client Information – Policy Exceptions Panel

The Policy Exceptions panel allows you to specify any exceptions to policy that this client may be granted.

Field Description

Policy exceptions Enter free-form text for any policy exception information you wish to record
about this client. This field can contain as many characters as you wish. Press
the Enter key to start a new line within the message box.

Modify Click this button to save changes to the Policy Exceptions panel.

Cancel Click this button to cancel unsaved changes.
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Client Information – Termination Panel

The Termination panel is used to record termination details for a client, should your relationship with the
client cease.

Field Description

Term date Enter the termination date for the client.

Non-accrual date Set the non-accrual date through which to calculate fees for payments and
overnight accruals that are processed, if this date is later than the payment
date.

Code Select the applicable dispute code for the client termination. Dispute codes are
defined in the Dispute Codes Table.

Description Enter free-form text for additional information relating to the termination of the
client.
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Client Information – Web Screens Panel

Allowing a client to access and use the ClientWeb is actually a matter of two distinct steps: granting
access and setting screen permissions. Access is granted by via a checkbox on the Client Information
screen and by setting a password for the client on the Control profile. Permissions are set via the Client
Information Web Screens panel.

Think of ClientWeb permissions as granting access to—or restricting access from—each screen that you
have made available in your ClientWeb interface.

Field Description

Allow web chat Not used.

Show credit limit on
invoice authorization
web screen

Select this option to enable the credit limit to be displayed on the

Screen Lists the available Client Web pages.

Status Displays the status of each available screen for the client. Double-click a line
item to change its status.

l Active: indicates that the page is enabled in ClientWeb for this client.

l Inactive: indicates that the page is not available in ClientWeb for this cli-
ent.
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Client Information – Web Users Panel

This panel lists all client users set up to access ClientWeb and to upload invoice and debtor data via the
Internet.

Clients are given permission to access ClientWeb from the Allow web access option in Client Information
upper fields. The user name is the Client Code, and the password is defined in the Web access P/W field of
the Control panel of the Client Information screen. This user name will then have authority to create new
users for ClientWeb access to the client's information.

All of the client's users (the company user and any users created by the company user) are displayed in a
view-only list that displays the following information:

Field Description

Code The user name for the user.

Name The name defined for the user in ClientWeb.

Created The computer processing date on which the user name was created.

By The user that created the web user name.

Add Indicates whether the user name has rights to add users in ClientWeb.

View Indicates whether the user name has rights to view the User List page in Cli-
entWeb.

DE Indicates whether the user name has data entry rights in ClientWeb.

Req Indicates whether the user name has rights to request distributions in Cli-
entWeb.
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Add New Contact/Contact Information

The Contact Information screen is used to create a new business contact for the client or cus-
tomer/debtor, or to view or modify an existing one. This screen can be accessed from the New or View but-
tons on the Contacts Panel of the Client Information or Debtor Information screen.

Field Description

First, Last Name The contacts first and last names (separate fields).

Title The business title of the contact.

Address The first two lines of the street address for the contact.

City, State, Zip The city, state, and Zip Code/Postal Code components for the contact address
(separate fields).

Country The country component for the contact address.

Email The email address for the contact.

When email requests are processed in FactorSoft, the logic for Top-level
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Field Description

Domains (or TLD's, the portion of the email address after the domain name, e.g.,
.com, .org, .us, etc.) first edits the TLD against the "standard" names. If the TLD is
not found, then, based on System Preference, the system edits against a
domain name text file (provided by ICANN - Internet Corporation for Assigned
Names and Numbers) in the production data folder, which will be updated and
patched as new names come on line.

Set System Preference Identification/system constants, System constants,
Email domain edit rule to determine how TLDs are edited to the desired
value:

l Validate against original top-level domains & table of ICANN-era
domains (this value is the default)

l Validate against original top-level domains only

l Do not edit top-level domains

Ownership % The percentage of ownership in the client business that the contact has, if
applicable.

Phone The contact's primary phone number.

If you have FactorSoft Auto Dialer enabled, you can call the contact by clicking
on the phone icons next to the debtor’s primary or secondary phone numbers.

Extension The contact's primary phone number extension.

Fax The contact's fax phone number.

Cell The contact's mobile phone number.

Authority Select this option to indicate that the contact has authority within the client
organization; for example to sign off or verify invoices.

Attention Select this option to include the contact’s fax or email address when sending
notices, reports, or statements.

To address several contacts within the organization, check each contact’s
Attention box. Depending on the main contact’s report preferences, FactorSoft
automatically includes the contacts’ email addresses or fax numbers when gen-
erating outgoing reports.

Notices Select this option to indicate that the contact is the recipient of notices of

Bulk Collaterals User Guide
Add New Contact/Contact Information

76 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

assignment for the organization.

Cng Rept Select this option to send the Client Change Report to selected client contacts
when the report is generated.

When the report is generated, it is transmitted to the client contact. If there is
not data for a client, a message indicating that no data was generated is trans-
mitted to the client. Transmittal occurs as follows: send via email if there is an
email address on the contact record. If there is no email, send via fax if there is
a fax number.

Guarantor Select this option to indicate that the contact is the guarantor of the cus-
tomer/debtor organization.

Inactivate Select this option to indicate that the contact is no longer active for the cus-
tomer/debtor.

Web Access Select this option to indicate that the contact should have access to the Web
Portal.

Web Admin Select this option to indicate that the contact should have Admin access to the
Web Portal.

Inv Delivery Select this option to email Invoice Delivery packages for the debtor to the con-
tact.

Note that this option only appears for debtor contacts.

Comments Enter additional contact related information as required.

Create/Update/
Verify

This button is used to complete add, update, and delete actions on the Cus-
tomer/Debtor Contact screen.

l Create: Complete the addition of a new entry.

l Modify: Complete an update to an existing entry.

l Verify: Confirm and complete the deletion of an existing entry.

Audit Click this button to open the Contact Audit History screen, which provides a
record of changes made to a contact record.

Note that the audit is specific to the contact and can be accessed only from the
Add New or View/Edit Existing Contact screens. The Audit function from the Cli-
ent Information and Debtor Information screens does not contain the contact
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Field Description

audit items.

Cancel Click this button to close this screen.

Apply Click this button to save the screen without closing.

Phone Log Click this button to access the call log. This option only applies if the FactorSoft
Auto Dialer is enabled.

Security Roles

To view and update the Contacts form, the following Security Role needs to be set to YES, Security Roles >
Contacts > Access:

l Add new contacts

l Delete contacts

l Contacts information (update)

l Contacts information (view)

l Allow Users to Update Web Access

l Allow Users to Update Web Admin

l Contact List
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Brokers

In FactorSoft, brokers are defined as persons acting as the lender's agent to assist in the development of
new business (as in negotiating contracts, purchases, or sales) in return for a fee or commission. Gen-
erally, commissions are paid to brokers based on the performance of clients associated with the broker.
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Broker List (F2)

The Broker List screen displays all brokers and associated details for each broker, such as the broker’s
name, address, phone number, status and so on.

TIP
The Broker List (F2) screen is accessed by selecting Office → Broker List or by pressing the F2 key on the
FactorSoft Desktop.

To modify information for a broker, double click the corresponding line. Information for the broker displays
on the Broker Information screen and can be modified as needed.

To add a new broker to the list displayed on the Broker List (F2) screen, select File → Add New Broker on the
FactorSoft Desktop.

For more information on the Broker Information screen and the Add New Broker screen, refer to " Add New
Broker/Broker Information" on page 82.

Field Description

(Scroll) Enter a character (number or letter) or combination of characters to advance
the list to the broker name beginning with that character or combination of
characters.

Show active brokers
only

Select this option to exclude brokers with a Status other than Active set in the
Broker Information screen from the Broker List.

Category Select the broker category to which to limit the display of brokers in the grid.
Broker categories are defined in the Broker Category Table.

(Grid) Displays the brokers with the following data. Click a header title to sort the list by
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Field Description

that column. Double-click a line-item to open the Broker Information screen for
that broker.

l Code: the broker code

l First Name: the broker first name

l Last Name: the broker last name

l Company: the company name for the broker

l City: city, state, and ZIP/Postal Code for the broker address

l Phone: the primary phone number for the broker

l Status: Status code selected for broker on Broker Information

Broker Information Select a broker from the list and click this button to display the Broker Inform-
ation screen for the broker.

Print Click this button to generate the Broker List Report, which contains the inform-
ation listed in the Broker List grid. The report is generated in a FactorSoft Report
Viewer preview screen, which can be printed to a local or network printer or
exported in a variety of formats.
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Add New Broker/Broker Information

The Broker Information/Add New Broker screen is used to add new brokers and related details to the sys-
tem, and to view or modify information about existing brokers.

NOTE
The name of this screen varies based on how the screen was accessed. If this screen was accessed
by double clicking a broker on the Broker List (F2) screen, this screen displays as the Broker Inform-
ation screen. If this screen was accessed by selecting the Add New Broker option in the File menu on
the FactorSoft Desktop, this screen displays as the Add New Broker screen.
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To add a new broker, enter information in the related fields, such as the broker name, company name,
address, phone number, and so on, and click the Create button. After clicking this button, the screen
closes and the broker is added.

To modify information for an existing broker, update the entries as necessary and click the Update button.
The window closes and the broker details are saved.

Use the fields on this screen to enter or modify basic information, such as the broker’s name, optional
code, physical and email address, phone, fax, social security number (SSN), and tax number.

Field Description

Code Enter the optional code that uniquely identifies the broker.

The rules for entry of this field are controlled through System Preference Field-
s/Screen Behavior, Codes, Broker Code. Options are Required,Optional, and
Never allowed.

Additionally, you can define whether or not the code must be unique. Set Sys-
tem Preference Fields/screen behavior, Screens, Broker information, Allow
duplicate broker codes to the appropriate option, as defined below:

l Do not allow duplicates

l Allow duplicates, requires user confirmation

l Allow duplicates, no warning will be issued

Status Select the broker’s status:

l Active

l Do Not Assign

l Do Not Report

Name, First/Last The first and last name of the broker.

Company The company or agency name associated with this broker.

Address The first and second lines of the broker's mailing address.

City The city, state and ZIP Code components of the broker's mailing address.

Country The country component of the broker's mailing address.

Email The broker's email address.

When email requests are processed in FactorSoft, the logic for Top-level
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Field Description

Domains (or TLD's, the portion of the email address after the domain name,
e.g., .com, .org, .us, etc.) first edits the TLD against the "standard" names. If the
TLD is not found, then, based on System Preference, the system edits against
a domain name text file (provided by ICANN - Internet Corporation for
Assigned Names and Numbers) in the production data folder, which will be
updated and patched as new names come on line.

Set System Preference Identification/system constants, System constants,
Email domain edit rule to determine how TLDs are edited to the desired
value:

l Validate against original top-level domains & table of ICANN-era
domains (this value is the default)

l Validate against original top-level domains only

l Do not edit top-level domains

Currency The default currency to use for the broker.

Category Select the broker category to which the broker is assigned. Broker categories
are defined in the Broker Category Table.

Phone The primary and secondary telephone numbers for the broker.

Fax The FAX phone number for the broker.

SS# The broker's Social Security Number.

Tax # The Federal Tax ID for the broker, company, or agency.

Expires Enter the broker’s Tax ID expiration date.

Create or Update Click to complete the task and exit.

Cancel Click to exit without saving changes to the Add Broker/Broker Information
screen.

Apply Click to update your entries without exiting.

Audit Click this button to open the Audit History screen, which provides a record of
changes made to a broker record.

Create or Update Click to complete the task and close the screen.

Delete Click to delete the displayed broker and close the screen.
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Field Description

This button is only available on the Broker Information screen.

Clients Tab

The Clients tab includes information for each client for which a relationship between the broker and a cli-
ent exists. Information such as the name and phone number of the client display.

To review client information on the Client Information screen, highlight the client in the grid and click the
Information button. In addition, highlight a client and click the Aging button or the Transactions button to
display the Summary Aging window or the Transactions window respectively, where aging information
and transaction information for the client can be reviewed.

Field Description

Name Displays the name of the client associated with the broker.

Phone Displays the phone number of the client associated with the broker.

Information button Click to view the selected client’s Client Information window.

Aging button Click to view the selected client’s Aging window.

Transactions button Click to view the selected client’s Transactions window.

Instructions Tab

The Instructions tab is used to add any notes or instructions related to the broker.
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Standard Commission Rate Tab

The Standard Commission Rate tab is used to define or modify the commission rates for the broker. When
defining commission rates on this tab, you can specify the number of months through which the rate
applies and the calculation method for the commissions.

Field Description

Payment on 1st Buy Enter the dollar amount of the payment the broker is to receive upon a first pur-
chase.

(Commission rate
table)

This table is used to create the standard commission rate structure for a broker:
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Field Description

l New: Click to display the Create New Rate window that is used to add a
month/rate category to the commission rate for the broker or cli-
ent/broker relationship.

l Cng: Click to display the Update Existing Rate window that is used to edit
an existing month/rate category for the broker or client/broker rela-
tionship.

l Del: Click this button to delete an existing month/rate category for the
broker or client/broker relationship.

l Grid: Displays the commission rates that have been set up for specified
time periods.

l Thru Month: Displays the number of months through which the rate
applies the broker commission.

l Rate: Displays the rate used to calculate the commission for each time
period entry.

Commission based
on

This option defines the broker’s commission calculation method:
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Field Description

l Select Earnings to base commission on fees earned.

l Select Earnings less cost of funds to base the commission on fees earned
minus a percentage of the average daily balance. For more information
on cost of funds, see the Broker Commission Report.

l Select Earnings excluding chargebacks to base the commission on earn-
ings that do not include chargeback fees.

l Select Earnings and fee escrow to base the commission on initial earn-
ings and collection fees.

l Select Earnings excluding purchase fees to base commission on fees
earned minus any purchase fees applied.

l Select Earnings from collections only to base commission on percentage
of collections.

l Select Earnings from collections, first tier only to base commission on per-
centage of collections that occur within the first rate tier.

l Select Earnings from purchases only to base commission on percentage
of purchases

l Select Payments applied to base the commission on collections received
from the client’s debtors.

l Select Invoices purchased to base the commission on invoices pur-
chased per statement period.

Exclude Earnings from
Client Fee Statement

Select this option to exclude earnings incurred on Net Funds Employed when cal-
culating a broker’s commission. As a result, earnings posted on the New Client
Fee Statement will be excluded from the broker commission statement.

Exclude earnings
from due day
increases

Select this option to exclude earnings incurred from due day increases when
calculating a broker’s commission.

Exclude earnings
from extra debtor
fees

Select this option to exclude earnings incurred from extra debtor fees when cal-
culating a broker’s commission.

Purchase fees are
taken when paid

Select this option to include earnings based on paid invoices only. The com-
mission is not calculated until the invoice is paid in full.
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Field Description

Non-funded invoices and invoices that are either written off (W/O) or charged
back (C/B) are not included in the calculation. The calculation includes only the
purchase fees and the fees earned from the Collection Fee Table in Client
Terms.

Contacts Tab

The Contacts tab is used to create new broker contacts, and to view or delete existing contacts.

Click the New button to access the Add New Broker Contact window, where information for a new contact
can be entered. To modify the information for an existing contact, highlight a contact in the grid and click
the View button. The View/Update Existing Broker Contact window displays, where information can be
modified as needed.

Fields Description

First Name Displays the first name of the broker contact.

Last Name Displays the last name of the broker contact.

Phone Displays the phone number for the broker contact.

Extension Displays the phone extension for the broker contact.

Web Access Tab

The Web Access tab is used to allow the broker to view client accounts online using ClientWeb.
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CAUTION
When this access is activated, the broker can view all processes viewable by the client. Information is
not specific to broker commission only.

To allow web access for the broker, select the Allow web access check box and enter a web access ID
and password in the associated fields.

Fields Description

Allow web access Select to provide the broker access to ClientWeb.

Web Access ID Enter the user name used to access ClientWeb for this broker.

Web Password Enter the password used to access ClientWeb for this broker.

System Preferences

The following system preferences for this function are found in the Administration module, System Prefer-
ences, Reports, Broker commission reports folder.

Preference Description

Earnings do not include
additional fees

FactorSoft can exclude any additional fee earnings from the client’s total
earnings when calculating a broker’s commission based on any of the
earning types mentioned above.

Setting this preference to True will cause any earnings posted to the cli-
ent’s Additional Fee Account to be excluded from the total earnings
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Preference Description

amount. Note that the client’s Additional Fee Account and Earned Fee
Account cannot be identical for this condition to apply.

For more information on setting up a client’s Additional Fee and Earned
Fee accounts using FactorSoft’s G/L Account Groups Table, click here. For
information on defining a client’s additional fees using the Client Term
window’s Additional Fee Panel, click here.
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Contact List (F4)

The Contact List displays all contacts currently available in your database.

Note that the Contacts Internal Keys must be recalculated once for each upgrade to a new version of
FactorSoft to prevent inaccurate sorting of the Contact List. In the Administrative module, select System,
Database maintenance, Recalculate redundant data, and select Internal Keys from the Recalculate
Redundant Data screen. On the Recalculate internal keys screen, select Contacts only and click Ok.

Field Description

(Scroll) Enter a character (number or letter) or combination of characters to advance
the list to the contact name beginning with that character or combination of
characters.

Clients Select this option to display client contacts created from the Contacts panel of
the Client Information screen.

Debtors Select this option to display customer/debtor contacts created from the
Contacts panel of the Customer/Debtor Information screen.

Brokers Select this option to display broker contacts created from the Contacts tab of
the Broker Information screen.

(Grid) List the client, debtor, and/or broker contacts with the following data. Double-
click an entry to see the Client, Debtor, or Broker Information screen for the selec-
ted contact.
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Field Description

l First Name

l Last Name

l Company

l Phone

View Contact Inform-
ation

Select a contact and click this button to display the View/Update Existing
Contact screen.

View Company
Information

Select a contact and click this button to display the Client, Debtor, or Broker
Information screen for the selected contact.

Hide inactive con-
tacts

Select this options to remove contacts on which the Inactivate option has been
selected from the list.
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Add New Contact/Contact Information

The Contact Information screen is used to create a new business contact for the client or cus-
tomer/debtor, or to view or modify an existing one. This screen can be accessed from the New or View but-
tons on the Contacts Panel of the Client Information or Debtor Information screen.

Field Description

First, Last Name The contacts first and last names (separate fields).

Title The business title of the contact.

Address The first two lines of the street address for the contact.

City, State, Zip The city, state, and Zip Code/Postal Code components for the contact address
(separate fields).

Country The country component for the contact address.

Email The email address for the contact.

When email requests are processed in FactorSoft, the logic for Top-level

Bulk Collaterals User Guide
Add New Contact/Contact Information

94 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

Domains (or TLD's, the portion of the email address after the domain name, e.g.,
.com, .org, .us, etc.) first edits the TLD against the "standard" names. If the TLD is
not found, then, based on System Preference, the system edits against a
domain name text file (provided by ICANN - Internet Corporation for Assigned
Names and Numbers) in the production data folder, which will be updated and
patched as new names come on line.

Set System Preference Identification/system constants, System constants,
Email domain edit rule to determine how TLDs are edited to the desired
value:

l Validate against original top-level domains & table of ICANN-era
domains (this value is the default)

l Validate against original top-level domains only

l Do not edit top-level domains

Ownership % The percentage of ownership in the client business that the contact has, if
applicable.

Phone The contact's primary phone number.

If you have FactorSoft Auto Dialer enabled, you can call the contact by clicking
on the phone icons next to the debtor’s primary or secondary phone numbers.

Extension The contact's primary phone number extension.

Fax The contact's fax phone number.

Cell The contact's mobile phone number.

Authority Select this option to indicate that the contact has authority within the client
organization; for example to sign off or verify invoices.

Attention Select this option to include the contact’s fax or email address when sending
notices, reports, or statements.

To address several contacts within the organization, check each contact’s
Attention box. Depending on the main contact’s report preferences, FactorSoft
automatically includes the contacts’ email addresses or fax numbers when gen-
erating outgoing reports.

Notices Select this option to indicate that the contact is the recipient of notices of
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Field Description

assignment for the organization.

Cng Rept Select this option to send the Client Change Report to selected client contacts
when the report is generated.

When the report is generated, it is transmitted to the client contact. If there is
not data for a client, a message indicating that no data was generated is trans-
mitted to the client. Transmittal occurs as follows: send via email if there is an
email address on the contact record. If there is no email, send via fax if there is
a fax number.

Guarantor Select this option to indicate that the contact is the guarantor of the cus-
tomer/debtor organization.

Inactivate Select this option to indicate that the contact is no longer active for the cus-
tomer/debtor.

Web Access Select this option to indicate that the contact should have access to the Web
Portal.

Web Admin Select this option to indicate that the contact should have Admin access to the
Web Portal.

Inv Delivery Select this option to email Invoice Delivery packages for the debtor to the con-
tact.

Note that this option only appears for debtor contacts.

Comments Enter additional contact related information as required.

Create/Update/
Verify

This button is used to complete add, update, and delete actions on the Cus-
tomer/Debtor Contact screen.

l Create: Complete the addition of a new entry.

l Modify: Complete an update to an existing entry.

l Verify: Confirm and complete the deletion of an existing entry.

Audit Click this button to open the Contact Audit History screen, which provides a
record of changes made to a contact record.

Note that the audit is specific to the contact and can be accessed only from the
Add New or View/Edit Existing Contact screens. The Audit function from the Cli-
ent Information and Debtor Information screens does not contain the contact
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Field Description

audit items.

Cancel Click this button to close this screen.

Apply Click this button to save the screen without closing.

Phone Log Click this button to access the call log. This option only applies if the FactorSoft
Auto Dialer is enabled.

Security Roles

To view and update the Contacts form, the following Security Role needs to be set to YES, Security Roles >
Contacts > Access:

l Add new contacts

l Delete contacts

l Contacts information (update)

l Contacts information (view)

l Allow Users to Update Web Access

l Allow Users to Update Web Admin

l Contact List

Bulk Collaterals User Guide
Add New Contact/Contact Information

97 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Bulk Collaterals Overview

FactorSoft enables lenders to integrate bulk collateral lending, asset based lending, invoice discounting,
inventory lending, and other forms of commercial finance, into one platform.

The Bulk Collaterals feature is grounded on the concepts of valuing and revaluing of assets, tracking, mon-
itoring, and analyzing trends. The collateral is the primary source of repayment, and the loan is tied to fluc-
tuating asset values.

Bulk Collateral Lending:

l Relies on its legal position in the assets of a business.

l Is a business loan supported by a security interest in the borrower's assets.

l Is designed to help undercapitalized, highly leveraged businesses.

l Loan thresholds are based on the client's collateral value.

l Provides a continuous source of funding.
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Using the Facility Information Screen

The Facility Information screen is used to define bulk collateral facilities for clients. This screen appears
when you click either the New Facility or Facility Information links from the Client List.

To add new facilities to a detail collateral, set the following system preference to True:

l System Preferences > Facility/Collateral Rules > General > Allow detail A/R collateral clients to
be assigned new facilities and collaterals

There are two main areas to this screen:

1. Facility Basics and Summary – The upper half of the screen is used to define basic facility inform-
ation such as name and loan number and view a summary of the facility information and bor-
rowing limits.

2. Panels – The lower half of the screen is used to access the “panels” where you can enter specific
facility details and transactions. Click one of the panel links on the left to show that panel on the
right. In the panel list, the panels listed “above the line” vary by the of facility, the “below the line”
panels are the same regardless of the facility type.
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Entering Facility Basics

The fields at the top of the screen are used to enter basic information about the facility. Make sure you
click the Save button on the bottom when you are done.

Field Description

Name Enter the facility name used to identify the facility in FactorSoft and reports.

Currency Select the currency type to use to conduct transactions and produce reports
for the facility. Currencies are defined in the Currency Denomination Table.

The default currency for new facilities created in FactorSoft is based on the
default currency type set for clients. Set System Preference Client
rules/defaults, Defaults, Miscellaneous, Currency type to the desired default
currency type for clients and facilities.

Acct group Select the default general ledger Account Group for the facility.
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Field Description

Preference Select the output preference for facility statements.

Loan Number Enter a loan identification number for a facility. The Loan Number field can
accept up to 30 alphanumeric characters.

Category Custom field

Inactive Select this option to mark the facility as inactive. Marking facilities as inactive
allows them to be filtered out of the Client List.

A message has been added to alert the user that the facility is set inactive and
that calculations and updates are not enabled for the facility. The message
"Setting the Collateral to inactive will stop calculations and updates" appears
when the user opens the Facility Information screen for a collateral previously
set inactive, or when the Inactive option on the Facility Information screen is
selected and the edit is saved. Although the position of the facility will be frozen,
updates to the facility can still be performed, and on the event that the inactive
status is removed, the facility position will be caught up on the first nightly pro-
cessing run of FactorSoft.

Term Loan Select this option to create a Term Loan facility, which offer terms that require
defined payments over a specified period of time.

Facility Summary

When pending posting transactions exist for a facility in the Pending Transactions panel of the Activity
Center screen, a red Pending indicator is present in the Facility Summary.

Field Description

Gross Collateral The current gross reported collateral value for the facility.

When there are pending postings for the facility, the gross collateral is presen-
ted in red to indicate that the figures are subject to change upon approval of
the pending transactions.

Eligible Collateral The gross reported collateral value less ineligibles, reserves, and set-asides.

Net Collateral The eligible collateral value multiplied by the Advance Rate (%) for the facility.

Current Limit The system-generated amount representing the current loan limit as determ-
ined by the established amortization settings.
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Field Description

Available The lower of the Net Collateral or the Available Limit, minus reserves.

Reserve The balance of cash reserve against the reported collateral value for the facil-
ity.

Balance Displays the outstanding loan balance of the facility.

When there are pending postings for the facility, the outstanding balance is
presented in red to indicate that the figures are subject to change upon
approval of the pending transactions.

Excess/Deficit Displays the excess (cash that can be distributed) or deficit (amount to be
made up) for the facility.

Client CAP Space Displays the available capital for the facility, calculated as Client Limit less the
sum of facility balances.

Facility Information Panels

There are many different panels that can appear on the Facility Information screen, depending on the spe-
cific set up for your company and client. See one of the sections below for more about using a specific
panel.
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Facility Information - Additional Terms Panel

The Additional Terms panel displays a list of additional Non-Statement Fee Types that are used to cal-
culate charges directly applied to the loan balance as the events occur.

NOTE
Currently there is only one additional fee type—the A/R Management Fee, which charges a flat
amount or percentage rate from Collection or Sales (or both), calculated from a specified G/L
account.

Field Description

(Grid) Displays each additional term definition as a line-item with the following data:

l Description: The description of the additional terms.

l Fee type: The fee type selected for the additional terms.

l Fee details: The rate or amount of collections or sales that make up the
fee.

New Click this button to add a new additional term to the facility. The Additional
Terms Information screen opens to allow entry of a new term.

View Select an existing line-item from the grid and click this button to view and/or
edit the additional term on the Additional Terms Information screen.

Delete Select an existing line-item from the grid and click this button to remove the
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Field Description

term from the facility record.
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Facility Information - Additional Terms Information Dialog

The Additional Terms Information Dialog is opened from the Additional Terms panel of the Facility Inform-
ation screen, and is used to view, add, modify, and delete Additional Terms definitions for the facility.
These Additional Terms creates an automated Adjustment Transaction when a certificate is posted with
sales or collections as defined on the panel.

Field Description

Description A user-defined description for the terms.

Inactive Select this option to suspend the use of this additional term. The term will not be
calculated and will not appear on the billing statement.

Fee Type Select A/R Management Fee.

G/L Account Select the G/L Account to which this fee will be credited.

Click this button to edit an existing term.

Click this button to save a term.

Click this button to undo unsaved changes to the term.

Flat Amount If the Additional Terms fee is to be a flat charge, enter the dollar amount of the
charge in either or both of the fields:
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Field Description

l Collections: Fee is a flat amount from collections

l Sales: Fee is a flat amount from sales

Percentage Rate If the Additional Terms fee is based on a percentage of collections or sales,
enter the percentage rate in either or both of the fields:

l Collections: Fee is a percentage of collections

l Sales: Fee is a percentage of sales

Click this button to open the Audit screen to view audit history for the additional
terms.

Click this button to generate a preview of the Additional Terms screen, which
can be printed or exported in a variety of formats.

Click this button to close the screen.
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Facility Information - Address Panel

The Facility Address profile contains the facility's mail and email addresses, plus phone and fax numbers.
The Address profile can provide auto-dialing capabilities, provided you have the required hardware.

Field Description

Address Enter the street address (two lines available) for the client.

City Enter the city component of the client address in its respective fields.

(State) Enter the state component of the client address in its respective fields.

(ZIP Code) Enter the ZIP Code or postal code for the facility address in its respective field.

Country Select the country for the facility address from the list

Phone Enter the primary and secondary contact phone numbers for the facility.

Fax Enter the fax phone number for the facility.

Email Enter the email address for the facility.

Bulk Collaterals User Guide
Facility Information - Address Panel

107 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Facility Information - Auto Expense Panel

The Auto Transfer feature allows you to create a recurring expenses not associated with a facility dis-
bursement transaction. The Auto Expense transaction is accessed from the Panel List of the Facility Inform-
ation screen for all facility types. When this option is selected, the Auto Expense panel is displayed. Each
automatic expense transaction for the facility is displayed as a line-item with the following details:

Field Description

Show Charged 1-Time
Expenses

Select this option to list expense that were charged only one time (Times to
Charge on Facility Auto Expense screen set to 1 and has been completed).

(Grid) Displays each auto-Expense definition as a line-item with the following data:

l Charged At: always Auto Charge

l Account #: the cash account against which to charge the account

l Expense Description: the Description entered for the expense on the Facil-
ity Auto Expense screen

l Amount Is: always Flat Charge

l Amount: the Amount of the recurring expense entered on the Facility Auto
Expense screen

New Click this button to add a new auto-expense definition to the facility. The Facility
Auto Expense screen opens to allow entry of a new definition.

View Select an existing line-item from the grid and click this button to view and/or
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Field Description

edit the auto-expense definition on the Facility Auto Expense screen.

Delete Select an existing line-item from the grid and click this button to remove the
definition from the facility record.
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Facility Information - Facility Auto Expense

The Facility Auto Expense screen is used to configure the details of an Auto Expense transaction, which cre-
ates a recurring expense not associated with a facility disbursement transaction.

Field Description

Charged At Select when to charge:

l Auto Charge

l Disbursement

Amount Is Always Flat Charge.

Schedule Complete the options that determine the frequency with which the recurring
expense transaction is charged.

l Freq: select Same Day Every Month, Every X Days, or Day of the Week.

l Day: enter the numeric day of the month on which to charge the expense
for Freq of Same Day Every Month or the number of days interval at which
to charge the expense for Freq of Every X Days.

l DOW: select the day of the week on which to charge the expense for a
Freq of Day of the Week.

Account Select the Cash Account against which to charge the expense

Description Enter a descriptive name for the expense to display in the Auto Expense panel
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Field Description

grid.

Amount Enter the dollar amount of the expense. This amount is charged against the
account for each instance of the Auto Expense.

Times to Charge Enter the number of recurring charges for the expense. When the Facility Auto
Expense screen is opened to view or edit an existing expense, the Times Done
field displays the number of times the expense has already been charged.

Use On/Before Select the ending date of a date range in which the Facility Auto Expense is act-
ive. The expense expires on the date entered and will not be charged on that
date or thereafter. If the expense is configured with this field cleared, the
expense has no expiration date and is charged indefinitely.

Use On/After Select the beginning date of a date range in which the Facility Auto Expense is
active. The expense becomes active on the date entered and will not be
charged for earlier dates. If the expense is configured with this field cleared, the
expense is charged on the next periodic date as determined by the Schedule.

Save Click this button to save the Facility Auto Expense definition.

Cancel Click this button to close the screen and abandon unsaved changes.
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Facility Information - Auto Transfers Panel

The Auto Transfer feature allows you to set up facility transfers that will be automatically queued for
approval based on pre-defined rules. This feature is an automation of the ledger Facility Transfer trans-
action (which is described in Facility Transfer), and its account effects are the same in that it increases
the loan balance of the sending facility (From Facility), reduces the loan balance of the receiving facility
(To Facility), and is a non-cash transaction sending "non-cash funds" from one facility to another.

Additional fee options not available in Client Terms can be configured for FactorSoft for Auto Transfers. To
utilize these options:

Set System Preference Facility/Collateral Rules (formerly Asset based lending) > Rules > General >
Allow Detail A/R facilities to use auto transfers to True.

Field Description

(Grid) Displays each auto-transfer definition as a line-item with the following data:

l Priority: the priority sequence number

l To Client / Facility: the client and facility to which to transfer funds for the
automated transfer

l Transfer Rule: the transfer rule for the transfer definition

l Last Process Date: the last date on which a transfer was automatically
processed

New Click this button to add a new auto-transfer definition to the facility. The Facility
Auto Transfer screen opens to allow entry of a new definition.
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Field Description

View Select an existing line-item from the grid and click this button to view and/or
edit the auto-transfer definition on the Facility Auto Transfer screen.

Delete Select an existing line-item from the grid and click this button to remove the
definition from the facility record.
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Facility Auto Transfer

The Facility Auto Transfer screen is opened from the Transfers panel of the Facility Information screen, and
is used to create facility transfers that will be automatically queued for approval.

When Auto Transfer rules have been configured and there are transfer requests generated based-on
those rules, use the Manage Pending Transfers screen to settle the pending transfers. See Manage Pend-
ing Transfers in the Office Menu section of this guide for details.

Field Description

From facility Displays the facility name of the facility selected from the Client List. This is the
facility from which funds are being transferred.

To facility Select the facility to which to transfer funds for the automated transfer.

Priority Enter the priority sequence number, if required.

If more than one automated transfer is configured for the facility, this priority
code determines the order in which the automated transfer rules are applied.

Rule Select the auto transfer rule to be applied:
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Field Description

l Reduce Over-Formula: Reduce the To Facility’s Loan Balance for any neg-
ative excess from the From Facility’s funds.

l Reduce Secondary Loan Balance: Transfer excess in From Facility to
reduce the To Facility’s loan balance.

l NFE: Transfer amount will be the Client’s Total A/R Balance minus Fee
Escrow minus Reserve Escrow minus Cash Reserves.

l NFE Net Change: Transfer Amount will be the difference between the
beginning NFE Balance from day after last Transfer and the NFE Balance
when the Auto Generate button is clicked by the User.

l TFE: Transfer Amount will be the Client’s Total A/R Balance minus Fee
Escrow minus Reserve Escrow minus Cash Reserves minus P.O/Load
Advances minus Simple Interest Loans minus Amortized Loans minus
Held Funds.

l TFE Net Change: Transfer Amount will be the difference between the
beginning TFE balance and the ending TFE balance between the last
Transfer that was generated and the current Auto Transfer that is being
created.

The funds transferred cannot exceed the balance of the To Facility.

Loan Balance Trans-
fer Option

drop-down to select options for NFE/TFE Rules:

l Positive: If the Client’s NFE/TFE is Positive and the other settings for the
Transfer are True, the Transfer should be generated. If the Client’s NFE/TFE
is Negative, the Transfer should not be generated.

l Negative: If the Client’s NFE/TFE is Negative and the other settings for the
Transfer are True, the Transfer should be generated. If the Client’s NFE/TFE
is Positive, the Transfer should not be generated.

l Any: If the Client’s NFE/TFE is either Negative or Positive and the other set-
tings for the Transfer are True, the Transfer should be generated.

Days to Hold Transfer Enter number of days to delay the auto transfer post date. This means that the
system will capture the Transfer Amount based on the Rule but the actual Trans-
fer transaction will not be available to be approved in the Activity Center until
the number of days specified. Scheduling Option is unavailable when using the
Days to Hold Transfer option.
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Field Description

Set how to handle days (calendar or business) at System Preferences > Facil-
ity/Collateral Rules (formerly Asset Based Lending) > Rules > Auto Transfer >
Days To Hold Transfer use business days only.

Last Evaluated Represents the date that the system looked at this specific rule to determine if
the criteria was met to generate a new Auto Transfer. The date will update
every time a User clicks the “Auto Generate” button in the Activity Center >
Pending Transfers queue.

Last Processed For an existing rule, this field displays the last date on which a transfer was auto-
matically processed for the facility as a result of the rule.

From Debit This field displays the debit account for the From Facility, as defined in the
Account Group assigned to the facility.

To Debit This field displays the debit account for the To Facility, as defined in the Account
Group assigned to the facility.

From Credit This field displays the credit account for the From Facility, as defined in the
Account Group assigned to the facility.

To Credit This field displays the credit account for the To Facility, as defined in the
Account Group assigned to the facility.

From Currency Type Displays the Currency Value set up in Client Information > Control panel for the
Client where the transfer will come “from”

To Currency Type Displays the Currency Value set up in Client Information > Control panel for the
Client where the transfer will go “to”

Conversion Rate Displays the conversion rate based on the Currency Denomination Table .

Schedule Interval drop-down to select the schedule interval:

l None: Disables scheduling interval options.

l Periodic: Enables the Periodic Interval Number of Days field and eval-
uation start date fields to set schedule.

l Day of the Week: Enables the Day of the Week Field to set the schedule.

l Day of the Month: Enables the Day of the Month field to set the schedule.

Periodic Interval Enter the number of days to wait between transfers. Transfer Amount will be cal-
culated from the day after the last Transfer was generated and when the Auto
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Field Description

Generate button is clicked by the User.

Set how to handle days (calendar or business) at System Preferences > Facil-
ity/Collateral Rules (formerly Asset Based Lending) > Rules> Auto Transfer >
Periodic Interval use business days only

Evaluation Start Date The Evaluation Start Date is used by the system to know the starting point for
the number of days specified.

Day of the Week Select the Day of the Week to schedule transfer.

For Example: If Monday is selected - Transfer Amount will be the difference between the
beginning NFE/TFE Balance from the prior Tuesday and the NFE/TFE Balance when the
Auto Generate button is clicked by the User

Day of the Month Select the Day of the Month to schedule transfer.

For example: If the Day of the Month = 25 - the Transfer Amount will be calculated as the
difference between the beginning NFE/TFE Balance on prior month and the Day 26
NFE/TFE Balance when Auto Generate button is clicked by the User

Click this button to edit an existing auto-transfer definition.

Click this button to save an auto-transfer definition.

Click this button to undo unsaved changes to the auto-transfer definition.

Click this button to open the Audit screen to view audit history for the auto-
transfer definition.

Click this button to generate a preview of the Facility Auto Transfer screen,
which can be printed or exported in a variety of formats.

Click this button to open help.

Click this button to close the screen.

Example #1 – Reduce Over Formula

This example illustrates the effect of an Auto Transfer using the Reduce Over-Formula rule. In this
example, client Advance System Designs has two lending products, a bulk A/R asset-based loan, and an
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inventory-based loan, as shown in the following illustration.

NOTE
The first facility has an Excess of $17,499.98, while the Inventory facility has a deficit of
$12,596.63.

The Facility Auto Transfer screen is set up to transfer excess from Advance System Designs to pay down
any Deficit in Advance System Designs (INV):

The effect of the transfer will be to pay $12,596.63 from the Advanced System Design facility’s Excess to
reduce the Advanced System Design (INV) facility’s Deficit to zero. This raises the balance of Advanced
System Design to $740,396.65, reduces Advance Systems Design (INV) Deficit to zero and reduces the bal-
ance the same amount, as shown next:

NOTE
The amount paid is the lesser of the From facility’s excess or the absolute value of the deficit of the To
facility.
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Example #2 – Reduce Secondary Loan Balance

This example illustrates the effect of an Auto Transfer using the Reduce Secondary Loan Balance rule.
This transfers funds from the Excess of the From facility to pay down the loan balance of the To facility. In
this example, client Dockers, Inc. has two lending products, a bulk A/R asset-based loan, and an invent-
ory-based loan, as shown in the following illustration.

NOTE
The From facility has an Excess of $32,349.15. In this example, the excess is used to pay down the bal-
ance of the To facility. Below is an illustration of the Facility Auto Transfer screen set up for this transfer:

The effect of the transfer will be to decrease the balance of the To Facility by the $32,349.15 available from
the From Facility’s Excess, and increase the balance of the From Facility by the same amount, as shown in
the following illustration:

NOTE
The amount paid is the lesser of the From facility’s excess or the absolute value of the balance of the
To facility.
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Example #3 – NFE

This example illustrates the effect of an Auto Transfer using the NFE rule. This transfers funds from the NFE
of the From facility to pay down the NFE balance of the To facility. In this example, client NFE Transfer Test
Client, Inc. (TO) has an NFE balance of $5,000.

NOTE
The From facility will pay down the NFE balance of the To facility. Below is an illustration of the Facility
Auto Transfer screen set up for this transfer.

The effect of the transfer will be to decrease the NFE balance of the To facility by the $5,000 from the From
Facility’s NFE and increase the From Facility’s NFE balance by the same amount as shown in the following
illustration.
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Example #4 – NFE Net Change

This example illustrates the effect of an Auto Transfer using the NFE Net Change rule. This transfers funds
from the NFE of the From facility to pay down the NFE balance of the To facility. In this example, client My
NFE net change 1 has an NFE Net Change of $5,000.

NOTE
The From facility will pay down the NFE Net Change of the To facility. Below is an illustration of the Facil-
ity Auto Transfer screen set up for this transfer.
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The effect of the transfer will be to decrease the NFE balance of the To facility by the $5,000 from the
From Facility’s NFE and increase the From Facility’s NFE balance by the same amount as shown in the fol-
lowing illustration.

Example #5 – TFE

This example illustrates the effect of an Auto Transfer using the TFE rule. This transfers funds from the TFE
of the From facility to pay down the TFE balance of the To facility. In this example, client M.A. Associates
has a TFE balance of $1,000.

NOTE
The From facility will pay down the TFE balance of the To facility. Below is an illustration of the Facility
Auto Transfer screen set up for this transfer.
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The effect of the transfer will be to decrease the TFE balance of the To facility by the $1,000 from the From
Facility’s TFE and increase the From Facility’s TFE balance by the same amount as shown in the following
illustration.
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Example #6 – TFE Net Change

This example illustrates the effect of an Auto Transfer using the TFE Net Change rule. This transfers funds
from the TFE of the From facility to pay down the TFE balance of the To facility. In this example, client Bob
Conley OP has a TFE Net Change of $1,000.

NOTE
The From facility will pay down the TFE Net Change of the To facility. Below is an illustration of the Facil-
ity Auto Transfer screen set up for this transfer.
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The effect of the transfer will be to decrease the TFE balance of the To facility by the $1,000 from the From
Facility’s TFE and increase the From Facility’s TFE balance by the same amount as shown in the following
illustration.
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Facility Information - Collaterals Panel

The Collaterals panel displays a list of all collateral entities associated with the facility.

Field Description

(Grid) Displays each additional term definition as a line-item with the following data:

l Description: The description of the additional terms.

l Type: The collateral type. For Bulk Collaterals, the type is selected on the
New Collateral screen when the collateral is created.

l Gross collateral: Displays the total book value of the asset as reported by
the client.

l Available: Displays the sum total of the available collateral supporting the
facility.

l Adv rate: Displays the advance rate for the collateral.

l Avail limit: Displays the loan limit for the facility.

New Click this button to add a new additional term to the facility. The collateral
Information screen opens to allow entry of a new collateral.

View Select an existing line-item from the grid and click this button to view and/or
edit the collateral on the Collateral Information screen.
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Facility Information - Contacts Panel

The Contacts panel of the Facility Information screen displays a list of the facility's individual contacts,
such as an executive or controller who can make financial decisions, or an office manager who can
handle inquiries. Each entry includes action options that indicate the level of authority that the contact
possesses.

Field Description

(Grid) Displays each attached document as a line-item with the following data:

l Name: The contact's first and last names.

l Phone: The contact's primary phone number.

l Extension: The contact's primary phone number extension.

l Auth: Indicates whether the contact has authority within the client organ-
ization; for example to sign off or verify invoices.

l Attn: Indicates whether the contact’s fax or email address is included
when sending notices, reports, or statements.

l Guar: Indicates that the contact is the guarantor of the customer/debtor
organization.

New Click this button to create a new contact for the facility. The Contact Inform-
ation screen opens to allow entry of a new contact.

View Select an existing contact from the grid and click this button to view and/or edit
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Field Description

the contact on the Contact Information screen.

Delete Select an existing contact from the grid and click this button to remove the con-
tact from the facility record.
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Contact Information Dialog

The Contact Information screen is accessed from the Contacts panel of the Facility Information screen
and is used to add, edit or deactivate contacts for the facility. This screen is intended to be used to record
contact information for the facility if that contact has not been previously recorded in FactorSoft. Once the
contact’s information has been saved, the contact is displayed on the Contact panel for the Facility
Information screen.

Field Description

Company Displays the client name of the client for the facility.

First Name Enter the contact’s first name.

Last Name Enter the contact’s last name.

Title Enter the business title of the contact.

Phone Enter the contact's primary phone number.

Fax Enter the contact's fax phone number.

Extension Enter the contact's primary phone number extension.

Authority Select this option to indicate that the contact has authority to make decisions
about the facility.
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Field Description

Attention Select this option to include the contact’s fax or email address when sending
notices, reports, or statements.

Guarantor Select this option to indicate that the contact is the guarantor for the facility.

Ownership (%) Enter the percentage of ownership in the client business that the contact has, if
applicable.

Email Enter the email address for the facility contact.

Comments Enter additional contact related information as required.

Inactivate Select this option to indicate that the contact is no longer active for the facility.

Click this button to edit an existing contact.

Click this button to save changes to a contact.

Click this button to undo unsaved changes to the contact.

Click this button to open the Audit screen to view audit history for the contact.

Click this button to generate a preview of the Contact Information screen, which
can be printed or exported in a variety of formats.

Click this button to close the screen.
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Facility Information - Custom Data Elements Panel

The Custom Data Element Panel displays a grid of all the data elements set up in the Miscellaneous Data
Elements table for the Facility Information Screen, and allows you to create a value for any of these ele-
ments for the facility.

Column Description

Element Displays the element name as defined on the Miscellaneous Data Elements
table.

Value Set a value for the data element in this column. To set a value:

l Click the Edit (pencil) button on the Facility Information screen

l Click in the Value column for the desired Element

l Enter the desired value

l Click the Save (disk) button
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Facility Information - Deferred Revenue Panel

This panel displays deferred revenue items recorded for the facility, and allows payout of the deferred rev-
enue balance. Deferred revenue items can be set up for the facility from the New Adjustment Transaction
or New Disbursement Transaction.

Field Description

(Grid) Displays each deferred earnings for a release for the client .as a line item with
the following data:

l Post Date: displays the post date of the release transaction on which the
deferred revenue items were created

l Journal#: displays the journal number of a paid deferred revenue item

l Earning: displays the account number of the Move to Account for the
deferred revenue item

l Amount: displays the original amount of the deferred revenue item

l Balance: displays the remaining balance of the deferred revenue item

l Frequency: displays the Frequency selected for the deferred revenue item

l Next Accrual: displays the next accrual date for the deferred earnings
based on the Deferral Information entered for the deferred revenue item

Payout Remaining Bal-
ance

Click this button to manually payout the remaining deferred revenue for the
selected item to the revenue account.
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Facility Information - Dependency Rules Panel

The Facility Dependency feature is used to calculate the loan limit for one facility (the “dependent” facil-
ity) based on a percentage of the current loan balance of another facility (the “dependency” facility)
within the same client relationship.

Element Description

Facility dependency Displays the dependency name as defined on the Dependency Rule screen.

Dependency rate Displays the dependency rate defined for the dependency rule on the Depend-
ency Rule screen.

New Click this button to add a new dependency rule. A blank Dependency Rule
screen opens to allow entry of a new rule.

View Select an existing dependency rule from the grid and click this button to view
and/or edit the rule on the Dependency Rule screen.

Delete Select an existing dependency rule from the grid and click this button to per-
manently delete the rule.
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Dependency Rule Dialog

This screen is used to select the dependency facility for a dependent facility, and establish the depend-
ency rate.

Field Description

Facility Displays the facility name of the selected facility. This is the dependent facility to which
the dependency rule applies.

Dependency Select the dependency facility whose current balance is used to calculate the loan
limit for the dependent facility.

Rate Enter the percentage of the dependency facility's current balance used to calculate
the loan limit for the dependent facility. Note that the Rate can be greater than 100%.

Click this button to edit an existing dependency rule.

Click this button to save a dependency rule.

Click this button to undo unsaved changes to the dependency rule.

Click this button to open the Audit screen to view audit history for the dependency rule.

Click this button to generate a preview of the Dependency Rule screen, which can be
printed or exported in a variety of formats.

Click this button to close the screen.
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Example

In this example, a dependency for the facility American Design LOC #2 is created based on a percentage
of the Current Loan Balance of American Design LOC #1. Notice that the loan Limit established is
$1,500,000.00 for the dependent facility American Design LOC #2, and that the current loan Balance of the
dependency facility American Design LOC #2 is $1,942,640.26.

When the dependency rule is created and applied, the Dependency Rules profile in the Facility Inform-
ation screen will show a line item for the new rule, and the Current limit field displays the new limit, based
on the percentage of the loan balance of the dependency facility.

The adjusted Limit is also displayed on the Client List, as shown below. The new limit for the example is
$1,942,640.08 x 0.50 = $971,320.04.
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Facility Information - Documents Panel

The Document panel is used to attach and view facility-related documents to the facility.

Field Description

(Grid) Displays each attached document as a line-item with the following data:

l Description: The document description entered for the document on the
Attach Document to Facility screen.

l Date: The FactorSoft processing date on which the document was
attached to the facility.

l File name: The actual file name of the attached document.

New Click this button to attach a document to the facility.The Attach Document to
Facility screen opens to allow searching and attaching a new document.

View Select an existing document from the grid and click this button to view and/or
edit the document attachment on the Attach Document to Facility screen.

Delete Select an existing document from the grid and click this button to remove the
attached document from the facility record. This does not delete the document
from its source directory.
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Attach Document to Facility

Use the Attach Document screen to attach documents (such as word documents, spreadsheets, images,
etc.) to a facility record. This screen is accessed from the Document panel of the Facility Information
screen.

Field Description

Facility Displays the facility to which the document will be attached.

Description Enter a description of the document to assist in identifying it in the Document
panel grid.

Document Displays the path and document to which you have browsed to attach to the
facility.

Displays a browser screen that you can use to navigate to the document to
attach to the facility.

Click this button to edit an existing attachment.

Click this button to save an attachment.

Click this button to undo unsaved changes to the attachment.

Click this button to open the Audit screen to view audit history for the attach-
ment.

Click this button to generate a preview of the Attach Document to Facility
screen, which can be printed or exported in a variety of formats.
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Field Description

Click this button to close the screen.
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Facility Information – Fee Reserve Panel

The Fee Reserve panel provides the option to reserve the daily statement fees accrued from facility avail-
ability. Each day the fees accrued for the period are calculated to determine the reserve amount.

Field Description

Reserve accrued fees Select this option to reserve accrued fees for the facility. Beginning with the next
date change, reserve is re-calculated daily for fees accrued in the current
billing period to date. The net effect of this feature is that:

l the daily reserve value decreases availability

l reserve resets to zero on each statement generation

To calculate reserves, all fee types associated with the periodic billing state-
ments are converted to a daily amount and multiplied by the number of days
into the current billing cycle.

Current fee reserve
balance

When Reserve Accrued Fees is enabled for the facility, this field displays the cur-
rent fee reserve for the facility.

NOTE
Interest is calculated daily on statement generation. Interest is calculated for the date range, which is
the beginning of the billing cycle to the last end-of-day.

Fees are calculated as total of all other fees divided by the number of days in the billing period and
multiplied by the number of completed days in the current billing cycle.
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The fee reserve reduces the Available balance amount at the facility level.
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Facility Information - Funding Instructions Panel

The Funding Instructions panel is used to override the lender-level instructions on the ClientWeb Advance
Request panel.

Field Description

Funding instructions Enter free-form text instructions. You can create texts of any length, and create
line breaks using the Enter key.
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Facility Information - Facility Groups Panel

The facility Groups panel lists the Client Groups created in the Client Group Table. Use this panel to set val-
ues in the Group Code(s) for the facility to allow you to generate reports based on group codes and group
values.

Field Description

Edit Click this button to open the Change Facility Group Value screen, which you can
use to set the Value for the selected Client Group code for the facility.
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Change Facility Groups Dialog

The Change Facility Group Value screen is used to assign values to a group code for the facility selected
in the Facility Information screen. You can also change or remove the group value using this screen.

Field Description

Client Displays the client name under which the facility is defined.

Facility Displays the facility name.

Code Displays the facility group code name of the group code selected in the Group
panel of the Facility Information screen.

Description Displays the facility group code description.

Value Select the value to be associated with the facility group code for this facility. The
group code values are defined on the Client Group Code table.

Clear Click this button to clear the contents of the Value field.

Save Click this button to complete the update to a facility group code

Cancel Click this button to close the screen without saving.
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Facility Information – Ledger Panel

The Ledger panel of the Facility Information screen lists the facility's postings processed during the spe-
cified date range (current fiscal month by default).

Field Description

From Select the starting posting date for postings to be displayed in the grid

To Select the ending posting date for postings to be displayed in the grid.

Click this button to display postings for the specified date range in the grid.

(Grid) Displays each posting as a line-item with the following data:

l Post Date: the posting date of the transaction

l Stmt Date: the statement date in which the posting occurred

l Type: the transaction type

l Status: the transaction status

l Amount: the transaction amount

l Balance: the facility balance after the transaction amount is applied

l Description: the transaction description

Trans Audit Click this button to access the facility Audit screen directly for the selected
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Field Description

transaction type. As there are not transaction posting screens for auto-
matically-generated entries, this provides the capability to access audit entries
for the loan transactions in FactorSoft that generate automatic transaction
entries.

Void Select a line-item and click this button to void a ledger transaction.

A confirmation message is displayed. Click Yes to void the transaction. The
transaction is removed from the grid. In the case of a Claimed Cash Posting,
both the Posting and associated Deposit are removed (although the deposit
will still be visible in the Unclaimed Cash Deposit transaction screen). The
voided transaction can be viewed in the Transaction Register.

New Choose the transaction from the adjacent list and click this button to create a
posting for the facility.

l Accrual posting

l Adjustment

l Claimed cash posting

l Disbursement

l Purchase (Bulk Purchase facility only)

l Purchase Adjustment (Bulk Purchase facility only)

l Payment

l Transfer

l Statement Payment

View Select an existing posting from the grid and click this button to view and/or edit
the posting on the associated transaction screen.

there is no transaction screen available for an Accrual Posting.

Delete Select an existing posting from the grid and click this button to delete the post-
ing.
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Ledger Transactions – Accrual Posting

The Facility Posting screen displays fees and/or interest that have been accrued, but not yet processed,
by a previously generated loan statement. The entry may be a single line item or multiple items depend-
ing on your fee structure.

This screen can be used to post full or partial fees to the loan balance. Posting the fee(s) lowers the fee
balance by the posting amount and increases the outstanding loan balance.

Column Description

Post date Click the calendar button and select the posting date for the accrual posting
from the calendar. The current FactorSoft processing date is used by default.

(Grid) Displays each posting as a line-item with the following data:

l Description: the accrual type description

l Stmt date: the statement date in which the interest or fee was accrued

l Post Date: the posting date of the transaction

l Balance: the balance available to post to the loan

l Projected balance: the loan balance after the accrual is posted

l Post Amount: enter the actual amount to post to the loan balance and
clear from the accrued fee balance
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Column Description

Refresh Click this button to display updated data in the grid.

Clear Clears the Post Amount column and moves the amount to the Projected Bal-
ance column. This allows the user to post selected fees and/or fee amounts.

Post fees Click this button to post the Post Amount of the accrual items.

Current balance Current balance of the loan prior to posting the accrual.

Fee posting amount The sum total amount of the fees to be posted from the accrual line items.

Projected balance The balance of the loan after the sum total of accrual items is posted.

Click this button to open the Audit screen to view audit history for the posting.

Click this button to generate a preview of the Facility Posting screen, which can
be printed or exported in a variety of formats.

Click this button to close the screen.

NOTE
The accrual posting screen tracks the unpaid accrued fees that are not immediately posted to the
loan at month end. For lines of credit, a lender may elect to calculate an interest statement at the end
of the month and either post it directly to the loan or accrue it. Delaying the posting gives the client
time after receiving the charges in a billing statement to plan on availability to absorb the charges. If
this method is used, the lender sets a day in the month (usually the 10th) and the system posts the
charges to the loan at the end of the designated day. This feature holds those charges until 1) the pre-
determined day comes, or 2) a manual entry is generated clearing the item from accrued fees and
posting it to the loan balance.

The Daily Transaction Journal (Transaction Summary) and the Trial Balance Report displays the fee
postings processed during the course of the day. Refer to the FactorSoft Reports Guide for more
information.

You can use the statement period ending date as the default posting date for Accrual Postings for a
facility. To enable this function, set System PreferenceFacility/Collateral Rules (Formerly Asset
Based Lending), Periodic statement generation, Use thru date to determine accrual post date to
True. If set to False, the actual statement generation date is used as the default posting date.
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Ledger Transactions - Facility Adjustment

Adjustments are journal entries that change, modify, or correct the current balance of the loan, but are
not payments or disbursements. The transaction increases the loan balance by the amount posted with a
positive entry and reduces the loan balance with a negative entry. For instance, the Facility Adjustment
could be used to process a rebate on a fee that the client requests some time after the loan was issued
and the original fee incurred.

Deferred Revenue

The Facility Adjustment can be used to take a set adjustment amount against the loan balance up front
as unrealized revenue, defer the revenue over a defined schedule, and realize the revenue over that
schedule. For example, the lender may take a $12,000 adjustment up front and defer the revenue by real-
izing $1,000 per month for a year. The balance of the amount is held in a G/L account designated for
deferred revenue.

On the first day, the adjustment transaction takes the amount from the loan balance and puts it into the
accrual account (the account selected in the above-the-line Account field on the Facility Adjustment
screen). This transactions debits the loan and credits the accrual account. At the frequency defined on
the Deferral Information section of the Facility Adjustment screen, the periodic payment amount is deduc-
ted from the accrual account and credited to the Move to Account account specified in the Deferral
Information section of the Facility Adjustment screen.

Field Description

Facility Displays the name of the facility selected from the Facility Information screen.
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Field Description

Description Enter a free-form text description of the adjustment transaction.

Post date Select the posting date for the adjustment transaction.

Current balance Displays the current loan balance of the facility prior to the adjustment.

G/L account Select the G/L account to which to post the adjustment.

Projected balance Displays a calculated projection of the facility balance after the transaction is
completed.

Amount Enter the adjustment amount.

Deferral Information - these fields are only available if the G/L Account is defined as a Deferred earnings
account on the Standard tab of the Account Table in the Tables module.

Move to Account Select the account to which the deferred revenue is moved from the deferred
revenue account.

Frequency Select the frequency with which the deferred revenue is moved to the Move to
Account.

l Manual: deferral repayment posting is posted manually by the user.

l Weekly: deferral repayment posting is performed by the Engine weekly on
the day selected in Day of the Week for the number of weeks selected in
Number of Payments.

l Monthly: deferral repayment posting is performed by the Engine monthly
on the day entered in Day of the Month for the number of weeks selected
in Number of Payments.

No. of Payments Enter the number of weekly or monthly payments by which to divide the
Amount of the deduction to determine the amount of each repayment of the
deferral.

Day of the Week If the Frequency is Weekly, select the day of the week on which the Engine is to
perform the deferral repayment.

Day of the Month If the Frequency is Monthly, enter the day of the month on which the Engine is to
perform the deferral repayment.

Amount Displays the repayment amount, which is the Amount divided by the Number of
Payments.
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Field Description

Click this button to edit an existing adjustment.

Click this button to save changes to a adjustment.

Click this button to undo unsaved changes to the adjustment.

Click this button to open the Audit screen to view audit history for the adjust-
ment.

Click this button to generate a preview of the Facility Adjustment screen, which
can be printed or exported in a variety of formats.

Click this button to close the screen.
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Ledger Transactions - Claimed Cash Posting

The Claimed Cash Posting transaction is used to transfer payments from an unclaimed cash holding
account to the loan balance. The cash, which was previously received and posted to unclaimed cash
instead of directly to the loan balance is claimed with the Claimed Cash Posting transaction as a reduc-
tion, or payment, to the loan balance.

Field Description

Ref # Enter a transaction identification number for the claimed cash posting.

Current balance Displays the current unclaimed cash balance for the facility.

Post Date Select the posting date for the claimed cash posting transaction.

Projected
balance

Displays a calculated projection of the unclaimed cash balance after the trans-
action is completed.

Amount Enter the claimed cash amount to be posted to the loan or net collections.

Collateral Select the collateral to which to post the claimed cash posting. This field is only
required when Post to net collections is selected in Effect on A/R.

Effect on A/R Select the option that determines how the claimed cash posting is posted:
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Field Description

l None: apply the cash to the loan balance

l Post to net collections: reduce the selected Collateral by the payment
amount. The posting updates collateral value and availability in the same
manner as when you create a Certificate and post the payment amount
to Net Collections. The effect is that a system-created certificate will
report the Net Collections as established by the claimed cash posting
entry.

(Grid) Displays each cash unclaimed cash deposit and posting transaction as a line-
item with the following data:

l Date: the posting date of the transaction

l Ref#: the transaction identification number

l Type: Deposit = cash posted to unclaimed cash via Unclaimed Cash
Deposit transaction, Post to Loan = cash claimed from unclaimed cash
and posted to loan

l Amount: the transaction amount

l Balance: the unclaimed cash balance after the transaction posted

Not available for claimed cash transactions.

Click this button to save a claimed cash posting.

Not available for claimed cash transactions.

Click this button to open the Audit screen to view audit history for the claimed
cash posting.

Click this button to generate a preview of the Claimed Cash Posting screen,
which can be printed or exported in a variety of formats.

Click this button to close the screen.
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Ledger Transactions - Disbursement Dialog

The Disbursement screen is accessed from the functions list of the Client List (with a facility selected) or
from the Ledger panel of the Facility Information scree. The Disbursement screen is used to record the
funding of the client loan, whether by check, wire, or other method, to a facility.

A System Preference allows disbursements with zero check amounts to be sent to the Manage Pending
Transactions (F8) screen for approval, rather than automatically approving the disbursement. To
enable this function, set System Preference Facility/Collateral Rules (Formerly Asset Based Lending),
Transactions, Send zero check amount disbursements to the Manage Pending Transactions (F8) to
True. Additionally, set System Preference Facility/Collateral Rules (Formerly Asset Based Lending),
Transactions, Always assign check number to ABL Disbursement when check amount equals zero
to True to allow the transaction to bypass the check writer process.

Deferred Revenue

The Facility Disbursement Transaction can be used to take a set expense amount against the loan bal-
ance up front as unrealized revenue, defer the revenue over a defined schedule, and realize the revenue
over that schedule. Alternately, offsetting expenses can be created to take the expense amount against a
cash account. For example, the lender may take a $12,000 adjustment up front and defer the revenue by
realizing $1,000 per month for a year. The balance of the amount is held in a G/L account designated for
deferred revenue.

On the first day, the adjustment transaction takes the amount from the loan balance (or cash) and puts it
into the accrual account (the account selected in the above-the-line Account field on the Facility Adjust-
ment screen). This transactions debits the loan and credits the accrual account. At the frequency defined
on the Deferral Information section of the Facility Adjustment screen, the periodic payment amount is
deducted from the accrual account and credited to the Move to Account account specified in the Defer-
ral Information section of the Facility Adjustment screen.
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Field Description

Facility Group

Facility Displays the name of the facility selected from the Facility Information screen.

Available collateral The amount of the total collateral availability (less reserve) as calculated in the
borrowing bases.

Loan balance The amount of the current outstanding loan balance.

Pending The amount of pending transactions against the facility.

Available to disburse The total amount for the facility that is available to disburse to the client. This
amount is the Available collateral, less any Pending transactions, and less the
Loan balance.

Disbursement Group

Bank acct Select the bank account into which the disbursement is to be paid.

Payee Enter the name to which the check is paid. Click the adjacent "Fill" button to pop-
ulate the payee and address fields automatically. If the check is for a third
party, enter the payee’s name and address in the Address and City fields
provided.
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Field Description

Address Enter the payee street address. Two lines are available.

City Enter the city, state, and ZIP/Postal Code components of the payee address in
the provided fields.

Description Enter any applicable transaction details. This information will be particularly use-
ful when following an audit trail.

Post date Select the transaction posting date.

Disburse Enter the disbursement amount.

Paid on Enter the date on which the disbursement occurred. This is the date on which
the check was (or is to be) printed, or the wire was sent.

Expenses The total amount of expenses entered in the Expenses grid is displayed here.

Check amount The total check amount for the disbursement, which is the Disburse amount
minus any expenses recorded in the Expense grid.

Collateral Displays each available collateral for the facility as a line-item.

Expenses Group

Expenses Displays any expenses, such as a transaction fee, as line-items in this grid with
the following data.

Note that expenses recorded against the disbursement are debited from the
loan balance if a single expense entry is entered. The user can, however, enter
two offsetting expense entries (one debit, one credit) to write an expense entry
against a cash account. The entries will wash and remove the amount in the
Expense field in the Disbursement group.

l Account: the account to which the expense is to be posted

l Description: the description for the associated account - the description
can be over-typed if required to enter an expense description

l Amount: the amount to be charged for the expense.

New Click this button to open the Expense screen, on which expense entries for the
transaction are defined.

Edit Select an existing expense line-item and click this button to open the item on
the Expense screen, on which expense entries for the transaction can be edited.
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Field Description

Delete Select an existing expense line-item and click this button to delete the item.

Not available for Disbursement transactions.

Click this button to save the disbursement. The transaction is placed in a 'Pend-
ing' status, and the disbursement is completed in the Managing Pending Trans-
actions screen.

Not available for Disbursement transactions.

Unprocess Click this button to unprocess approved or processed disbursements. This fea-
ture is available for current and prior day disbursement transactions, and is
restricted to users with rights to Update Disbursements.

To enable unprocessing, set the system preference Facility/Collateral Rules
(Formerly Asset Based Lending), Transactions, Allow Unprocessing of dis-
bursement transactions from prior dates to True. Also, the Security Role Facil-
ity/Collateral Rules (Formerly Asset Based Lending), Transactions, Allow
unprocessing of disbursements must be set to True in the Security Role
assigned to the user.

Click this button to open the Audit screen to view audit history for the dis-
bursement.

Click this button to generate a preview of the Disbursement screen, which can
be printed or exported in a variety of formats.

Click this button to close the screen.
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Disbursement Expenses Dialog

The Expenses screen opens from the Disbursement screen, and is used to create expenses against a facil-
ity disbursement.

Field Description

Description Enter any applicable distribution details. You can use this information for audit
trail purposes.

G/L Account Select the applicable distribution account from the list. The accounts are
defined in the FactorSoft Accounts table.

Amount Enter the distribution amount. Note that the check, wire or transfer amount
entered on the Check Register screen must equal the sum of all distributions
entered for the check.

Deferral Information - these fields are only available if the G/L Account is defined as a Deferred earnings
account on the Standard tab of the Account Table in the Tables module.

Move to Account Select the account to which the deferred revenue is moved from the deferred
earnings account.

Frequency Select the frequency with which the deferred revenue is moved to the Move to
Account.
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Field Description

l Manual: deferral repayment is posted manually by the user.

l Weekly: deferral repayment is performed by the Engine weekly on the day
selected in Day of the Week for the number of weeks selected in Number
of Payments.

l Monthly: deferral repayment is performed by the Engine monthly on the
day entered in Day of the Month for the number of weeks selected in Num-
ber of Payments.

No. of Payments Enter the number of weekly or monthly payments by which to divide the
Amount of the deduction to determine the amount of each repayment of the
deferral.

Day of Week If the Frequency is Weekly, select the day of the week on which the Engine is to
perform the deferral repayment.

Day of Month If the Frequency is Monthly, enter the day of the month on which the Engine is to
perform the deferral repayment.

Amount Displays the repayment amount, which is the Amount divided by the Number of
Payments.

Save Click this button to save the expense definition and close the Expense screen.

Cancel Click this button to close the screen without saving.
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Ledger Transactions - Payment Screen

The Payment screen is accessed from the Ledger panel of the Facility Information screen and is used to
reduce the loan balance with funds received from various payment sources. The entry may be either a
single payment or a batch of payments received in a lockbox. The payment is entered as a batch total
and can be itemized.

Additionally, the Post to net collection option under Effect on A/R provides the opportunity to auto-
matically reduce the collateral by the payment amount when the payment is posted.

Field Description

Facility Displays the name of the facility selected from the Facility Information screen.

Post date Select the transaction posting date.

Ref # Enter a transaction identification number. Typically the reference is a certificate
number or a posting number.

Source Select the payment source. The options in this list are set up in Check Source
table.

Amount Enter the total payment amount.

If this field is red-outlined, this indicates that detail entries in the Payment detail
grid do not equal the total payment amount entered in this field.

Collateral Select the accounts receivable borrowing base to which to post the payment.
This field is only available if Post to net collection is selected under Effect on A/R.
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Field Description

Effect on A/R Select the option that determines the effect of the payment on the A/R balance:

l None: pays down the loan balance

l Reserve from availability: payment places a reserve against the collateral

l Post to Net Collections: reduce the selected Collateral by the payment
amount. The posting updates collateral value and availability in the same
manner as when you create a certificate and post the payment amount
to net collections. The effect is that a system created certificate will report
the net collections as established by the payment posting entry.

You can set a default Effect on A/R on payment transactions for loans con-
taining A/R collateral types. Set System Preference Facility/Collateral Rules
(Formerly Asset Based Lending), Transactions, Default “Effect on A/R” for Pay-
ment Postings to the desired value.

The Effect on A/R functionality can allow a back-dated loan payment for a facil-
ity to affect the reserves or net collateral amount for the underlying collaterals.
To utilize this option, set System Preference Facility/Collateral Rules (Formerly
Asset Based Lending), Transactions, Allow post date on payment when effect on
A/R is used to True. Note that the posting date for the collateral posting will
always be the current FactorSoft processing date, and not the date of the facil-
ity loan payment.

Payment details Record additional payment detail as line-items in this grid. For example, if you
receive multiple checks from a lockbox, you can record each check separately
in the Payment Details pane. These details are saved with the payment and are
available for viewing.

l Date: select the check/payment date

l Amount: the detail payment amount

l Reference #: the detail transaction identification number.

When details are entered into the Payment details grid, the outline of the
Amount field turns red until the sum of detail entries equals the total amount of
the payment transaction entered in the Amount field. When the total of details
equals the Amount, the outline changes to green.

Click this button to edit an existing payment.
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Field Description

Click this button to save changes to a payment.

Click this button to undo unsaved changes to the payment.

Void Click this button to void the payment transaction in the current day (on the Fact-
orSoft current processing date that the payment was formatted). Voiding a pay-
ment takes the following actions:

l Clears the transaction’s financial posting from the loan balance

l Erases the G/L entry for the transaction

l Removes the transaction from the Facility Ledger

l Creates an entry in the Transaction Register for the void.

To enable transaction voiding, System Preference Facility/Collateral Rules
(Formerly Asset Based Lending), Transactions, Allow voiding of facility trans-
actions for current day only must be set to True. The capability to void trans-
actions can also be limited by Security Role.

Click this button to open the Audit screen to view audit history for the payment.

Click this button to generate a preview of the Payment screen, which can be
printed or exported in a variety of formats.

Click this button to close the screen.

NOTE
The Daily Transaction Journal (Daily Payments Journal) and the Cash Receipts Ledger report displays
the payments processed during the course of the day.

Bulk Collaterals User Guide
Ledger Transactions - Payment Screen

162 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Facility Purchase Dialog

Purchase transactions can be created from several locations within FactorSoft:

l from the Client List by selecting the facility and then selecting the New Purchase option in the Bulk
Purchase facility menu

l from the Facility Information Screen for the facility by selecting Purchases from the panel menu

l from the Ledger panel for a Bulk Purchase facility

The Purchase Certificate panel is used to create a new purchase transaction for the facility. Note that the
top half of the screen provides the fields for creating the purchase transaction, while the bottom half
provides the fields to create the corresponding disbursement transaction to fund the client. Only the pur-
chase transaction detail is required complete a purchase transaction.
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Field Description

Purchase Certificate

Facility Displays the name of the facility selected from the Facility Information screen.

Date Select the posting date of the purchase transaction. This field displays the Fact-
orSoft current processing date by default.

Certificate No Enter an identification number for the purchase certificate.

Status Displays the current status of the purchase transaction. For a new purchase,
this field displays New.

Limit Available Displays the current available collateral amount.

Post to Collateral Select the offset collateral to which to post the purchase offset entry. This field
will only be available if there is an A/R Aging collateral in the borrowing base
with the Aging Category set to Sales Posted.

(Purchase Rules) Displays the purchase rule percentages defined for the facility on the Purchase
Rules panel:

l Estimated Uncollectible %

l GLR %

l Credit Reserve %

l Discount Fee %

Purchase This row allows entry of the gross purchase amount, and provides a breakdown,
as described below:

l Gross Receivables

l Adjust LEC/Billing

l After GLR

l Credit Reserve

l Discount Fee

l Net Value

The labels for these headings can be customized in System Preferences.
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Field Description

Disbursement Information

Bank acct Select the bank account into which the disbursement is to be paid.

Payee Enter the name to which the check is paid. Click the adjacent "Fill" button to pop-
ulate the payee and address fields automatically. If the check is for a third
party, enter the payee’s name and address in the Address and City fields
provided.

Address Enter the payee street address. Two lines are available.

City Enter the city, state, and ZIP/Postal Code components of the payee address in
the provided fields.

Description Enter any applicable transaction details. This information will be particularly use-
ful when following an audit trail.

Post date Select the transaction posting date.

Client Reserve Displays the remainder of the purchase amount after the Purchase Rules are
applied. This is the total amount available to fund.

Paid on Enter the date on which the disbursement occurred. This is the date on which
the check was (or is to be) printed, or the wire was sent.

Expenses The total amount of expenses entered in the Expenses grid is displayed here.

Check amount The total check amount for the disbursement, which is the Client Reserve
amount minus any expenses recorded in the Expense grid.

Status Displays the current status of the purchase transaction. For a new purchase,
this field displays New.

Collateral Displays each available collateral for the facility as a line-item.

Expenses Enter any expenses, such as a transaction fee, as line-items in this grid.

l Account: selecting the Account to which the expense is to be posted

l Description: automatically completed with the description for the asso-
ciated Account - the description can be over-typed if required to enter
an expense description

l Amount: enter the amount to be charged for the expense.

Bulk Collaterals User Guide
Facility Purchase Dialog

165 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

Not available for Purchase transactions.

Click this button to save the purchase. The transaction is placed in a 'Pending'
status, and the purchase is completed in the Managing Pending Transactions
screen.

Not available for Purchase transactions.

Void Click this button to void the purchase transaction in the current day (on the
FactorSoft current processing date that the purchase was formatted). Voiding
a facility purchase takes the following actions:

l Clears the transaction’s financial posting from the loan balance

l Erases the G/L entry for the transaction

l Removes the transaction from the Facility Ledger

l Creates an entry in the Transaction Register for the void.

To enable transaction voiding, System Preference Facility/Collateral Rules
(Formerly Asset Based Lending), Transactions, Allow voiding of facility trans-
actions for current day only must be set to True. The capability to void trans-
actions can also be limited by Security Role.

Click this button to open the Audit screen to view audit history for the purchase.

Click this button to generate a preview of the Purchase screen, which can be
printed or exported in a variety of formats.

Click this button to close the screen.
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Facility Purchase Adjustment Dialog

The Purchase Adjustment transaction, accessed exclusively from the Ledger panel of the Facility Inform-
ation screen for a Bulk Purchase facility, enables the lender to reconcile the value of the borrowing base
based on the collateral declarations entered for the bulk purchase. The screen displays the two views of
the borrowing base: the Collateral Totals row shows the sum of the collateral declarations, and the
Account Balance row shows the current value of the account at the Facility level. The Adjustment row
shows the difference between the two, which is also the adjustment that will be applied to the account
when the transaction is processed. When the Purchase Adjustment is saved, the Account Balance value
will be adjusted to the collateral value, with any difference applied to the Client Reserve.

Field Description

Purchase Adjustment Certificate

Facility Displays the name of the facility selected from the Facility Information screen.

Date Select the posting date of the purchase adjustment transaction. This field dis-
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Field Description

plays the FactorSoft current processing date by default.

Certificate No Enter an identification number for the purchase adjustment.

Status Displays the current status of the purchase adjustment transaction. For a new
purchase adjustment, this field displays New.

Limit Available Displays the current available collateral amount.

(Purchase Rules) Displays the purchase rule percentages defined for the facility on the Purchase
Rules panel:

l Estimated Uncollectible %

l GLR %

l Credit Reserve %

l Discount Fee %

Excess Availability Displays the difference between net availability and the current loan balance.

Gross Receivables This row allows entry of the gross purchase amount, and provides a breakdown,
as described below:

l Collateral Totals - displays the sum total of collateral for the facility

l Account Balance - displays the current value of the account at the facility
level

l Adjustment - displays the difference between the collateral and account
balances

As Of Select the date through which to display Gross Receivable data.

Rework Click this button to update the Gross Receivables information based on the As-
Of date.

Disbursement Information

Bank acct Select the bank account into which the disbursement is to be paid.

Payee Enter the name to which the check is paid. Click the adjacent "Fill" button to pop-
ulate the payee and address fields automatically. If the check is for a third
party, enter the payee’s name and address in the Address and City fields
provided.
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Field Description

Address Enter the payee street address. Two lines are available.

City Enter the city, state, and ZIP/Postal Code components of the payee address in
the provided fields.

Description Enter any applicable transaction details. This information will be particularly use-
ful when following an audit trail.

Post date Select the transaction posting date.

Client Reserve Displays the Excess Availability amount. This is the total amount available to dis-
burse.

Paid on Enter the date on which the disbursement occurred. This is the date on which
the check was (or is to be) printed, or the wire was sent.

Expenses The total amount of expenses entered in the Expenses grid is displayed here.

Check amount The total check amount for the disbursement, which is the Client Reserve
amount minus any expenses recorded in the Expense grid.

Status Displays the current status of the purchase transaction. For a new purchase,
this field displays New.

Collateral Displays each available collateral for the facility as a line-item.

Expenses Enter any expenses, such as a transaction fee, as line-items in this grid.

l Account: selecting the Account to which the expense is to be posted

l Description: automatically completed with the description for the asso-
ciated Account - the description can be over-typed if required to enter
an expense description

l Amount: enter the amount to be charged for the expense.

Not available for Purchase Adjustment transactions.

Click this button to save the purchase adjustment. The transaction is placed in
a 'Pending' status, and the purchase adjustment is completed in the Managing
Pending Transactions screen.

Not available for Purchase Adjustment transactions.
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Field Description

Click this button to open the Audit screen to view audit history for the purchase.

Click this button to generate a preview of the Purchase screen, which can be
printed or exported in a variety of formats.

Click this button to close the screen.
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Ledger Transactions - Facility Transfer

The Facility Transfer screen is accessed from the Ledger panel of the Facility Information screen and is
used to transfer funds from one facility to another. Transfers are similar to adjustments except that trans-
fers reduce one loan balance while increasing another. This transaction increases the loan balance of the
sending facility (From facility) and reduces the loan balance of the receiving facility (To facility). This is a
non-cash transaction sending "non-cash funds" from one facility to another.

NOTE
The From Facility disburses the transfer funds, and its balance consequently increases. The funds are
being applied to the To Facility, which results in a decrease in the loan balance.

Field Description

From facility Displays the name of the facility selected from the Facility Information screen,
which will be the facility from which the funds are transferred.

To facility Select the facility to which to transfer funds.

From Debit Displays the account set up as the Loan balance account in the Account Group
for the From Facility.

To Debit Displays the account set up as the Loan balance account in the Account Group
for the To Facility.

From Credit Displays the account set up as the Accrued transaction fee account in the
Account Group for the From Facility.
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Field Description

To Credit Displays the account set up as the Accrued transaction fee account in the
Account Group for the To Facility.

Post date Select the transaction posting date.

Current balance Displays the current loan balance of the facility from which the transfer is being
made.

Amount Enter the amount of the transfer

Projected balance Displays a calculated projection of the From Facility balance after the trans-
action is completed.

From Currency Type Displays the currency type of the From facility.

To Currency Type Displays the currency type of the To facility.

Conversion Rate Displays the calculated conversion rate for the From/To currency types. Cal-
culated as (From Facility Currency Value / To Facility Currency Value). The Cur-
rency Values are held in the Currency Denomination table.

Converted Amount the converted transaction amount, calculated by multiplying the transaction
amount by the Conversion Rate.

Explanation Enter descriptive text for the transfer.

Click this button to edit an existing transfer.

Click this button to save changes to a transfer.

Click this button to undo unsaved changes to the transfer.

Click this button to open the Audit screen to view audit history for the transfer.

Click this button to generate a preview of the Facility Transfer screen, which can
be printed or exported in a variety of formats.

Click this button to close the screen.

NOTE
The Daily Transaction Journal (Transaction Summary and Adjustment Journal formats) and the Trial
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Balance Reports display the transfers processed during the course of the day.
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Ledger Transactions - Statement Payment

The Statement Payment screen is used to record loan statement payments. Outstanding fees and/or
interest that have been accrued by a previously generated loan statement are displayed in the grid. This
transaction is accessed by selecting Statement Payment from the actions list on the Ledger panel of the
Facility Information screen, or from the New Statement Payment option in the Facility Functions list on the
Client List (F3) screen.

This screen behaves differently depending on whether the Auto Distribute Payment is set on the Payment
Rules tab of the Facility Information screen.

l If the Auto Distribute Payment option is set to Do Not Use, the outstanding Fee Posting Amount is
populated in the Variance field, and the Post Amount for each fee line-item is the full outstanding
balance of the fees. If the statement payment Amount is less than the variance, the user must
account for the variance by reducing the Posting Amount of fees in the grid to remove the Vari-
ance before the transaction can be saved. This is done by entering the new amount directly in the
Post amount column for the line-item.

l If the Auto Distribute payment feature is being employed in the facility (Auto Distribute Payment
option is set to any value other than Do Not Use for the facility), the actual allocation of the pay-
ment distribution , based on the Payment Terms hierarchy and Payment Rule, is previewed for the
affected fee line-items when the user enters the payment total in the Amount field and then tabs
out of the field (note that the payment rule is displayed on the Facility Positing screen). The Post
Amount column display the allocation of the amount to each terms type/transaction date, and the
Principal Reduction field at the bottom of the screen displays the amount applied to the principal
of the loan, if the payment amount exceeds the amount of all outstanding fees. There is only a Vari-
ance when the payment amount exceeds the amount of all outstanding fees.
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Column Description

Facility Displays the facility name.

Ref # Enter a transaction identification number.

Source Select the payment source. The options in this list are set up in Check Source
table.

Date The transaction posting date for the statement payment. This field contains the
current FactorSoft processing date by default. You can enter a different date dir-
ectly in the field, or select the date from a calendar by clicking the calendar
icon in the field.

Amount Enter the total payment amount.

When Auto Distribute is not used, if this field is red-outlined, this indicates that
detail fee line-items in the grid do not equal the total payment amount entered
in this field.
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Column Description

Variance If the Auto Distribute feature is not used, this field displays the full outstanding
balance of the Fee Posting Amount, or the difference between the Fee Posting
Amount and the payment Amount.

If the Auto Distribute feature is used, this field displays the portion entered in the
Amount field that is above the Fee Posting Amount, and will be applied to prin-
cipal.

Post date Click the calendar button and select the posting date for the accrual posting
from the calendar. The current FactorSoft processing date is used by default.

(Grid) Displays each posting as a line-item with the following data:

l Description: the Statement Terms type description

l Stmt date: the statement date in which the interest or fee was accrued

l Post Date: the posting date of the transaction

l Balance: the line-item balance available to post to the loan

l Projected balance: the line-item balance after the accrual is posted

l Post Amount: if Auto Distribute is not used, enter the actual amount to
post to the loan balance and clear from the accrued fee balance. If Auto
Distribute is used, displays the amount of the statement payment applied
to the fee.

Refresh Click this button to display updated data in the grid.

Clear Clears the Post Amount column and moves the amount to the Projected Bal-
ance column. This allows the user to post selected fees and/or fee amounts.

Current balance Current balance of the loan prior to posting the payment.

Fee posting amount The sum total amount of the fees to be posted from the Statement Terms line-
items.

Principal reduction The amount applied to the principal of the loan, if the payment amount
exceeds the amount of all outstanding fees.

Projected balance The balance of the loan after the sum total of payment items is posted, which is
Current balance less Principal reduction.
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Column Description

Click this button to open the Audit screen to view audit history for the posting.

Click this button to generate a preview of the Facility Posting screen, which can
be printed or exported in a variety of formats.

Click this button to close the screen.
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Facility Information - Letter of Credit

The Letter of Credit(LOC) panel shows all letters of credit defined for the facility. Letter of Credit is rep-
resented in FactorSoft as a facility reserve that covers the Lender’s exposure as it relates to agreements
(Letters of Credit) made on behalf of the borrower. The Letter of Credit function serves to reserve an
amount sufficient to cover the Lender’s guarantees made to a supplier in the event the borrower fails to
make payments on purchases.

Field Description

(Grid) Displays each facility reserve item as a line-item with the following data:

l Title: The reserve title for the reserve item.

l LOC Number: The Letter of Credit Number.

ll Amount: The reserve amount to be held against availability for the
reserve item.

l Balance: Basis for the reserve calculation.

l Issue Date: The date that the LOC takes effect.

l Expire Date: The date that the LOC expired.
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Field Description

New Click this button to create a LOC for the facility.

View Select an existing reserve item from the grid and click this button to view and/or
edit the LOC.

Terminate Used to reset reserve amount to zero permanently andeEnters final date in
Expired Date column.

System Preferences

To configure the Letter of Credit functionality, set the following System Preferences in the Facil-
ity/Collateral Rules (formerly Asset Based Lending) > Rules > Letters of Credit folder:

Preference Description

Use Facility Letter of
Credit

Set to TRUE to activate Letter of Credit functions.

General Ledger Entry
Prefix

Future use.

Name of LC Type 1-12 Enter the abbreviated descriptor for the type of Letter of Credit. User can
name up to 12 different classifications for LC Type.

Percentage for LC
Type 1-12

Enter the default reserve rate for each associated LC Type

Note: any value entered in the Letter of Credit form for “LC Type” that is not saved
as one of the named preferences will have a default reserve rate of 100%
assigned.

Adding a Letter of Credit

Add a Letter of Credit on the Facility Information screen > Letter of Credit panel > New. Fill out the fields
as described in the table below.
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Field Description

Required

Title Enter the LOC reference name/label.

LOC Number Enter the LOC reference number or abbreviation.

LOC Type Enter LOC Type exactly as named in system preference. The associated
default Reserve Rate will be used.

Balance Represents the current LOC exposure which is the value used in cal-
culating the LOC Reserve.

Optional

Inactive Checkbox Resets the Reserve Amount to zero when the override rate is zero.

Qualifier User-defined purpose.

Effective Date User-defined purpose.

Override Enter the Override Rate. The rate entered in this field will be used to cal-
culate reserve amount instead of the default reserve rate.

Informational

Client Direct link to the Client Information screen.

Facility Direct link to the Facility Information screen.

Letter of Credit Check- Indicates reserve type is Letter of Credit.
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Field Description

box

LOC Expired General Information Captured in the File Upload from Imported LOC.

Reserve Rate Displays the default reserve rate as assigned by system preference or
100% if no system preference is set for the associated LC Type.

Amount Displays the calculated Reserve Amount.

Reserve Amount = Balance * Reserve Rate or Override

Modifying a Letter of Credit

To modify a Letter of Credit on the Facility Information screen > Letter of Credit panel > click Edit. Fill out
the fields as described in the table below.

1. Update the Required Fields from the table above.

NOTE
Updating the balance will recalculate the reserve amount based on the new “Balance” amount
entered. Also, a line will be added to the Activity grid that indicates the changes made to the
LOC record.

2. Update the Optional Fields from the table above.

NOTE
Entries saved in Override will reevaluate the reserve amount based on the rate entered over the
original default reserve rate.

Terminate a Letter of Credit

To Terminate a Letter of Credit on the Facility Information screen > Letter of Credit panel > click Ter-
minate.
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Upon Terminating a Letter of Credit the following items are updated:

1. Reset reserve amount to zero permanently.

2. Enters final date in Expired Date column.

NOTE
To temporarily remove reserve, set LOC to inactive or set balance or override rate to zero.

Letter Of Credit Tabs - Activity
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Column Description

Activity Date Event Date

Indicator Originator of the event.

l Balance indicates file upload or an automated import process.

l Manual indicates a user has entered updated balance

Type Effect of the event

l Bal: The LOC balance has been updated

l ADJ: An administration fee has been charges against the loan for
this LOC.

ADJ – LOC Adjustment -Indicates a transaction against the Letter of
Credit Loan Balance/Cash Reserve. The Facility transaction form has a
drop-down field (lower right) that allows the user to indicate the trans-
action against the Loan Balance/ Cash Reserve associated with a Letter
of Credit. When the Letter of Credit is selected the activity will be added to
the LOC Activity Grid history.

Tran Status Processes indicates the manual processing is completed.

Activity Amount New “balance” as entered on edit. Reserve amount has been recal-
culated and updated in Facility Summary position.

Last Modified By Indicates the user or which process generated the event.
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Letter Of Credit Tabs - Notes

Field Description

Edit Click Edit button to add a new note.

Current Note Type Notes in the freeform text box and select Add New Note to save.

Grid l Created Date: Date the Note was entered.

l User: User that entered note.

l Notes: Abbreviated note line
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Letter Of Credit Tabs - Documents

Column Description

Edit Click Edit button to attach a new document.

Description Enter the document description or identifier.

Browse Select Browse to locate the document for upload.

Click this button to edit an existing document.

Click this button to save.

Click this button to undo unsaved changes.

Click this button to display the Audit screen.

Click this button to print.

Click this button to open the help screen.

Click this button to close the screen.
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Column Description

Grid Double-click line items in the grid to view saved document.

l Description: The Document description.

l Date: Date the document was uploaded.

l File Name: File name of the uploaded document.

Letter of Credit Search

You can search Letters of Credit at fsMain > Search > Letters of Credit. The user must have proper per-
missions set to access Search Capabilities.

Field Description

LOC Number Enter the LOC reference number or abbreviation.

Type Enter LOC Type by which to limit the search.

Client Select the client by which to limit the search.

Facility Select the facility by which to limit the search.

Client CIF LOC Account number

Bulk Collaterals User Guide
Facility Information - Letter of Credit

186 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

Use Partial Lookup Select this checkbox to search fields that contain your entries.

Clear Removes all search settings.

Search Execute the search based on search criteria input.

Grid Double-click results to open LOC form.

l Client: Client name associated with LOC.

l Client CIF: LOC Account number.

ll Facility: The facility for the LOC.

l LOC Number: The Letter of Credit Number.

ll Type: The LOC Type as named in system preferences.

l Issue Date: The date that the LOC takes effect.

l Expire Date: The date that the LOC expired.

Importing Letters of Credit

For information on Importing Letters of Credit, see the Import Guide.
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Facility Information - Limits Panel

The Limits panel of the Facility Information screen is used to set, update, and view the loan limits for the
facility.

Field Description

Loan limit The maximum exposure for this loan agreement

Decrease by The amount that will be used to reduce the Loan Limit over the interval selec-
ted.

Current limit The system-generated amount representing the current loan limit as determ-
ined by the established amortization settings.

Interval Select the frequency of the loan limit reductions (daily, weekly, monthly,
quarterly, or annually).

Established The date on which the lending facility was established. The system defaults to
the current FactorSoft processing date when the facility is created.

Amortized from The date on which the amortization of the lending facility began. The system
defaults to the current FactorSoft processing date.

Maturity Date The maturity date of the loan.

A System Preference allows advances to be limited if the Maturity Date is
exceeded. Set System Preference Facility/Collateral Rules (Formerly Asset
Based Lending), Transactions, Do not allow disbursement transactions when
facility maturity date is expired or not set to True to prevent advances against

Bulk Collaterals User Guide
Facility Information - Limits Panel

188 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

the facility if the Maturity Date is exceeded.
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Facility Information - Lock Box Panel

The Lock Box panel is used to create lock box name that is used to uniquely identify the facility for lock box
posting.

Field Description

(Grid) Displays each lock box definition as a line-item with the following data:

l Created by: The user id of the user that created the definition.

l Date Created: The FactorSoft processing date on which the lock box defin-
ition was created.

l Inactive: Indicates whether the lock box definition is inactive.

l LockBox: The lock box name.

New Click this button to add a new lock box definition to the facility. The Facility Lock-
Box screen opens to allow entry of a new lock box definition.

View Select an existing line-item from the grid and click this button to view and/or
edit the lock box definition on the Facility LockBox screen.

Delete Select an existing line-item from the grid and click this button to remove the
lock box definition from the facility record.
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Facility LockBox

The Lock Box screen is accessed from the Lock Box panel of the Facility Information screen, and is used to
create lock box names that are used to uniquely identify facilities for lock box posting.

Field Description

Name Enter a unique lock box name for the facility by which the facility is identified for
lock box posting.

Date Created Displays the date on which the lock box name was created for the facility. For
new lock box names, the current FactorSoft processing date is displayed.

(User Name) Displays the user-id under which the lock box name was (or will be) created.

Inactive Select this option to flag the lock box name as inactive to indicate that it is not
available for use.

Save Click this button to save the lock box name to the facility.

Cancel Click this button to closed the screen without saving.
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Facility Information - Payment Rules Panel

The Facility Information -Payment Rules is used to set the Auto Distribute rule for the facility, and displays
the Statement Terms set up for the facility. The Auto Distribute functionality is used to set up a hierarchy of
payments for fees and financial terms (set up in the Statement Terms) at the Facility level, based on the
Payment Rule applied here.

NOTE
On the Statement Posting screen (accessed from the New Statement Payment option in the Facility
Functions panel or the Statement Payment action in the Ledger panel), the actual effect of the pay-
ment distribution can be previewed. Enter the payment total in the Amount field and then tab out of
the field to show the allocation based on the Payment Terms hierarchy and Payment Rule (note that
the payment rule is displayed on the Facility Positing screen). The Post Amount column display the
allocation of the amount to each terms type/transaction date, and the Principal Reduction field at
the bottom of the screen displays the amount applied to the principal of the loan.

Field Description

Auto Distribute Pay-
ment

Set the payment rule to be used for this facility:
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Field Description

l Do Not Use: Apply payments to principal only.

l Oldest to Newest, Payment Level: Apply loan payments to payment terms
types by Payment Level within transaction date, oldest to newest.

For example, if there were 6 transactions, 3 on transaction date 1 and 3 on
transaction date 2, and each date with terms types 1-3, the payments are
applied:

l Date 1, priority 1

l Date 1, priority 2

l Date 1, priority 3

l Date 2, priority 1

l Date 2, priority 2

l Date 2, priority 3

l Principal

l Newest to Oldest, Payment Level: Apply loan payments to payment terms
types by Payment Level within transaction date, newest to oldest.

For example, if there were 6 transactions, 3 on transaction date 1 and 3 on
transaction date 2, and each date with terms types 1-3, the payments are
applied:

l Date 2, priority 1

l Date 2, priority 2

l Date 2, priority 3

l Date 1, priority 1

l Date 1, priority 2

l Date 1, priority 3

l Principal

l Payment Level, Oldest to Newest: Apply loan payments to payment terms
types by transaction date, oldest to newest, within Payment Level.

For example, if there were 6 transactions, 3 on transaction date 1 and 3 on
transaction date 2, and each date with terms types 1-3, the payments are
applied:

l Priority 1, date 1

l Priority 1, date 2

l Priority 2, date 1

l Priority 2, date 2

l Priority 3, date 1

l Priority 3, date 2

l Principal

l Payment Level, Newest to Oldest: Apply loan payments to payment terms
types by transaction date, oldest to newest, within Payment Level.

For example, if there were 6 transactions, 3 on transaction date 1 and 3 on
transaction date 2, and each date with terms types 1-3, the payments are
applied:

l Priority 1, date 2

l Priority 1, date 1

l Priority 2, date 2

l Priority 2, date 1

l Priority 3, date 2

l Priority 3, date 1

l Principal
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Field Description

(Grid) Each Statement Terms set up for the facility is displayed as a line-item, with the
following information:

l Payment Level: the hierarchical level of the statement term, as set on the
Statement Terms screen

l Description: the Statement Terms description

l Fee Type: the Fee Type set for the Statement Terms

View Select an existing statement terms from the grid and click this button to view
and/or edit the terms on the Statement Terms Information screen.
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Facility Information - Payment Stream

The Payment Stream defines the payment conditions for a Term Loan Facility. This definition determines
the frequency with which statements are produced for the term loan, as well as the payment amount. The
grid displays payment streams as line-items with the statement date, number of statements, payment
amount.

Field Description

Payment Method Select the payment method that determines how the statement payment
amount is calculated:

l Total Payment: the payment amount is a flat amount consisting of cal-
culated interest and fees with the remainder applied to principle

l Principal Payment: the full payment amount is applied to the principal
amount, with calculated interest and fees added to the payment.

Days until payment is
considered late

Enter the number of grace days from the payment due date until late fees are
assessed.

Payment Recurrence:
Due

Select the statement due interval to be used with the Every setting to determine
statement payment stream frequency.
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Field Description

l Days

l Weeks

l Months

l Years

Payment Recurrence:
Every

Enter the Payment Recurrence Due qualifier to determine statement payment
stream frequency

Grid Each payment stream for the facility is displayed as a line-item with the fol-
lowing information:

l Beginning statement: the first payment date defined for the payment
stream

l Number of statements: the number of statements in the payment stream

l Payment amount: the payment amount for the payment stream

New Click this button to add a new payment stream to the facility. The Term Pay-
ment Group Information screen opens to allow entry of a new term.

View Select an existing line-item from the grid and click this button to view and/or
edit the additional term on the Additional Terms Information screen.

Delete Select an existing line-item from the grid and click this button to deleter the
term.
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Term Payment Group Information Dialog

The Term Payment Information Group Dialog accessed from the Payment Stream Panel of the Facility
Information screen for a term loan facility. This screen is used to define the repayment schedule for the
term loan facility.

Field Description

Client/Facility Displays the client and facility name of the selected facility.

Beginning statement Select the date of the first loan repayment statement.

Payment amount Enter the payment or principal amount for each statement, depending on the
setting of the Payment Method on the Payment Stream panel of the Facility
Information screen.

Number of state-
ments

Enter the number of loan repayment statements to be issued for the facility.

Payment setup Displays the Payment Method set for the payment stream on the Payment
Stream panel of the Facility information screen.

Days before payment
is late

Displays the Days before payment is late set for the payment stream on the Pay-
ment Stream panel of the Facility information screen.

Recurrence Setup:
Due

Displays the statement due interval selected for the payment stream repay-
ment schedule.

Recurrence Setup:
Every

Displays the payment recurrence qualifier for the payment stream repayment
schedule.
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Field Description

Click this button to edit a Term Payment Group definition.

Click this button to save a Term Payment Group definition.

Click this button to undo unsaved changes to the Term Payment Group defin-
ition.

Click this button to open the Audit screen to view audit history for the Term Pay-
ment Group definition.

Click this button to generate a preview of the Term Payment Group screen,
which can be printed or exported in a variety of formats.

Click this button to close the screen.
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Facility Information - Purchases Panel

The Purchase Certificate panel is used to create a new purchase transaction for the Bulk Purchase facility.
You can also create a purchase transaction for the bulk purchase facility by selecting New Purchase in
the Functions panel.

Field Description

From Select the starting posting date for purchases to be displayed in the grid

To Select the ending posting date for purchases to be displayed in the grid.

Click this button to display purchases for the date range dates in the grid.

Include Void Select this option to included voided purchase transactions within the date range in
the grid.

Grid Displays each purchase as a line-item with the following data:
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Field Description

l Post Date: the posting date of the transaction

l Certificate No: the certificate number associated with the purchase transaction

l Type: The transaction type - BulkPurchase or TrueUp

l Status: the status of the purchase transaction - Pending, Processed, Void

l Gross Receivables: the collateral total for the facility

l Adjustment LEC/Billing: the amount of receivables applied to estimated uncol-
lectible reserve (Estimated Uncollectible rate applied)

l After GLR: the amount of receivables after the GLR (gross lending rate) per-
centage is applied

l Credit Reserve: the amount of receivables applied to credit reserve (Credit
Reserve rate applied)

l Discount Fee: the amount of receivables deducted for fees (Discount Fee rate
applied)

l Net Value: the receivable amount available to the client

Void Select a line-item and click this button to void a purchase transaction.

A confirmation message is displayed. Click Yes to void the transaction. The transaction
is removed from the grid. The voided transaction can be viewed in the Transaction
Register.

New Click this button to add a new purchase certificate to the facility. The Purchase screen
opens to allow entry of a new term.

View Select an existing line-item from the grid and click this button to view and/or edit the
purchase line item

Delete Select an existing line-item from the grid and click this button to delete a purchase
line-item.
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Facility Purchase Dialog

Purchase transactions can be created from several locations within FactorSoft:

l from the Client List by selecting the facility and then selecting the New Purchase option in the Bulk
Purchase facility menu

l from the Facility Information Screen for the facility by selecting Purchases from the panel menu

l from the Ledger panel for a Bulk Purchase facility

The Purchase Certificate panel is used to create a new purchase transaction for the facility. Note that the
top half of the screen provides the fields for creating the purchase transaction, while the bottom half
provides the fields to create the corresponding disbursement transaction to fund the client. Only the pur-
chase transaction detail is required complete a purchase transaction.
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Field Description

Purchase Certificate

Facility Displays the name of the facility selected from the Facility Information screen.

Date Select the posting date of the purchase transaction. This field displays the Fact-
orSoft current processing date by default.

Certificate No Enter an identification number for the purchase certificate.

Status Displays the current status of the purchase transaction. For a new purchase,
this field displays New.

Limit Available Displays the current available collateral amount.

Post to Collateral Select the offset collateral to which to post the purchase offset entry. This field
will only be available if there is an A/R Aging collateral in the borrowing base
with the Aging Category set to Sales Posted.

(Purchase Rules) Displays the purchase rule percentages defined for the facility on the Purchase
Rules panel:

l Estimated Uncollectible %

l GLR %

l Credit Reserve %

l Discount Fee %

Purchase This row allows entry of the gross purchase amount, and provides a breakdown,
as described below:

l Gross Receivables

l Adjust LEC/Billing

l After GLR

l Credit Reserve

l Discount Fee

l Net Value

The labels for these headings can be customized in System Preferences.
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Field Description

Disbursement Information

Bank acct Select the bank account into which the disbursement is to be paid.

Payee Enter the name to which the check is paid. Click the adjacent "Fill" button to pop-
ulate the payee and address fields automatically. If the check is for a third
party, enter the payee’s name and address in the Address and City fields
provided.

Address Enter the payee street address. Two lines are available.

City Enter the city, state, and ZIP/Postal Code components of the payee address in
the provided fields.

Description Enter any applicable transaction details. This information will be particularly use-
ful when following an audit trail.

Post date Select the transaction posting date.

Client Reserve Displays the remainder of the purchase amount after the Purchase Rules are
applied. This is the total amount available to fund.

Paid on Enter the date on which the disbursement occurred. This is the date on which
the check was (or is to be) printed, or the wire was sent.

Expenses The total amount of expenses entered in the Expenses grid is displayed here.

Check amount The total check amount for the disbursement, which is the Client Reserve
amount minus any expenses recorded in the Expense grid.

Status Displays the current status of the purchase transaction. For a new purchase,
this field displays New.

Collateral Displays each available collateral for the facility as a line-item.

Expenses Enter any expenses, such as a transaction fee, as line-items in this grid.

l Account: selecting the Account to which the expense is to be posted

l Description: automatically completed with the description for the asso-
ciated Account - the description can be over-typed if required to enter
an expense description

l Amount: enter the amount to be charged for the expense.
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Field Description

Not available for Purchase transactions.

Click this button to save the purchase. The transaction is placed in a 'Pending'
status, and the purchase is completed in the Managing Pending Transactions
screen.

Not available for Purchase transactions.

Void Click this button to void the purchase transaction in the current day (on the
FactorSoft current processing date that the purchase was formatted). Voiding
a facility purchase takes the following actions:

l Clears the transaction’s financial posting from the loan balance

l Erases the G/L entry for the transaction

l Removes the transaction from the Facility Ledger

l Creates an entry in the Transaction Register for the void.

To enable transaction voiding, System Preference Facility/Collateral Rules
(Formerly Asset Based Lending), Transactions, Allow voiding of facility trans-
actions for current day only must be set to True. The capability to void trans-
actions can also be limited by Security Role.

Click this button to open the Audit screen to view audit history for the purchase.

Click this button to generate a preview of the Purchase screen, which can be
printed or exported in a variety of formats.

Click this button to close the screen.
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Facility Information - Purchase Rules Panel

The Purchase Rules panel of the Facility Information screen is only available to Bulk Purchase facilities, and
defines the deductions taken from the facility balance to determine the funding to the client.

Field Description

Estimated Uncol-
lectible

Enter the percentage to be deducted from the balance as uncollectible funds.

GLR Enter the percentage to be advanced on the purchase. Calculated as a per-
centage of the gross purchase amount minus Uncollectible Rate.

Credit Reserve Enter the percentage of the balance to be withheld as credit reserve. Cal-
culated as a percentage of the gross purchase amount.

Discount Fee Enter the discount fee percentage applicable to the bulk purchase. Calculated
as a percentage of the gross purchase amount.

Post Discount Fee Enter the post discount fee percentage applicable to the bulk purchase. Cal-
culated as a percentage of the gross purchase amount.
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Facility Information – Reserves Panel

The Reserves panel displays a list of all facility reserves created for the facility. This panel is only present if
System Preference> Facility/Collateral Rules (Formerly Asset Based Lending) >Rules > General > Use
multiple facility reserves is set to True, and is used to declare reserve amounts for multiple Reservation
Titles.

Field Description

(Grid) Displays each facility reserve item as a line-item with the following data:

l Title: The reserve title for the reserve item.

l Qualifier: The unique description, if entered.

l Date: The date that the reserve takes effect.

l Amount: The reserve amount to be held against availability for the
reserve item.

New Click this button to create a reserve item for the facility. See Adding or Modifying
Facility Reserve for more information.

View Select an existing reserve item from the grid and click this button to view and/or
edit the reserve item on the Facility Reserve screen.

Delete Select an existing reserve item from the grid and click this button to remove the
contact from the facility record.
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Facility Information - Statement Panel

The Statements panel is used to define statements that detail the financial position of the client on a peri-
odic basis. These parameters determine the following:

1. how are statements delivered

2. when are fees posted

Statement generation is a process in which periodic interest and fees are calculated and posted. The pro-
cess uses the facility statement settings, both in this panel and Statement Terms, to establish daily loan
balance information with summary billing fee information. Depending on the rules established, state-
ments are generated either at the end of each month or a selected day(s) of the month other than the
end of the month. Fees are posted either directly to the loan balance or accrued and automatically pos-
ted at a later date.

TIP
You must click the edit (pencil) button between the Upper Fields and panels to open the Statement
panel for editing.

Field Description

Run statement at Currently, the only available option is Manually to calculate statement fees and
run the statement when the Loan Statement report is generated with the Pre-
liminary option deselected from the Reports Module > Facility > Loan State-
ment (crystal)

Days after EOM Currently not used.

Days to wait for post-
ing

Enter the number of days after the day indicated in Run statement at to actu-
ally post fees to the loan balance. Leaving this field blank indicates that fees are
posted as the statement is being generated.
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Field Description

Output Select the statement output option to be used from the Reports Module > Facil-
ity > Loan Statement (crystal):

l Print: to print the statement to a local or network printer

l Fax: to fax the statement directly to the client

l Email: to email the statement directly to the client

Next statement date
thru

Currently not used.

Next statement run
date

Currently not used.

Next fee posting Currently not used.

First statement from Displays the from date of the last run statement.

Last statement thru Displays the thru date of the last run statement.

From facility Select the facility which will satisfy the statement balance. If a facility is selected
here, a non-cash transfer transaction is created to satisfy the statement from
the From facility's funds.
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Facility Information – Statement Terms Panel

The Facility Information - Statement Terms panel lists the basic fee types and financial terms that are
applied to the facility when statements are run.

Field Description

(Grid) Each fee type set up for the facility is displayed as a line-item, with the following
information:

l Description: the fee description created on the Statement Terms screen
for the fee,

l Fee type: the fee type selected on the Statement Terms screen for the fee.

l Fee details: a synopsis of the fee settings created for the fee

l Inactive: indicates whether the fee is active or inactive.

New Click this button to create a new fee type for the facility. The Statement Terms
Information screen opens to allow entry of a new fee.

View Select an existing fee type from the grid and click this button to view and/or edit
the fee type on the Statement Terms Information screen.

Delete Select an existing fee type from the grid and click this button to remove the fee
type from the facility record.
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Statement Terms Information

The Statement Terms Definition screen is opened from the Statement Terms panel of the Facility Inform-
ation screen. This screen is used to configure the various fee types and financial terms that are applied
when a statement is run for a facility.

Field Description

Description Enter a description for the fee to be displayed in the grid of the Statement
Terms panel of the Facility Information screen.

Fee type Select the fee type to be configured for the statement terms. See the detailed
descriptions of each fee type in the following subsections.
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Field Description

l Interest

l Maintenance

l Transaction

l One-Time

l Minimum

l Reimbursement

l Exception

l Unused Line

l Over/Under

l Tiered

l Incremental

Payment Level This field is used to set the Payment Level for each Payment Terms for the facil-
ity on the Statement Terms screen (accessed from the Statement Terms panel
of the Facility Information screen) for the Auto Distribute feature. The Auto Dis-
tribute feature allows you to configure a hierarchy for fees and financial terms
set up in the Statement Terms, and then apply a Payment Rule to determine
how the hierarchy is applied.

Payment Level is a numeric field, 0-9 with 0 being highest priority and 9 lowest.
Zero is the default.

Include in minimum Select this option to indicate whether the fee is included in the minimum fee cal-
culation.

Inactive Select this option to suspend the use of this statement term. The term will not
be calculated and will not appear on the billing statement.

Click this button to edit an statement term.

Click this button to save a statement term.
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Field Description

Click this button to undo unsaved changes to the statement term.

Click this button to open the Audit screen to view audit history for the statement
term.

Click this button to generate a preview of the Statement Terms Information
screen, which can be printed or exported in a variety of formats.

Click this button to close the screen.

Bulk Collaterals User Guide
Statement Terms Information

212 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Statement Terms - Interest

Used to set up facility statement terms based on a standard interest rate plus basis (LIBOR, Prime, etc.),
usually within a minimum and maximum rate boundary, and optional float days.

Field Description

Interest rate Enter the standard interest rate and select the basis and year options.

l Rate: the base interest rate

l View: click this button to open the Interest Rate Detail screen to create an
interest rate table and apply rates by effective date

l Basis: the fluctuating interest rate on which to base the interest. The
choices are defined in the Daily Rate Basis table

l Year: the time unit on which the interest rate is calculated: 360, 365, or
Actual

l Type: the interest type: Standard or Compound

Rate boundaries Enter the minimum and maximum interest rates to charge for the facility.

l Min rate: the lowest rate to charge for the facility

l Max rate: the highest interest rate to charge for the facility

Float rules Enter the float days detail for the facility interest:
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Field Description

l Float days: the number of float days for the facility

l Float type: the days on which to base float days - Calendar days,
Monday-Friday, or Business days

When calculating interest on collections for bulk collaterals via a statement
posting, FactorSoft uses the Float increment from the Check Source specified in
the payment posting when required. The logic follows the hierarchy below:

l If no Float type is defined in the Statement Terms, no float is charged

l If a Float type and Float days are defined in the Statement Terms, these
are the float parameters charged, and the Float increment in the Check
Source is not considered

l If a Float type is defined in the Statement Terms, but no Float days are
defined, the Float increment from the Check Source table for the check
source specified in the payment posting is used to determine the float
charged
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Interest Rate Detail

The Interest Rate Detail screen is accessed from the Interest panel of the Facility Statement Terms screen,
and is used to create an interest rate table and apply rates by effective date for loan statements. The
Effective Date, Basis Name, and Margin Rate are entered on the Interest Rate Detail screen, and when the
statement is generated, the Effective Date and Margin Rate for the effective date on which the statement
is generated are used to calculate interest.

Field Description

Grid Displays previously defined interest rate detail entries.

As Of Date Select the date on which the Margin Rate for this interest rate detail table entry
is effective. The rate is effective up to the date of an entry in the table with a
newer Effective Date defined.

Basis Name Select the rate basis table used for interest calculation. The entries (and asso-
ciated rate tables) in this list are defined in the Daily Rate Basis Table in the
Tables module.

Margin Rate Enter the rate to be used to calculate interest for the effective date entry.

New Click this button to enter a new effective date entry to the table.

Edit Select an existing effective date entry in the grid and click this button to edit the
entry.

Save Click this button to save a new effective date entry or edits to an existing entry.

Delete Select an existing effective date entry in the grid and click this button to delete
the entry.
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Field Description

Audit Click this button to open the Audit screen, which displays the update and
change history for the Interest Rate Detail screen.
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Statement Terms - Maintenance/Monitoring Fee

Used to set up a loan maintenance or monitoring fee based on either a percentage rate applied for the
statement period or a flat fee. Fees can be based on several calculation bases, as described below. either
the as the basis, loan limit, or the average daily net collateral value as the basis.

Field Description

Rate The first field is the maintenance or monitoring fee rate to charge, which is the
rate applied to the statement period, based on the average daily loan balance
or total of net collateral balances at the end of the period. If you wish to see the
rate for a smaller period (daily, for instance), you can enter the divisor in the
second field, and the calculated rate is displayed in the field following the equal
sign.

Flat amount Enter a flat fee to be charged for the statement period.

Calculate based on Select the rate basis:
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Field Description

l Average Daily balance: Base the fee on the average daily loan balance

l Available Collateral: Base the fee on the available collateral, which is the
lower of the Loan Limit or Net Collateral (applicable only for A/R Aging, A/R
Summary, Bulk A/R, and Inventory collateral types)

l Eligible Collateral: Base the fee on eligible collateral, which is calculated
as the Gross Collateral minus ineligibles (applicable only for A/R Aging,
A/R Summary, Bulk A/R, and Inventory collateral types)

l Gross Collateral: Base the fee on the reported value of the collateral
(applicable only for A/R Aging, A/R Summary, Bulk A/R, and Inventory col-
lateral types)

l Loan Limit Amount: Base the fee on the loan limit

l Net Collateral: Base the fee on the net collateral, which is calculated as
the Available Collateral multiplied by the Advance Rate (applicable only
for A/R Aging, A/R Summary, Bulk A/R, and Inventory collateral types)

l Supporting Collateral: Base the fee on the collateral amount required to
support the loan balance on a daily basis. Supporting collateral is cal-
culated as the collateral balance divided by the advance rate (applic-
able only for A/R Aging, A/R Summary, Bulk A/R, and Inventory collateral
types)

l Other: Base the fee on the amount entered in Other amount.

l Out of Formula:

Collateral Select the collateral to which the fee type will apply. This selection is required if
Calculate based on is set to Available Collateral, Eligible Collateral, Gross Col-
lateral, Net Collateral, and Supporting Collateral.

Other amount If Other is selected in the Calculate based on option, set the amount on which
to base the fee in this field. The Rate is applied to this amount to determine the
maintenance fee charged.

Calculate fee Select the period on which to base the fee:
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Field Description

l Fixed period - based on actual days - average balance * rate

l Standard Per Diem - based on a 30 day month - ((average balance *
rate) / 30) * 30

l Actual Per Diem - based on actual month - ((average balance * rate) /
30) * actual number of days in month

Rate boundaries Enter the minimum and maximum interest amount to charge for the facility.

l Min amount: the lowest amount to charge for the facility

l Max amount: the highest amount to charge for the facility
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Statement Terms - Transaction

Used to set up a transaction-based fee based on either a percentage of the transaction amount or a flat
fee based upon either the total funding amount for the period as the basis, or the total payments posted
to A/R as the basis.

Field Description

Rate The first field is the transaction fee rate to charge, which is the rate applied to
the funding or payment amount. If you wish to see the rate for a smaller period
(daily, for instance), you can enter the divisor in the second field, and the cal-
culated rate is displayed in the field following the equal sign.

Flat amount Enter a flat fee to be charged for each transaction.

Other amount Set the amount on which to base the fee in this field. The Rate is applied to this
amount to determine the transaction fee charged.

Calculate based on Select the rate basis:

l Each funding amount: total funding for the period

l Each collection amount: total payments posted to the loan balance for
the period

Rate boundaries Enter the minimum and maximum interest amount to charge for the facility.
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Field Description

l Min amount: the lowest transaction fee amount to charge for the facility.

l Max amount: the highest transaction fee amount to charge for the facility.
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Statement Terms - One-Time

Used to set up a One-Time fee based on a percentage of either the facility limit or the client limit as the
basis. Alternately, a flat amount One-Time fee can be defined.

Field Description

Rate Enter the rate to charge for the annual fee. The fee uses the predetermined facil-
ity or client limit, or another user-specified limit, as the basis, as determined in
the Based on option.

Based on Select the fee basis:

l Facility limit

l Client limit

l Other limit

Other limit Enter the user-defined limit amount to use as the fee basis.

Flat amount Enter a flat fee to be charged for the annual fee.

Post date Select the date on which the annual fee is to be posted.
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Statement Terms - Minimum

Used to set up a minimum fee to be charged to the facility. If the total fees calculated (Interest, Main-
tenance, etc.) do not exceed the minimum fee, a fee is charged to make up the shortage.

Field Description

Minimum fee amount Enter the minimum amount to be charged for all fees for the facility. If the sum
of all fees does not meet or exceed this figure, an additional fee is charged in
the amount of the shortage.
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Statement Terms - Reimbursement

Used to set up a flat fee (such as a monthly expenses) that is charged at statement generation.

Field Description

Amount The amount to be charged at statement generation.
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Statement Terms - Exception

Used to set up an exception fee that is a flat amount charged at statement generation.

Field Description

Amount The amount to be charged at statement generation.
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Statement Terms - Unused Line

Used to set up a fee based on the difference between the average daily loan balance and the basis limit
(either facility or client).

An option to prevent periodic statements from calculating the Unused Line Fee on loans that have a neg-
ative average daily loan balance is available. To utilize this option, set System Preference Facil-
ity/Collateral Rules (Formerly Asset Based Lending), Periodic statement generation, Do not calculate
unused line fee if loan balance is not positive to True.

Field Description

Fee rate The first field is the unused line fee rate to charge, which is calculated by mul-
tiplying the percentage rate by the basis (facility limit or client limit) minus the
average daily loan balance. If you wish to see the rate for a smaller period
(daily, for instance), you can enter the divisor in the second field, and the cal-
culated rate is displayed in the field following the equal sign.

Based on Select the rate basis:

l Facility limit

l Client limit

l Other limit

Other limit If Other limit is selected in the Based on option, set the amount on which to base
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Field Description

the fee in this field. The Rate is applied to this amount to determine the fee
charged.

Calculate fee Select the period on which to base the fee:

l Fixed period - based on actual days - average balance * rate

l Standard Per Diem - based on a 30 day month - ((average balance *
rate) / 30) * 30

l Actual Per Diem - based on actual month - ((average balance * rate) /
30) * actual number of days in month
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Statement Terms - Over/Under

Used to set up a fee calculated off the average daily loan balance. If the average daily balance is over the
specified threshold, the "above" rate or flat amount is charged. If the average daily balance is below the
threshold, the "below" rate or flat amount is charged.

Field Description

Threshold The threshold amount to which average daily balance is compared to determ-
ine whether the above or below rate is applied.

Rate Specify the percentage rates for the fee:

l Above: the percentage to be applied if average daily balance is above
the threshold.

l Below: the percentage to be applied if average daily balance is below the
threshold.

Flat amount Specify the exact dollar amounts for the fee:

l Above: the amount to be charged if average daily balance is above the
threshold.

l Below: the amount to be charged if average daily balance is below the
threshold.
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Statement Terms - Tiered

Used to set up a tiered fee structure calculated from the average daily loan balance. When the average
daily balance falls within a specified tier, the corresponding rate or flat amount is charged.

Field Description

Tiers Enter the To dollar amounts to be used to compare to average daily balance to
determine the fee tier to be applied. As each To amount is entered, the From
amount on the following tier is automatically set to the appropriate amount
(one dollar more than the previous To amount).

(Fee Selection) Select the option that determines how the fee is calculated.

l Rates: Percentage rates of the average daily balance are used to cal-
culate the fee.

l Amounts: Fees are flat dollar amounts specified for each tier.

Rates Enter the percentage of average daily balance to charge for each tier.

Flat amounts Enter the dollar amount to charge for each tier.
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Statement Terms - Incremental

Used to set up an incremental fee structure calculated off the average daily loan balance. This is similar
to tiered, except that each level adds an incremental factor to the previous amount or percentage, so
that the fee assessed is the sum of all the Levels up to the average daily balance. Fees are increased by
the percentage factor or amount for the specified levels of average daily balance, until the fee reaches a
capped percentage or amount.

Field Description

Levels Enter the dollar amounts to compare to average daily balance to
determine the fee level to be applied.

(Fee Selection) Select the option that determines how the fee is calculated.

l Rates: Percentage rates of the average daily balance are used to
calculate the fee.

l Amounts: Fees are flat dollar amounts specified for each level.

Rates Enter the percentage of average daily balance to charge for each tier.

Flat amounts Enter the dollar amount to charge for each tier.
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Facility Summary

The Facility Summary screen provides, at the facility level, an analysis of the current position, as well as effi-
cient access to the most critical posting transactions, thus consolidating the most used facility man-
agement tools on one simple to use form.

To access this form, select a bulk collateral facility from the Client List, and select Facility Summary from
the Functions list for the facility. The Facility Summary screen consists of two tabs. The Borrowing Base tab
displays the current position of each collateral for the facility, and the Loan Summary tab displays the
loan activity on the facility for the current FactorSoft processing day. The Letters of Credit Tab may not dis-
play depending on system preferences. See the Letters of Credit section for more details. The Borrowing
Base tab is illustrated and described in detail below:

Field Description

Client Name Displays the client name and code for the client to which the facility belongs.
Click the link to open the Client Information detail screen for the client.

Facility Name Displays the facility name and code of the selected facility. Click the link to open
the Facility Information detail screen.
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Borrowing Base Tab

Field Description

(Collateral Grid) Each collateral for the facility is listed as a separate line item with the following
information:

l New: Click this button to open the appropriate new posting screen for the
collateral to create a new posting. This button only appears for collaterals
that support a posting transaction.

l Collateral Description: The collateral name.

l Available Amt: displays the sum total of the available collateral sup-
porting the facility.

Available Displays the sum total of the net collateral supporting the facility.

Loan Limit Displays the loan limit for the facility.

Balance Displays the outstanding loan balance of the facility.

Excess/Deficit Displays the excess (cash that can be distributed) or deficit (amount to be
made up) for the facility.

Client CAP Space Displays the client CAP space (Client Limit less the sum of facility balances).

Loan Summary Tab

The Loan Summary tab displays the loan activity for the current FactorSoft processing date that has
occurred on the facility. This tab allows you to view the transaction activity and access posting trans-
actions directly from the screen.

The activity is displayed in grids for each posting type that has had activity. Double-clicking a line-item in
the activity grid opens the corresponding posting detail screen for the transaction.
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Field Description

Beginning
Balance

Displays the outstanding loan balance prior to any activity for the day.

Loan Pay-
ments

Displays the total amount of loan payments for the day, and each transaction as a line-
item in the grid. Double-clicking a line-item opens the transaction detail on the Payment
screen.

Click New to open the Payment screen to create a new loan payments posting.

TIP
From Facility Loan Payments screen, line-items in the grid can be quickly deleted in
edit mode using Ctrl + Delete keys.

Claimed
Cash Post-
ings

Displays the total amount of claimed cash transfer postings for the day, and each trans-
action as a line-item in the grid. Double-clicking a line-item opens the transaction detail
on the Claimed Cash Posting screen.

Click New to open the Claimed Cash Posting screen to create a new posting.

Adjustments Displays the total amount of adjustment postings for the day, and each transaction as a
line-item in the grid. Double-clicking a line-item opens the transaction detail on the
Facility Adjustment screen.

Click New to open the Facility Adjustment screen to create a new posting.
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Field Description

New Dis-
bursements

Displays the total amount of disbursement postings for the day, and each transaction
as a line-item in the grid. Double-clicking a line-item opens the transaction detail on the
Disbursement screen.

Click New to open the Disbursement screen to create a new posting.

Other Activity Displays the sum total amount of other postings for the day.

Ending Bal-
ance

Displays the outstanding loan balance after activity for the day.

Excess / Defi-
cit

Displays the excess (cash that can be distributed) or deficit (amount to be made up) for
the facility.

Loan Payments

Selecting New on the Facility Summary > Loan Summary tab will open this screen to allow you to create
a new loan payment.

TIP
Line-items in the grid can be quickly deleted in edit mode using Ctrl + Delete keys.

Bulk Collaterals User Guide
Facility Summary

234 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Collateral Information

Borrowings under a bulk collateral facility are limited by a borrowing base, which is comprised of to the
net realizable value of accounts receivable, inventory, and fixed assets with advance rates applied . These
assets serve as collateral for the facility.

In FactorSoft, collateral is established as part of Facility Information. Part of each facility’s profile in Fact-
orSoft is the set up of collateral as security for the facility. The purpose of the FactorSoft Collateral Inform-
ation profile is to set up and assign collateral to support a facility. The Collateral Information screen is
used to both create new collateral and to manage existing collateral.

Upper Fields

Collateral Profile Fields

Field Description

Client Displays the client name associated with the collateral.

Bulk Collaterals User Guide
Collateral Information

235 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

Facility Displays the facility name associated with the collateral.

Description The name of the collateral as it appears on screens and reports.

Inactive Select this option to make the collateral unavailable within FactorSoft. Selecting
Inactive excludes the collateral from valuation calculations and reports and
allows the collateral to be filtered out of the Client List.

A message has been added on the Collateral Information screen to alert the
user that the collateral is set inactive and that calculations and updates are not
enabled for the collateral. The message "Setting the Collateral to inactive will
stop calculations and updates" appears when the user opens the Collateral
Information screen for a collateral previously set inactive, or when the Inactive
option on the Collateral Information screen is selected and the edit is saved.
Although the position of the collateral will be frozen, updates to the collateral
can still be performed, and on the event that the inactive status is removed, the
collateral position will be caught up on the first nightly processing run of Fact-
orSoft.

Type Select the collateral type associated with the collateral to be managed:

l Bulk A/R

l Equipment

l Inventory

l Purchase Orders

l Real Estate

l Securities

l Medical Receivable

l Factoring

l A/R Aging

l Other

These types are system-defined, and each has a unique set of dialogs, rules,
and valuation methods. See the Detail Panels section for the corresponding
type for help with configuring each type. Depending on the collateral types pur-
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Field Description

chased, you may not be able to save new collaterals for all types.

Note that once the Type is set and saved for the collateral, it cannot be
changed.

Currency Select the currency type with which to value the collateral.

Note that once the Currency is set and saved for the collateral, it cannot be
changed.

Advance rate (%) Enter the percentage of the collateral value to offer as available credit.

Availability Limit Enter the dollar amount at which to cap available credit for this collateral.

Save Click this button to save changes to the Collateral Information profile.

Cancel Click this button to undo unsaved changes to the Collateral Information profile.

Collateral Balances

On the right-hand side of the upper fields, the collateral balances are displayed. The Declaration bal-
ances display the collateral balance fields as updated by collateral declarations in FactorSoft. The
Tracked column displays balances most recently imported from the Tracked A/R module. This column
only appears if the Tracked A/R module is enabled in your implementation of FactorSoft. The Variance fig-
ures display the difference between the Declaration and Tracked figures, and is also only displayed if
Tracked A/R is enabled.

Field Description

Current Collateral The gross reported collateral value.

Note that if there are pending postings for the collateral, this figure is displayed
in red, and a the note "Pending" appears

Less Ineligibles The current total ineligible amount for the collateral.

Less Reserves The balance of cash reserve against the reported collateral value.

Less Set Asides The balance of ineligibility set asides defined for the collateral.

Eligible Collateral The gross reported collateral value less ineligibles, reserves, and set-asides.

Advance Rate The Advance rate(%) defined for the collateral.

Net Collateral The eligible collateral value multiplied by the Advance Rate (%).
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Field Description

Collateral Limit The Availability Limit defined for the collateral.

Available Collateral The lower of the Net Collateral or the Available Limit. This amount will always be
either the Availability limit or the Net collateral.

Panel Lists

The panels in the panel list are used to record collateral details, display postings and declarations, and
access detail screens to create new posting and declarations. There are common detail panels as well as
panels that are unique to specific collateral types.

Collateral Above-the-Line Panels

The topics for each Collateral Type list the detail panels that are used with that collateral.

Below-the-Line Panels

Select the link in the list below for help with each panel:

l Amortizing adv rate

l Custom Data Elements

l Dependency rules

l Documents

l Seasonal availability

Collateral Above-the-Line Panels

Each Collateral Type lists the detail panels that are used with that collateral. Refer to the specific collateral
description in the following section for the panels that apply to that collateral.

Below-the-Line Panels

Below-the-line panels are common to all collateral types. These are presented in alphabetical order
immediately following.
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Tracked A/R and Loan Backed Collateral Panels

The last set of panels listed for A/R collateral types are used with the Tracked A/R and/or Loan Backed Col-
lateral modules. Refer to Tracked A/R or Loan Backed Collateral Guides for descriptions of these panels.
These panels will only appear in the list if the Tracked A/R or Loan Backed Collateral modules is enabled.

SEPARATELY LICENSED ADD-ON MODULE

This feature is only available as a separately licensed upgrade.
For more information, contact your Jack HenryTM representative at lendinginfo@jackhenry.com
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Common Collateral Panels

The panels and dialogs in the following section are common to all collateral type. These panels are
referred to as "below-the-line" panels.
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Collateral Information - Amortizing Adv Rate Panel

The Amortizing Available Rate feature allows you to add limitations on collateral limits by amortizing (redu-
cing) the available rate by a flat amount at predetermined intervals. This feature is most commonly used
with inventory collaterals.

Field Description

(Grid) Displays each amortizing rate as a line-item with the following data:

l Beginning date: The beginning date for the amortization period.

l Amortized rate: The percentage rate to apply for the amortization period.

New Click this button to add a new amortized rate to the collateral. The Amortize
Rate screen opens to allow entry of a new rate.

View Select an existing line-item from the grid and click this button to view and/or
edit the amortized rate on the Amortize Rate screen.

Remove Select an existing line-item from the grid and click this button to remove the
rate from the collateral record.
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Amortize Rate Dialog

Use the Amortize Rate screen to define a new amortization period and rate for the collateral. This screen is
accessed from the Amortizing Adv Rate panel of the Collateral Information screen.

Field Description

Beginning Date Select the beginning date at which the amortization rate takes effect.

Amortized rate Enter the percentage by which the collateral limit is reduced.

Click this button to edit an existing rate.

Click this button to save the rate.

Click this button to undo unsaved changes to the rate.

Click this button to open the Audit screen to view audit history for the rate.

Click this button to generate a preview of the Amortize Rate screen, which can
be printed or exported in a variety of formats.

Click this button to close the screen.
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Collateral Information - Dependency Rules Panel

The Collateral Dependency feature is used to calculate the collateral availability limit for one collateral
(the “dependent” collateral) based on a percentage of the availability limit of another facility (the
“dependency” collateral) within the same facility. This is typically used to limit the availability of a client's
inventory collateral by making the availability of inventory collateral dependent on a percentage of the
availability of the client's accounts receivable collateral. When calculating a dependency involving a
factoring collateral, the program uses the Available Amount from FactorSoft for Detail Collaterals.

Element Description

(Grid) Displays each dependency rule as a line-item with the following data:

l Dependency Group: the dependency group name entered for the
dependency rule

l Post Date: the effective date of the dependency rule

l Collateral Dependency: the dependency collateral name

l Dependency Rate: the dependency rate

New Click this button to add a new dependency rule. A blank Dependency Rule
screen opens to allow entry of a new rule.

View Select an existing dependency rule from the grid and click this button to view
and/or edit the rule on the Dependency Rule screen.

Remove Select an existing dependency rule from the grid and click this button to per-
manently delete the rule.
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Collateral Dependency Rules Dialog

This screen is used to select the dependency facility for a dependent collateral and establish the depend-
ency rate.

Field Description

Post Date Select the effective date of the dependency rule.

Current Collateral Displays the collateral name of the selected collateral. This is the dependent col-
lateral to which the dependency rule applies.

Dependency Group Select the dependency group for the dependency rule.

Dependency Select the dependency collateral whose current balance is used to calculate
the limit for the dependent collateral.

Dependency Rate (%) Enter the percentage of the dependency available balance used to calculate
the availability limit for the dependent collateral. Note that the percentage can
be greater than 100%.

Click this button to edit an existing dependency rule.

Click this button to save a dependency rule.

Click this button to undo unsaved changes to the dependency rule.

Click this button to open the Audit screen to view audit history for the depend-
ency rule.

Click this button to generate a preview of the Dependency Rule screen, which
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Field Description

can be printed or exported in a variety of formats.

Click this button to close the screen.
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Collateral Information - Documents Panel

The Document panel is used to attach and view collateral-related documents to the collateral. Note that
the grid displays each stored document by Description, Date, and File Name within document category.

Field Description

(Grid) Displays each attached document as a line-item with the following data:

l Description: The document description entered for the document on the
Attach Document to Collateral screen.

l Date: The FactorSoft processing date on which the document was
attached to the collateral.

l File name: The actual file name of the attached document.

New Click this button to attach a document to the facility. The Attach Document to
Collateral screen opens to allow selection of a document.

View Select an existing document from the grid and click this button to view and/or
edit the document attachment on the Attach Document to Collateral screen.

Remove Select an existing document from the grid and click this button to remove the
attached document from the collateral record. This does not delete the doc-
ument from its source directory.
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Attach Document to Collateral Dialog

Use the Attach Document screen to attach documents (such as word documents, spreadsheets, images,
etc.) to a collateral record. This screen is accessed from the Document panel of the Collateral Information
screen.

Field Description

Collateral Displays the collateral to which the document will be attached.

Description Enter a description for the document to assist in identifying it in the Document
panel grid.

Document Displays the directory, folder , and name information for the document to
attach to the collateral.

Displays a browser screen that you can use to navigate to the document to
attach to the collateral.

Click this button to edit an existing attachment.

Click this button to save an attachment.

Click this button to undo unsaved changes to the attachment.

Click this button to open the Audit screen to view audit history for the attach-
ment.

Click this button to generate a preview of the Attach Document to Collateral
screen, which can be printed or exported in a variety of formats.
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Field Description

Click this button to close the screen.
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Collateral Information - Seasonal Availability Panel

The Seasonal Availability feature allows you to add seasonal limitations that are placed on collateral lim-
its over a specified period of time. Seasonal limits are pre-set to anticipate business changes that typ-
ically occur at given times throughout the calendar year.

Field Description

(Grid) Displays each seasonal availability definition as a line-item with the fol-
lowing data:

l Descr: the seasonal variation description

l Amount: the dollar amount or percentage of the seasonal adjust-
ment

l Type: determines whether the amount is an amount or per-
centage

l Date range: displays the months and days of the time period for
the seasonal variation

New Click this button to create a seasonal availability definition. The
Seasonal Variation screen opens to allow entry of a new variation.

View Select an existing seasonal availability definition from the grid and click
this button to view and/or edit the variation on the Seasonal Variations
screen.

Remove Select an existing seasonal availability definition from the grid and click
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Field Description

this button to remove the event from the collateral record.
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Seasonal Variations Dialog

Use the Seasonal Availability screen to add seasonal limitation definitions that are placed on collateral
limits over a specified period of time. This screen is accessed from the Seasonal Variations panel of the
Collateral Information screen.

Field Description

Description Enter a description of the seasonal limitation.

Amount Enter the dollar amount or percentage of the seasonal adjustment. If the adjust-
ment is an increase, enter the figure unsigned. If the adjustment is a decrease,
enter the figure preceded by a minus sign.

Type Select the amount type for the adjustment:

l Amount: adjustment is a flat dollar amount

l Percent: adjustment is a percentage adjustment to availability

Start month Select the month in which the seasonal adjustment takes effect.

Day Select the day of the month on which the seasonal adjustment takes effect.

End month Select the month in which the seasonal adjustment expires.

Day Select the day of the month on which the seasonal adjustment expires.

Click this button to edit an existing seasonal variation definition.

Click this button to save a seasonal variation definition.
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Field Description

Click this button to undo unsaved changes to the seasonal variation definition.

Click this button to open the Audit screen to view audit history for the seasonal
variation definition.

Click this button to generate a preview of the Seasonal Variation screen, which
can be printed or exported in a variety of formats.

Click this button to close the screen.
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Collateral Types

This section provides a general description of each collateral type, and details the panels and dialogs
used to create and update the collaterals. There are three categories of collaterals, which may or may not
be available depending on the options configured in your implementation of FactorSoft.

A/R Collaterals

The following collateral types are available to implementations of FactorSoft with A/R Collaterals enabled:

l A/R Aging Collaterals

l Bulk A/R Collaterals

l Summary A/R Collaterals

l A/R Aging Collaterals

l Bulk A/R Collaterals

l Summary A/R Collaterals

Inventory Collaterals

The following collateral types are available to implementations of FactorSoft with A/R Collaterals enabled:

l Inventory Collaterals

l Bulk Inventory Collaterals

l Inventory Collaterals

l Bulk Inventory Collaterals

Supplemental Collaterals

The following collateral types are available to implementations of FactorSoft with Supplemental Col-
laterals enabled.
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l Equipment Collaterals

l Purchase Order Collaterals

l Real Estate Collaterals

l Securities Collaterals

l Other Collaterals
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AR Aging Collateral

A/R Aging collaterals allow you to manage an accounts receivable collaterals borrowing base. A/R Aging
is a summary aging method with the availability percentages applied to aging day periods. The collateral
is valued by declaration.

l A/R Aging value is configured by Category Rates

l A/R Aging categories are valued by Declaration

l The gross collateral value can be reduced by Ineligible Postings

Panel List

Click the link for help with the panels associated with this collateral type

l Summary

l Advanced Settings

l A/R Aging Category Rates

l A/R Aging Declaration

l Ineligible Posting

l Set Aside
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Collateral Information - Summary Panel

The Summary panel displays collateral balances. The Declaration balances display the collateral balance
fields as updated by collateral declarations in FactorSoft.

The Tracked column displays balances most recently imported from the Tracked AR or Loan Backed Col-
lateral modules. This column only appears if the Tracked AR or Loan Backed Collateral module is enabled
in your implementation of FactorSoft. Both previously posted and pending, to be posted figures are
provided.

Field Description

Current Collateral The gross reported collateral value.

Less Ineligibles The current total ineligible amount for the collateral.

Less Reserves The balance of cash reserve against the reported collateral value.

Less Set Asides The balance of ineligibility set asides defined for the collateral.

Eligible Collateral The gross reported collateral value less ineligibles, reserves, and set-
asides.

Advance Rate The Advance rate(%) defined for the collateral.

If multiple advance rates are in use for the collateral, this field displays
"***".

Net Collateral The eligible collateral value multiplied by the Advance Rate (%).

Collateral Limit The Availability Limit defined for the collateral.
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Field Description

Available Collateral The lower of the Net Collateral or the Available Limit. This amount will
always be either the Availability limit or the Net collateral.

Action Select the action to perform and click this button to execute the selected
function.

l Post Ineligibles open the appropriate ineligible posting transaction
screen for the A/R collateral type. The ineligible items are auto-
matically added to the ineligible posting screen

l Recalc Ineligibles update the displayed Tracked Aging data for the
most recent borrower submission.

This button is only active if either the Tracked AR or Loan Backed Col-
lateral Add On modules is implemented.

Aging Detail Click this button to open the Tracked Aging Detail screen, which displays
the detailed aging for the most recently submitted report.

This button is only active if the Tracked AR or Loan Backed Collateral Add
On module is implemented.

Recent Report Opens the Report History Details screen.

This button is only active if the Tracked AR or Loan Backed Collateral Add
On module is implemented.

Refresh Click this button to update the data displayed in the panel.

Print Click this button to generate a preview of the Summary panel that can
be printed to a local or network printer.
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Collateral Information - Advanced Settings Panel (Aging Col-
laterals)

Select the aging type for Summary A/R or A/R Aging collaterals.

Field Description

Aging type Select the aging type for the collateral.

l Bill date aging: age by invoice date

l Date of service aging: age by due date

Edit Click this button to edit the Aging Type setting.

Save Click this button to save the Aging Type setting.

Undo Click this button to undo unsaved changes to the Aging
Type setting.
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Collateral Information - A/R Aging Category Rates Panel

The Category Rates panel lists the categories created to manage A/R Aging collateral borrowing bases.
This panel is accessed from the panel list for an A/R Aging collateral from the Collateral Information
screen. The Category Rates panel allows you to establish unique valuation rates and limits for each aging
category.

Field Description

(Grid) Displays each category as a line-item with the following data:

l A/R Category: the category description

l A/R Age: the aging bucket for which the rates and limits are established

l NCV rate: the net collectible value rate

l Adv rate: the advance rate used for the collateral line-item

l Limit: the category limit

l Ineligible age: the age at which A/R collateral within this category
becomes ineligible

New Click this button to add a new line item to the collateral. The A/R Aging Cat-
egory Info screen opens to allow entry of a category.

View Select an existing line-item from the grid and click this button to view and/or
edit the line-item on the A/R Aging Category Info screen.

Remove Select an existing line-item from the grid and click this button to remove the cat-
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Field Description

egory from the collateral record.
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A/R Aging Category Info Dialog

The A/R Aging Category Info screen is used to establish category rates and limits for the aging buckets
that determine the valuation of the collateral. This screen is accessed from the A/R Aging Category panel
of the Collateral Information screen for an A/R Aging Collateral.

Field Description

Category Select the category for the A/R Aging collateral. Categories are established on
the A/R Aging Category Table.

Category Age Select the aging bucket for which the rates and limits are to be established.

l Bucket 0 (Unbilled): select to define an unbilled A/R bucket.

l Bucket 1 (1-30): select to define a bucket for A/R aged 1-30 days.

l Bucket 2 (31-60): select to define a bucket for A/R aged 31-60 days.

l Bucket 3 (61-90): select to define a bucket for A/R aged 61-90 days.

l Bucket 4 (91-120): select to define a bucket for A/R aged 91-120 days.

l Bucket 5 (121-150): select to define a bucket for A/R aged 121-150 days.

l Bucket 6 (over 150): select to define a bucket for A/R aged 151+ days.

Category limit Enter the maximum dollar amount for the aging bucket. This amount is used as
an upper limit of availability for A/R collateral in the aging category. Availability
for the category is the lesser of this amount or the calculated amount.

NCV rate Enter the percentage rate to be discounted from the total for the A/R category
to determine the Net Collectible Value. The NCV rate limits the collateral avail-
ability to a percentage of the category's overall total availability.
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Field Description

Advance rate Enter the percentage rate to be applied to the Net Collectible Value to determ-
ine the advance for the A/R category.

Ineligible age (days) Enter the number of days at which collateral of this type becomes ineligible.

Automatically add
the remaining Cat-
egory Rates using
these values

Select this option to automatically create all of the aging categories from the
first category defined. Any parameters (limits or rates) created for the first
aging category are duplicated in the remaining categories. You can use this
option to create all of the aging buckets, and then edit each bucket to the
desired parameters.

Click this button to edit a A/R Aging category definition.

Click this button to save a A/R category definition.

Click this button to undo unsaved changes to the A/R Aging category definition.

Click this button to open the Audit screen to view audit history for the A/R Aging
category definition.

Click this button to generate a preview of the A/R Aging category screen, which
can be printed or exported in a variety of formats.

Click this button to close the screen.
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Collateral Information - A/R Aging Declaration Panel

The A/R Declaration panel lists the A/R Aging collateral declarations, which are used to update the col-
lateral value of A/R Aging borrowing bases. This panel is accessed from the panel list for an A/R Aging col-
lateral from the Collateral Information screen. The Category Rates panel allows you to establish unique
valuation rates for each aging category.

Field Description

(Grid) Displays each A/R Aging declaration as a line-item with the following data:

l Decl Date: the declaration date, set on the A/R Aging Declaration screen

l Aging Date: the declaration aging date, set on the A/R Aging Declaration
screen

l Decl Type: the declaration type, Manual or Automatic

l Total Amount: the total A/R Aging value as of the declaration

l Ref No: the user-entered transaction identification number

New Click this button to add a declaration to the collateral. The A/R Aging Declar-
ation screen opens to allow entry of a declaration.

View Select an existing line-item from the grid and click this button to view and/or
edit the line-item on the A/R Aging Declaration screen.

Remove Select a declaration line-item and click this button to delete the declaration.
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A/R Aging Declaration Dialog

The A/R Declaration screen is used to set the dollar values for the aging buckets for an A/R Aging cat-
egory. This screen shows each defined Aging Category for the collateral. Each aging cell in the grid is a
data entry field, and you simply enter the dollar values for the aging category and then click the Save but-
ton. The A/R Declaration screen is accessed from the A/R Declaration panel of the Collateral Information
screen.

Field Description

Date The valuation date for the A/R declaration. This field contains the current Fact-
orSoft processing date by default. You can enter a different date directly in the
field, or select the date from a calendar by clicking the calendar icon in the
field.

Aging Date The aging date for the A/R declaration. This field contains the current FactorSoft
processing date by default. You can enter a different date directly in the field, or
select the date from a calendar by clicking the calendar icon in the field.

Ref # Enter a transaction identification number.

(Grid) The grid displays the Category name and all of the defined aging buckets. Each
aging bucket column is a data entry field in which you enter the dollar amount
of the A/R collateral for that aging category.

Aged ineligibles Once the declaration is saved, this field displays the dollar amount of A/R bal-
ances entered in the declaration that exceed limits of dollar or date, and are
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Field Description

therefore ineligible.

Total declared value Once the declaration is saved, this field displays the total declared value of the
A/R, including ineligible amounts.

Click this button to edit a A/R Aging declaration.

Click this button to save a A/R Aging declaration.

Click this button to open the Audit screen to view audit history for the A/R Aging
declaration.

Click this button to generate a preview of the A/R Aging Declaration screen,
which can be printed or exported in a variety of formats.

Click this button to close the screen.

Documents Click this button to open the Document List screen to attach supporting doc-
uments for the A/R Aging declaration.
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Collateral Information - Ineligible Posting Panel

The Ineligibles Posting panel lists ineligible postings for the collateral. Ineligibles are deducted from avail-
ability before the advance rate is applied. This panel is accessed from the panel list for an A/R Aging, Bulk
A/R, or Bulk Inventory collateral from the Collateral Information screen.

Field Description

(Grid) Displays each facility event as a line-item with the following data:

l Post Date: the posting date of the ineligible posting

l Ineligible amount: the dollar amount of the ineligible posting

l Ref No: the transaction identification number

l User Key: the FactorSoft user who created the posting

New Click this button to create an ineligible posting for the collateral. The Bulk Ine-
ligible Posting screen opens to allow entry of a new ineligible posting.

View Select an existing ineligible posting from the grid and click this button to view
and/or edit the posting on the Bulk Ineligible Posting screen.

Remove Select an existing ineligible posting from the grid and click this button to
remove the posting from the collateral record. This option is only available
within the posting day, and can be limited by Security Role.
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A/R Aging Ineligible Posting Screen

The Ineligible Posting screen is used to record ineligible postings that reduce the available value of the col-
lateral. This screen is accessed from the Ineligible Postings panel of the Collateral Information screen for
A/R Aging collateral.

Field Description

Date Select the effective date of the ineligible posting. This field is set to the current
FactorSoft working date by default.

Ref# Enter a transaction identification number.

(Grid) Displays the Ineligible Titles (i.e, categories) set up in Ineligible/Reservation Title
Table and the ineligible Amount for each category.

l Category: the A/R Aging category for which the ineligibility posting is
saved

l Reason: displays the ineligibility reason

l Amount: the ineligible amount for the category
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Field Description

Subtotal Displays the total amount of ineligibles for the collateral.

Set Asides Displays the total amount of any set-aside ineligibility for the collateral.

Total Ineligibles Displays the total collateral ineligibility amount, which is the Subtotal plus Set
Asides.

Click this button to add a new ineligible posting to the collateral. The Reason,
Category, and Amount fields are cleared for data entry.

Click this button to edit an ineligible posting.

Based on Security Role settings, this may be unavailable, available within pro-
cessing day, or available within month.

Select an ineligible entry from the grid and click this button to delete the
ineligible posting for the collateral.

Click this button to save an ineligible posting.

Click this button to undo unsaved changes to the ineligible posting.

Reason Select the ineligible reason for the posting. Ineligible reasons are set up in the
Ineligible/Reservation Title table.

Category Select the ineligibility category for the posting. Ineligibility categories are set up
in the A/R Aging Category Info screen, which is accessed from the Category
Rates panel of the Collateral Information screen of the Collateral Information
screen.

Amount Enter the ineligible amount for the posting.

To accommodate add-backs to gross ineligibles on AR Aging and AR Summary
collaterals, negative may be entered in the Amount field for these two col-
lateral types.

Documents Click this button to open the Document List screen to attach supporting doc-
uments for the ineligible posting.

Click this button to open the Audit screen to view audit history for the ineligible
posting.
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Field Description

Click this button to generate a preview of the Ineligible Posting screen, which
can be printed or exported in a variety of formats.

Click this button to close the screen.
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Collateral Information - Set Aside Panel

The Set Aside panel lists ineligibility set asides defined for the collateral, and is accessed from the Col-
lateral Information panel list for a A/R Aging, Bulk A/R, Bulk Inventory, or Summary A/R collaterals.

Field Description

(Grid) Displays each set aside as a line-item with the following data:

l Title: the set aside title

l Qualifier: qualifying text pertaining to the set aside

l Date: the set aside date

l Amount: the set aside amount

New Click this button to add a new set aside to the collateral. The Collateral Ine-
ligibility screen opens to allow entry of a new ineligibility set aside.

View Select an existing line-item from the grid and click this button to view and/or
edit the ineligibility set aside on the Collateral Ineligibility screen.

Delete Select an existing line-item from the grid and click this button to remove the set
aside from the collateral record.
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Collateral Ineligibility Dialog

The Collateral Ineligibility screen, accessed from the Set Aside panel, is used to add a new set aside
ineligibility amounts to A/R Aging, Bulk A/R, Bulk Inventory, or Summary A/R collaterals.

Field Description

Title Select the Ineligible Title that defines the ineligibility reason for the set aside. Ine-
ligible Titles are defined in the Ineligible/Reservation Titles table.

Qualifier Enter qualifying text pertaining to the set aside.

Effective Select the date on which the set aside ineligibility amount is deducted from
availability.

Amount Enter the ineligibility amount.

Notes Enter notes specific to the set aside in this field.

History This grid lists any previously saved set aside ineligibility for the collateral.

Save Click this button to save changes to the Collateral Ineligibility and close the
screen.

Cancel Click this button to close the screen without saving.
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Bulk AR Collaterals

Bulk A/R collaterals allow you to manage an accounts receivable collaterals borrowing base. When cre-
ating a new Bulk A/R collateral, you will typically work from a loan document and a facility set-up doc-
ument.

The Bulk A/R collateral type is a balance-forward method that rolls the collateral values forward based on
periodic certificate postings.

l Bulk A/R collaterals are established and updated in FactorSoft by Certificate Postings.

l The gross collateral value can be reduced by Ineligible Postings

l Bulk A/R availability can be increased by Reserve Release to release cash reserves

Panel List

Click the link for help with the panels associated with this collateral type

l Summary

l Certificate Posting

l Ineligible Posting

l Set Aside

l Reserve Release
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Collateral Information - Summary Panel

The Summary panel displays collateral balances. The Declaration balances display the collateral balance
fields as updated by collateral declarations in FactorSoft.

The Tracked column displays balances most recently imported from the Tracked AR or Loan Backed Col-
lateral modules. This column only appears if the Tracked AR or Loan Backed Collateral module is enabled
in your implementation of FactorSoft. Both previously posted and pending, to be posted figures are
provided.

Field Description

Current Collateral The gross reported collateral value.

Less Ineligibles The current total ineligible amount for the collateral.

Less Reserves The balance of cash reserve against the reported collateral value.

Less Set Asides The balance of ineligibility set asides defined for the collateral.

Eligible Collateral The gross reported collateral value less ineligibles, reserves, and set-
asides.

Advance Rate The Advance rate(%) defined for the collateral.

If multiple advance rates are in use for the collateral, this field displays
"***".

Net Collateral The eligible collateral value multiplied by the Advance Rate (%).

Collateral Limit The Availability Limit defined for the collateral.
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Field Description

Available Collateral The lower of the Net Collateral or the Available Limit. This amount will
always be either the Availability limit or the Net collateral.

Action Select the action to perform and click this button to execute the selected
function.

l Post Ineligibles open the appropriate ineligible posting transaction
screen for the A/R collateral type. The ineligible items are auto-
matically added to the ineligible posting screen

l Recalc Ineligibles update the displayed Tracked Aging data for the
most recent borrower submission.

This button is only active if either the Tracked AR or Loan Backed Col-
lateral Add On modules is implemented.

Aging Detail Click this button to open the Tracked Aging Detail screen, which displays
the detailed aging for the most recently submitted report.

This button is only active if the Tracked AR or Loan Backed Collateral Add
On module is implemented.

Recent Report Opens the Report History Details screen.

This button is only active if the Tracked AR or Loan Backed Collateral Add
On module is implemented.

Refresh Click this button to update the data displayed in the panel.

Print Click this button to generate a preview of the Summary panel that can
be printed to a local or network printer.
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Collateral Information - Certificate Posting Panel

The Certificate Posting panel lists Borrowing Certificates, which are the information used to update Bulk
A/R or Bulk Inventory collateral values. This panel is accessed from the panel list for a Bulk A/R or Bulk
Inventory collateral from the Collateral Information screen.

Field Description

(Grid) Displays each certificate posting as a line-item with the following data:

l Post Date: the posting date of the certificate

l Beginning collateral: the gross receivable balance prior to the certificate
posting

l Current collateral: the gross receivable balance after the certificate post-
ing

l Eligible collateral: the current collateral less ineligibles and reserves - i.e.,
available collateral

l Source: indicates the source of the certificate posting - Manual, Web,
~~Shadow (Tracked AR)

l User: the FactorSoft user who created the posting

l Ref No: the transaction identification number

New Click this button to create a certificate posting for the collateral. The Certificate
screen opens to allow entry of a new certificate posting.

Bulk Collaterals User Guide
Collateral Information - Certificate Posting Panel

275 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

View Select an existing certificate posting from the grid and click this button to view
and/or edit the posting on the Certificate screen.

Remove Select an existing certificate posting from the grid and click this button to
remove the posting from the collateral record. This option is only available
within the posting day, and can be limited by Security Role.
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Certificate Dialog

The Certificate screen is used to record a new borrowing certificate for the collateral. This screen is
accessed from the Certificate Posting panel of the Collateral Information screen.

Field Description

Date Posted Select the effective date of the certificate posting. This field is set to the current
FactorSoft working date by default.

Beginning collateral Displays the current gross receivable balance prior to the certificate posting.

Sales Enter the current reported sales amount (increases collateral value).

Credit Enter the current reported credits (reduces collateral value).

Adjustments (+) Enter the amount of adjustments that increase the collateral value.

Adjustments (-) Enter the amount of adjustments that decrease the collateral value.
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Field Description

Discount Enter the amount of discounts (reduces collateral value).

Net Collections Enter the amount of A/R collections (reduces collateral value).

Over payment Enter the over payment amount received. (increases collateral value).

Note –when entered as a negative amount it will decrease collateral value.

Current collateral Displays the total receivable balance adjusted by the recorded certificate val-
ues.

Ineligible Displays the calculated ineligible balance for the collateral.

Reserve Displays the cash reserves balance for the collateral.

Eligible collateral Displays the calculated eligible collateral after the certificate posting, which is
the Current Collateral less ineligibles and reserves.

Comment Enter certificate-related notes. This is a free-form field.

Click this button to edit a certificate posting.

Based on Security Role settings, this may be unavailable, available within pro-
cessing day, or available within month.

Click this button to save a certificate

Click this button to undo unsaved changes to the certificate.

Click this button to open the Audit screen to view audit history for the certificate.

Click this button to generate a preview of the Certificate screen, which can be
printed or exported in a variety of formats.

Click this button to close the screen.
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Collateral Information - Ineligible Posting Panel

The Ineligibles Posting panel lists ineligible postings for the collateral. Ineligibles are deducted from avail-
ability before the advance rate is applied. This panel is accessed from the panel list for an A/R Aging, Bulk
A/R, or Bulk Inventory collateral from the Collateral Information screen.

Field Description

(Grid) Displays each facility event as a line-item with the following data:

l Post Date: the posting date of the ineligible posting

l Ineligible amount: the dollar amount of the ineligible posting

l Ref No: the transaction identification number

l User Key: the FactorSoft user who created the posting

New Click this button to create an ineligible posting for the collateral. The Bulk Ine-
ligible Posting screen opens to allow entry of a new ineligible posting.

View Select an existing ineligible posting from the grid and click this button to view
and/or edit the posting on the Bulk Ineligible Posting screen.

Remove Select an existing ineligible posting from the grid and click this button to
remove the posting from the collateral record. This option is only available
within the posting day, and can be limited by Security Role.
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Bulk Ineligible Posting

The Bulk Ineligible screen is used to record ineligible postings that reduce the available value of the col-
lateral. This screen is accessed from the Ineligible Postings panel of the Collateral Information screen.

Field Description

Date Posted Select the effective date of the ineligible posting. This field is set to the current
FactorSoft working date by default.

Ref# Enter a transaction identification number.

Comment Enter ineligibles-related notes. This is a free-form field.

(Grid) Displays the Ineligible Titles (i.e, categories) set up in Ineligible/Reservation Title
Table and the ineligible Amount for each category.

To add ineligible reductions, enter the new ineligible amount for the category in
the Amount column.
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Field Description

Click this button to edit an ineligible posting.

Based on Security Role settings, this may be unavailable, available within pro-
cessing day, or available within month.

Click this button to save a ineligible posting.

Subtotal Displays the total amount of ineligibles for the collateral.

Set Asides Displays the total amount of any set-aside ineligibility for the collateral.

Total Ineligibles Displays the total collateral ineligibility amount, which is the Subtotal plus Set
Asides.

Documents Click this button to open the Document List screen, which is used to attach doc-
ument and image files for the posting.

Click this button to undo unsaved changes to the ineligible posting.

Click this button to open the Audit screen to view audit history for the ineligible
posting.

Click this button to generate a preview of the Bulk Ineligible Posting screen,
which can be printed or exported in a variety of formats.

Click this button to close the screen.
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Collateral Information - Set Aside Panel

The Set Aside panel lists ineligibility set asides defined for the collateral, and is accessed from the Col-
lateral Information panel list for a A/R Aging, Bulk A/R, Bulk Inventory, or Summary A/R collaterals.

Field Description

(Grid) Displays each set aside as a line-item with the following data:

l Title: the set aside title

l Qualifier: qualifying text pertaining to the set aside

l Date: the set aside date

l Amount: the set aside amount

New Click this button to add a new set aside to the collateral. The Collateral Ine-
ligibility screen opens to allow entry of a new ineligibility set aside.

View Select an existing line-item from the grid and click this button to view and/or
edit the ineligibility set aside on the Collateral Ineligibility screen.

Delete Select an existing line-item from the grid and click this button to remove the set
aside from the collateral record.
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Collateral Ineligibility Dialog

The Collateral Ineligibility screen, accessed from the Set Aside panel, is used to add a new set aside
ineligibility amounts to A/R Aging, Bulk A/R, Bulk Inventory, or Summary A/R collaterals.

Field Description

Title Select the Ineligible Title that defines the ineligibility reason for the set aside. Ine-
ligible Titles are defined in the Ineligible/Reservation Titles table.

Qualifier Enter qualifying text pertaining to the set aside.

Effective Select the date on which the set aside ineligibility amount is deducted from
availability.

Amount Enter the ineligibility amount.

Notes Enter notes specific to the set aside in this field.

History This grid lists any previously saved set aside ineligibility for the collateral.

Save Click this button to save changes to the Collateral Ineligibility and close the
screen.

Cancel Click this button to close the screen without saving.
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Collateral Information - Reserve Release Panel

The Reserve Release panel lists releases of set-aside reserve to the collateral. This panel is accessed from
the panel list for Bulk A/R collaterals from the Collateral Information screen. Reserves are deducted from
availability after the advance rate has been applied. Release of reserves reduces the cash reserve bal-
ance and increases the available collateral amount.

Field Description

(Grid) Displays each facility event as a line-item with the following data:

l Post Date: the transaction date of the reserve release

l Effective Date: The collateral posting date from Facility Payments that
were applied against reserves on the Payment transaction screen (Effect
on A/R is set to Reserve from availability).

l Ref#: the user-entered transaction identification number

l Type: Deposit = reserves deducted from certificate posting, Release =
reserves released to the collateral.

l Amount: the posted transaction amount

l Balance: the reserve balance

New Click this button to create a reserve release to the collateral. The Payment
Reserve Release screen opens to allow entry of a new reserve release.

View Select an existing reserve release line-item from the grid and click this button to
view the release on the Payment Reserve Release screen.
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Reserve Release Dialog

The Payment Reserve Release screen is used to record reserve releases that increase the available value
of the collateral. This screen is accessed from the Reserve Release panel of the Collateral Information
screen.

Field Description

Ref# Enter a transaction identification number.

Date Select the effective date of the reserve release. This field is set to the current
FactorSoft working date by default.

Amount Enter the dollar amount of the reserve release transaction.

Current balance Displays the system-calculated reserve balance.

Projected balance Displays the reserve balance with the transaction amount applied.

Not available for this transaction.

Click this button to save a reserve release.

Not available for this transaction.

Click this button to open the Audit screen to view audit history for the reserve
release.

Click this button to generate a preview of the Payment Reserve Release screen,
which can be printed or exported in a variety of formats.

Click this button to close the screen.
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Summary A/R Collateral

Summary A/R collateral manages a collateral borrowing base of your own description. A System Prefer-
ence allows the screens and fields formerly labeled “Medical Receivables” to be labeled with words of
your choice. Set System Preference Facility/Collateral Rules (Formerly Asset Based Lending), Ter-
minology, Summary AR Collateral Type Name to the desired name for the collateral. The default name
for these screens and fields is “Summary A/R”.

l Summary A/R pricing structure is configured by Category Rates

l Summary A/R categories are valued by Declaration

l The gross collateral value can be reduced by Ineligible Postings

Panel List

Click the link for help with the panels associated with this collateral type

l Summary

l Advanced Settings

l Summary A/R Category Rates

l Summary A/R Declaration

l Summary A/R Ineligible Posting

l Set Aside
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Collateral Information - Summary Panel

The Summary panel displays collateral balances. The Declaration balances display the collateral balance
fields as updated by collateral declarations in FactorSoft.

The Tracked column displays balances most recently imported from the Tracked AR or Loan Backed Col-
lateral modules. This column only appears if the Tracked AR or Loan Backed Collateral module is enabled
in your implementation of FactorSoft. Both previously posted and pending, to be posted figures are
provided.

Field Description

Current Collateral The gross reported collateral value.

Less Ineligibles The current total ineligible amount for the collateral.

Less Reserves The balance of cash reserve against the reported collateral value.

Less Set Asides The balance of ineligibility set asides defined for the collateral.

Eligible Collateral The gross reported collateral value less ineligibles, reserves, and set-
asides.

Advance Rate The Advance rate(%) defined for the collateral.

If multiple advance rates are in use for the collateral, this field displays
"***".

Net Collateral The eligible collateral value multiplied by the Advance Rate (%).

Collateral Limit The Availability Limit defined for the collateral.
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Field Description

Available Collateral The lower of the Net Collateral or the Available Limit. This amount will
always be either the Availability limit or the Net collateral.

Action Select the action to perform and click this button to execute the selected
function.

l Post Ineligibles open the appropriate ineligible posting transaction
screen for the A/R collateral type. The ineligible items are auto-
matically added to the ineligible posting screen

l Recalc Ineligibles update the displayed Tracked Aging data for the
most recent borrower submission.

This button is only active if either the Tracked AR or Loan Backed Col-
lateral Add On modules is implemented.

Aging Detail Click this button to open the Tracked Aging Detail screen, which displays
the detailed aging for the most recently submitted report.

This button is only active if the Tracked AR or Loan Backed Collateral Add
On module is implemented.

Recent Report Opens the Report History Details screen.

This button is only active if the Tracked AR or Loan Backed Collateral Add
On module is implemented.

Refresh Click this button to update the data displayed in the panel.

Print Click this button to generate a preview of the Summary panel that can
be printed to a local or network printer.
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Collateral Information - Advanced Settings Panel (Aging Col-
laterals)

Select the aging type for Summary A/R or A/R Aging collaterals.

Field Description

Aging type Select the aging type for the collateral.

l Bill date aging: age by invoice date

l Date of service aging: age by due date

Edit Click this button to edit the Aging Type setting.

Save Click this button to save the Aging Type setting.

Undo Click this button to undo unsaved changes to the Aging
Type setting.
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Collateral Information - Summary A/R Category Rates Panel

The Category Rates panel lists the categories created to manage Summary A/R collateral borrowing
bases. This panel is accessed from the panel list for an Summary A/R collateral from the Collateral Inform-
ation screen. The Category Rates panel allows you to establish unique valuation rates for specific classes,
such as third-party payers accepted by the client.

Field Description

(Grid) Displays each category as a line-item with the following data:

l A/R Category: the category description

l NCV rate: the net collectible value rate

l Adv rate: the advance rate used for the collateral line-item

l Limit: the category limit

l Ineligible age: the age at which A/R collateral within this category
becomes ineligible

New Click this button to add a new line item to the collateral. The Summary A/R Cat-
egory Info screen opens to allow entry of a category.

View Select an existing line-item from the grid and click this button to view and/or
edit the line-item on the Summary A/R Category Info screen.

Remove Select an existing line-item from the grid and click this button to remove the cat-
egory from the collateral record.
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Summary AR Category Info Dialog

The Summary A/R Category Rates screen is used to select Summary A/R categories for the collateral and
establish category rates and limits for the collateral. This screen is accessed from the Category Rates
panel of the Collateral Information screen for a Summary A/R collateral.

Field Description

Category Select the category for the Summary A/R collateral. Categories are established
on the Summary A/R Category Table.

Category Limit Enter the dollar amount of the availability limit for the category.

NCV rate Enter the Net Collectable Value rate, which limits the collateral availability to a
percentage of the category's overall total availability.

Advance rate Enter the basic availability advance rate applied to the net collateral value.

Ineligible age (days) Enter the number of days at which collateral of this type becomes ineligible.

Click this button to edit a Summary A/R category definition.

Click this button to save a Summary A/R category definition.

Click this button to undo unsaved changes to the Summary A/R category defin-
ition.

Click this button to open the Audit screen to view audit history for the Summary
A/R category definition.

Click this button to generate a preview of the Summary A/R Category screen,
which can be printed or exported in a variety of formats.

Click this button to close the screen.
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Collateral Information - Summary A/R Declaration Panel

The Summary A/R Declaration panel lists the Summary A/R collateral declarations, which are used to
update the collateral value of Summary A/R borrowing bases. This panel is accessed from the panel list
for an Summary A/R collateral from the Collateral Information screen. The Category Rates panel allows
you to establish unique valuation rates for specific classes, such as third-party payers accepted by the cli-
ent.

Field Description

(Grid) Displays each Summary A/R declaration as a line-item with the following data:

l Date: the declaration date

l Amount: the total Summary A/R value as of the declaration

l Ref No: the user-entered transaction identification number

New Click this button to add a declaration to the collateral. The Summary A/R Declar-
ation screen opens to allow entry of a declaration.

View Select an existing line-item from the grid and click this button to view and/or
edit the line-item on the Summary A/R Declaration screen.

Remove Not available for Summary A/R declaration.
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Summary A/R Declaration Dialog

The Summary A/R Declaration screen is used to record Summary A/R declarations that create and
update the available value of the collateral. This screen is accessed from the Summary A/R Declaration
panel of the Collateral Information screen for a Summary A/R collateral.

Field Description

Declaration Date Select the effective date of the Summary A/R Aging declaration. This field is set
to the current FactorSoft working date by default.

Ref# Enter a transaction identification number.

(Category Grid) Displays the Inventory Categories set up in Inventory Category Table and the fol-
lowing data for each category.

l Unbilled: enter the total amount of unbilled receivables for declaration

l (Aging Days Categories): enter the total amount of billed receivables
within each aging days category

l Total: calculated total amount of receivables entered in the category

To add a Summary A/R declaration, enter the new declaration amounts for
each category in the Unbilled and aging days columns.

Aged Ineligibles Displays the total amount of billed receivables that are older than the Ineligible
age defined on the Summary A/R Category Info screen for the categories.
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Field Description

Total declared value The total declared value of the Summary A/R collateral.

Click this button to edit an inventory declaration.

Based on Security Role settings, this may be unavailable, available within pro-
cessing day, or available within month.

Click this button to save a Summary A/R declaration.

Click this button to undo unsaved changes to the Summary A/R declaration.

Click this button to open the Audit screen to view audit history for the Summary
A/R declaration.

Click this button to generate a preview of the Summary A/R Declaration screen,
which can be printed or exported in a variety of formats.

Click this button to close the screen.

Documents Click this button to open the Document List screen to attach supporting doc-
uments for the Summary A/R declaration.
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Collateral Information - Summary A/R Ineligible Panel

The Ineligibles Posting panel lists ineligible postings for the collateral. Ineligibles are deducted from avail-
ability before the advance rate is applied. This panel is accessed from the panel list for a Summary A/R
collateral from the Collateral Information screen.

Field Description

(Grid) Displays each ineligible posting as a line-item with the following data:

l Date: the posting date of the ineligible posting

l Amount: the dollar amount of the ineligible posting

l Ref No: the user-entered transaction identification number

New Click this button to create an ineligible posting for the collateral. The Ineligible
Posting screen opens to allow entry of a new ineligible posting.

View Select an existing ineligible posting from the grid and click this button to view
and/or edit the posting on the Ineligible Posting screen.

Remove Select an existing ineligible posting from the grid and click this button to
remove the posting from the collateral record. This option is only available
within the posting day, and can be limited by Security Role.
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Summary A/R Ineligible Posting Dialog

The Ineligible Posting screen is used to record ineligible postings that reduce the available value of the col-
lateral. This screen is accessed from the Ineligible Postings panel of the Collateral Information screen for
Summary A/R collateral.

Field Description

Date Select the effective date of the ineligible posting. This field is set to the current
FactorSoft working date by default.

Ref# Enter a transaction identification number.

(Grid) Displays the Ineligible Titles (i.e, categories) set up in Ineligible/Reservation Title
Table and the ineligible Amount for each category.

l Category: the Summary A/R category for which the ineligibility posting is
saved

l Reason: displays the ineligibility reason for the posting

l Amount: the ineligible amount for the category
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Field Description

Subtotal Displays the total amount of ineligibles for the collateral.

Set Asides Displays the total amount of any set-aside ineligibility for the collateral.

Total Ineligibles Displays the total collateral ineligibility amount, which is the Subtotal plus Set
Asides.

Click this button to add a new ineligible posting to the collateral. The Reason,
Category, and Amount fields are cleared for data entry.

Click this button to edit an ineligible posting.

Based on Security Role settings, this may be unavailable, available within pro-
cessing day, or available within month.

Select an ineligible entry from the grid and click this button to delete the
ineligible posting for the collateral.

Click this button to save an ineligible posting.

Click this button to undo unsaved changes to the ineligible posting.

Reason Select the ineligible reason for the posting. Ineligible reasons are set up in the
Ineligible/Reservation Title table.

Category Select the ineligibility category for the posting. Ineligibility categories are set up
in the Summary A/R Category Info screen, which is accessed from the Category
Rates panel of the Collateral Information screen of the Collateral Information
screen.

Amount Enter the ineligible amount for the posting.

Documents Click this button to open the Document List screen to attach supporting doc-
uments for the ineligible posting.

Click this button to open the Audit screen to view audit history for the ineligible
posting.

Click this button to generate a preview of the Ineligible Posting screen, which
can be printed or exported in a variety of formats.

Click this button to close the screen.
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Collateral Information - Set Aside Panel

The Set Aside panel lists ineligibility set asides defined for the collateral, and is accessed from the Col-
lateral Information panel list for a A/R Aging, Bulk A/R, Bulk Inventory, or Summary A/R collaterals.

Field Description

(Grid) Displays each set aside as a line-item with the following data:

l Title: the set aside title

l Qualifier: qualifying text pertaining to the set aside

l Date: the set aside date

l Amount: the set aside amount

New Click this button to add a new set aside to the collateral. The Collateral Ine-
ligibility screen opens to allow entry of a new ineligibility set aside.

View Select an existing line-item from the grid and click this button to view and/or
edit the ineligibility set aside on the Collateral Ineligibility screen.

Delete Select an existing line-item from the grid and click this button to remove the set
aside from the collateral record.
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Collateral Ineligibility Dialog

The Collateral Ineligibility screen, accessed from the Set Aside panel, is used to add a new set aside
ineligibility amounts to A/R Aging, Bulk A/R, Bulk Inventory, or Summary A/R collaterals.

Field Description

Title Select the Ineligible Title that defines the ineligibility reason for the set aside. Ine-
ligible Titles are defined in the Ineligible/Reservation Titles table.

Qualifier Enter qualifying text pertaining to the set aside.

Effective Select the date on which the set aside ineligibility amount is deducted from
availability.

Amount Enter the ineligibility amount.

Notes Enter notes specific to the set aside in this field.

History This grid lists any previously saved set aside ineligibility for the collateral.

Save Click this button to save changes to the Collateral Ineligibility and close the
screen.

Cancel Click this button to close the screen without saving.
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Equipment Collateral

Equipment collaterals are used to manage equipment borrowing bases. Each equipment type is indi-
vidually valued by declaration and configured with its own depreciation calculation.

Panel List

Click the link for help with the panels associated with this collateral type

l Equipment list
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Collateral Information - Equipment List Panel

The Equipment List panel lists equipment being managed as collateral for the borrowing base. This panel
is accessed from the panel list for an Equipment collateral from the Collateral Information screen.

Field Description

(Grid) Displays each equipment collateral as a line-item with the following data:

l Description: the description of the equipment

l Acquired: the date the equipment was acquired

l Basis value: the original value of the equipment

l Depr amt: the depreciation value, which is either an amount or per-
centage applied for a specified period

l Current value: the depreciated current value of the equipment

New Click this button to add a new equipment item to the collateral. The Equipment
Declaration screen opens to allow entry of a new equipment collateral.

View Select an existing line-item from the grid and click this button to view and/or
edit the equipment collateral on the Equipment Declaration screen.

Remove Select an existing line-item from the grid and click this button to remove the
equipment from the collateral record.
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Equipment Declaration Dialog

The Equipment Declaration screen is used to record equipment items being managed as collateral for the
borrowing base. This screen is accessed from the Equipment List panel of the Collateral Information
screen.

Field Description

Post Date Select the effective date of the equipment declaration posting.

Description Enter a description of the equipment item.

Manufacturer Enter the brand name of the manufacturer of the equipment.

Availability con-
tribution

Calculated current book value of the item (cost basis less all depreciation taken to
date).

Basis Enter the basis value details for the equipment:

l Date: the date for the current borrowing base

l Value: the value for the current borrowing base

Acquisition Enter the acquisition details for the equipment:

l Date: the date on which the equipment was acquired

l Cost: the original cost of the equipment

Depreciation Enter the depreciation details for the equipment:
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Field Description

l Type: Flat/Interval = reduce value by a fixed dollar amount at the given interval,
Percentage of Basis = reduce value by the given percentage

l Rate/Amount: the dollar amount or percentage by which to reduce the value of
the equipment

l Interval: Monthly = apply depreciation monthly, Annual = apply depreciation
yearly.

Comment Enter equipment-related notes. This is a free-form field.

Click this button to edit an equipment declaration.

Click this button to save an equipment declaration.

Click this button to undo unsaved changes to the equipment declaration.

Click this button to open the Audit screen to view audit history for the equipment
declaration.

Click this button to generate a preview of the Equipment Declaration screen, which
can be printed or exported in a variety of formats.

Click this button to close the screen.
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Inventory Collateral

Inventory collaterals are used to manage inventory borrowing bases. Each inventory type is individually
valued by declaration and configured with its own limits and advance rate, including primary and sec-
ondary valuation methods, reserve for liquidation costs, fluctuating seasonal date ranges and limits.

l Inventory pricing is configured by Category Rates

l Inventory categories are valued by Declaration

Panel List

Click the link for help with the panels associated with this collateral type

l Summary

l Advanced Settings

l Category Rates

l Inventory Declaration
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Collateral Information - Summary Panel

The Summary panel displays collateral balances. The Declaration balances display the collateral balance
fields as updated by collateral declarations in FactorSoft.

The Tracked column displays balances most recently imported from the Tracked AR or Loan Backed Col-
lateral modules. This column only appears if the Tracked AR or Loan Backed Collateral module is enabled
in your implementation of FactorSoft. Both previously posted and pending, to be posted figures are
provided.

Field Description

Current Collateral The gross reported collateral value.

Less Ineligibles The current total ineligible amount for the collateral.

Less Reserves The balance of cash reserve against the reported collateral value.

Less Set Asides The balance of ineligibility set asides defined for the collateral.

Eligible Collateral The gross reported collateral value less ineligibles, reserves, and set-
asides.

Advance Rate The Advance rate(%) defined for the collateral.

If multiple advance rates are in use for the collateral, this field displays
"***".

Net Collateral The eligible collateral value multiplied by the Advance Rate (%).

Collateral Limit The Availability Limit defined for the collateral.
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Field Description

Available Collateral The lower of the Net Collateral or the Available Limit. This amount will
always be either the Availability limit or the Net collateral.

Action Select the action to perform and click this button to execute the selected
function.

l Post Ineligibles open the appropriate ineligible posting transaction
screen for the A/R collateral type. The ineligible items are auto-
matically added to the ineligible posting screen

l Recalc Ineligibles update the displayed Tracked Aging data for the
most recent borrower submission.

This button is only active if either the Tracked AR or Loan Backed Col-
lateral Add On modules is implemented.

Aging Detail Click this button to open the Tracked Aging Detail screen, which displays
the detailed aging for the most recently submitted report.

This button is only active if the Tracked AR or Loan Backed Collateral Add
On module is implemented.

Recent Report Opens the Report History Details screen.

This button is only active if the Tracked AR or Loan Backed Collateral Add
On module is implemented.

Refresh Click this button to update the data displayed in the panel.

Print Click this button to generate a preview of the Summary panel that can
be printed to a local or network printer.
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Collateral Information - Category Rates Panel

The Category Rates panel lists the categories created to manage Inventory collateral borrowing bases.
This panel is accessed from the panel list for an Inventory collateral from the Collateral Information
screen.

Field Description

(Grid) Displays each category as a line-item with the following data:

l Category: the category description

l Alt rate: the market advance rate used with the Alternate Valuation
Method for the collateral line-item

l Max advance: the maximum advance rate for the collateral line-item

l Date Range: the date range limitations that are placed on the inventory
rates

l Adv rate: the advance rate used with the Cost Valuation Method for the
collateral line-item

l Liq rate: the liquidation expense rate for the collateral line-item

l AVM rate: the market multiplier value used with the Alternate Valuation
Method for the collateral line-item

New Click this button to add a new line item to the collateral. The Inventory Rates
screen opens to allow entry of a category.
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Field Description

View Select an existing line-item from the grid and click this button to view and/or
edit the line-item on the Inventory Rates screen.

Remove Select an existing line-item from the grid and click this button to remove the cat-
egory from the collateral record.
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Inventory Rates Dialog

The Inventory Rates screen is used to select inventory categories for the collateral and establish the limits
and valuation rates for each category. This screen is accessed from the Category Rates panel of the Col-
lateral Information screen for an Inventory collateral.

Field Description

Category Select the category for the inventory collateral. Categories are established on
the Inventory Category Table.

Subcategory Enter an additional category description for the inventory collateral to dis-
tinguish this inventory from others of the same category.

Max advance amount Enter the availability limit for the category.

Liquidation expense
rate

Enter the rate at which the reported value will be further discounted to account
for anticipated dilution as a result of expenses incurred during the liquidation of
the asset. The field displays the setting in the Default Inventory Rate section on
the Collateral Information screen by default.

Cost valuation
method

In the Advance rate field, enter the rate used for traditional cost method of valu-
ation. The advance rate is the rate at which the reported cost valued is to be dis-
counted. The field displays the setting in the Default Inventory Rate section of
the Collateral Information screen by default.

If the user changes an existing Advance rate, an informational message is dis-
played when the user clicks the Save button. The message informs the user that
they must post an Inventory Declaration transaction in order for the new rate to
be effective.
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Field Description

Alternate Valuation
Method (AVM)

Enter the alternate valuation factor and rate to be revised to market conditions.

l Market multiplier: set the discount for gross inventory. Collateral Balance
times Market Multipliers = Gross AVM

l Market advance rate: the rate at which the reported cost value adjusted
for market is to be discounted

Date Range Enter the date range limitations that are placed on the inventory rates over a
specified period of time:

l Start month: select the month in which the inventory rates takes effect.

l Day: select the day of the month on which the rates takes effect.

l End month: select the month in which the inventory rates expire.

l Day: select the day of the month on which the rates expire.

Click this button to edit an inventory rates definition.

Click this button to save an inventory rates definition.

Click this button to undo unsaved changes to the inventory rates definition.

Click this button to open the Audit screen to view audit history for the inventory
rates definitions.

Click this button to generate a preview of the Inventory Rates for Inventory
screen, which can be printed or exported in a variety of formats.

Click this button to close the screen.
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Collateral Information - Advanced Setting Panel (Inventory)

The Valuation Methods are used to specify the method for valuing inventory collaterals. The Default Cat-
egory Rates are used to set the default rates for inventory declarations.

Field Description

Apply liquidation to Select the calculation to use for liquidation valuation.

l Cost (reported value)

l Market (alternate value)

l Both cost and market value

Apply ineligibles to Select which of the valuation methods to apply to ineligibles.

l Cost (reported value)

l Market (alternate value)

l Both cost and market value

Value availability as Select method will be used to determine inventory availability.

l Cost (reported value)

l Market (alternate value)

l Lesser of cost or market

Advance rate (%) Enter the default inventory category rate at which the reported value is to be dis-
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Field Description

counted.

Liquidation rate (%) Enter the default inventory category rate at which the reported value will be fur-
ther discounted to account for anticipated dilution as a result of expenses
occurred during the liquidation of the asset.

Edit Click this button to edit the Advanced settings.

Save Click this button to save the Advanced settings.

Undo Click this button to undo unsaved changes to the Advanced settings.
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Collateral Information - Inventory Declaration Panel

The Inventory Declaration panel lists inventory by category and includes columns that summarize the for-
mula calculation.

Field Description

(Grid) Displays each inventory declaration as a line-item with the following data:

l Date: the declaration date

l Amount: the total inventory value as of the declaration

l Available: the available amount of the inventory as of the declaration

l Ref No: the user-entered transaction identification number

l User Key: the FactorSoft user who created the posting

l Source: indicates the source of the inventory declaration - Manual, Web

New Click this button to add a new inventory declaration to the collateral. The Invent-
ory Declaration screen opens to allow entry of a category.

View Select an existing line-item from the grid and click this button to view the line-
item on the Inventory Declaration screen.

Remove Select an existing line-item from the grid and click this button to remove the
declaration from the collateral record.
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Inventory Declaration Dialog

The Inventory Declaration screen is used to record inventory declarations that create and update the
available value of the collateral. This screen is accessed from the Inventory Declaration panel of the Col-
lateral Information screen for an inventory collateral.

Field Description

Declaration Date Select the effective date of the inventory declaration. This field is set to the cur-
rent FactorSoft working date by default.

Ref# Enter a transaction identification number.

Comment Enter ineligibles-related notes. This is a free-form field.

(Category Grid) Displays the Inventory Categories set up in Inventory Category Table with the fol-
lowing data for each category.
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Field Description

l Category: the inventory category name

l Inventory: the total value of the inventory category for this collateral

l Liq Cost: the liquidation cost of the category for this collateral

l Inv Avail: the total value minus liquidation cost

l Gross AVM: collateral balance adjusted by Alternate Valuation Method
calculation set on the Inventory Category Rates screen for the category

l Available: the category available amount for the collateral

To add an inventory declaration, enter the new inventory amount for the cat-
egory in the Inventory column.

(Ineligible Grid) Displays existing ineligibility amounts declared for inventory categories and
allows entry of new ineligibility amounts within the inventory declaration for the
collateral. Clicking in an empty row activates the row for data entry.

l Ineligibility Category: select the inventory category to which the ineligib-
ility applies.

l Reason: enter an ineligibility reason

l Ineligible amount: enter the ineligible amount

Click this button to edit an inventory declaration.

Based on Security Role settings, this may be unavailable, available within pro-
cessing day, or available within month.

Click this button to save an inventory declaration.

Click this button to undo unsaved changes to the inventory declaration.

Click this button to open the Audit screen to view audit history for the inventory
declaration.

Click this button to generate a preview of the Inventory Declaration screen,
which can be printed or exported in a variety of formats.
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Field Description

Click this button to close the screen.

Documents Click this button to open the Document List screen to attach supporting doc-
uments for the inventory declaration.
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Purchase Order Collateral

Purchase order collaterals are used to manage purchase order borrowing bases. Each purchase order is
individually valued by declaration.

Panel List

Click the link for help with the panels associated with this collateral type

l Purchase orders
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Collateral Information - Purchase Order Panel

The Purchase Order panel lists current, active purchase orders being managed as collateral for the bor-
rowing base. This panel is accessed from the panel list for a Purchase Order collateral from the Collateral
Information screen.

Field Description

(Grid) Displays each Purchase order collateral as a line-item with the following data:

l Post Date: the date that the purchase order was posted as collateral to
the borrowing base

l Order No: the purchase order number

l Order date: the purchase order date

l Expires: the purchase order expiration date

l Ship date: the purchase order ship date

l Amount: the purchase order amount

New Click this button to add a new purchase order to the collateral. The Purchase
Order screen opens to allow entry of a new purchase order collateral.

View Select an existing line-item from the grid and click this button to view and/or
edit the purchase order collateral on the Purchase Order screen.

Remove Select an existing line-item from the grid and click this button to remove the pur-
chase order from the collateral record.
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Purchase Order Dialog

The Purchase Order screen is used to record open purchase orders being managed as collateral for the
borrowing base. This screen is accessed from the Purchase Orders panel of the Collateral Information
screen.

Field Description

Post Date Select the effective date of the purchase order posting.

Order Information Enter the purchase order identification details:

l Order #: the purchase order number

l Amount: the purchase order amount

l Date: the purchase order date

Order Dates Enter the purchase order date details:

l Expires: the purchase order expiration date

l Ship date: the purchase order ship date

Debtor Enter the debtor name of the debtor that issued the purchase order.

Supplier Enter the product supplier name, if required.

Terms Enter the purchase order terms (e.g., Net 30).

Comment Enter purchase order-related notes. This is a free-form field.

Bulk Collaterals User Guide
Purchase Order Dialog

319 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

Click this button to edit a purchase order collateral.

Click this button to save a purchase order collateral.

Click this button to undo unsaved changes to a purchase order collateral.

Click this button to open the Audit screen to view audit history for the purchase
order collateral.

Click this button to generate a preview of the Purchase Order screen, which can
be printed or exported in a variety of formats.

Click this button to close the screen.

Bulk Collaterals User Guide
Purchase Order Dialog

320 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Real Estate Collateral

Real Estate collaterals are used to manage real estate borrowing bases. Each property is individually val-
ued by declaration and configured with original acquisition cost and appraised value.

Panel List

Click the link for help with the panels associated with this collateral type

l Real estate list
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Collateral Information - Real Estate List Panel

The Real Estate List panel lists real estate being managed as collateral for the borrowing base. This panel
is accessed from the panel list for a real estate collateral from the Collateral Information screen.

Field Description

(Grid) Displays each real estate collateral as a line-item with the following data:

l Descr: the description of the real estate collateral

l Acquired: the date the real estate was acquired

l Acquis cost: the original cost to acquire the real estate

l Building value: the most recent valuation for the property

l Other value: the additional borrowing base value for the collateral

New Click this button to add a new real estate item to the collateral. The Real Estate
Declaration screen opens to allow entry of a new real estate collateral.

View Select an existing line-item from the grid and click this button to view and/or
edit the real estate collateral on the Real Estate Declaration screen.

Remove Select an existing line-item from the grid and click this button to remove the
real estate from the collateral record.
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Real Estate Declaration Dialog

The Real Estate Declaration screen is used to record real estate being managed as collateral for the bor-
rowing base. This screen is accessed from the Real Estate List panel of the Collateral Information screen.

Field Description

Post Date Select the effective date of the real estate declaration posting.

Description Enter a description of the real estate item.

Location Enter the real estate location.

Availability con-
tribution

Calculated current book value of the item (cost basis less all depreciation
taken to date).

Acquisition Enter the acquisition details:

l Date: the date of acquisition

l Cost: the original acquisition price

Appraisal Enter the appraisal details for the real estate:
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Field Description

l Date: the appraisal date

l Building value: the appraised value of the property

l Other value: additional value not covered by appraisal

Exclude from discount Select this option to exclude the property value from discount calculations.

Comment Enter real estate-related notes. This is a free-form field.

Click this button to edit a real estate declaration.

Click this button to save a real estate declaration.

Click this button to undo unsaved changes to the real estate declaration.

Click this button to open the Audit screen to view audit history for the real estate
declaration.

Click this button to generate a preview of the Real Estate Declaration screen,
which can be printed or exported in a variety of formats.

Click this button to close the screen.

Bulk Collaterals User Guide
Real Estate Declaration Dialog

324 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Securities Collateral

Securities collaterals are used to manage securities borrowing bases. Each security holding is individually
valued by declaration and configured with quantity and per unit value.

Panel List

Click the link for help with the panels associated with this collateral type

l Securities list
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Collateral Information - Securities List Panel

The Securities List panel lists securities being managed as collateral for the borrowing base. This panel is
accessed from the panel list for a securities collateral from the Collateral Information screen.

Field Description

(Grid) Displays each securities collateral as a line-item with the following data:

l Descr: the description of the securities collateral

l Symbol: the market ticker symbol for the security

l Qty: the number of shares/units held

l Unit value: the value of a single stock/unit

l Current value: the calculated value of the securities holding

New Click this button to add a new securities item to the collateral. The Stocks and
Securities Declaration screen opens to allow entry of a new securities collateral.

View Select an existing line-item from the grid and click this button to view and/or
edit the securities collateral on the Stocks and Securities Declaration screen.

Remove Select an existing line-item from the grid and click this button to remove the
security from the collateral record.
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Stock and Securities Declaration

The Stock and Securities Declaration screen is used to record securities being managed as collateral for
the borrowing base. This screen is accessed from the Securities List panel of the Collateral Information
screen.

Field Description

Post Date Select the effective date of the securities declaration posting.

Symbol Enter the market ticker symbol for the stock or security.

Description Enter the stock or security name.

Valuation Enter the valuation details:

l Quantity: the number of shares of securities

l Value per unit: the stock/unit price

l $: Click this button to retrieve the share value as it is being traded
(real time) FactorSoft calculates and automatically fills the Value
per Unit field

l Availability contribution: calculated number of shares and value
per unit. This field is updated based on changes in price

l Evaluation date: system-generated date based on the most
recent update of the stock value

Comment Enter stock or security declaration-related notes. This is a free-form field.
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Field Description

Click this button to edit a securities declaration.

Click this button to save securities declaration.

Click this button to undo unsaved changes to the securities declaration.

Click this button to open the Audit screen to view audit history for the
securities declaration.

Click this button to generate a preview of the Stocks and Securities
Declaration screen, which can be printed or exported in a variety of
formats.

Click this button to close the screen.
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Other Collateral

The Other collateral type is used to manage borrowing bases for assets that are not well defined by any of
the defined collateral types. This is an item-based collateral type.

Panel List

Click the link for help with the panels associated with this collateral type

l Item Postings
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Collateral Information - Item Postings Panel

The Item Postings panel lists "other assets" (i.e., assets not well defined by any of the defined collateral
types) being managed as collateral for the borrowing base. This panel is accessed from the panel list for
an Other collateral from the Collateral Information screen.

Field Description

(Grid) Displays each "other" collateral as a line-item with the following data:

l Post Date: the date that the items were posted as collateral to the bor-
rowing base

l Description: the description of the collateral

l Amount: the dollar value of the collateral

l Comment: item related notes

l Evaluation Date: the date of collateral evaluation

New Click this button to add a new item posting to the collateral. The Other Amount
screen opens to allow entry of a new item posting collateral.

View Select an existing line-item from the grid and click this button to view and/or
edit the item posting collateral on the Other Amount screen.

Remove Select an existing line-item from the grid and click this button to remove the
item from the collateral record.
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Other Amount Dialog

The Other Amount screen is used to record "other assets"(i.e., assets not well defined by any of the defined
collateral types) being managed as collateral for the borrowing base. This screen is accessed from the
Item Postings panel of the Collateral Information screen.

Field Description

Post Date Select the effective date of the item posting.

Description Enter a description of the item.

Evaluation date Select the date of last evaluation for the collateral.

Amount Enter the dollar value of the collateral.

Comment Enter collateral-related notes. This is a free-form field.

Click this button to edit an item posting.

Click this button to save the item posting.

Click this button to undo unsaved changes to the item posting.

Click this button to open the Audit screen to view audit history for the item post-
ing.

Click this button to generate a preview of the Other Amounts screen, which can
be printed or exported in a variety of formats.

Click this button to close the screen.
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Bulk Inventory Collaterals

Bulk Inventory collaterals allow you to manage an inventory collateral borrowing base.

Bulk Inventory collaterals increase inventory through sales and decrease inventory through inventory
removal. The Bulk A/R collateral type is a balance-forward method that rolls the inventory values forward
based on periodic certificate postings.

l Bulk inventory collaterals are established and updated in FactorSoft by Certificate Postings.

l The gross collateral value can be reduced by Ineligible Postings

Panel List

Click the link for help with the panels associated with this collateral type

l Summary

l Certificate Posting

l Ineligible Posting

l Set Aside
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Collateral Information - Summary Panel

The Summary panel displays collateral balances. The Declaration balances display the collateral balance
fields as updated by collateral declarations in FactorSoft.

The Tracked column displays balances most recently imported from the Tracked AR or Loan Backed Col-
lateral modules. This column only appears if the Tracked AR or Loan Backed Collateral module is enabled
in your implementation of FactorSoft. Both previously posted and pending, to be posted figures are
provided.

Field Description

Current Collateral The gross reported collateral value.

Less Ineligibles The current total ineligible amount for the collateral.

Less Reserves The balance of cash reserve against the reported collateral value.

Less Set Asides The balance of ineligibility set asides defined for the collateral.

Eligible Collateral The gross reported collateral value less ineligibles, reserves, and set-
asides.

Advance Rate The Advance rate(%) defined for the collateral.

If multiple advance rates are in use for the collateral, this field displays
"***".

Net Collateral The eligible collateral value multiplied by the Advance Rate (%).

Collateral Limit The Availability Limit defined for the collateral.
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Field Description

Available Collateral The lower of the Net Collateral or the Available Limit. This amount will
always be either the Availability limit or the Net collateral.

Action Select the action to perform and click this button to execute the selected
function.

l Post Ineligibles open the appropriate ineligible posting transaction
screen for the A/R collateral type. The ineligible items are auto-
matically added to the ineligible posting screen

l Recalc Ineligibles update the displayed Tracked Aging data for the
most recent borrower submission.

This button is only active if either the Tracked AR or Loan Backed Col-
lateral Add On modules is implemented.

Aging Detail Click this button to open the Tracked Aging Detail screen, which displays
the detailed aging for the most recently submitted report.

This button is only active if the Tracked AR or Loan Backed Collateral Add
On module is implemented.

Recent Report Opens the Report History Details screen.

This button is only active if the Tracked AR or Loan Backed Collateral Add
On module is implemented.

Refresh Click this button to update the data displayed in the panel.

Print Click this button to generate a preview of the Summary panel that can
be printed to a local or network printer.
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Collateral Information - Certificate Posting Panel

The Certificate Posting panel lists Borrowing Certificates, which are the information used to update Bulk
A/R or Bulk Inventory collateral values. This panel is accessed from the panel list for a Bulk A/R or Bulk
Inventory collateral from the Collateral Information screen.

Field Description

(Grid) Displays each certificate posting as a line-item with the following data:

l Post Date: the posting date of the certificate

l Beginning collateral: the gross receivable balance prior to the certificate
posting

l Current collateral: the gross receivable balance after the certificate post-
ing

l Eligible collateral: the current collateral less ineligibles and reserves - i.e.,
available collateral

l Source: indicates the source of the certificate posting - Manual, Web,
~~Shadow (Tracked AR)

l User: the FactorSoft user who created the posting

l Ref No: the transaction identification number

New Click this button to create a certificate posting for the collateral. The Certificate
screen opens to allow entry of a new certificate posting.
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Field Description

View Select an existing certificate posting from the grid and click this button to view
and/or edit the posting on the Certificate screen.

Remove Select an existing certificate posting from the grid and click this button to
remove the posting from the collateral record. This option is only available
within the posting day, and can be limited by Security Role.
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Certificate Dialog

The Certificate screen is used to record a new borrowing certificate for the bulk inventory collateral. This
screen is accessed from the Certificate Posting panel of the Collateral Information screen.

NOTE
The labels for the bulk inventory collateral update fields can be customized by System preference. See
the field descriptions for the specific system Preference names.

Field Description

Date Posted Select the effective date of the certificate posting. This field is set to the current
FactorSoft working date by default.

Beginning
collateral

Displays the current gross receivable balance prior to the certificate posting.

Additional
Inventory

Enter the current reported inventory additions amount (increases inventory
value).

You can customize this label by setting System Preference Facility/Collateral
Rules (Formerly Asset Based Lending), Terminology, Bulk Inventory, Override
default label caption (Additional Inventory) to the desired label text.
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Field Description

Removed
Inventory

Enter the current reported inventory removals (reduces inventory value).

You can customize this label by setting System Preference Facility/Collateral
Rules (Formerly Asset Based Lending), Terminology, Bulk Inventory, Override
default label caption (Removed Inventory) to the desired label text.

Adjustments (+) Enter the amount of adjustments that increase the inventory value.

You can customize this label by setting System Preference Facility/Collateral
Rules (Formerly Asset Based Lending), Terminology, Bulk Inventory, Override
default label caption (Adjustments +) to the desired label text.

Adjustments (-) Enter the amount of adjustments that decrease the inventory value.

You can customize this label by setting System Preference Facility/Collateral
Rules (Formerly Asset Based Lending), Terminology, Bulk Inventory, Override
default label caption (Adjustments -) to the desired label text.

Discount Enter the amount of discounts (reduces inventory value).

You can customize this label by setting System Preference Facility/Collateral
Rules (Formerly Asset Based Lending), Terminology, Bulk Inventory, Override
default label caption (discounts) to the desired label text.

Net Collections Enter the amount of inventory reduction (reduces inventory value).

You can customize this label by setting System Preference Facility/Collateral
Rules (Formerly Asset Based Lending), Terminology, Bulk Inventory, Override
default label caption (Reduction to the desired label text.

Over payment Enter the amount of returns (increases inventory value).

You can customize this label by setting System Preference Facility/Collateral
Rules (Formerly Asset Based Lending), Terminology, Bulk Inventory, Override
default label caption (Returns) to the desired label text.

Current collateral Displays the total receivable balance adjusted by the recorded certificate val-
ues.

Ineligible Displays the calculated ineligible balance for the collateral.

Reserve Displays the cash reserves balance for the collateral.

Eligible collateral Displays the calculated eligible collateral after the certificate posting, which is
the Current Collateral less ineligibles and reserves.
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Field Description

Comment Enter certificate-related notes. This is a free-form field.

Click this button to edit a certificate posting.

Click this button to save a certificate

Click this button to undo unsaved changes to the certificate.

Click this button to open the Audit screen to view audit history for the certificate.

Click this button to generate a preview of the Certificate screen, which can be
printed or exported in a variety of formats.

Click this button to close the screen.
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Collateral Information - Ineligible Posting Panel

The Ineligibles Posting panel lists ineligible postings for the collateral. Ineligibles are deducted from avail-
ability before the advance rate is applied. This panel is accessed from the panel list for an A/R Aging, Bulk
A/R, or Bulk Inventory collateral from the Collateral Information screen.

Field Description

(Grid) Displays each facility event as a line-item with the following data:

l Post Date: the posting date of the ineligible posting

l Ineligible amount: the dollar amount of the ineligible posting

l Ref No: the transaction identification number

l User Key: the FactorSoft user who created the posting

New Click this button to create an ineligible posting for the collateral. The Bulk Ine-
ligible Posting screen opens to allow entry of a new ineligible posting.

View Select an existing ineligible posting from the grid and click this button to view
and/or edit the posting on the Bulk Ineligible Posting screen.

Remove Select an existing ineligible posting from the grid and click this button to
remove the posting from the collateral record. This option is only available
within the posting day, and can be limited by Security Role.
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Bulk Ineligible Posting

The Bulk Ineligible screen is used to record ineligible postings that reduce the available value of the col-
lateral. This screen is accessed from the Ineligible Postings panel of the Collateral Information screen.

Field Description

Date Posted Select the effective date of the ineligible posting. This field is set to the current
FactorSoft working date by default.

Ref# Enter a transaction identification number.

Comment Enter ineligibles-related notes. This is a free-form field.

(Grid) Displays the Ineligible Titles (i.e, categories) set up in Ineligible/Reservation Title
Table and the ineligible Amount for each category.

To add ineligible reductions, enter the new ineligible amount for the category in
the Amount column.
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Field Description

Click this button to edit an ineligible posting.

Based on Security Role settings, this may be unavailable, available within pro-
cessing day, or available within month.

Click this button to save a ineligible posting.

Subtotal Displays the total amount of ineligibles for the collateral.

Set Asides Displays the total amount of any set-aside ineligibility for the collateral.

Total Ineligibles Displays the total collateral ineligibility amount, which is the Subtotal plus Set
Asides.

Documents Click this button to open the Document List screen, which is used to attach doc-
ument and image files for the posting.

Click this button to undo unsaved changes to the ineligible posting.

Click this button to open the Audit screen to view audit history for the ineligible
posting.

Click this button to generate a preview of the Bulk Ineligible Posting screen,
which can be printed or exported in a variety of formats.

Click this button to close the screen.
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Collateral Information - Set Aside Panel

The Set Aside panel lists ineligibility set asides defined for the collateral, and is accessed from the Col-
lateral Information panel list for a A/R Aging, Bulk A/R, Bulk Inventory, or Summary A/R collaterals.

Field Description

(Grid) Displays each set aside as a line-item with the following data:

l Title: the set aside title

l Qualifier: qualifying text pertaining to the set aside

l Date: the set aside date

l Amount: the set aside amount

New Click this button to add a new set aside to the collateral. The Collateral Ine-
ligibility screen opens to allow entry of a new ineligibility set aside.

View Select an existing line-item from the grid and click this button to view and/or
edit the ineligibility set aside on the Collateral Ineligibility screen.

Delete Select an existing line-item from the grid and click this button to remove the set
aside from the collateral record.
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Collateral Ineligibility Dialog

The Collateral Ineligibility screen, accessed from the Set Aside panel, is used to add a new set aside
ineligibility amounts to A/R Aging, Bulk A/R, Bulk Inventory, or Summary A/R collaterals.

Field Description

Title Select the Ineligible Title that defines the ineligibility reason for the set aside. Ine-
ligible Titles are defined in the Ineligible/Reservation Titles table.

Qualifier Enter qualifying text pertaining to the set aside.

Effective Select the date on which the set aside ineligibility amount is deducted from
availability.

Amount Enter the ineligibility amount.

Notes Enter notes specific to the set aside in this field.

History This grid lists any previously saved set aside ineligibility for the collateral.

Save Click this button to save changes to the Collateral Ineligibility and close the
screen.

Cancel Click this button to close the screen without saving.

Bulk Collaterals User Guide
Collateral Ineligibility Dialog

344 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Activity Center

The Activity Center screen consists of multiple tabs that display pending activity and transaction entries
for loans:

l Pending Postings: displays pending postings submitted from ClientWeb or Web Portal for summary
A/R declarations, ineligible postings, and inventory declarations for loans processing

l Manage Pending Transfers: displays pending auto-transfer requests generated based on Auto
Transfer rules for loans processing

l Manage Pending Transactions: displays pending disbursement transactions for loans processing

l New Unclaimed Cash Deposit: displays transactions posted to the loan balance via a Claimed
Cash Posting transaction for the Facility

l Transactions: displays any transaction entry recorded to date
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Manage Pending Postings

The Pending Postings tab of the Activity Center used to view, approve, rework, or deny pending postings,
submitted from ClientWeb/Web Portal, for summary A/R declarations, ineligible postings, and inventory
declarations. These collaterals are used in bulk collaterals processing.

The Pending Postings screen is accessed from the Office menu of the FactorSoft desktop application.

Field Description

(Grid) Displays each pending posting as a line-item with the following data:

l Client: the client name

l Facility: the facility name

l Collateral: the collateral to which the posting is being applied

l Date: the effective date of the posting

l Type: the posting type

l Status: the status of the posting

Approve Select a line-item and click this button to approve and release a single posting.
Note: For all dates prior to current date, the user is prompted to accept sub-
mission date or change to current date on approval.

Deny Select a line-item and click this button to reject a pending posting.
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Field Description

Approve All Click this button to approve and release all pending postings.
Note: For all dates prior to current date, the user is prompted to accept sub-
mission date or change to current date on approval.

Client Rework Click this button to return the posting to the client for rework in the ClientWeb or
Web Portal.

Refresh Click this button to update the information in the grid.

View Click this button to view the posting certificate screen for the selected posting.

Print Click this button to generate a preview of the Manage Pending Postings screen,
which can be printed or exported in a variety of formats.

Close Click this button to close the screen.
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Manage Pending Transfers

The Manage Pending Transfers tab of the Pending Transactions screen displays pending auto-transfer
requests generated based on Auto Transfer rules for bulk collateral processing. Using this screen, you can
approve these requests to execute the transfer, or deny the request to send it back for rework.

The Pending Transactions screen is accessed from the Office menu of the FactorSoft desktop application.

Field Description

(Grid) Displays each pending transfer as a line-item with the following data:

l From Client: the client from which the transfer transaction was taken

l From Facility: the facility name from which funds are being transferred

l To Client: the client to which funds are to be transferred

l To Facility: the facility name to which funds are to be transferred

l Transfer Amt: the amount of the pending transfer

l Status: the status of the transfer – always “Pending”.

l Created By: always “~auto”.
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Field Description

Auto Generate Click this button to execute the auto-transfer rules and generate the pending
transfers queue.

Approve Select a line-item and click this button to approve a single Auto-Transfer
request.

Approved requests are posted immediately and can be viewed in the Ledger
for the Facility.

Approve All Click this button to approve all pending auto-transfer requests.

Approved requests are posted immediately and can be viewed in the Ledger
for the Facility.

Deny Select a line-item and click this button to deny a single auto-transfer request
and remove it from the queue. Note that if no modification is made to the facil-
ity, the denied request will re-queue when the auto transfer rule logic is
executed.

Deny All Click this button to deny all pending auto-transfer requests. Note that if no
modifications are made to the facilities, the denied requests will re-queue when
the auto transfer rule logic is executed.

Refresh Click this button to update the information in the grid

Print Click this button to generate a preview of the Manage Pending Transfers screen,
which can be printed or exported in a variety of formats.

Close Click this button to close the screen.
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Manage Pending Transactions

The Manage Pending Transactions screen is used to view, approve, rework, deny, or void pending dis-
bursement transactions for facilities both Factoring and Asset-Based.

NOTE
Access to void pending disbursements may be limited by security role.

The Manage Pending Transactions screen is accessed from the Office menu of the FactorSoft desktop
application.

Field Description

Filter by AE Select the account executive to which to limit the display of pending trans-
actions

l Clear: click this button to clear an AE filter and display transactions for all
AE's

l Refresh: click this button to update the grid for an AE filter

(Grid) Displays each pending posting as a line-item with the following data:
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Field Description

l Client: the client name

l Facility: the facility name

l Post: the posting date of the transaction

l Amount: the transaction amount

l Status: the status of the transaction

Approve Select a line-item and click this button to approve and release a single trans-
action.

User limits specified in the Manage Users screen of the Administration module
may affect the user's ability to approve items in the Pending Transactions tab.

Approve All Click this button to approve and release all pending transactions.

User limits specified in the Manage Users screen of the Administration module
may affect the user's ability to approve items in the Pending Transactions tab.

Rework Select a line-item and click this button to revise or correct a pending trans-
action. The transaction screen is opened in edit mode to allow rework.

Deny Select a line-item and click this button to reject a pending transaction.

Void Select a line-item and click this button to void the transaction. Transactions can
only be voided in the current FactorSoft processing day (i.e., on the processing
day that the transaction was formatted).

Position Summary Click this button to generate a preview of the Position Summary Report for the
client.

Avail Cert Click this button to generate a preview of the Availability Certificate/Advance
Request for the facility.

Print Click this button to generate a preview of the Manage Pending Transaction
screen, which can be printed or exported in a variety of formats.

Close Click this button to close the screen.

NOTE
During Approval or Rework, if the Post Date does not match the current date, the user is asked to verify
the correct Post Date.
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System Preferences

The following system preferences related to Reserve Releases are located in the Administration module,
System Preferences, Client rules & Defaults, Ineligibility/summary calculation, Release tab folder.

Preference Description

Allow negative
checks

When set to True, accepting negative checks takes money from the operating
account. Do not use unless the system has the ability to get funds from the DDA
Account.

Bank account must
be selected to
release reserves

Set to True to require the Bank Acct field to be completed on the Release tab of
the Client Summary / Reserve Release screen to process a reserve release
transaction.

Disable the ability to
write reserve release
checks

Set to True to turn off the Write checks ability on Reserve Releases.

Do not allow reserve
release on inactive cli-
ents

When set to True, users will not be able to release reserves if the client is inact-
ive.

Do not allow reserve
release if there is an
expired lien

Set to True to deny reserve release to a client with an expired lien. If a reserve
release is attempted for a client with an expired lien subordination or a lien
release date in the future (as recorded in the Client Liens screen from the Liens/-
monitoring tab of the Client Information screen), an error indicating that “a lien
is not subordinated or released, a reserve release may not be performed” is dis-
played.

Do not allow reserve
release if there is an
open alert

Set this option to True to prevent reserve release on any client that has an open
alert returned from the monitoring vendor.

Do not allow reserve
release over the client
credit limit

Set to True to restrict users from releasing reserves that put the client over its
credit limit.

Over available for
release rule

Determines how a disbursement "over the available for release" will be handled.
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Preference Description

l No Edit

l Do not allow

l Allow for authorized user only with a warning

l Allow for authorized user only without a warning

Paid on date Determines how to edit the transfer paid on date.

l Warn if not current date, allow any date

l Date must be in current fiscal month

l Date must be current date (not changeable)

l Date can not be entered

Pending rule Select the option that determines how reserves are released and/or pended.

l Releases can only be written immediately: reserve release transactions
are immediately release to the Write Checks screen by clicking the Write
button on the Release tab of the Client Summary screen; there is no
option to make reserve release transactions pending.

l Releases can only be pended (release later): reserve release transactions
are created from the Release tab of the Client Summary by pressing the
Pend button; the pending reserve transaction is released from the Man-
age Pending Purchases screen.

l Releases may be pending or written immediately: reserve release trans-
actions can be pended by clicking the Pend button on the Release tab of
the Client Summary screen, or created immediately by clicking the Write
button on the Release tab of the Client Summary screen.

Note: Pending Rule must be set to Releases can only be pended (release later) if
using System Preference: Reserve Release requires Manager Authorization as
Second Approval to prevent Releases from being written immediately.

Post date rule Select the value for the Post Date to be displayed on the Release tab:
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Preference Description

l Must Be Current Date (not changeable): Select this option to display the
current date without the ability to change it. As a result, FactorSoft will
always display the current date, whether the transaction is new or repro-
cessed.

l Current Fiscal Period but not in the Future: Select this option to display the
current date, with the ability to overwrite it only with a date falling within
the fiscal period.

l Current Fiscal Period, Future Date Allowed: Select this option to display the
current date, with the ability to overwrite it only with a date falling within
current and future fiscal periods.

l Any Date but not in the Future: Select this option to display the current
date, with the ability to overwrite it with a date falling within past and cur-
rent fiscal periods.

l Any Date Past or Future: Select this option to display the current date, with
the ability to overwrite it with any date, regardless of the fiscal period.

Preference print
reserve release report

Determines how the Reserve Release report can be printed.

l Never

l All Clients (extra copy if preference is print)

l Clients with non-print preferences only

Reserve Release
amount should come
up as zero

Set to True to display a zero amount in the Release Amount field. This setting
was designed to help prevent erroneous or accidental disbursements.

Reserve Release
requires Manager
Authorization as
Second Approval

When set to True, manager approval is required for Reserve Releases through
the Activity Center.

Note: Pending Rule must be set to Releases can only be pended (release later) if
using System Preference: Reserve Release requires Manager Authorization as
Second Approval to prevent Releases from being written immediately.

Reserve release is a
transaction

Set to True for Reserve Releases to be treated as their own Transaction Type.

Respect user reserve
release limit when

Set to True to indicate that FactorSoft enforces Reserve Release limit set for the
user for pending reserve releases.
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Preference Description

pending

Respect user reserve
release limit when
releasing

Set to True to indicate that FactorSoft enforces Reserve Release limit set for the
user for immediate reserve releases.

Show all accounts for
reserve release
expenses

Set to True to allow all accounts as opposed to only allowing specifically
flagged accounts that are of the same currency.

Use address from
bank info if available

Set to True to have the address from the Bank info tab used if the" Payable to"
field is filled in.

Warn if not all cash
reserves released

Set to True to display a verification message if the full amount of available cash
reserves is not released.

The following system preferences related to Reserve Releases are located in the Administration module,
System Preferences, Client rules & Defaults, Ineligibility/summary calculation, Reserves tab folder.

Preference Description

Accept Escrowed
Reserves as correct

Set to True to always consider Escrowed Reserves as correct.

Do not deduct
accrued invoice fees

If True, accrued invoice fees are not shown or deducted from available reserves
on the summary screen.

Do not deduct
accrued interest

If True, accrued interest is not shown or deducted from available reserves on
the summary screen.

Do not deduct special
expense shortages

If True, special expense shortages are not deducted from available reserves on
the summary screen.

Float Ineligibility
affects available for
release

Set to True to subtract ineligible float days from client reserves when dealing
with check payments that have not cleared the bank.

Float ineligibility is
based on client
reserve escrow less
fees earned

Set this preference to determine the calculation of the Float Ineligibility Vari-
ance total displayed on the Reserves tab of the Client Summary/Reservers
Release screen, and thus the Available for Release calculation on the Release
tab.
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Preference Description

l False = Use the standard calculation. If float is held on payments based
on Client Terms, Client Information, or Check Source, the entire payment
amount applied to invoices is held in float (as can be seen in the Paid in
Float field on the Collateral tab of the Client Summary/Reserve Release
screen) and any overage is displayed in the Float Ineligibility Variance
field on the Reserves tab, affecting the Available for Release total.

l True = Use the alternate calculation. If float is held on payments based
on Client Terms, Client Information, or Check Source, only the reserve
escrow, minus fees earned, is held in float. Nothing is held in float against
the invoice payment (thus Paid in Float field on the Collateral tab of the
Client Summary/Reserve Release screen is blank) and the reserve escrow
less fees earned is reflected in the Float Ineligibility Variance field on the
Reserves tab.

Minimum Cash
Reserves excludes Ine-
ligibles

Set to True and the minimum cash reserves calculation will exclude ineligibles
and accrued fees from the calculation.
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Manage Unclaimed Cash Deposit

The Manage Unclaimed Cash Deposit screen displays transactions posted to the loan balance via a
Claimed Cash Posting transaction for the Facility. This screen allows you to void the transaction or open
the Unclaimed Cash Deposit screen to post the funds to an unclaimed cash holding account while you
wait to receive instructions from the client as to how to post the funds.

Field Description

Facility Select the facility for which to record a deposit.

l Clear: click this button to clear an Facility filter and display transactions
for all facilities

l Refresh: click this button to update the grid for an Facility filter

(Grid) Displays each unclaimed cash deposit as a line-item with the following data:

Bulk Collaterals User Guide
Manage Unclaimed Cash Deposit

357 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

l Date: the deposit date

l Ref #: the transaction reference number

l Type: the deposit type

l Amount: the deposit amount

l Balance: the unclaimed cash balance

Void Select a line-item and click this button to void a ledger transaction.

A confirmation message is displayed. Click Yes to void the transaction. The
transaction is removed from the grid. Both the Posting and associated Deposit
are removed, although the deposit will still be visible in the Unclaimed Cash
Deposit transaction screen. The voided transaction can be viewed in the Trans-
action Register.

Post Select a line-item and click this button to open the posting transaction screen
for the Claimed Cash posting transaction screen for the selected transaction.

Audit Click this button to open the Audit screen to view audit history for unclaimed
cash deposits.

Print Click this button to generate a preview of the Unclaimed Cash Deposit screen,
which can be printed or exported in a variety of formats.

Close Click this button to close the screen.
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Transaction Register

The Transaction Register screen allows you to view any transaction entry recorded to date, such as dis-
bursements, payments, accrual postings, statement postings, and the like. The transaction details can be
filtered by selected transaction type, and you can also limit the display by client, facility, office, and date
range, and select whether or not to include voided transactions.

The Transaction Register screen is accessed from the Office menu of the FactorSoft desktop application.

Note that this screen is only accessible from the Office menu of the FactorSoft Desktop application if Sys-
tem Preference Fields/screen behavior, Screens, Activity center, Use older Transaction Register ver-
sion is set to True.

Field Description

Transaction Type Filter

Transaction type filter From this group, select the Transaction Types for the transaction items you
want to view.

Include void trans-
actions

Select this option to include voided transactions in the register display.

Display Filters
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Field Description

Client/Facility filters Select the attributes to which to limit the display. If no criteria is selected here,
all transactions for the selected Transaction Types is displayed.

l Client: select the Client for which you want to display transaction records.
If no Facility or Office criteria are selected, all transactions for the selected
transaction types within the Client are displayed.

l Facility: select the Facility for which you want to display transaction
records. This list is only available if a Client is selected. If a Client is selec-
ted and no Facility is selected, transactions for all facilities for the selec-
ted Client are displayed.

l Office: select the Office to limit the display to from this drop-down list.
This criterion is independent of the Client and Facility. If an Office is selec-
ted, and no Client/Facility is selected, the transactions displayed are lim-
ited only to Clients and Facilities assigned to the selected office.

Date filter Use these fields to define the date range to which to limit the display of trans-
action records. You can click on the calendar icon and select a date, or manu-
ally enter the date in most standard formats (“01/01/10”, “Jan 1, 10”, and “January
1, 2010” are all valid formats). If no dates are provided, all transactions matching
the transaction type and client/facility criteria are displayed.

Load Transactions Click this button to display the transactions for the selected criteria.

Transaction Grid For each transaction line item, some or all of the following data is displayed.
Double-click any transaction line item to display the details of the transaction
on the Transaction Detail screen.

l Date: the date of the transaction

l User: the FactorSoft user-id that created the transaction

l Client: the Client for which the transaction was created

l Facility: the Facility for which the transaction was created

l Type: the Transaction Type of the original transaction

l Status: the current status of the transaction

l Check#: the check number associated with the transaction, if applicable

l Amount: the dollar amount of the transaction
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Field Description

Click this button to generate a preview of the Transaction Register screen,
which can be printed or exported in a variety of formats.

Click this button to close the screen.

Bulk Collaterals User Guide
Transaction Register

361 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Unclaimed Cash Deposit

The Unclaimed Cash Deposit screen is used to post cash transactions to an unclaimed cash holding
account while you wait to receive instructions from the client as to how to post the funds. Unclaimed cash
deposits are posted to the loan balance via a Claimed Cash Posting transaction for the Facility.

The Unclaimed Cash Deposit screen is accessed from the Office menu of the FactorSoft desktop applic-
ation.

Field Description

Facility Select the facility for which to record a deposit.

(Grid) Displays each unclaimed cash deposit as a line-item with the following data:

l Date: the deposit date

l Ref #: the transaction reference number

l Type: the deposit type

l Amount: the deposit amount

l Balance: the unclaimed cash balance

Click this button to add a new unclaimed cash deposit for the facility.

Click this button to edit an existing for unclaimed cash deposit.
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Field Description

Click this button to save an unclaimed cash deposit.

Click this button to undo unsaved changes an unclaimed cash deposit.

Date Select the deposit date.

Ref # Enter a transaction reference number.

Source Select the payment source for the deposit.

Amount Enter the deposit amount.

Click this button to open the Audit screen to view audit history for the
unclaimed cash deposit.

Click this button to generate a preview of the Unclaimed Cash Deposit screen,
which can be printed or exported in a variety of formats.

Click this button to close the screen.
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Bulk Collateral Reports

The standard reports included with FactorSoft for Bulk Collaterals provide detailed summaries of the activ-
ity involving your clients, facilities, and collateral in a variety of formats

Reports can be saved as Templates, which save the settings of commonly used reports. The reports can
then be scheduled to run at a specified interval via the Engine. Click here for more information about cre-
ating Report Templates.

Reports can be generated in a variety of output formats: printer, email, Fax or output file. When emailing
reports, a screen pops up on which you can provide an address, subject, and summary. The reports can
be scheduled to be generated automatically and sent to Fax or email recipients.
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Facility Reports

The Facility report group contains reports that provide details on facilities in bulk collateral lending envir-
onments.
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ABL Payment Import Report

The ABL Payment Import report summarizes successful imports and lists each unsuccessful payment
import record uploaded from the ABL Lockbox Payment Importer. The report is accessed from the Facility
menu in the Reports module.

The default report definition for this report is ABLPayImport.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As Of Date Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.
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Field Description

If Set At Run Time (Web Template Only) is selected, when the report is clicked
in the ClientWeb Report Queue, a screen appears to choose the date range
(Current Date, Previous Month-End Date, or Specific Date).

Report Sample

Report Details

Column Description

Date Displays the date and time stamp the upload launched.

Location Displays the location of the folder where import files are placed.

File Name Displays the file name of the import.

Status Displays the status of the transaction that was imported:

l Processed - successfully completed

l Process w/ Exceptions - successfully completed with exceptions, see res-
ults

l Failed - unsuccessful, no transaction records created
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Column Description

Results Displays details based on the Status.

Security Roles

To generate the ABL Payment Import Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print ABL Payment Importer Report
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Account Table Report

This report generates the Chart of Accounts Report, which lists the accounts configured in the FactorSoft
Accounts Table.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Sample
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Report Details

Column Description

Account # Displays the assigned General Ledger account number

Description Displays the name of the General Ledger Account

Notes Displays an additional description given to the account type

Security Roles

To generate the Account Table Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Account Table
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Daily Transaction Journals Report

The Daily Transaction Journals report is used to assist in your end-of-day processes, helping you close
out your daily transactions and balance your portfolio to FactorSoft. This report is accessed from the Facil-
ity menu of the Reports module.

The Daily Transaction Journals report has several formats that provide detail different daily Loan Trans-
action activities. See the Format field for descriptions.

NOTE
The disclaimer “Post dated transactions are not included” appears at the top of these reports to indic-
ate that only transactions from the As Of date to the current FactorSoft processing date are included
on the report

The default report definitions for this report are:

l Transaction Summary – DailyTransSummary

l Adjustment Journal – DailyTransAdj

l Advance Journal – DailyTransAdv

l Payment Journal – DailyTransCash

l Cash Receipt Journal – DailyTransCash

l Unclaimed Cash Deposit – DailyTransCash
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As Of Date Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is
clicked in the ClientWeb Report Queue, a screen appears to choose the
date range (Current Date, Previous Month-End Date, or Specific Date).

Client Select the client for which you want to generate the report. Leave client
blank to generate a portfolio level report for the date requested.

Note that inactive clients are filtered out of this report.

A/E Select the Account Executive (FactorSoft user) to which to limit the res-
ults in the report, or leave blank to include all users. When a user is selec-
ted, the report is limited to clients that have that user selected in the A/E
field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an
A/E, use the following System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an
Office restriction defined on the Manage Users screen in the Admin mod-
ule, the user will only be able to generate the report within that office
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Field Description

restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user
will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor
menu, click Office.

Client Group Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables
feature. To access this table, on the File menu, click Tables. Then, on the
Client & Debtor menu, click Client Group Codes.

Value Select the specific client group value to which to limit the results in the
report.

Client Groups are defined in the Client Group Code table in the Tables
feature. To access this table, on the File menu, click Tables. Then, on the
Client & Debtor menu, click Client Group Codes.

Facility Select the facility for the selected client to include in the report or leave
blank to include all facilities. This field only becomes active if you select
a client from the Client list above.

Format Select the report format to be generated:
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Field Description

l Transaction Summary – Rolls forward each facility loan balance
from the beginning of the day, adding all transactions posted
against that loan, summed by transaction type, and arriving at
the end of day loan balance

l Adjustment Journal – Displays each facility loan adjusting type
transaction which includes the following: Addl Fees, Accrual Post-
ing, Fee Distribution, Adjustments, Transfers and Expenses,
summed by transaction type.

l Advance Journal – Displays each facility total loan advances
made in the day

l Payment Journal – Displays each facility total loan payments
applied in the day

l Cash Receipt Journal – Displays each facility total cash received
in the day

l Unclaimed Cash Journal – Displays each facility cash receipts
posted to unclaimed cash in the day

Exclude Participations Select this check box to exclude lending partners' participation trans-
action types from the report. This option only applies if you are using the
Participation add-on.
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Report Sample

Security Roles

To generate the Daily Transactions Journal Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Daily Transaction Journal Reports
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Facility Analysis Report

The Facility Analysis Report summarizes monthly facility activity during a selected date range. The ana-
lysis rolls forward each facility loan balance from the beginning of a month, adding all transactions pos-
ted against that loan, summed by transaction type, and arriving at the end of the month loan balance.
This report is accessed from the Facility menu of the Reports module.

The default report definitions for this report are FacilityAnalysis and FacilityAnalysis2.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date Range
is set to Last Business Day. This function is only valid for Reporting Services reports when Use
last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Format Select the report format to be generated:

l Monthly detail by facility - for a selected facility the analysis reports on monthly activity,
summed to transaction type, for each month end included in the report call date range.

l Monthly summary by client - generates a portfolio level analysis for a selected month’s
transaction activity listed by facility.
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Field Description

Month Select the month to be reported for the Monthly summary by client format.

Year Enter the year to be reported for the Monthly summary by client format

Report Sample

Report Details

Column/Label Description

Loan Turn End of Month Loan Balance / Total Collections * Actual Number of
Days in the Month.

Note: Results in number of days the loan turns (not a percentage).

Yield Total Fees + Total Facility Posting Amount / End of Month Loan Bal-
ance *360 / Actual Number of Days in the Month.

Note: Result is the annualized percentage return on investment.

Security Roles

To generate the Facility Analysis Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Facility Analysis Report
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Facility Ledger Report

The Facility Ledger Report is an accounting ledger which provides a listing of all transactions posted to the
selected facility during a specified date range. This report is accessed from the Facility menu of the
Reports module.

The default report definition for this report is FacilityLedger.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the adjacent fields.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
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Field Description

on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Bulk Collaterals User Guide
Facility Ledger Report

382 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Office Maintenance Table.htm
Client Group Codes Table.htm


Report Sample

Security Roles

To generate the Facility Ledger Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Facility Ledger Report
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Facility List Report

The Facility List Report prints a list of all the facilities associated with a client. This report is accessed from
the Facility menu of the Reports module.

The default report definition for this report is FacilityList.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.
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Field Description

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Show
Facility
Address

Select this option to include the facility address in the Facility Description column of the
report.
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Field Description

Show
Facility
Phone
Number

Select this option to include the facility primary phone number in the Facility Description
column of the report.

Show
Facility
Fax

Select this option to include the facility FAX phone number in the Facility Description column
of the report.

Show
Facility
Email

Select this option to include the facility email address in the Facility Description column of the
report.

Sample Report

Report Details

Column Description

Client Displays the Client to which the Facility is associated

Facility Description Displays the Facility name and contact information based on parameters set.

Loan Limit Displays the maximum exposure for this loan agreement

Status The status of the facility: Active/Inactive

Type Custom field for category defined in Facility Information
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Column Description

Credit Rating Displays the Credit Rating of the Facility

A/E Displays the account executive to which the client account is assigned.

G/L Group Displays the default general ledger Account Group for the facility.

Currency Displays the currency type to use to conduct transactions and produce reports
for the facility.
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Facility Loan Status Report

The Facility Loan Status report lists two sets of historic activity. First, Bulk AR collateral and or Factoring
Batch transaction, second is the Loan Balance and Funds Employed Balance activity. The report is based
on facilities activity within a specified date range. The Facility Loan Status includes both factoring detail as
a “collateral” and non-detail Bulk AR collateral concurrently for databases that have both types. This
report is accessed from the Facility menu of the Reports module.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use last
business day instead of yesterday in date range to True. The Yesterday option in the Date
Range field is replaced with Last Business Day, and reports printed on Monday will print Fri-
day’s data (assuming Friday was the last business day) instead of Sunday’s. Set System Prefer-
ence Identification/system constants > CLMS|Reporting Services > Requests > Saturday is a
business day to True to consider Saturday a business day when the Date Range is set to Last
Business Day. This function is only valid for Reporting Services reports when Use last business
day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

Note that inactive clients are filtered out of this report.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

GL
Group

Select the GL Group to which to limit the results in the report.

Sum To drop-down to select statement format:
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Field Description

l Date: activity by each day in the period

l Activity: activity by individual batch

l Portfolio: accumulated activity calculated by adding all postings and transactions

Check
Box

Include Facility Position: as secondary report attachment.

Report Sample

Date Format

Activity Format
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Portfolio Format

Report Details

Column Description/Calculation

Date and Activity Format

Date Displays the posting date.

Type Displays the Collateral Post or Transactions Type abbre-
viated descriptor.
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Column Description/Calculation

Ref# Displays the transaction identification.

Accounts Receivable Postings

Net Sale Displays reported Net Sales less Credit amounts for the
period.

Net Collections Net collections included on Collateral posting.

Discounts Displays reported Payment Discount amount for the period.

Other Displays posting against invoices for the period.

Adjustments Displays Adjustments to collaterals and Invoices for the
period.

Loan Transactions

Funding Displays the distributions made to the borrower for the
period.

Cash Receipts Displays the payments received against the loan amount for
the period.

Charges & Fees Displays the Fees & Changes added to the Loan Balance for
the period.

Expenses Displays the Expenses added to the Loan Balance for the
period.

Adjustments Displays Adjustments made to the Loan Balance for the
period.

Balances

Accounts Receivable Displays the balance of Collateral Bulk AR plus Open
Factored Invoices.

Funding Displays the balances of Loan Amount plus Factored Funds
Employed.

Portfolio Format

Loan Limit Limit set at the facility level.

Accounts Receivable Postings
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Column Description/Calculation

Net Sales Displays reported net sales less credit amounts for the
period.

Collections Displays reported net collections less over payment amount
for the period.

Adjustments Displays the sum of Discounts, Other and Adjustments to col-
laterals and Invoices for the period.

Ineligibles Displays the ending Ineligible amount for the period.

Loan Transactions

Advances Displays the funding distributions made to the borrower for
the period.

Collections Displays the cash receipt payments received against the
loan amount for the period.

Other Displays the sum of Fees & Changes Expenses and Adjust-
ments added to the Loan Balance for the period.

Balances

Accounts Receivable Displays the balance of Collateral Bulk AR plus Open
Factored Invoices.

Loan Balance Displays the balances of Loan Amount plus Factored Funds
Employed.

Accrued Revenue Displays the Current Period to Date accruing revenue.

Security Roles

To generate the Cash Posting Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Facility Loan Status Report
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Facility Position Report

The Facility Position report provides an overview of each client’s facility information, broken down by cli-
ent, facility, and collateral.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As Of
Date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
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Field Description

entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

Note that inactive clients are filtered out of this report.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
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Field Description

Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Format drop-down to select the specific report format: Client Detail or Client Summary

Security Role

Security Roles for this report are located at Security > Manage Roles > Reports > Facility > Print Facility
Position Report (Yes/No).

Report Details

Column Description/Calculation

General Report Details

Facility (name)/ Collateral (name) Displays the Facility or Collateral name

Currency Displays the default currency type for the facility. Currency
types are created in the Currency Denominations Table in
the Table module and assigned on the New Facility screen
when the facility is created.

Type Displays the Collateral type as defined on the Collateral
Information screen

Limits (omit cents) Displays the client's overall credit limit as defined on the
Credit/no buy panel of the Client Information screen.

Advance Rate (%) Displays the Collateral Advance Rate % as defined on the Col-
lateral Information screen in the Availability Rate (% ) field

Gross Collateral Displays the sum total of the current collateral values used
to support the loan balance.
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Column Description/Calculation

The sum of Gross Collateral for all facilities is the figure dis-
played in the optional Gross Collateral column at the Client
level.

Total Ineligibles Displays the Total Ineligibles for each Collateral as shown on
the Collateral Information screen under Collateral Summary.

Eligible Collateral Displays the current Eligible Collateral amounts used to sup-
port the loan balance. (Current Collateral value - Ineligible
values)

Net Collateral Displays the calculated Net Collateral amount used to sup-
port the loan balance. (Eligible Collateral value * Advance
Rate)

Availability Displays the calculated Available Collateral amount used to
support the loan balance. (Lower of Available Limit and Net
Collateral Amount)

Balance Displays the Facility Balance as shown on the Facility Sum-
mary screen under Facility Summary.

Excess/Deficit Sum of facility amounts available to be disbursed.

Client Detail Format - Current days activity in Blue

Activity Section (left) - Loan transaction ledger for current days activity

Activity Date

Description Displays the appropriate Description for the type of trans-
action posted.

For example, a Loan Payment transaction will show the Source
value and an Accrual Posting transaction will show Accrual Posting.

Transaction Type Displays the Transaction Type such as Accrual Posting, State-
ment and Disbursement.

Begin Balance Balance at the beginning of current day.

Amount Activity Amount.

End Balance Balance at the end of current day.
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Column Description/Calculation

Extra Summary Section (right) - Current Balances of:

Fee Balance Unposted/paid accrued fees.

Fee Reserve Calculated facility reserve based on MTD accrued fees.

Other Reserves Facility Reserves

LOCRsv Letter of Credit Reserve

Payment RSV Balance of Reserved established from Cash Posting.

U/C Balance Balance of unapplied unclaimed cash.

Activity Section (middle left) - Collateral updates posted in the current day. (Same columns for Bulk AR
Collateral and Bulk Inventory Collateral)

Activity Date

Begin Balance Balance at the beginning of current day.

Sales Sales included on Collateral posting

Credits Credits included on Collateral posting

Adjustments (minus) Adjustments (minus) included on Collateral posting

Adjustments (plus) Adjustments (plus) included on Collateral posting

Discounts Discounts included on Collateral posting

Collections Net collections included on Collateral posting

Over Payments Over Payments included on Collateral posting

End Balance Balance at the end of current day

Supplemental Collaterals

Activity Date

Begin Value Balance at the beginning of current day

Change Displays Collateral value change entered by the User

End Value Balance at the end of current day
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Report Sample
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Facility Position Summary Report

The Facility Position Summary report provides an overview of each client’s facility position summarized to
“Excess/Deficit” availability portfolio wide.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

As Of
Date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).
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Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

Note that inactive clients are filtered out of this report.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.
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Field Description

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Report Sample

Report Details

Column Description/Calculation

Gross Col-
lateral

Displays the sum total of the current collateral values used to support the loan bal-
ance

Currency Displays the Currency type assigned to the facility

Availability Displays the calculated Available Collateral amount used to support the loan bal-
ance. (Lower of Available Limit and Net Collateral Amount)

Balance Displays the Facility Balance as shown on the Facility Summary screen under Facility
Summary

Excess/Deficit Sum of facility amounts available to be disbursed
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Security Roles

To generate the Facility Position Summary Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print facility position summary report

Bulk Collaterals User Guide
Facility Position Summary Report

404 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Facility Trial Balance Report

The Facility Trial Balance Report is an accounting of the daily transactions. This report can display results
in a variety of formats. This report is accessed from the Facility menu of the Reports module.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date Range Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests
> Use last business day instead of yesterday in date range to True. The Yesterday option
in the Date Range field is replaced with Last Business Day, and reports printed on
Monday will print Friday’s data (assuming Friday was the last business day) instead of
Sunday’s. Set System Preference Identification/system constants > CLMS|Reporting Ser-
vices > Requests > Saturday is a business day to True to consider Saturday a business
day when the Date Range is set to Last Business Day. This function is only valid for Report-
ing Services reports when Use last business day instead of yesterday in date range is set
to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include
all facilities. This field only becomes active if you select a client from the Client list above.

Par-
ticipation

Select a participant entity to which to limit the report. This list is only populated if you are
using the Participation module.

Member Select a member of the participant entity to which to limit the report. This list is only pop-
ulated if you are using the Participation module.
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Field Description

Account # Select the G/L Account to which to limit the report.

Format Select the report format to be generated:

l Detail as Account/Check #/Date

l Detail as Account/Date/Check #

l Summarize to Account

l Summarize to Account/Client

l Summarize to Account/Date/Source

l Summarize to Date/Account/Source

G/L Group Select a G/L Group to which to limit the report, or leave this field blank to include all G/L
Groups.

Convert to
native cur-
rency

Select this option to convert amounts from the base currency to the native currency (the
currency of the transaction). The conversion occurs on a client-by-client basis. If the cli-
ent has a currency type set and the currency type is different from the default currency,
FactorSoft looks up the conversion rate using the As of date in the currency table for the
client's currency.

For example, if client ABC Company has a currency type of Canadian Dollars and the
daily conversion rate for Canadian dollars is 1.5, the report increases all of the client's
amounts by a factor of 1.5.

Include
Facility

Select this option to include the Facility.

Exclude
Trans-
actions with
Pending
Checks

Select this option to filter out transactions that do not have a check number assigned.

Report Sample

Detail Format

Bulk Collaterals User Guide
Facility Trial Balance Report

408 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Summary Format
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Security Roles

To generate the Facility Trial Balance Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print facility trial balance report
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Monthly Client Trend Report

The Monthly Client Trend report is an analysis of the most recent 24 months of Client activity. The report
compares period to period data over four critical areas which includes:

l Financial information: Client Information > Financials: Summarized balance sheet and income
statement information is entered, saved and accumulated for the client and evaluated in the
report.

l Collateral activity > Collateral Information: Collateral data captured in posting history is trended.

l Loan activity: Facility Information: Loan transactions and loan balance history is used to trend loan
activity.

l Receivables (AR) and Payables (AP): Facility Information > Accounts Payable/Receivable: Addi-
tional input of Receivable and payable monthly summary account balances are used to establish
trends. This information is entered in the Facility > Accounts Payable\Receivable panel.

This report is available on by clicking Monthly Client Trend on the Facility menu in the Reports module.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.
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Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or leave
blank to include all users. When a user is selected, the report is limited to clients that have that
user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.
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Field Description

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Report Sample

Report Calculations

The data in this report is calculated in the thousands. This report also calculates the following ratios:
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l A/R Turn - Beginning Collateral Balance / Gross Cash * 30 days

l Inv Turn - Beginning Collateral Balance / Inventory Removal * 30 days

l Loan Turn - Beginning Loan Balance / Net Cash * Number of Days in the Month

l % Dil – Dilution: EOM total credits+ EOM total discounts * 100 / EOM total sales

l % Yld - Yield: [(EOM total interest + Float + Fees + Deferred Fees / Yield days) * 365 * 100] / Average
Loan Balance

Report Details

Column Description

Date Month/Year starting at the 24th month working down to the current period.

C/A Current Asset - last record created in the period for each date listed

C/L Current Liability - last record created in the period for each date listed

W/C Working Capital - last record created in the period for each date listed

T/D Total Liability - last record created in the period for each date listed

N/W Net Worth - last record created in the period for each date listed

Mos Number of months - last record created in the period for each date listed

REV Net Sales - last record created in the period for each date listed

G/P Gross Profit - last record created in the period for each date listed

B/T Before Tax - last record created in the period for each date listed

Sales Posted Sales - Sum of all sales reported on Certificate Postings for each period lis-
ted in the date column

Cred&Adj Posted Credits and Adjustments - S um of all Credits and Adjustments reported on
Certificate Postings for each period listed in the date column.

Grs Cash Posted Collections - Sum of all Cash Collections reported on Certificate Postings for
each period listed in the date column.

A/R Bulk AR Collateral Balance - last record created in the period for each date listed

AR Inel Bulk AR Ineligible Balance - last record created in the period for each date listed

AR Elig Bulk AR Eligible Collateral Balance - last record created in the period for each date
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Column Description

listed

Inv Bal Bulk Inventory Collateral Balance - last record created in the period for each date
listed

Inv Inel Bulk Inventory Ineligible Balance - last record created in the period for each date lis-
ted

Inv Elig Bulk Inventory Eligible Collateral Balance - last record created in the period for each
date listed

Total Elig Total Eligible - Sum of each of the collateral lines last record created in the period
for each date listed

Adv Facility Transaction Disbursements - Sum of all Facility Disbursement transaction
amounts reported for each period listed in the date column

Net Cash Facility Transaction Type26 > Payments - Sum of all Facility Payment transaction
amounts reported for each period listed in the date column

Loan Bal Loan Balance - last record created in the period for each date listed

A/R Turn Calculated Account Receivable Turn - as calculated for each period listed

Inv Turn Calculated Inventory Turn - as calculated for each period listed

Loan Turn Calculated Loan Turn - as calculated for each period listed

% Dil Calculated Dilution - as calculated for each period listed

Incm Total Income - Sum of all Facility Statement transaction amounts reported for each
period listed in the date column

% Yld Calculated Yield - as calculated for each period listed

0-30 Receivable age bucket 0-30 days - last record created in the period for each date
listed

30-60 Receivable age bucket 31-60 days - last record created in the period for each date
listed

60-90 Receivable age bucket 61-90 days - last record created in the period for each date
listed

Over 90 Receivable age bucket 91+ days - last record created in the period for each date lis-
ted
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Column Description

0-30 Payables age bucket 0-30 days - last record created in the period for each date lis-
ted

30-60 Payables age bucket 31-60 days - last record created in the period for each date lis-
ted

60-90 Payables age bucket 61-90 days - last record created in the period for each date lis-
ted

Over 90 Payables age bucket 91+ days - last record created in the period for each date lis-
ted

System Preferences

To use this report, a System Preference must be set to define how many months of data to update in the
tables each night.

l Identification/system constants > CLMS Engine > Overnight tasks to designate the number of
months to recalculate

NOTE
The report compiles a large amount of information. The nightly engine tasks updates these
tables each date roll. Processing this task could take several hours or more to complete. It is
recommended that the setting be for 1-3 periods. It is generally unnecessary to calculate 24
prior periods every night.

Security Roles

To generate the Monthly Client Trend Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Monthly Client Trend report
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Monthly Position Trend Report

The Monthly Position Trend Report analyzes month end collateral availability trends over time. A facility-
level summary format and a collateral level detail format are included. Each displays the facility or col-
lateral line information and balance at each month-end for the 12 month period preceding the
month/year specified on the Monthly Position Trend Report request screen.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Last com-
pleted
month

Select the month of the last completed submission to be used as the as-of date month for
the report.

Year Enter the year of the last completed submission to be used as the as-of date year for the
report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.
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Field Description

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.
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Field Description

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Format Select the report format to be generated:

l Client Summary : Portfolio-level report that list each facility “Excess/Deficit” value for
each period listed.

l Facility Detail : Loan level report that details the EOM position of each collateral avail-
ability and sums to the EOM Facility totals and EOM Excess Availability.

Report Samples

Client Summary Format

Facility Detail Format
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Security Roles

To generate the Monthly Position Trend Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print monthly position trend report
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Over Advance Report

The facility-level Over Advance Report lists facilities that have a negative facility excess/deficit balance.
Information for each facility returned in the report includes: the Facility Limit, Loan Balance, Available Col-
lateral, Over Advance amount, Days Over, and Low Amount and High Amount over advance.

The default report definition for this report is OverAdvance.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.
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Field Description

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office
to which they are restricted will be selected in the Office field by default and the user will
not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Include
Current
Day in Cal-
culation

Select this option to include the current day in the calculation of number of days ending in
an over advance position.
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Report Sample

Security Roles

To generate the Over Advance Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Over Advance report
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Posted Loan Statement Report

The Posted Loan Statement report allows the user to print or reprint previously posted loan statements - it
does not apply charges and update the account balance. When the user selects a Client and Facility, the
Statement dates for reprint displays the previously run statements available for reprint by the statement
date ranges so that the user can select the statement to be reprinted.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
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Field Description

the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office
to which they are restricted will be selected in the Office field by default and the user will
not be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.
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Field Description

Statement
dates

Select a previously-posted statement to reprint.

Show float
balance

Select this option to include the Float Balance column on the report.

Show daily
interest
amount

Select the option to include the Est. Interest column on the report.

Show com-
pound bal-
ance

Select the option to include the Compound Balance column on the report.

Allow user
to override
para-
meters on
the web

Select this option to allow the ClientWeb user the ability to select parameters when
requesting the report from the Report Queue page in ClientWeb. This option applies to Pos-
ted Loan Statements templates set up as a Web destination and with the Scheduling tab
set to Web request, which allows the selection of the previously run statement to reprint
from the ClientWeb Report Queue at the time the report is requested.
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Report Sample

Report Details

Column Description

Statement Format

Address The Loan Statement Address will display the following:

l Lender Name (in bold print) Located in System Preferences > Iden-
tification/system constants > Name & address > Lender name)

l Client Name

l Facility Description

l Client/Facility Address
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Column Description

Date Displays the day of the Month

Begin Balance Displays the beginning Loan Balance on the specific day

Disbursement Displays the amount of the Loan Disbursement on the specific day

Payment Displays the amount of the Loan Payment on the specific day; if there are multiple
Loan Payments posted on the same day, this column will display the total Loan Pay-
ments for the specific day

Other Displays the amount of Other Loan Transactions. This is typically the Accrual Posting
transactions on the Loan on the specific day

End Balance Displays the ending Loan Balance on the specific day

Float Balance Displays the Float Balance for the day that is calculated as:

Payment column * Float Days (as defined on the Statement Terms > Fee Type Interest
record) + End Balance column

Compound Bal-
ance

Displays the Compound Balance for the day that is calculated as:

Payment Column * Float Days (as defined on the Statement Terms > Fee Type Interest
record) + End Balance column Plus prior day Interest

Est. Interest Displays the calculated daily interest that is calculated as:

(End Balance column or Float Balance (if applicable)) *Rate% / 360 or 365

Number of
Days; Interest
Rate

Displays number of days for the period; displays the interest rate as defined on the
Statement Terms > Fee Type Interest record

Other Charges Displays all Fee Types that are flagged as Active on Facility Statement Terms

Average Daily
Balance

Displays the average of the End Balance for the period

Interest Charge Displays the interest calculated as:

(End Balance or Float Balance total (if applicable) * Rate % / 360 or 365)) * Days in
Period

Other Charges Displays the total of the calculated Other Charges

Total State- Displays the total of the Interest Charge and the Other Charges
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Column Description

ment Charges

Past Due Bal-
ance

Displays any Interest that has not yet been applied to the Loan

Total Due Displays the total of the Interest Charge, Other Charges and Past Due balance.

Column Description

Fee Type Calculation

Fee Description Displays the Description of the Maintenance Fee type on Facility Information > State-
ment Terms

Post Date Displays the date that the fee type was analyzed in the date range the statement was
run

Loan Limit Displays the value in the Facility Information > Limits > Loan Limit field

Available Displays the Net Availability

Ending Balance Displays the Loan Balance as of the end of the reported day

Excess Deficit Displays the difference between the Availability and the Loan Balance

Fee Rate Displays the rate set for that fee type on Facility Information > Statement Terms

Fee Amount Displays the calculated value of the Fee Rate column * Excess Deficit column

Security Roles

To generate the Posted Loan Statement Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print loan statement report (preliminary) and Print loan
statement report (non-preliminary)

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Facility/Collateral Rules (Formerly Asset Based Lending, Periodic statement generation folder.

Preference Description

Max days in advance
to allow posting

Maximum number of days prior to the statement through date to allow
advance posting of statement fees
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Preference Description

For example, if the Max Days = 5 and the system date is 6/25/20 and the state-
ment through date is 6/30/20, the system would allow the posting of the fees
to occur.

If the system date is 6/24/20 and the statement through date is 6/30/20, the
system would not allow the posting of the fees to occur.

Standard Maintenance
Fee Days in Month

Standard number of days in month used to calculate daily maintenance fee
amount

Use control date for
certificate approve
time (T/F)

If True, the Certificate Posting will be posted as of the current date. If False, the
Certificate Posting will be posted as of the date entered.

Use ending date to
determine fee month
(T/F)

If True, the fiscal month the fees will apply to will be determined by the ending
date of the statement. If False, the fees will apply to the date when the state-
ment is run.

Use thru date to
determine statement
post date (T/F)

Determines if the post date for the Loan Statement is the date indicated as the
thru date when running the Loan Statement

For example, if the Thru Date is 6/30/20, this will be the post date of the State-
ment transaction in the system.

Use thru date to
determine accrual
post date (T/F)

Determines if the accrual post date for the Loan Statement is determined by
the thru date when running the Loan Statement.

The system will look at the thru date on the Loan Statement and add the value
in the Facility Information > Statements > Days to wait for posting to determine
the date of the accrual posting.

For example, if the Thru Date is 6/30/20 and the Days to wait for posting = 1, the
accrual posting date will be 7/1/20.

Interest Calculation
Rounding Method

Select the rounding method for periodic generation of loan statements in Fact-
orSoft.

l No rounding limitation

l Limit rounding to 2 decimal places

l Limit rounding to 3 decimal places

l Limit rounding and truncate after 2 decimal places
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Preference Description

Do not calculate
interest float if loan bal-
ance is not positive
(T/F)

Determines if interest on float is calculated on days where the Loan Balance is
negative

Do not calculate
unused line fee if loan
balance is not positive
(T/F)

Determines if the unused line fee (set up under Facility Information > State-
ment Terms > Fee Type = Unused Line) is calculated if the Loan Balance is neg-
ative

Use effective dates
with the spread rate
when calculating
interest (T/F)

Determines if the effective dates on the spread rate is used when calculating
interest

Use tiered basis
method when cal-
culating interest (T/F)

Determines if the Lender can set up multiple interest rates on the Facility
Information > Statement Terms > Fee type = Interest. The multiple rates can be
set up by clicking the “View” button next to the rate under the Interest Rate sec-
tion.

Customize the Statement

To add your logo and footer text to statements set the following in the Administration module, System
Preferences, Facility/Collateral Rules (Formerly Asset Based Lending), Reports, Loan Statement
Reports folder.

Preference Description

Logo Image File
Name

The fully qualified path and file name which the image file is located.

Recommended Logo Size: 1.7” x .8”

Acceptable File Types: .jpg, .tiff, .png

Footer Text drop-down to select the statement text to be used in the footer of the report.

Statement language options are defined on the Statement Text Table screen in
the Tables module.
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Unclaimed Cash Ledger Report

The Unclaimed Cash Ledger provides a summary of cash transactions that have not been posted to Facil-
ity/Loan. The report will also display the transaction of posting the unclaimed cash to the loan. This report
is specific to bulk collateral accounts in FactorSoft.

The default report definition for this report is UnclaimedLedger.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

Bulk Collaterals User Guide
Unclaimed Cash Ledger Report

432 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the adjacent fields.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
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Field Description

on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the report results from the list. Client
Groups are defined in the Group Code Table.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Report Sample

Report Details

Column Description

Date Displays the post date of the Unclaimed Cash Deposit or the Unclaimed Cash
Posting

Reference # Displays the value entered by the User at the time of posting the Unclaimed
Cash Deposit or the Unclaimed Cash Posting

Transaction Type Displays the value of the transaction type; this will be either Unclaimed Deposit
or Unclaimed Cash Posting

Beginning Balance Displays the beginning amount in the Unclaimed Cash account at the time of
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Column Description

posting

Amount Displays the amount of either the Unclaimed Cash Deposit or the Unclaimed
Cash Posting

Ending Balance Displays the ending amount in the Unclaimed Cash account at the time of post-
ing

Security Roles

To generate the Unclaimed Cash Ledger, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Unclaimed Cash Ledger Report
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Unposted Accrued Fees Report

The Unposted Accrued Fees provides you with a listing of the fees and/or interest that have been accrued
since previously generated loan statements.

The default report definition for this report is UnpostedAccruedFees.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

Bulk Collaterals User Guide
Unposted Accrued Fees Report

437 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7

Office Maintenance Table.htm
Client Group Codes Table.htm
Client Group Codes Table.htm


Report Sample

Report Details

Column Description

Client Displays the Client name

Facility Displays the Facility name

Description Displays the Fee Type Description found on Facility Information > Statement
Terms

Posted Date Displays date the accrued fees will be posted to the Loan

Stmt Date Displays the date the Loan Statement was posted to the transaction ledger

Amount Posted Displays the calculated or flat fee amount for each fee type charged on the
Loan Statement

Balance Displays the balance of the calculated or flat fee amount for each fee type on
the Loan Statement

Facility Total Displays the total Amount Posted and Balance for the Facility

Client Total Displays the total Amount Posted and Balance for the Client

Grand Total Displays the grand total Amount Posted and Balance for the Client

Security Roles

To generate the Unposted Accrued Fees, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print Unposted Accrued Fees Report
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Collateral Reports

The Collateral report group contains reports that provide details on collaterals in bulk collateral lending
environments.
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A/R Aging Declaration Report

The A/R Aging Declaration Report summarizes posting activity for the A/R Aging collateral type. This report
is accessed from the Collateral menu of the Reports module.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

Bulk Collaterals User Guide
A/R Aging Declaration Report

441 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Format Select the report format to generate:
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Field Description

l Available: generate the AR Aging Declaration Report highlighting the borrowing base
calculation to “Available at Posting”.

l Aging: generate the AR Aging Report listing data entry by aging bucket.

Report Sample

Available Format

Aging Format
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Report Details

Column Description

Available Format

Category Description for the “Asset Class” set-up by the user to identify the source for the
summary aging information ( usually Debtor Name).

Declaration Date Posting date, defaults to the current date.

Gross Collateral Displays the current collateral value used to support the loan balance.

Aged Ineligible Sum of the data entered in aging bucket(s) that are flagged as ineligible in the
Category set-up.

Other Ineligible Sum of (other) ineligible amounts posted in the Ineligibles declaration.

Eligible Collateral Displays the current Eligible Collateral amounts used to support the loan bal-
ance. (Current Collateral value - Ineligible values)

Bulk Collaterals User Guide
A/R Aging Declaration Report

444 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Column Description

Net Collateral Displays the calculated Net Collateral amount used to support the loan bal-
ance. (Eligible Collateral value * Advance Rate)

Available at Posting Displays the calculated Available Collateral amount used to support the loan
balance. (Lower of Available Limit and Net Collateral Amount)

Aging Format

Gross Collateral Displays the current collateral value used to support the loan balance.

Unbilled Field label for generic aging bucket that user can use for miscellaneous
amounts or for sales not yet booked.

Aging Columns Each aging category is displayed as a separate column, and the outstanding
balance in each of the categories is displayed.

Aged Ineligible Sum of the data entered in aging bucket(s) that are flagged as ineligible in the
Category set-up.

Net Collateral Displays the calculated Net Collateral amount used to support the loan bal-
ance. (Eligible Collateral value * Advance Rate)

Security Roles

To generate the A/R Aging Declaration Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print AR Aging Declaration Report
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A/R Aging Trend Report

The A/R Aging Trend Report screen is used to define the selection criteria for the A/R Aging Trend report.
The A/R Aging Report lists all declarations posted for A/R Aging collateral types within the date range
provided and high-lights the borrowing base calculation to “Available at Posting”. The report provides
details for each financial category for the date range requested. This report is accessed from the Col-
lateral menu of the Reports module.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.
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Report Sample

Report Details

Column Description

Date Posting date

Gross Collateral Displays the current collateral value used to support the loan balance.

Aged Ineligible Sum of the data entered in aging bucket(s) that are flagged as ineligible in the
Category set-up.

Other Ineligible Sum of (other) ineligible amounts posted in the Ineligibles declaration.

Eligible Collateral Displays the current Eligible Collateral amounts used to support the loan bal-
ance. (Current Collateral value - Ineligible values)

Net Collateral Displays the calculated Net Collateral amount used to support the loan bal-
ance. (Eligible Collateral value * Advance Rate)

Available at Posting Displays the calculated Available Collateral amount used to support the loan
balance. (Lower of Available Limit and Net Collateral Amount)

Security Roles

To generate the A/R Aging Trend Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print AR Trend Report
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A/R Monthly Analysis Report

The A/R Monthly Analysis Report summarizes Accounts Receivable posting activity summed by month for
selected client's Bulk AR collateral. This report is accessed from the Collateral menu of the Reports mod-
ule.

The default report definition for this report is ArMonthlyAnalysis.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

Note that inactive clients are filtered out of this report.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.
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Field Description

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.

Dilution Select the desired dilution calculation to use for the Dilution column of the report. The label
of the dilution column in the generated report will reflect the option selected.

l AR Balance: Dilution = Sum of Credits and Discounts / End of Month Accounts Receiv-
able balance.

l Total Sales: Dilution = Credits + Adjustments / Total Sales

l Total Collections: Dilution = Credits + Adjustments / Total Collections

Format Select the report format to generate:

l Monthly detail by facility: produces a report listing each Facility and its transactions
by the specified Date Range.

l Current month portfolio summary: produces a report listing each Facility activity for
the specified Month and Year.

Month If the Current month portfolio summary format is selected, select the month for which to pro-
duce the report.

Year If the Current month portfolio summary format is selected, enter the year for which to pro-
duce the report. If no year is specified, the current year is assumed by default.

Report Sample

Monthly Detail by Facility

Current Month Portfolio Summary
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Report Details

Column Description

Begin Balance Displays Gross AR amount at the beginning of the period being evaluated.

Sales Displays sum of the sales reported in Bulk AR Certificate Postings in the period
being evaluated.

Credits Displays sum of the credits reported in Bulk AR Certificate Postings in the period
being evaluated.

Discounts Displays sum of the discounts input in Bulk AR Certificate Postings in the period
being evaluated.

Adjustments Displays sum of the adjustments input in Bulk AR Certificate Postings in the
period being evaluated.

Collections Displays Collections: sum of the collections input in Bulk AR Certificate Postings
in the period being evaluated.
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Column Description

Over Pays Displays sum of the Over Pays input in Bulk AR Certificate Postings in the period
being evaluated.

End Balance Displays Gross AR amount at the end of the period being evaluated

Ineligible Displays Total Ineligible at the end of the period being evaluated.

Cash Turn Total End of Period Accounts Receivable Balance divided by the Period Total Col-
lections multiplied by the Actual number of Days in the Period.

Sales Turn Total End of Period Accounts Receivable Balance divided by the Period Total
Sales multiplied by the Actual number of Days in the Period.

Dilution l AR Balance: Dilution = Sum of Credits and Discounts / End of Month
Accounts Receivable balance.

l Total Sales: Dilution = Credits + Adjustments / Total Sales

l Total Collections: Dilution = Credits + Adjustments / Total Collections

Security Roles

To generate the A/R Monthly Analysis Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print A/R Monthly Analysis Report
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A/R Trend Report

The A/R Trend report provides a summary of accounts receivable activity. The Report lists all certificate
postings for the Bulk A/R collateral types within the date range provided and also high-lights the bor-
rowing base calculation to “Availablity”. This report is accessed from the Collateral menu of the FactorSoft
Report module.

The default report definition for this report is ARTrends.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.
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Report Sample

Report Details

Column Description

Date Posting date.

Gross Collateral Displays the current collateral value used to support the loan balance.

Ineligible Displays the current total Ineligible amounts.

Eligible Collateral Displays the current Eligible Collateral amounts used to support the loan bal-
ance. (Current Collateral value - Ineligible values)

Adv. Rate Displays the Advance Rate set for the Collateral.

Net Collateral Displays the calculated Net Collateral amount used to support the loan bal-
ance. (Eligible Collateral value * Advance Rate)
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Column Description

Limit Displays the loan limit for the Collateral.

Availability Displays the sum of the calculated Available Collateral amounts used to sup-
port the loan balance. (Lower of Loan Limit and Net Collateral amount)

Security Roles

To generate the A/R Trend Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print A/R Trend Report
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Availability Certificate Report

The Availability Certificate report is used to show the current loan position which and provide a method to
make an advance request. The report includes a user defined (see system preference) header and footer
instruction section and a form with availability certificate and advance request. This report is accessed
from the Collateral menu of the Reports module.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
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Field Description

matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.
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Report Sample

Report Details

Column Description

Facility Displays Facility Name

Collateral Displays the Collateral Name

Limits Displays the loan limit for the Collateral

Gross Collateral Displays the current collateral value used to support the loan balance

Total Ineligible Displays the Total Ineligibles for each Collateral as shown on the Collateral
Information screen under Collateral Summary.

Eligible Collateral Displays the current Eligible Collateral amounts used to support the loan bal-
ance. (Current Collateral value - Ineligible values)
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Column Description

Net Collateral Displays the calculated Net Collateral amount used to support the loan bal-
ance. (Eligible Collateral value * Advance Rate)

Available Displays the calculated Available Collateral amount used to support the loan
balance. (Lower of Available Limit and Net Collateral Amount)

Balance Displays the Facility Balance as shown on the Facility Summary screen under
Facility Summary.

Excess Displays the excess (cash that can be distributed)

Security Roles

To generate the Cash Posting Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print Availability Certificate Report

System Preferences

The following system preferences for this report are located in the Administration module, System Prefer-
ences, Reports, Availability Certificate folder.

Preference Description

Availability Certificate
heading text

Select specific text that will appear in the Heading section of the Availability Cer-
tificate Report

This text is set at Tables > Statements & Letters > Statement Text Table

Availability Certificate
footer text

Select specific text that will appear in the Footer section of the Availability Cer-
tificate Report

This text is set at Tables > Statements & Letters > Statement Text Table

SQL Reports module
name

Used to assign the SQL reports module a name
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Bulk Inventory Trend Report

The Bulk Inventory Trend report provides a of inventory receivable activity. The Report lists all certificate
postings for the Bulk Inventory collateral types within the date range provided and also high-lights the bor-
rowing base calculation to “Availability”. This report is accessed from the Collateral menu of the Fact-
orSoft Report module.

The default report definition for this report is BulkInvTrend.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.
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Report Sample

Report Details

Column Description

Client Displays Client Name

Facility Displays Facility Name

Collateral Displays the Collateral Name

Date Displays the date of the posting

Gross Collateral Displays the current collateral value used to support the loan balance

Ineligible Displays the Ineligibles as shown on the Collateral Information screen under Col-
lateral Summary

Eligible Collateral Displays the current Eligible Collateral amounts used to support the loan bal-
ance. (Current Collateral value - Ineligible values)

Adv. Rate Displays the advance rate used for the collateral

Net Collateral Displays the calculated Net Collateral amount used to support the loan bal-
ance. (Eligible Collateral value * Advance Rate)

Limits Displays the loan limit for the Collateral

Availability Displays the calculated Available Collateral amount used to support the loan
balance. (Lower of Available Limit and Net Collateral Amount)
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Security Roles

To generate the Bulk Inventory Trend Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print Bulk Inventory Trend Report
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Bulk Inventory Monthly Analysis Report

The Bulk Inventory Monthly Analysis Report summarizes Inventory Posting activity summed by month for
selected Client's Bulk Inventory collateral. This report is accessed from the Collaterals menu of the Reports
module.

The default report definition for this report is InvMonthlyAnalysis and InvMonthlyAnalysis2.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:
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Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Format Select the report format to generate:
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Field Description

l Monthly detail by facility: produces a report listing each Facility and its transactions
by the specified Date Range.

l Current month portfolio summary: produces a report listing each Facility activity by
the specified Month and Year.

Month If the Current month portfolio summary format is selected, select the month for which to pro-
duce the report.

Year If the Current month portfolio summary format is selected, enter the year for which to pro-
duce the report. If no year is specified, the current year is assumed by default.

Report Sample

Monthly Detail by Facility

Current Month Portfolio Summary
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Report Details

Column Description

Purchase Turn # of Days, Total End of period Inventory Balance divided by the period total Purchases
multiplied by the actual number of days in the period.

Usage Turn # of Days, Total End of period Inventory Balance divided by the period total Usage
multiplied by the actual number of days in the period.

Dilution - Invent-
ory Balance

Percentage, Period Total Removed divided by the end of period Inventory

Dilution - Addi-
tions

Percentage, Period Total Removals divided by the end of period Total Additions

Dilution - Reduc-
tions

Percentage, Period Total Removals divided by the end of period Total Reductions

Security Roles

To generate the Bulk Inventory Monthly Analysis Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print Bulk Inventory Monthly Analysis Report
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Tracked Collateral Summary Report

The Tracked Collateral Summary Report is presented by client in three sections: Accounts Receivable
Aging, Ineligibles by Reason, and Concentration, and provides trending and analysis information for
Tracked AR data. The report is produced from a selected Last completed month and Year as-of date, and
displays up to six preceding submissions for analysis. A Format option allows the user to select whether to
locate the last submission in the most recent completed month or quarter, and report the preceding
month or quarter ends in prior months, quarters, or years. The report can be filtered by Client, A/E, Office,
Client Group/Value, Facility and/or Collateral.

Report Parameters

Field Description

Last com-
pleted
month

Select the month of the last completed submission to be used as the as-of date month for
the report.

Year Enter the year of the last completed submission to be used as the as-of date year for the
report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
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Field Description

s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
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Field Description

this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Format Select the report format to be generated:

l Monthly

l Quarterly

l Annual
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Report Sample
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Healthcare Receivable Monthly Analysis Report

The HR (Healthcare Receivables) Monthly Analysis Report summarizes HC Receivable posting activity
summed by month for selected client's Bulk HR collateral . This report is accessed from the Collaterals
menu of the Reports module.

Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

Bulk Collaterals User Guide
Healthcare Receivable Monthly Analysis Report

479 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Description

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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Field Description

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Dilution Select the desired dilution calculation to use for the Dilution column of the report. The label
of the dilution column in the generated report will reflect the option selected.
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Field Description

l AR Balance: Dilution = Sum of Credits and Discounts / End of Month Accounts Receiv-
able balance.

l Total Sales: Dilution = Credits + Adjustments / Total Sales

l Total Collections: Dilution = Credits + Adjustments / Total Collections

Format Select the report format to generate:

l Monthly detail by facility: produces a report listing each Facility and its transactions
by the specified Date Range.

l Current month portfolio summary: produces a report listing each Facility activity by
the specified Month and Year.

Month If the Current month portfolio summary format is selected, select the month for which to pro-
duce the report.

Year If the Current month portfolio summary format is selected, enter the year for which to pro-
duce the report. If no year is specified, the current year is assumed by default.

Report Sample

Monthly Detail by Facility

Current Month Portfolio Summary
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Report Details

Column Description

Cash Turn Total End of Period Accounts Receivable Balance divided by the Period Total Col-
lections multiplied by the Actual number of Days in the Period.

Sales Turn Total End of Period Accounts Receivable Balance divided by the Period Total
Sales multiplied by the Actual number of Days in the Period.

Dilution l AR Balance: Dilution = Sum of Credits and Discounts / End of Month
Accounts Receivable balance.

l Total Sales: Dilution = Credits + Adjustments / Total Sales

l Total Collections: Dilution = Credits + Adjustments / Total Collections

Security Roles

To generate the Bulk Inventory Monthly Analysis Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Collateral > Print Healthcare Monthly Analysis Report
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Inventory Declaration Report

The Inventory Declaration Report summarizes declarations on Inventory collaterals for selected clients dur-
ing a selected date range. This report is accessed from the Collaterals menu of the Reports module.

The default report definition for this report is InvenDeclaration.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
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Field Description

date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
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Field Description

which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.
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Report Sample
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Inventory Trends Report

The Inventory Trends report summarizes the financial trends of an Inventory collateral over a specified
period of time. This report is accessed from the Collateral menu of the FactorSoft Report module.

The default report definition for this report is InvenTrends.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
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Field Description

date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
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Field Description

which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Report Sample
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Summary A/R Declaration Report

The Summary A/R Declaration report summarizes declarations on Summary A/R collaterals for selected
clients during a selected date range. .The results detail each category of the receivable. This report is
accessed from the Collaterals menu of the Reports module. The results detail each category of the receiv-
able.

The default report definition for this report is MedRecDeclaration.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)
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If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
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Field Description

erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Format Select the report format to be generated:

l Available: generate the availability format of the Summary AR Declaration Report

l Aging: generate the aging format of the Summary AR Declaration Report
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Report Sample
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Summary A/R Trends Report

The Summary A/R Trends report summarizes the financial trends of a Summary AR collateral over a spe-
cified period of time. This report is accessed from the Collaterals menu of the Reports module.

The default report definition for this report is MedRecTrend.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.
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Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.
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Field Description

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Report Sample
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Tracked Ineligibility Listing Report

The Tracked Ineligible Listing Report lists Tracked AR submission ineligibles by debtor within ineligibility cat-
egory. The report is produced from a selected As Of Date, and can be filtered by Client, A/E, Office, Client
Group/Value, Facility and/or Collateral.

Report Parameters

Field Description

As Of
Date

Select the ending date of the date range for the report.

l Current date

l Previous month-end date

l Specific date

l Set At Run Time (Web Template Only)

If Specific date is selected, specify the as-of date in the field to the right.

If Set At Run Time (Web Template Only) is selected, when the report is clicked in the Cli-
entWeb Report Queue, a screen appears to choose the date range (Current Date, Previous
Month-End Date, or Specific Date).

Year Enter the year of the last completed submission to be used as the as-of date year for the
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Field Description

report.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.
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Field Description

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

Sample Report
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Tracked Ineligibility Report

The Tracked Ineligibility Report provides three report formats for viewing ineligibles identified in the
Tracked AR module.

The default report definitions for this report is TrackIneligSumm, TrackIneligDet1, and TrackIneligDet2.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.
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TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Collateral Select an Inventory collateral for the selected facility to which to limit the report, or leave
blank to report on all collaterals for the selected facility.

As Of
Date

Select the ending date of the date range for the report. Choose Current date, Previous
month-end date, or specify a Specific date in the field to the right.
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Field Description

Format Select the report format to be generated:

l Summary by Category

l Detail by Category

l Detail by Invoice

Show
both pos-
ted and
pending

Select this option to include pending imports in the report results.

Report Sample
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Facility Reports

The Facility report group contains reports that provide details on facilities in bulk collateral lending envir-
onments.

Loan Statement

The Loan Statement provides a financial statement for a specific facility. When run with the Preliminary
option cleared, this statement calculates the interest fee for the period selected. An additional page for
each Available, Eligible, Gross, and/or Net Collateral fee type for the facility is included. Additional state-
ment pages list each day in the period with daily average balance detail for Gross Collateral, Ineligible
Collateral, Eligible Collateral, and Net Collateral, as well as Available balance and Limit Amount. An Aver-
age line displays the period average for each column. Note that the collateral column for which the Fee
Type is calculated is displayed in bold type, and the period and rate on which the fee is calculated is also
displayed.

This report is accessed from the Facility menu of the Reports module.

Field Description

Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Template
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name and click the save button to create a new template for this report, then
select the template from the Templates tab and make any applicable para-
meter and scheduling selections to complete the template.

Click this button to save a report template.

Click this button to close the report screen.

Click this button to generate the report to the selected Output format.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

If you leave this field blank, you cannot make selections in the Facility or Collateral fields.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-

Bulk Collaterals User Guide
Facility Reports

505 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7
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erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report is
to be generated.

Facility
Group

Select a facility group code (as defined in the Client Group Code Table) to which to limit
the report, or leave this field blank to include all facility groups.

Statement
to reprint

Select a previously-run statement to reprint. Using this option prints a copy of the report
and does not apply additional charges against the account balance.

Output Select one of the following reprint output option from the drop-down list:

l Preview to preview the report on the window before printing it.

l Print to print the report without previewing it.

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Note: When the Preliminary check box is checked, the Statement output is Preview only.
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Field Description

Date
Range

Select the date range for the report:

l Month to Date: displays the first day of the current FactorSoft processing month in
From date and the current FactorSoft processing date in the Thru date.

l Last Month: displays the first day of the previous FactorSoft processing month in
From date and the last day of the previous FactorSoft processing month in the Thru
date.

l Yesterday: displays the of the previous FactorSoft processing day date in the From
date and Thru date fields.

l Today: displays the of the current FactorSoft processing day date in the From date
and Thru date fields.

From date Enter the beginning date of the date range for records to be selected for the report.

Thru date Enter the ending date of the date range for records to be selected for the report.

Pre-
liminary

If this box is flagged, the Loan Statement will run only as a report using the Preview Output
option. If this box is not flagged, the Loan Statement will run and post the appropriate fees
to the Loan using the output preference from Facility Information > Statement panel >
Output.

Show float
balance

If this box is flagged, the Loan Statement will include a column to show the Float Balance
based on payments posted to the Loan.

Show daily
interest
amount

Select the option to include the Est. Interest column on the report.

Show Com-
pound Bal-
ance

If this box is flagged, the Loan Statement will show the Compound Balance column.
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Report Samples
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Report Details

Column Description

Statement Format

Address The Loan Statement Address will display the following:
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Column Description

l Lender Name (in bold print) Located in System Preferences > Iden-
tification/system constants > Name & address > Lender name)

l Client Name

l Facility Description

l Client/Facility Address

Date Displays the day of the Month

Begin Balance Displays the beginning Loan Balance on the specific day

Disbursement Displays the amount of the Loan Disbursement on the specific day

Payment Displays the amount of the Loan Payment on the specific day; if there are multiple
Loan Payments posted on the same day, this column will display the total Loan Pay-
ments for the specific day

Other Displays the amount of Other Loan Transactions. This is typically the Accrual Post-
ing transactions on the Loan on the specific day

End Balance Displays the ending Loan Balance on the specific day

Float Balance Displays the Float Balance for the day that is calculated as:

Payment column * Float Days (as defined on the Statement Terms > Fee Type
Interest record) + End Balance column

Compound Bal-
ance

Displays the Compound Balance for the day that is calculated as:

Payment Column * Float Days (as defined on the Statement Terms > Fee Type
Interest record) + End Balance column Plus prior day Interest

Est. Interest Displays the calculated daily interest that is calculated as:

(End Balance column or Float Balance (if applicable)) *Rate% / 360 or 365

Number of Days;
Interest Rate

Displays number of days for the period; displays the interest rate as defined on the
Statement Terms > Fee Type Interest record

Other Charges Displays all Fee Types that are flagged as Active on Facility Statement Terms

Average Daily Bal-
ance

Displays the average of the End Balance for the period

Interest Charge Displays the interest calculated as:
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Column Description

(End Balance or Float Balance total (if applicable) * Rate % / 360 or 365)) * Days in
Period

Other Charges Displays the total of the calculated Other Charges

Total Statement
Charges

Displays the total of the Interest Charge and the Other Charges

Past Due Balance Displays any Interest that has not yet been applied to the Loan

Total Due Displays the total of the Interest Charge, Other Charges and Past Due balance.

Fee Type Calculation Format

Note: This format is for the Fee Type “Maintenance” and Calculate Based on “Out of Formula”

Fee Description Displays the Description of the Maintenance Fee type on Facility Information > State-
ment Terms

Post Date Displays the date that the fee type was analyzed in the date range the statement
was run

Loan Limit Displays the value in the Facility Information > Limits > Loan Limit field

Available Displays the Net Availability

Ending Balance Displays the Loan Balance as of the end of the reported day

Excess Deficit Displays the difference between the Availability and the Loan Balance

Fee Rate Displays the rate set for that fee type on Facility Information > Statement Terms

Fee Amount Displays the calculated value of the Fee Rate column * Excess Deficit column

Security Roles

To generate the Loan Statement Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Facility > Print loan statement report (preliminary)

l Security Roles > Reports > Facility > Print loan statement report (non-preliminary)
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System Preferences

The following system preferences for this report are found in the Administration module, System Prefer-
ences, Facility/Collateral Rules (Formerly Asset Based Lending), Periodic statement generation folder.

Preference Description

Max days in advance
to allow posting

Maximum number of days prior to the statement through date to allow
advance posting of statement fees.

For example:

l If the Max Days = 5 and the system date is 6/25/20 and the statement
through date is 6/30/20, the system would allow the posting of the fees to
occur.

l If the system date is 6/24/20 and the statement through date is 6/30/20,
the system would not allow the posting of the fees to occur.

Standard Main-
tenance Fee Days in
Month

Standard number of days in month used to calculate daily maintenance fee
amount.

Use control date for
certificate approve
time (T/F)

If True, the Certificate Posting will be posted as of the current date. If False, the
Certificate Posting will be posted as of the date entered.

Use ending date to
determine fee month
(T/F)

If True, the fiscal month the fees will apply to will be determined by the ending
date of the statement. If False, the fees will apply to the date when the state-
ment is run.

Use thru date to
determine statement
post date (T/F)

Determines if the post date for the Loan Statement is the date indicated as the
thru date when running the Loan Statement

For example, if the Thru Date is 6/30/20, this will be the post date of the State-
ment transaction in the system.

Use thru date to
determine accrual
post date (T/F)

Determines if the accrual post date for the Loan Statement is determined by the
thru date when running the Loan Statement. The system will look at the thru
date on the Loan Statement and add the value in the Facility Information >
Statements > Days to wait for posting to determine the date of the accrual
posting.

For example, if the Thru Date is 6/30/20 and the Days to wait for posting = 1, the
accrual posting date will be 7/1/20.
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Preference Description

Interest Calculation
Rounding Method

Select the rounding method for periodic generation of loan statements in Fact-
orSoft.

l No rounding limitation

l Limit rounding to 2 decimal places

l Limit rounding to 3 decimal places

l Limit rounding and truncate after 2 decimal places

Do not calculate
interest float if loan
balance is not pos-
itive (T/F)

Determines if interest on float is calculated on days where the Loan Balance is
negative

Do not calculate
unused line fee if loan
balance is not pos-
itive (T/F)

Determines if the unused line fee (set up in Facility Information > Statement
Terms > Fee Type = Unused Line) is calculated if the Loan Balance is negative

Use effective dates
with the spread rate
when calculating
interest (T/F)

Determines if the effective dates on the spread rate is used when calculating
interest

Use tiered basis
method when cal-
culating interest (T/F)

Determines if the Lender can set up multiple interest rates on the Facility
Information > Statement Terms > Fee type = Interest. The multiple rates can
be set up by clicking the “View” button next to the rate under the Interest Rate
section.

Customize the Statement

To add your logo and footer text to statements set the following in the Administration module, System
Preferences, Facility/Collateral Rules (Formerly Asset Based Lending), Reports, Loan Statement
Reports folder.

Preference Description

Logo Image File
Name

The fully qualified path and file name which the image file is located.

Recommended Logo Size: 1.7” x .8”

Acceptable File Types: .jpg, .tiff, .png
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Preference Description

Footer Text drop-down to select the statement text to be used in the footer of the report.

Statement language options are defined on the Statement Text Table screen in
the Tables module.
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Position Summary Report

The Position Summary report provides an overview of each client’s facility information, broken down by cli-
ent, facility, and collateral.

NOTE
The disclaimer “Post dated transactions are not included” appears at the top of these reports to indic-
ate that only transactions from the As Of date to the current FactorSoft processing date are included
on the report.

Field Description

Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Template
name and click the save button to create a new template for this report, then
select the template from the Templates tab and make any applicable para-
meter and scheduling selections to complete the template.
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Field Description

Click this button to save a report template.

Click this button to close the report screen.

Click this button to generate the report to the selected Output format.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

If you leave this field blank, you cannot make selections in the Facility fields.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
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Field Description

menu, click Tables. Then, on the Client & Debtor menu, click Office.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.

Client
Group

Select the client group (as defined in the Client Group Code Table) for which this report is to
be generated.

Value Select the client group’s value (as defined in the Client Group Code Table) for which this
report is to be generated.

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Facility
Group

Select a facility group code (as defined in the Client Group Code Table) to which to limit the
report, or leave this field blank to include all facility groups.

Value Select the facility group’s value (as defined in the Client Group Code Table) for which this
report is to be generated.

Format Select the report format to be generated:

l Client Detail

l Client Summary

l Facility Summary

l Loan Status
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Report Samples

Client Detail Format

The Position Summary – Client Detail format includes each Facility’s Collateral Description, Currency, Col-
lateral Type, Limits, Adv Rate, Gross Collateral, Total Ineligible, Net Collateral, Eligible Collateral, Availability,
Balance, and Excess/Deficit. A Grand Total line totals the Availability, Balance, and Excess/Deficit columns
for all clients included in the report. The Detail report also includes transaction detail and collateral post-
ing detail for the current day.

Client Summary Format

The Position Summary format includes each Facility’s Collateral Description, Currency, Collateral Type, Lim-
its, Adv Rate, Gross Collateral, Total Ineligible, Net Collateral, Eligible Collateral, Availability, Balance, and
Excess/Deficit. A Grand Total line totals the Availability, Balance, and Excess/Deficit columns for all clients
included in the report.
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Facility Summary Format

The Facility Summary format returns a similar report, but instead of grouping the report by facility within
client, all facilities are listed individually as <client name>/<facility name>.

Loan Status Format

The Loan Status format includes information about loans for each client.
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Facility Trend Card Report

The Facility Trend Card Report provides a 13 month trend analysis and includes Loan Summary, Revenue
Summary, Accounts Receivable Summary, and Inventory Summary reports. The 13 month period includes
the month of the current working date and the 12 months preceding the current working date. This report
is accessed from the Facility menu of the Reports module.

Field Description

Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Template
name and click the save button to create a new template for this report, then
select the template from the Templates tab and make any applicable para-
meter and scheduling selections to complete the template.

Click this button to save a report template.

Click this button to close the report screen.
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Field Description

Click this button to generate the report to the selected Output format.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

If you leave this field blank, you cannot make selections in the Facility fields.

Facility Select the facility for the selected client to include in the report or leave blank to include all
facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.
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Field Description

To limit the A/E field to list only those users that have been marked as an A/E, use the following
System Preference:

l Terminology > Select account executive based on check box: TRUE

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report is to
be generated.

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.
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Report Sample
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Trial Balance Report

The Trial Balance Report is a summary of daily transactions. This report can display results in a variety of
formats. This report is accessed from the Facility menu of the Reports module.

Field Description

Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Template
name and click the save button to create a new template for this report, then
select the template from the Templates tab and make any applicable para-
meter and scheduling selections to complete the template.

Click this button to save a report template.

Click this button to close the report screen.
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Field Description

Click this button to generate the report to the selected Output format.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to
500 matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

If you leave this field blank, you cannot make selections in the Facility fields.

Facility Select the facility for the selected client to include in the report or leave blank to include
all facilities. This field only becomes active if you select a client from the Client list above.

If you leave this field blank, you cannot make a selection in the Collateral field.

Par-
ticipation

Select a participant entity to which to limit the report. This list is only populated if you are
using the Participation module.

Member Select a member of the participant entity to which to limit the report. This list is only pop-
ulated if you are using the Participation module.

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to
generate the report within that office restriction. When the user generates a report, the
office to which they are restricted will be selected in the Office field by default and the
user will not be able to change the Office field when generating the report.
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Field Description

Offices are defined in the Office table in the Tables feature. To access this table, on the
File menu, click Tables. Then, on the Client & Debtor menu, click Office.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

C/O Select a Credit Officer to which to limit the report, or leave blank to include all C/O’s.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the client group’s value (as defined in the Group Code Table) for which this report
is to be generated.

G/L Group Select the G/L Account Group to which to limit the report.

Account # Select the G/L Account to which to limit the report.

Format Select the report format to be generated:

l Detail as Account/Check #/Date

l Detail as Account/Date/Check #

l Summarize to Account

l Summarize to Account/Client

l Summarize to Account/Date/Source

l Summarize to Date/Account/Source

Date Range Select the date range for the report:
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Field Description

l Month to Date: displays the first day of the current FactorSoft processing month in
From date and the current FactorSoft processing date in the Thru date.

l Last Month: displays the first day of the previous FactorSoft processing month in
From date and the last day of the previous FactorSoft processing month in the Thru
date.

l Yesterday: displays the of the previous FactorSoft processing day date in the From
date and Thru date fields.

l Today: displays the of the current FactorSoft processing day date in the From date
and Thru date fields.

From date Enter the beginning date of the date range for records to be selected for the report.

Thru date Enter the ending date of the date range for records to be selected for the report.

Output Select one of the following print output option from the drop-down list:

l Preview to preview the report on the window before printing it

l Print to print the report without previewing it

l Fax to fax the report directly to the selected client.

l Email to email the report directly to the selected client.

Report Samples
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Parameters Tab

The Schedule Services screen open to the Parameters tab, where you can select the service to use for the
scheduled event.

NOTE
The Schedule Date Change service is used to schedule the date roll for use with the Engine only. If your
installation uses the Engine, you must schedule the Schedule Date Change service to enable the date
roll process. If the Desktop Service is being used instead of the Engine, the date roll is enabled through
System Preference Identification/system constants, Engine, Allow service to change date.

Field Description

Service Template This field is used to define or select service templates to be created, updated, or
deleted using the Schedule Services screen.

Service From this list, select the service to be scheduled. The Schedule Date Change,
Send Email and Send Fax services are available for all installations. Other ser-
vices listed will be dependent upon the Add-on modules purchased for your
installation of FactorSoft.
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Scheduling Tab

Use the Scheduling tab to set the interval at which the service is to be polled and executed by the Engine.

Field Description

Template only Defer selecting a scheduled polling time. The Engine will not execute tasks
marked as Template Only

Run once per sched-
ule

Execute the task once, at the next periodic polling of the database.

Run once per sched-
ule

Set a schedule to poll the service. Select a date in the adjacent calendar and
enter the time at which the service should start.

Every Enter an interval number in the first field and select the interval from the drop-
down list. The available options are: Day Week Month Year.

Day of the week Select this option and the applicable weekday in the adjacent list to poll on a
weekly basis. To poll at a specific time of day, enter the time in the adjacent
Time field.

Week of the Month Select the applicable week in the adjacent list, and select the applicable week-
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Field Description

day from the Day drop-down list to poll during a specific week each month. To
poll at a specific time of day, enter the time in the adjacent Time field.

Same Day Every
Month

Select a date in the adjacent calendar and enter the time at which service or
report is to be polled to poll on a specific day each month.

Event Not used.

Fax/email subject If Email or Fax output methods are selected, enter a subject description in this
field to appear in the subject line of the email or Fax.

Processes that do not allow email/fax distribution will not display this field.

Email address If the Email output method is selected, enter a body text to appear in the body
of the email.

Processes that do not allow email/fax distribution will not display this field.

Email message If the Email output method is selected, enter the email address or addresses to
which the email is to be sent.

Processes that do not allow email/fax distribution will not display this field.
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Using the Templates Tab

The Templates tab lists the saved templates (if any) for the report. These are the reports that have been
scheduled to be run by the engine.

On this tab you can select a template to open it and then work with it, delete a template you no longer
need, place a scheduled template on hold, retry a template job that has failed, or view the history for a
template report.

The list shows the following information for each template.
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l Description – Name given to the template when it was created (or last modified).

l Interval – The interval defined for the template (on the Scheduling tab).

l Status – Indicates the status of the scheduled template.

l Waiting – Report is waiting to be run by the engine.

l Running Complete – Report is running or completed.

l Held by user – Report was put on hold. If a report is on hold, select it and click the Retry but-
ton to release the hold.

l Failed/Unknown – The scheduled report has failed or the status is unknown.If the report has
failed, select it and click the Retry button to reset the report and have the system try again
(based on the interval).

l Next Run – Shows when the report will next run, if applicable.

Use the buttons defined in the table below to work with the templates in the list.

Button Use To:

Refresh Updates the list to show the most recent information.

Hold Places the scheduled template on hold. Templates that are on hold are not run
by the engine until the hold is released (use the Retry button).

Delete Permanently deletes the template from the system.

Retry Retries a template that has failed (Failed/Unknown status) or releases the hold
on a template (Held status).

History Shows the history for the template which details when the template Report
Detail history for the selected report job.

Select Click this button to modify the Parameters and/or Scheduling options for the
template.
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Scheduling Services

You can schedule web service based events to be processed by the Engine. This is done on the Schedule
Services screen.

To open the Schedule Services screen, in Administration module, on the System menu, click Schedule
FactorSoft Task Processor. The Schedule Services screen has three tabs used to define, schedule, and
manage services:

l Parameters Tab

l Scheduling Tab

l Templates Tab

How to Schedule Services

Following are instructions for using the Schedule Services screen to schedule an event to be processed
automatically by the Engine.

To schedule a service from the Schedule Services screen:
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1. In the System Menu of the Administration module, select Schedule FactorSoft Task Processor.

The Schedule Services screen opens.

2. Select the Service to use for the scheduled task.

3. Enter the template name in the Service Template field.

4. Click the Save button to save the template name.

A confirmation message appears. Click OK to clear the message.

5. Select the Templates tab.

6. Select the template from the list and click the Select button.
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7. Select the Scheduling tab.
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8. In the Repeat Interval group, select the desired interval option and specify the frequency (where
applicable) that the Engine polls for the event on behalf of this template.

9. Click Save.
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Setting Printing Preferences

FactorSoft’s print preference option allows you to distribute reports and statements according to a client
or debtor's individual needs.

Use the Client Information Screen (Upper Fields) and the Debtor Information Screen to define client and
debtor preferences respectively, and choose from the following options:

l Select Print to print reports and statements and mail them to the client or debtor.

l Select Fax to fax reports and statements to the client or debtor directly from FactorSoft. For more
information about faxing reports, see "Setting Up Faxing" on page 539.

l Select Email to email reports and statements to the client or debtor directly from FactorSoft.

l Select Folder to save the report or statement in PDF format to a user-specified disk folder.

In addition, clients must be assigned client codes to be able to use the folder preference feature. (Once
saved, the PDF file uses the following name format: Client#_ReportID_YYMMDD_SSS.PDF, where Client# is
the user-assigned client code, Report ID is a system-defined report name, and SSS is a system-defined
sequence).

NOTE
FactorSoft gives you the option to include more than one fax number or email address when dis-
tributing reports and statements. To email or fax reports to several contacts within the client’s com-
pany, open each contact’s Add New Contact Screen, fill in any appropriate fields, and check the
Attention box to include the contact in the client’s report distribution list. Depending on the client’s
report preferences, FactorSoft automatically includes the contact’s email address or fax numbers
when generating outgoing reports.

When generating reports and statements, FactorSoft always gives you the option to preview the doc-
uments before printing, faxing, or emailing them.

System Preferences

The following system preferences for this function are located in the Administration module, System Prefer-
ences, Data entry behavior, Imaging folder.

Preference Description

Maximum images
per email

Set the number of images to allow per email that is reasonable based on the
average size of your images
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The following system preferences for this function are located in the Administration module, System Prefer-
ences, Identification/system constants, Interface parameters, Preference folder printing folder.

Preference Description

Folder for saved
reports

Enter the name and location of the folder in which you want to save the client’s
PDF reports.

The following system preferences for this function are located in the Administration module, System Prefer-
ences, Identification/system constants, System constants folder.

Preference Description

Emailed reports
should be sent using

Select SMTP or MAPI as the preferred way to send email.

SMTP Hostname Enter your SMTP host address, e.g. mail.your company.com.

SMTP default sender
email address

Enter the address that will show as the "From" address on the email. This can be
set here as a system default.

SMTP default sender
display name

Specify the name that will show up as the sender. Some users may want the
company name to show as the system default.

SMTP host requires
authentication

Specify whether the host expects you to supply a username and password. If
true, you must supply those in the user preferences.

User Preferences

The following user preferences must be configured in the Email Parameters tab of the User Preferences
screen.

Preference Description

From email address Set the email address to override the system default from
address. An email address must be entered either at the
user or system level for an email to send correctly.

From display name Enter a name to override the system default from display
name if supplied for the user. If one is not entered the
from address is displayed.

Username and pass-
word

These are only enabled if the system preference says
authentication is required. If it is required, you must sup-
ply both of these credentials to correctly send an email.
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Setting Up Faxing

To use fax output option for reports and notices, a third party fax software solution for sending faxes must
be configured. Typically, these solutions require a fax server application be deployed, as well as a fax cli-
ent that must be deployed on each FactorSoft user's computer.

Fax solutions currently supported in FactorSoft are:

l Equisys ZetaFax®

l GFI FaxMaker®

l Sagem-Interstar LightningFAX®

You can configure FactorSoft to automatically produce fax output when reports and/or statements are
generated from Preference-enabled-reports.

To configure FactorSoft to automatically produce faxes:

1. In User Preferences, select the installed fax software solution in the Report fax driver and Prefer-
ence fax driver fields on the Print/Faxing Parameters tab of the User Preferences screen in the Fact-
orSoft Systems menu.

2. Select Fax in the Preference field in the upper fields of the Client Information and Debtor inform-
ation screens for the clients and debtors to be included in automatic fax distribution of reports
and/or statements.

NOTE
FactorSoft gives you the option to include more than one fax number or email address when dis-
tributing reports and statements. To email or fax reports to several contacts within the client’s
company, open each contact’s Add New Contact Screen, fill in any appropriate fields, and
check the Attention box to include the contact in the client’s report distribution list. FactorSoft
automatically includes the contact’s fax numbers when generating outgoing reports. See "Set-
ting Printing Preferences" on page 537 for more information.

3. Ensure that each client and debtor to be included in automatic fax distribution have a valid fax num-
ber in the Address panel.

NOTE
Contacts with Attention must also have a valid fax number recorded in the Contact Information
screen.
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Using the Client Summary Worksheet

Business methods among lenders vary greatly; consequently, their requirements for personalized reports
vary as well. The Client Summary Worksheet in FactorSoft was developed with customization in mind. With
it, you can create ad hoc reports based on many predefined data fields from the Client and CalcClient
tables and then save the report as a template to be reused over and over again.
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Client Summary Worksheet Basics

The Client Summary Worksheet is template-driven. This means that a skeleton report template is first cre-
ated in Microsoft Excel, and then is executed in the Reports module to extract data from the FactorSoft
database, populate the report with the client data, and print the report as a completed Excel spreadsheet.
The spreadsheet can then be transformed into output in any of the ways that you typically associate with
an Excel spreadsheet (print, PDF, data file, etc.).

Excel Spreadsheets

Since the underlying templates of the Client Summary Worksheet are based on Excel spreadsheets, you
can utilize the page layout, formulas, sorting/filtering, and chart features of Excel to customize your
reports. Reports can be as simple or complex as you desire, with the following limitations:

l Must be stored in the FactorSoft Reports directory.

l Must have a horizontal format.

l One line per client.

l Must always have one empty “H” row between the last header row and the first client (repeating
data) row.

l Must always be one empty “H” row between the last client (repeating data) row and the overall
Total row.

l Sort fields will automatically include subtotals and an overall total at the end.

You can create templates for as many reports as you require, and each template can be used again and
again.

FactorSoft Field Codes

There are four sets of field codes that you can utilize to extract client and financial data from the Fact-
orSoft and ABL databases for display in your reports:

l Client Oriented Field Codes (various data from Client, Client Terms, and Tables views)

l Client Calc Field Codes (calculated financial data from FactorSoft tables)

l Clients Table (data fields in the Clients Table)

l ABL Field Codes (data from ABL tables)
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FactorSoft Client Summary Worksheet Screen

The Client Summary Worksheet screen provides the FactorSoft interface for producing the report. This
screen provides criteria for filtering the data on the report by date ranges, all clients, specific clients, and
more specific criteria such as Account Executives (A/E), Client Groups, Offices, Brokers, Territories, and
Regions.

This screen also provides options that allow you to sort and group the data on the report by A/E, Group,
Office, Region, and/or Territory.

The Client Summary Worksheet screen is fully described in the FactorSoft Help File.
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Getting Started

This section of the document addresses the following topics:

l Creating a new Client Summary Worksheet

l Saving the worksheet template in the FactorSoft Reports directory

l Generating Client Summary Worksheets

FactorSoft is provided with an array of pre-defined templates designed to suit a variety of anticipated
reporting needs. These reports can be customized to suit your needs such as isolating one or including all
clients, grouping by specific subcategories (A/E, Client Group, Office, etc), and sorting to prioritize results
based on the selection criteria entered on the Client Summary Worksheet screen. These templates are
outlined in the following table:

Template Description

Activity_Accrual_
Summary.xls

The Activity Accrual Summary provides a summary of clients’ A/R activity, Cash
Received, Purchases, Reserve Activity, Settlement, and Fees during a specified
date range.

Activity_By_
Region.xls

The Activity By Region report provides a summary of clients’ A/R activity,
broken-out by region during a specified date range, including Amounts, Fees,
Averages, and Number of Buys, Invoices, Checks, Payments, and Adjustments.

AR_Loan_Sum-
mary.xls

The AR Loan Summary provides a snapshot of clients’ A/R activity during a spe-
cified date range, including Amounts, Fees, Averages, and Number of Buys,
Invoices, Checks, Payments, and Adjustments.

Average_Net_Fund-
s.xls

The Average Net Funds report provides a summary of clients’ Current Gross A/R,
Current Cash Reserves, Current Escrowed Reserves, Current Funds Employed,
and Average Funds Employed.

Balance.xls The Balance report provides a summary of clients’ A/R activity during a spe-
cified date range, including Amounts, Fees, Averages, and Number of Buys,
Invoices, Checks, Payments, and Adjustments.

Broker_Analysis.xls The Broker Analysis report provides a summary of Broker activity during a spe-
cified date range, including A/R Activity—balances, purchases, collections,
chargebacks, giveback, gross collections—Settlement, a breakdown of Fees,
and a breakdown for Commissions. The Date Signed is also listed.

The report can be run on one broker or all brokers, for all or one client. The Sort
Fields do not apply to this report.
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Template Description

ClientWorkSheet.xls The Client Worksheet provides a summary of clients’ financial activity, by A/E,
during a specified date range, including Gross A/R, Recourse/Ineligible, Eligible
A/R, Advance Rate, Gross Available, Funds Employed, Accrued Fees, Available
Cash, Current Balance, a breakdown of balances by Aging bucket and the per-
centage of each against the Total, a Month To Date summary of Sales,
Recourse, Payments chargebacks, givebacks, WO/Suspense, as well as dilution
percentage.

Ineligibility.xls The Ineligibility report provides a summary of clients’ ineligibility during a spe-
cified date range, including Gross A/R, Cash Reserves, Escrowed Reserves,
Funds Employed, Effective Rate, Industry, Eligible Rate, Ineligible Rate, and Ine-
ligible Amount.

Insurers.xls The Insurers report provides a summary of Insurers for each client, and lists the
Insurer, Amount Insured, Expiration, and UCC#. The report can be run on one cli-
ent or all clients.
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Creating a New Client Summary Worksheet Template

NOTE
This is a how-to guide focused primarily on the functionality of FactorSoft, and consequently assumes
a level of knowledge with Microsoft Excel. For tutorials and help creating Excel spreadsheets, we recom-
mend visiting http://office.microsoft.com/en-us/excel/FX100646951033.aspx.

You can create reports in a variety of formats using Microsoft Excel and the defined FactorSoft Field Codes
(a complete list of field codes is included in this document at Client Summary Worksheet Field Codes).
The following provides instruction on creating such a report from scratch.

This report would contain four data fields:

Name Field Code

Client Name NameWithCode

A/E Name AcctExecName

Beginning Balance Act_BegBal

Ending Balance Act_EndBal

In addition, this example contains two formulas, summing the beginning and ending balances (formula is
=Sum(firstCell:lastCell) ).

This description is based on Microsoft Office Excel 2007. Actual steps may vary based on the version of
Microsoft Office you are using.
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1. To begin, open a new Book in Microsoft Excel.

NOTE
In the Client Summary templates, column A is used to identify row types to FactorSoft, so should
never be used to contain any printed data. In fact, when you create output from the Client Sum-
mary Report, you will want to hide column A to prevent these codes from being printed in the
final output.

2. Grab the border of column B and widen it out to accept a longer field.

This will contain the Client Name field, so be sure to provide plenty of room.

Before creating the header line, enter two fields that will print your company’s name and the as-of
date for the report at the top left of the report.

3. In cell B1, enter field code <FactorName> to import your company name.

4. In cell B2, enter the text “As of:” followed by the field code <AsOfDate> to print the as-of date of the
report.

Next, enter the header line that will define the heading rows.

5. In cell A4, enter H to create a header row.

There are three row type identifiers that can be entered in column A:

Field Description

H Header row. A header row accepts text and cell formatting. The out-
put of a header row is static.

R Repeating data row. A repeating data row accepts either text or field
codes or a combination of the two. Field codes are entered between
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Field Description

“angle brackets” (technically the less-than and greater-than sym-
bols – e.g. <field_code>).

T Totals row. Totals rows contain Excel formulas. If sorting is used on the
Client Summary Worksheet screen, the report will be subtotaled at
each break point and a grand total will be created at the end of the
report.

Note that if the Accumulate to master clients option is selected in the
Client Summary Worksheet screen, the columns for which you want to
accumulate member totals to the master must be included in a totals
row to display the accumulated master totals in the generated work-
sheet.

6. Enter the text for the first header in cell B4:

7. In cell 5A, enter H.

NOTE
An empty H row must precede the first R
row.

8. In cell 6A, enter R to create a repeating data row.

9. In cell 6B, enter the field code for the client name and code.

Next, expand columns, enter header text and field codes for the remainder of the data on the report,
as shown in the following illustration. Note that columns D and F are used as spacing between the

Bulk Collaterals User Guide
Creating a New Client Summary Worksheet Template

547 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



two amount columns, and also that a border has been added to the header row. This was done by
selecting rows B4 through G4, right-clicking in the selected row, selecting Format Cells, and then
the Border tab on the Format Cells screen.

10. In cell 7A, enter an H to insert another blank row after the repeating data row.

NOTE
An empty H row must precede the last R
row.

11. In cell A8, enter T to create a totals row.

12. Enter an Excel formula in the Total row for the Beginning Balance:
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l Select cell E8.

l Select the Formula tab and click AutoSum in the Excel ribbon.

l Enter the cell prior to the first R row as the first coordinate, a colon, and then the cell following
the last R row as the second coordinate. A blue box should surround the cells to be summed,
as in the following illustration.

l Press the Enter key.

A zero is displayed in row E8.

13. Enter an AutoSum formula for the Ending Balance using the same procedure as above.

14. Right-click in column A and click Hide in the pop-up menu.

This hides column A so that the Row Type Identifiers are not printed in the output.

See Client Summary Worksheet Field Codes for details about the field codes available for use in Cli-
ent Summary Worksheets. The data displayed when the worksheet is processed are the actual val-
ues from your database.
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Save the Worksheet Template

When you have created the template in Excel, save it to the FactorSoft Report Path. All templates must be
saved in the defined Reports directory, typically C:\FactorSoft\Reports. To verify your defined Report dir-
ectory, open the About FactorSoft screen from the Help menu.

NOTE
If an older version of FactorSoft is being used, the path may be displayed with a FactorSoft or
CADENCE folder instead of a FactorSoft folder.

Templates for use with the Client Summary Worksheet must be saved in the .XLS format specific to
Microsoft Excel 97-2003, not the newer .XLSX format specific to Microsoft Excel 2007. If using Excel 2007,
select Save As and in the Save As Type list, select Excel 97-2003 Workbook (*.xls).

The Report Path field contains the path where you must save the Excel spreadsheet templates.

1. Save the template as an .XLS file.

2. Save the template with a descriptive name (Client_Balance_List.xls in this example) to make it easy
for anyone who might use the report to find it.
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Generate the Client Summary Worksheet

The Client Summary Worksheet screen is the tool in FactorSoft that is used to create reports from the tem-
plates created in Excel spreadsheets. A full description of the Client Summary Worksheet screen is found
in the FactorSoft Reports section of this guide. This section contains examples in which the Client Balance
List template created in the previous section is utilized to demonstrate generating and sorting reports.

To generate the desired Client Summary Worksheet report, simply select the desired template, set the
selection criteria to limit the report to the desired data, and then click the Process button. The completed
Client Summary Worksheet report is created and saved as an Excel spreadsheet. The location that the
completed spreadsheet is created is defined by a System Constant: Reports, Client summary
worksheet, Folder for completed Excel Spreadsheets.

Example 1

In this example, the Client Balance List report created in the previous section is selected, and the only
selection criteria selected is the date range.

When the Process button is pressed, a progress bar appears showing the progress of the report, and then
a message appears that contains the location and name of the completed report.

The processing of the report retrieves the data from the database and generates the results in an Excel
spreadsheet
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Example 2

This example uses the same template as Example 1, but shows the effect of using a Sort field and limiting
display to Active accounts only in Client Filters:

l Show active clients only

l Sort by Account Executive
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The processing of the report retrieves the data from the database and generates the results in an Excel
spreadsheet:

Note that the report format, which is controlled by the template, is the same, but the results are grouped
by Account Executive (based on the Sort criteria) and subtotaled by Account Executive.
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Example 3

This example shows the Client Worksheet report generated based on the options specified on the Client
Summary Worksheet screen. The Client Worksheet template is one of the stock templates provided with
FactorSoft (ClientWorkSheet.xls):

The processing of the report retrieves the data from the database and generates the results in an Excel
spreadsheet:
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Generate the 2020 Tax Guard Spreadsheet

A template to extract information for interface with 20/20 Tax Guard Monitoring Service has been added
for the Client Summary Worksheet in the Reports module in version 2.14.7. This template can be used to
electronically transmit client information to 20/20 Tax Guard for the creation of IRS form 8821. To create
the Tax Guard spreadsheet:

1. Open the reporting module and choose Client Summary Worksheet from the Client Menu.

2. From the drop-down list of spreadsheet templates, select the 2020TaxGuardTemplate.x ls.

NOTE
If you do not have this spreadsheet in your Reports directory, contact Support to arrange to
have the worksheet added to your Reports Folder.

3. Enter the current days date in the As-of date

4. Enter any valid day in the past in the Activity From Date.

NOTE
There is no financial data in the extract, so the actual date set for the Activity From Date is not
important.
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Client Summary Worksheet Field Codes

The Client Summary Worksheet can be customized using the database codes from :

l Client Summary Worksheet Field Codes (fsClient and/or fsClientCalc API modules)

l Clients Table

l Collateral field Codes

NOTE
Jack Henry™ makes every effort to keep this field code documentation up-to-date, but you can
always find the most up-to-date information on Clients Table Field Codes by selecting Database
Maintenance, Print Table Views from the Administration module System menu. A list of all tables is
returned. Select Clients from the list and click the Print button to print a report of the field codes in the
Clients table.

Field Names must be inserted into the Client Summary Worksheet within angle brackets (< >).
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Client Summary Worksheet Field Codes

These field codes allow access to a variety of financial data for display in the Client summary Worksheet.
These field codes are returned by the fsClient and/or fsClientCalc API modules, and are only applicable to
the Client Summary Worksheet.

Field Name Description

AcctExecName Name of the account executive assigned on the Control Panel of the Client
Information. From Client Information, Control tab.

AcctGroupDescr The name of the G/L account group assigned to a client

Act_Adjusts All chargebacks for period

This code also equals <Act_CreditCb> + <Act_CreditDb>)

Act_Advances Total advanced amount for the period

Act_ArTurn The average number of days a client’s A/R portfolio turns over(not the aver-
age days to pay) calculated as (365 days / ((12 * sales) / (average bal-
ance)))

Act_AvgBal Average A/R balance for the selected period

Act_AvgNfe Average net funds employed for the selected period

Act_AvgInvoice Average invoice amount for the selected activity period

This code equals the same value as <Act_Purchases> / <Act_CountInv>

Act_BegBal A/R balance at the beginning of the selected period

Same as < Beg_ArBal >

Act_BegFeeEscrow Fee escrow balance at the beginning of the selected period

Same as <Beg_FeeEscrow>

Act_BegRsvEscrow Reserve escrow balance at the beginning of the selected period

Same as <Beg_RsvEscrow>

Act_BulkCredit Credit(s) recorded in Bulk AR Certificate Posting for the period selected

Act_BulkSales Sales recorded in Bulk AR Certificate Posting for the period selected

Act_BulkPlusAdjustments Adjustments (+) recorded in Bulk AR Certificate Posting for the period selec-
ted
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Field Name Description

Act_BulkMinusAd-
justments

Adjustments (-) recorded in Bulk AR Certificate Posting for the period selec-
ted

Act_BulkDiscount Discount(s) recorded in Bulk AR Certificate Posting for the period selected

Act_BulkNetCollections Net Collections recorded in Bulk AR Certificate Posting for the period selec-
ted

Act_BulkOverPayment Over payment(s) recorded in Bulk AR Certificate Posting for the period selec-
ted

Act_CbDebits Debit chargebacks against purchased invoices for the selected period

Act_CbNonFactor All chargebacks against non-factored invoices for the selected period

Act_CbRecovery Credit chargebacks against purchased invoices for the selected period

Act_Collects Total Collections for the selected period

Act_CountAdj Number of Adjustments for the selected period

Act_CountBuys Number of Purchase Batches for the selected period

Act_CountChk Number of Checks processed for the selected period

Act_CountInv Number of Invoices purchased for the selected period

Act_CountPmt Number of Payments applied for the selected period

Act_CreditCb Credit chargebacks (givebacks)

Act_CreditMemo Total amount of credit invoices purchased for the selected period

Act_DebitCb Debit chargebacks (chargebacks)

Act_DebitMemo Total amount of debit invoices purchased for the selected period

Act_EarnAdj Total earnings generated from Adjustment transactions for the selected
period

Act_Earnings Total earnings for the selected period

Act_EarnTax Tax earned on Purchases within period

Act_EndBal A/R balance at the end of the selected period

Same as < Emp_ArBal>
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Field Name Description

Act_LoanAdjust Total amount of adjustments posted to the loan for the selected period

Act_LoanCollect Total amount of payment collections posted to the loan for the selected
period

Act_LoanDisburse Total amount of disbursement fundings posted to the loan for the selected
period

Act_LoanTrfFrom Total amount of transfers posted from the loan for the selected period

Act_LoanTrfTo Total amount of transfers posted to the loan for the selected period

Act_NonFactored Total amount of non-factored payments posted for the selected period

Act_Purchases Total amount of invoices purchased for the selected period

This code equals the same value as <Act_DebitMemo> + <Act_Cred-
itMemo>

Act_Rebates Total amount of rebates for the selected period

Act_Recourse Total amount of recoursed invoices for the selected period

Act_Refactors Total amount of fees generated from invoices refactored for the selected
period

Act_RsvHeld Total amount of reserves held on purchases for the selected period

Act_RsvRel Total amount of all reserve releases for the selected period (this includes
releases done from the release tab of the client summary screen, as well as
monies released from the reserve from the checks/journals screen)

Act_RsvRelExp Total amount of expenses captured from reserve releases done from the
release tab of the client summary screen for the selected period

Act_RsvRelTrans Total amount of Reserve Release transactions only.

Act_SalesExp Total amount of expenses captured from purchases for the selected period

Act_StmtEarn Total amount of earnings captured from posted statements for the selected
period

Act_Suspense The net total of debit and credit items to the suspense accounts for the
selected period

Act_SuspenseActAl Total net Hold Account activity for the reporting date range (Collection Hold
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Field Name Description

Acct Activity + C-Misc Journal Hold Acct Activity)

Act_SuspenseActColl Total net Hold Account activity from Collections for the reporting date range

Act_Verified Total amount of invoices verified for the selected period

Act_VerPre The pre-purchase verification total amount at the end of the selected
period.

Act_VerPost The post-purchase verification total amount at the end of the selected
period.

Act_WriteOff Total amount of write-offs processed for the selected period

Adv_Current Total amount of A/R that is current

Adv_PastAmt0 Total amount of A/R in the first aging bucket

Adv_PastAmt1 Total amount of A/R in the second aging bucket

Adv_PastAmt2 Total amount of A/R in the third aging bucket

Adv_PastAmt3 Total amount of A/R in the fourth aging bucket

Adv_PastAmt4 Total amount of A/R in the fifth aging bucket

Adv_PastAmt5 Total amount of A/R in the sixth aging bucket

Adv_PastAmt4+5 Total amount of A/R in the fifth and sixth aging bucket

This code also equals <Adv_PastAmt4> + <Adv_PastAmt5>

AdvRate Advance rate from the client terms currently assigned to the client record
(e.g. 85.00)

AdvRatePer Advance rate percentage from the client terms currently assigned to the cli-
ent record (e.g. 0.85)

Age_Current Total of the current aging

Age_PastAmt0 Total of the current aging

Same as Age_Current

Age_PastAmt1 Total of the first aging bucket

Age_PastAmt2 Total of the second aging bucket
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Field Name Description

Age_PastAmt3 Total of the third aging bucket

Age_PastAmt4 Total of the fourth aging bucket

Age_PastAmt5 Total of the fifth aging bucket

Age_PastAmt4+5 Combination of fields <Age_PastAmt4> plus <Age_PastAmt5>

Age_PastPer0 This is the percentage of the total A/R that falls into the current aging
bucket. This can also be calculated as <Age_Current> divided by <Act_
EndBal>

Age_PastPer1 This is the percentage of the total A/R that falls into the first aging bucket.
This can also be calculated as <Age_PastAmt1> divided by <Act_EndBal>

Age_PastPer2 This is the percentage of the total A/R that falls into the second aging
bucket. This can also be calculated as <Age_PastAmt2> divided by <Act_
EndBal>

Age_PastPer3 This is the percentage of the total A/R that falls into the third aging bucket.
This can also be calculated as <Age_PastAmt3> divided by <Act_EndBal>

Age_PastPer4 This is the percentage of the total A/R that falls into the fourth aging bucket.
This can also be calculated as <Age_PastAmt4> divided by <Act_EndBal>

Age_PastPer4+5 Combination of fields <Age_PastPer4> plus <Age_PastPer5>

AttnContacts List all active contacts for the client with Attention selected in the Client
Information Contacts tab.

AuthContacts List all active contacts for the client with Authority selected in the Client
Information Contacts tab.

AveLoanBal Average loan balance as of the reporting date

Beg_ArBal A/R balance at the beginning of the period

Same as <Act_BegBal>

Beg_FeeEscrow Fee escrow balance at the beginning of the period

Same as <Act_BegFeeEscrow>

Beg_LoanAmt Loan balance at the beginning of the selected period

Beg_MedArAmt Beginning A/R amount for medical receivables as of the reporting date
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Field Name Description

Beg_MedArBal Beginning A/R balance for medical receivables the day before the reporting
date

Beg_NetFunds Net funds employed balance at the beginning of the period

Same as <Emp_BegDeployed>

Beg_RsvAmt Cash reserve balance at the beginning of the period

Same as <Emp_BegCashRsv>

Beg_RsvEscrow Reserve escrow balance at the beginning of the period

Same as <Act_BegRsvEscrow>

Bkr_CommsAmt The total amount of broker commission at the end of the selected period.

Bkr_OthRate The broker commission rate for brokers not selected in the Parameters tab
of the Client Summary Worksheet (i.e., "other" brokers). If there are more
than one, the percentage is cumulative of all "other" brokers percentages.

Bkr_SelRate The broker commission rate for the Broker selected in the Parameters tab of
the Client Summary Worksheet screen, if applicable.

Col_AnyDilution If there was dilution during the period, this value will be returned as TRUE. If
there was no dilution during the period, the value returned will be FALSE.

Col_Balance Current A/R balance for the selected period Same as <Emp_ArBal>

Col_Collateral Available collateral

Calculated as (<Emp_ArBal> - <Col_Dilution> - <Col_Recourse> - <Col_
InelAll> - <Col_InelTable>

Col_Dilution Total Dilution for the selected period

Calculated as (Charge-backs on paid positive invoices / Total positive
invoices paid)

Col_Dilution% The dilution percentage over time.

Col_InDispute Total amount of all current invoices in dispute

Col_InelAll Current total amount of all ineligible items (ineligible for any reason)

Same as <Col_InelInvoices> + <Col_InelTierAmt> + <Col_InelCrossAmt> +
Col_InelOverCred>
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Field Name Description

Col_InelCrossAmt Current total amount of all invoices ineligible due to cross ineligibility reas-
ons

Col_InelInvoices Total amount of all ineligible specific invoices

Col_InelInv&Over Total amount of ineligibility due to specific ineligible invoices and invoices
over credit limits.

This code also equals (<Col_InelInvoices> plus <Col_InelOverCred>)

Col_InelOverCred Current total amount of all invoices ineligible due to being over a credit limit

Col_InelTable Total amount of ineligibility from the Ineligible Titles Table

Col_InelTierAmt Total amount of ineligibility generated by the tiered ineligibility table

Col_InelTier&Cross Total amount of ineligibility generated by cross ineligibility and tiered
ineligibility table

Same as (<Col_InelTierAmt> + <Col_InelCrossAmt>)

Col_RecDays The age (in number of days) specified in the client information at which an
invoice becomes available for recourse

Col_RecDaysShortOver Recourse not including in dispute; calculated as field <Col_RecDays> plus
<Col_RecShort> plus <Col_RecOver>.

Col_Recourse All recourse items; calculated as <Col_RecDaysShortOver> plus <Col_InDis-
pute>.

Col_RecOver The total amount of cash posting credit chargebacks for the period selected

Col_RecShort The total amount of cash posting debit chargebacks for the period selected

Col_Unpaid The total amount of the total number of unpaid items in open A/R for a spe-
cific date range

Contacts List all active contacts for the client in the Client Information Contacts tab.

CurrencyType Currency type assigned to client. From Client Information, Control tab.

Emp_AdvBal The advance balance at the end of the selected period

Emp_AmortLoan The balance of the loans payable G/L account at the end of the selected
period

Emp_ArBal The total amount of the A/R balance at the end of the selected period Same
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Field Name Description

as < Act_EndBal>

Emp_BegCashRsv Cash reserves balance at the beginning of the selected period

Emp_BegDeployed Funds employed balance at the beginning of the selected period.

Emp_BulkARAdvRate The Advance Rate stored within the ABL Bulk Loan Posting closest to the
given as-of date. The following query retrieves the advance rate.

Emp_BulkIneligAmt The Total Bulk Ineligibles at the client level as posted by the user and stored
in the AblBulkIneligHdr and AblBulkIneligDtl tables. This element provides the
most current record for a given client and date.

Emp_BulkEligCollAmt Returns the Eligible bulk A/R collateral.

Same as <emp_BulkARBal> – <emp_BulkIneligAmt>

Emp_BulkNetCollAmt Returns the Net Bulk Collateral.

Same as (<emp_BulkARBal> – <emp_BulkIneligAmt>) * <emp_BulkARAd-
vRate>

Emp_BulkUnApplied Unapplied cash balance as of the reporting date selected

Emp_CashRsv Cash reserves balance at the end of the selected period

Emp_Deployed Funds employed balance at the end of the selected period

Emp_Escrow Total escrow held; this is <Emp_FeeEscrow> plus <Emp_RsvEscrow>.

Emp_FeeEscrow Fee escrow balance at the end of the selected period

Emp_LoanAmt Loan Balance as of the date selected

Emp_MedArAmt Current A/R balance for medical receivables the day before the reporting
date

Emp_MedArBal Current A/R amount for medical receivables as of the reporting date

Emp_MedDeclDate Declaration posting date

Emp_NetSettle The net settlement amount at the end of the selected period. The formula
for this field is:

EmpNetSettle = EmpDeployed + Rsv_AccInvFees + Rsv_AccInvTax + Rsv_
intFees

Bulk Collaterals User Guide
Client Summary Worksheet Field Codes

564 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Name Description

Emp_PoFinance Purchase order finance balance at the end of the selected period

Emp_RsvEscrow Reserve escrow balance at the end of the selected period

Emp_Settle The amount of funds awaiting settlement at the end of the selected period
(settlement, in this context, is about advancing funds before the invoice is
purchased, as in PO financing. When the invoice is purchased, the funds are
settle out the settlement account).

Emp_SimpLoan The simple loan balance at the end of the selected period.

fac_accruedfee The sum of the facility reserve fees under a client.

fac_feebal The facility fee balance for the specified period.

fac_feersv The amount of facility fee reserve for the specified period.

fac_ineligibles The sum of the facility ineligibles under a client.

fac_limit The sum of the facility limits under a client.

fac_otherrsv The amount of facility other fee reserve for the specified period.

fac_paymentrsv The amount of facility payment reserves for the specified period.

fac_ucbal The facility unapplied cash balance for the specified period.

FinChgDebtor Indicates (True/False) if there is a second monthly statement charge and
finance charges are accessed against debtors. From Client Terms, Addi-
tional Fees tab.

FinChgPer Finance charge per from any second monthly statement charge. From Cli-
ent Terms, Additional Fees tab.

0=day

1=month

2=year 360

3=year 365

4=year actual

FinChgRate Finance charge rate from any second monthly statement charge. From Cli-
ent Terms, Additional Fees tab.
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Field Name Description

FirstBuyDate Lists the date of first purchase for the client.

FirstFundDate Lists the date of first funding for the client.

FloatDays Float days from the client terms record currently assigned to the client. From
Client Terms, Float days tab

FloatDaysAre Code from client terms record currently assigned to the client to indicate on
what float days are based. From Client Terms, Float days tab.

0=Calendar Days

1=Monday-Friday

2=Business Days

GuarContacts List all active contacts for the client with Guarantor selected in the Client
Information Contacts tab.

InelTable Total value of the ineligible titles table for the client. From Tables, Ineligible
titles table.

MasterName Lists the master client name. If the current client does not have a master cli-
ent, blanks are returned. If the current client does have a master client, the
master client name and number (if applicable) are returned.

Members List of members of this master client. If the client is not a master client this
will be the name of the client. From Client Information screen, Part of Master.

Misc=DE name

(where "DE name" is the
actual Miscellaneous
Data Element name)

Name of the miscellaneous data element to reproduce in the Client Sum-
mary Worksheet. Miscellaneous Data Elements are created and their value
defined on the Misc. Data tab of the Client Information screen. Note the vari-
ation in format of the field name: a miscellaneous data element value is
included in the Client Summary Worksheet by including the misc= field
along with the actual data element name defined on the Client Information
Screen. From Client Information, Misc. data. tab

NameWithCode Client name with client number following in parenthesis if a client number
exists. From Client Information screen, Client name, Client code.

NoticeContacts List all active contacts for the client with Notices selected in the Client Inform-
ation Contacts tab.

Office Office assigned to client. From Client Information, Control tab.
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Field Name Description

OldestOpenInvDate Lists the invoice date of the oldest open invoice by invoice date.

OldestOpenInvDateNo Lists the invoice number of oldest open invoice by invoice date.

OldestOpenPostDate Lists the post date of the oldest open invoice by post date.

OldestOpenPostDateNo Lists the invoice number of the oldest open invoice by post date .

ProgAdminFeeTaken Code for when the administrative fee is taken from the current client terms
record. From Client Terms, Portfolio Fees tab.

0=On Fee Statement

1=At Purchase

2=At Collection)

ProgAdminRate Administrative fee % from the client terms record currently assigned to the
client. From Client Terms, Portfolio Fees tab.

ProgAdvanceRate Advance rate from the client terms record currently assigned to the client.
From Client Terms, Portfolio Fees tab.

ProgDailyRate Daily rate from the client terms record currently assigned to the client. From
Client Terms, Portfolio Fees tab.

ProgFeeBasisKey Database key of daily rate basis plus table from the client terms record cur-
rently assigned to the client.

ProgFeeRatePer Daily rate per code from the client terms record currently assigned to the cli-
ent. From Client Terms, Portfolio Fees tab.

0=day

1=month

2=year 360

3=year 365

4=year actual

ProgRecourseDays Recourse days from the client terms record currently assigned to the client.
From Client Terms, Recourse tab.

ProgRecourseType Recourse type from the client terms record currently assigned to the client.
From Client Terms, Recourse tab.
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Field Name Description

0=Recourse is stated in days

1=Recourse is stated in statements

ProgRsvEscrow Indicates if reserve escrow is held from the client terms record currently
assigned to the client. From Client Terms, Purchase Fees tab.

True=Reserve is Escrowed

False=Reserve is not Escrowed

ProgTitle Displays the Client Terms descriptive name for the client.

ProgType Program type code from the client terms record currently assigned to the cli-
ent. From Client Terms, Type field.

0= Invoice based terms

1= Portfolio based terms - Daily rate

2= Portfolio based terms - A/R finance

3= Inventory – non A/R

4=Time Payments

5=Loan Style Terms

6=Merchant Bank Terms

Rsv_AccInvFees The total amount of the accrued invoice fees at the end of the selected
period

Rsv_AddlFeeAcc The total amount of the accrued additional fees at the end of the selected
period

Rsv_AddlReqd The total amount of additional reserves required at the end of the selected
period

Rsv_AdjRsv The adjusted reserve balance at the end of the selected period

Rsv_AdvanceRate Advance rate from the client terms record currently associated with the cli-
ent

Rsv_Available Total available reserves for the period

Same as Reserve "Available for Release" on Client Summary Report
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Field Name Description

Rsv_AvailRsv Available reserves

Calculated as (<Rsv_MaxAdvance> - <Rsv_FundsEmpl>)

Rsv_CashRsv Total cash reserve balance at the end of the selected period

Rsv_Collateral Total collateral at the end of the selected period

Same as <Col_Collateral>

Rsv_EarnedFeeAcc The total amount of the accrued earned fees at the end of the selected
period.

Rsv_Escrow The total amount of escrow (fee and reserve) at the end of the selected
period

Calculated as (<Emp_FeeEscrow> + <Emp_RsvEscrow>)

Rsv_FundsEmpl Funds employed balance at the end of the selected period

Same as <Emp_Deployed>

Rsv_Ineligible Total amount of ineligibles

Same as (<Col_Recourse> + <Col_InelAll>)

Rsv_IntFees Total amount of NFE fees plus daily fees for the selected period

Rsv_MaxAdvance Maximum advance based on current collateral

Calculated as (<Col_Collateral> * <Rsv_AdvanceRate>)

Rsv_PriorAccFees The total accrued fees for the previous period

Rsv_ReqRsv The total required reserve based on the current A/R balance

Rsv_TotRsv The total of Cash Reserves and Escrowed Reserves

Same as (<Rsv_CashRsv> + <Rsv_Escrow>)

StmtGuarAmt The total sales or earnings amount guaranteed to be sold by the client over
the period specified in StmtGuarMos. From Client Information, Statement
Terms panel.

StmtGuarMos The number of months over which the sales or earnings guarantee applies.
From Client Information, Statement Terms panel.

StmtGuarType The basis for the guarantee of sales for the statement period. Sales or

Bulk Collaterals User Guide
Client Summary Worksheet Field Codes

569 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Name Description

Earned Fees. From Client Information, Statement Terms panel.

Territory Territory value assigned to region for the client. From Tables, Region table.

Trend_AnnAvgBal The average annual A/R balance

Trend_AnnPurch The average annual purchase
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Clients Table Field Codes

The following codes are accessed directly from the Client Table, and can be used in Client Summary Work-
sheet templates.

Field Name Field Type Field Length

AcctExec nvarchar 24

AcctGroupHdrKey int 4

Addr1 nvarchar 100

Addr2 nvarchar 100

AeCliApprRuleKey int 4

AgeDays1 int 4

AgeDays2 int 4

AgeDays3 int 4

AgeDays4 int 4

AgeDays5 int 4

AgeInterval smallint 2

AgingAccurate bit 1

AgingAsOfDate datetime 16

AllowDating bit 1

AllowHauler bit 1

AllowInstallments bit 1

AllowLoads bit 1

AllowPoFinance bit 1

AltName nvarchar 200

AtRistReqd bit 1

AutoApprRuleKey int 4

AutoCloseHoldAbbr nvarchar 12
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Field Name Field Type Field Length

AutoNonHoldAbbr nvarchar 40

AutoOverAction smallint 2

AutoOverAmtLimit money 21

AutoOverHoldAbbr nvarchar 12

AutoRecHoldAbbr nvarchar 12

AutoShortAmtLimit money 12

AutoShortPerLimit money 12

BankState nvarchar 60

BegAsOfDate datetime 16

BegBalAmt money 21

BegFeeEscrow money 21

BegRsvAmt money 21

BegRsvEscrow money 21

BegSettleAmt money 21

BizType nvarchar 40

BulkChargeBack bit 1

CalcColFeeOnNegInv bit 1

CalcColFeeOnNegInv bit 1

CalcNoFloat bit 1

City nvarchar 100

ClientKey int identity 4

ClientMotorNo nvarchar 12

ClientNo nvarchar 24

CloseDay smallint 2
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Field Name Field Type Field Length

ConcentrationLimit money 21

Country nvarchar 60

CredAppBy nvarchar 24

CredAppFor nvarchar 24

CredRate nvarchar 20

CrossAgeInelig bit 1

CrossAgePercent money 21

CurrBalAmt money 21

CurrencyType nvarchar 40

CurrFeeEscrow money 21

CurrNonFundAmt money 21

CurrRsvAmt money 21

CurrRsvEscrow money 21

DaysDue smallint 2

DbDunsNo nvarchar 40

DebtorMotorNo nvarchar 12

DefaultBankAcctKey int 4

DefaultRsvAcctKey int 4

DeliverBy nvarchar 60

DilutionLimit money 21

DiscDays int 4

DiscRate money 21

DueFrom smallint 2

EarlyPayToFactor bit 1
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Field Name Field Type Field Length

EdiInterchangeNo nvarchar 18

Email nvarchar 100

ExpectedDilution money 21

ExtendInel smallint 2

Fax nvarchar 40

FedBizNo nvarchar 60

FedCoNo nvarchar 60

FedTaxNo nvarchar 40

FundNotes ntext <memo>

HoldInclEscrow bit 1

HoldInclMisc bit 1

HoldRsvAmt money 21

HoldRsvCode int 4

HoldRsvLarge money 21

HoldRsvLim money 21

HoldRsvPer money 21

Inactive bit 1

Inbox nvarchar 40

IndivCreditLimit money 21

IndivCreditPer money 21

IneligDays smallint 2

InsurerAmt money 21

InsurerExpire smalldatetime 16

InsurerKey int 4
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Field Name Field Type Field Length

InvDupeRule smallint 2

InvTerms nvarchar 80

LanguageCode nvarchar 40

LoadAdvanceLimit money 21

MasterClient smallint 2

MasterClientKey int 4

MaxInvAge smallint 2

MaxInvAmt money 21

MaxWriteOff money 21

MgrCliApprRuleKey int 4

MinInvFee money 21

MotorCarrNo nvarchar 12

Name nvarchar 200

NameKey nvarchar 60

NeverTfr bit 1

NextBatchNo int 4

NextColNo int 4

NextInvNo nvarchar 20

NoAdvAtBuy bit 1

NoaReqd bit 1

NoaWaivedLim money 21

NoBuy bit 1

NoDebLimIsIneligible bit 1

NoFeeOnNegInv bit 1
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Field Name Field Type Field Length

NoMixedBuy bit 1

NoRecourse int 4

NoRsvOnNegInv bit 1

NoRsvRel bit 1

NoStmt bit 1

Notes ntext <memo>

Office nvarchar 40

OkBy nvarchar 24

OnlyFromTfr bit 1

OverDebLimIsIneligible bit 1

ParticipantKey int 4

ParticipationCode smallint 2

ParticipationRate money 21

Password nvarchar 24

PastDueDays smallint 2

PayRebatesOnCollection bit 1

Phone1 nvarchar 40

Phone2 nvarchar 40

PoAdvanceLimit money 21

Policies ntext <memo>

PreCalcTime datetime 16

Preference smallint 2

ProgramsKey int 4

PurchOrdReqd smallint 2
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Field Name Field Type Field Length

PurProg nvarchar 16

RecourseDays smallint 2

Region nvarchar 60

RelAddOn int 4

RsvBankAcctNo nvarchar 40

ScanTableKey nvarchar 40

ShowOnBuy bit 1

Sic nvarchar 20

SignedDate datetime 16

SignLines smallint 2

SmartFaxNo nvarchar 30

Source nvarchar 60

State nvarchar 60

StdDiscount money 21

StmtDesc text <memo>

StmtTextName nvarchar 40

TaxCode nvarchar 6

TermDate datetime 16

TermDesc ntext <memo>

TermDisputeKey int 4

TierInelHdrKey int 4

TotalCreditLimit money 21

UccDate datetime 16

UccNo nvarchar 40
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Field Name Field Type Field Length

VerificationNote ntext <memo>

VerRatio money 21

VerReqd bit 1

VerReqdAmt money 21

VolRebateHdrKey int 4

Warning nvarchar 100

WebAccess bit 1

WebChatOk bit 1

ZipCode nvarchar 20

Bulk Collaterals User Guide
Clients Table Field Codes

578 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Collateral Field Codes

The following field codes can be used to access collateral data from the FactorSoft for Bulk Collaterals sys-
tem’s tables.

Note that these field codes are for use with the Client Summary Worksheet only, and consequently the
data returned is client-level data for the collaterals. These field codes cannot be used to return data at
the facility or collateral level.

Field Name Description

Act_BulkSales Returns the increases to Bulk A/R for the reporting period

Act_BulkCredit Returns the decreases to Bulk A/R for the reporting period

Act_PlusAdjustments Returns the total adjustment decreases to Bulk A/R for the reporting period

Act_MinusAd-
justments

Returns the total adjustment decreases to Bulk A/R for the reporting period

Act_Discount Returns the total discounts to Bulk A/R for the reporting period

Act_BulkNetCol-
lections

Returns the total of payments applied to the Bulk A/R balance for the reporting
period

Act_OverPayment Returns the total amount of all overpayments received toward Bulk A/R for the
reporting period

Beg_BulkArBal Returns the Bulk A/R balance as of the day before the beginning date or the
reporting period

Col_GrossBulkAR Returns Gross Collateral for Bulk A/R collateral types (type 0)

Col_IneligBulkAR Returns ineligible balance for Bulk A/R collateral types (type 0)

Resv_BulkAR Returns reserve balance for Bulk A/R collateral types (type 0)

SetASide_BulkAR Returns set aside balance for Bulk A/R collateral types (type 0)

Col_EligBulkAR Returns eligible collateral balance for Bulk A/R collateral types (type 0)

Col_NetBulkAR Returns net collateral balance for Bulk A/R collateral types (type 0)

Col_LimitBulkAR Returns collateral limit for Bulk A/R collateral types (type 0)

Col_AvailBulkAR Returns available collateral for Bulk A/R collateral types (type 0)

Col_GrossEquip Returns Gross Collateral for Equipment collateral types (type 1)
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Field Name Description

Col_IneligEquip Returns ineligible balance for Equipment collateral types (type 1)

Col_EligEquip Returns eligible collateral balance for Equipment collateral types (type 1)

Col_NetEquip Returns net collateral balance for Equipment collateral types (type 1)

Col_LimitEquip Returns collateral limit for Equipment collateral types (type 1)

Col_AvailEquip Returns available collateral for Equipment collateral types (type 1)

Col_GrossInventory Returns Gross Collateral for Inventory collateral types (type 2)

Col_IneligInventory Returns ineligible balance for Inventory collateral types (type 2)

Col_EligInventory Returns eligible collateral balance for Inventory collateral types (type 2)

Col_NetInventory Returns net collateral balance for Inventory collateral types (type 2)

Col_LimitInventory Returns collateral limit for Inventory collateral types (type 2)

Col_AvailInventory Returns available collateral for Inventory collateral types (type 2)

Col_GrossPO Returns Gross Collateral for Purchase Order collateral types (type 3)

Col_EligPO Returns eligible collateral balance for Purchase Order collateral types (type 3)

Col_NetPO Returns net collateral balance for Purchase Order collateral types (type 3)

Col_LimitPO Returns collateral limit for Purchase Order collateral types (type 3)

Col_AvailPO Returns available collateral for Purchase Order collateral types (type 3)

Col_GrossRE Returns Gross Collateral for Real Estate collateral types (type 4)

Col_EligRE Returns eligible collateral balance for Real Estate collateral types (type 4)

Col_NetRE Returns net collateral balance for Real Estate collateral types (type 4)

Col_LimitRE Returns collateral limit for Real Estate collateral types (type 4)

Col_AvailRE Returns available collateral for Real Estate collateral types (type 4)

Col_GrossSec Returns Gross Collateral for Securities collateral types (type 5)

Col_EligSec Returns eligible collateral balance for Securities collateral types (type 5)

Col_NetSec Returns net collateral balance for Securities collateral types (type 5)

Bulk Collaterals User Guide
Collateral Field Codes

580 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Field Name Description

Col_LimitSec Returns collateral limit for Securities collateral types (type 5)

Col_AvailSec Returns available collateral for Securities collateral types (type 5)

Col_GrossMedRec Returns Gross Collateral for Summary A/R collateral types (type 7)

Col_IneligMedRec Returns ineligible balance for Summary A/R collateral types (type 7)

Col_EligMedRec Returns eligible collateral balance for Summary A/R collateral types (type 7)

Col_NetMedRec Returns net collateral balance for Summary A/R collateral types (type 7)

Col_LimitMedRec Returns collateral limit for Summary A/R collateral types (type 7)

Col_AvailMedRec Returns available collateral for Summary A/R collateral types (type 7)

Col_GrossARAging Returns Gross Collateral for A/R Aging collateral types (type 9)

Col_IneligARAging Returns ineligible balance for A/R Aging collateral types (type 9)

Col_EligARAging Returns eligible collateral balance for A/R Aging collateral types (type 9)

Col_NetARAging Returns net collateral balance for A/R Aging collateral types (type 9)

Col_LimitARAging Returns collateral limit for A/R Aging collateral types (type 9)

Col_AvailARAging Returns available collateral for A/R Aging collateral types (type 9)

Col_GrossOther Returns Gross Collateral for Other collateral types (type 10)

Col_EligOther Returns eligible collateral balance for Other collateral types (type 10)

Col_NetOther Returns net collateral balance for Other collateral types (type 10)

Col_LimitOther Returns collateral limit for Other collateral types (type 10)

Col_AvailOther Returns available collateral for Other collateral types (type 10)

Col_GrossLnBacked Returns Gross Collateral for Loan Backed collateral types (type 11)

Col_IneligLnBacked Returns ineligible balance for Loan Backed collateral types (type 11)

Col_EligLnBacked Returns eligible collateral balance for Loan Backed collateral types (type 11)

Col_NetLnBacked Returns net collateral balance for Loan Backed collateral types (type 11)

Col_LimitLnBacked Returns collateral limit for Loan Backed collateral types (type 11)
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Field Name Description

Col_AvailLnBacked Returns available collateral for Loan Backed collateral types (type 11)

Col_GrossBulkInv Returns Gross Collateral for Bulk Inventory collateral types (type 12)

Col_IneligBulkInv Returns ineligible balance for Bulk Inventory collateral types (type 12)

Col_EligBulkInv Returns eligible collateral balance for Bulk Inventory collateral types (type 12)

Col_NetBulkInv Returns net collateral balance for Bulk Inventory collateral types (type 12)

Col_LimitBulkInv Returns collateral limit for Bulk Inventory collateral types (type 12)

Col_AvailBulkInv Returns available collateral for Bulk Inventory collateral types (type 12)

Col_GrossTotal Returns Gross Collateral total of all collateral types (type 99)

Col_IneligTotal Returns ineligible total of all collateral types (type 99)

Col_ResvTotal Returns reserve total of all collateral types (type 99)

Col_SetASideTotal Returns set aside total of all collateral types (type 99)

Col_EligTotal Returns eligible collateral total of all collateral types (type 99)

Col_NetTotal Returns net collateral total of all collateral types (type 99)

Col_LimitTotal Returns collateral limit total of all collateral types (type 99)

Col_AvailTotal Returns available collateral total of all collateral types (type 99)

Emp_BulkArBal Returns the bulk A/R amount as of the reporting date, same as Emp_BulkArAmt

Emp_BulkArAmt Returns the bulk A/R amount as of the reporting date, same as Emp_BulkArBal

Emp_BulkUnApplied Returns the unapplied cash amount as of the reporting date
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Calculations

The following table details system calculations for the FactorSoft for Bulk Collaterals.

Item Value Calculation

Client List

Cap Space Amount Total client credit limit less sum of facility balances (FAC
Excess Deficit).

FAC Excess Deficit Amount Sum of client's facility balance. Note: no currency con-
version

(Client) Excess
Deficit - see sys-
tem preference

Amount SP Option #1 - FAC Excess Deficit

SP Option #2 - Cap Space (Capped excess availability)

SP Option #3 - lower of SP Option #1 and SP Option #2

Client Level Cur-
rency Conversion

Amount Facility Data Element (when the facility currency type is dif-
ferent than the client currency type) multiplied by the Client
Currency exchange rate. The amount of the client level data
element is the sum of all converted facility data elements.

Inventory Collateral Category

Cost Valuation
Method

Amount Current Collateral multiplied by CVM Advance Rate capped
at Max advance amount

Alternate Valu-
ation Method

Amount Current Collateral multiplied by the AVM Market Multiplier
multiplied by Market Advance Rate capped at Max advance
amount

Gross AVM Amount Current Collateral multiplied by the AVM Market Multiplier

Available (cat-
egory)

Amount Option #1 - Cost Valuation Method

Option #2 - Alternate Valuation Method

Option #3 - Lower of Cost Valuation Method and Alternate
Valuation Method.

Equipment Collateral Category

Depreciation Amount Option 1 - Rate Multiplied by Basis sum number of depre-
ciated intervals
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Item Value Calculation

Option 2 - Flat sum number of depreciated intervals

Availability Con-
tribution

Amount Category Basis Amount less accumulated depreciation

Current Collateral Amount Sum of Categories Availability Contributions

AR Aging

NCV Amount per
category (bucket)

Amount Current Age Bucket Amount multiplied by the NCV Rate mul-
tiplied by Advance Rate capped at Category Limit

Total Declared
Value

Amount Sum of all age bucket amounts

Aged Ineligibles Amount Sum of all age bucket amounts in buckets flagged as over
Ineligible age (days)

NCV Amount (per
bucket)

Amount Age Bucket Amount multiplied by the NCV Rate

Net Collateral Amount Sum of NCV Amount

Available Col-
lateral

Amount Sum of age buckets NCV amounts capped at Category
Limit less Aged Ineligible capped at available limit

AR Summary Collateral Category

NCV Amount per
category (fin-
ancial class)

Amount Sum Age Buckets Amount multiplied by the NCV Rate mul-
tiplied by Advance Rate capped at Category Limit

Total Declared
Value

Amount Sum of all categories aging bucket amounts

Aged Ineligibles Amount Sum of all age bucket amounts in buckets flagged as over
Ineligible age

NCV Amount (per
bucket)

Amount Age Bucket Amount multiplied by the NCV Rate

Net Collateral Amount Sum of Categories NCV Amount

Available Col-
lateral

Amount Sum of categories age buckets NCV amounts capped at
Category Limit less Aged Ineligible capped at available limit
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Item Value Calculation

Collateral Summary

Current Collateral Amount Gross Value of the most recent collateral posting or edit

Eligible Collateral Amount Gross Collateral less ineligibles, less reserves, less set asides

Net Collateral Amount Eligible Collateral multiplied by Advance Rate

Available Col-
lateral

Amount Lower of Net Collateral and Available Limit (collateral limit)

Set Aside -apply
before eligible col-
lateral

Action Reduces Eligible Collateral

Set Aside -apply
after eligible col-
lateral

Action Reduces Available Collateral

Dependency Rule
(collateral)

Action Reduces Available Collateral

Facility

Gross Collateral Amount Sum of Current Collaterals

Eligible Collateral Amount Sum of Eligible Collaterals

Net Collateral Amount Sum of Net Collaterals

Current Limit Amount Loan Limit less decreased by amount

Available Amount Sum of Available Collaterals capped at Current Limit

Excess/Deficit Amount Lower of Available less Loan Balance and Client Cap Space

Dependency Rule
(facility)

Action Reduces Available (facility)

Additional Terms

Sales Amount Bulk AR Posted Sales multiplied by Percentage Rate (sales)
or flat amount when sales are greater than zero

Collections Amount Bulk AR Posted Collections multiplied by Percentage Rate
(collections) or flat amount when Collections are greater
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Item Value Calculation

than zero

Deferred Revenue
Amount

Amount (Fee) Amount divided by No. of Payments

Fee Reserve Amount Sum of statement fees accrued period to date

Payment Rules

Do Not Use No Action None Calculated

Oldest to Newest,
Payment Level

Priority Apply oldest first finish statement before moving to newer

Newest to Oldest,
Payment Level

Priority Apply newest first finish statement before move to older

Payment Level,
Newest to Oldest

Priority Apply fee type oldest to newest before moving on the next
fee type

Payment Level, Old-
est to Newest

Priority Apply fee type newest to oldest before moving on to the
next fee type

STATEMENT TERMS

Interest

Average Loan Bal-
ance

Amount Sum of loan balances at the end of each day in a period
divided by the number of days in the period

Standard Interest Amount Average Loan Balance multiplied by the annual interest rate
divided by selected number of days in the year multiplied
by actual number of days in the period.

Compound
Interest

Amount Sum Average Loan Balance and calculated interest to date
multiplied by the annual interest rate divided by selected
number of days in the year multiplied by actual number of
days in the period.

Float Balance Amount Sum cash payments for the day multiplied by the number
of defined float days and the end of day loan balance.

Maintenance: Fee calculated based on:

Average daily bal- Amount Maintenance/Monitoring Fee Rate multiplied by the aver-
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ance age daily loan balance

Available Col-
lateral

Amount Maintenance/Monitoring Fee Rate multiplied by the aver-
age daily selected Available Collateral balance

Eligible Collateral Amount Maintenance/Monitoring Fee Rate multiplied by the aver-
age daily selected Eligible Collateral balance

Gross Collateral Amount Maintenance/Monitoring Fee Rate multiplied by the aver-
age daily selected Gross/Current Collateral balance

Loan Limit Amount Amount Maintenance/Monitoring Fee Rate multiplied by the Current
Loan Limit Amount

Net Collateral Amount Maintenance/Monitoring Fee Rate multiplied by the aver-
age daily selected Net Collateral balance

Supporting Col-
lateral

Amount Maintenance/Monitoring Fee Rate multiplied by the aver-
age daily loan balance divided by the selected collateral
advance rate

Other Amount Maintenance/Monitoring Fee Rate multiplied by Other
Amount

Out of Formula Amount Maintenance/Monitoring Fee Rate multiplied by sum of the
daily out of formula amounts (when excess availability is
less than zero).

Fixed Period Amount Rate multiplied by Basis multiplied by 100%

Standard Per Diem Amount Rate multiplied by Basis divided by 30 multiplied by days
with active loan balance (fee pro-rata)

Actual Per Diem Amount Rate multiplied by Basis divided by 30 multiplied by actual
days in the period.

Transaction

Advances Amount Sum the funding amounts in the period multiplied by Option
#1 Transaction Fee Rate or Option #2 Sum flat amount per
occurrence.

Payments Amount Sum the payment amount in the period multiplied by
Option #1 Transaction Fee Rate or Option #2 Sum flat
amount per occurrence.
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Item Value Calculation

Annual: Fee calculation based on

Facility Limit Amount Annual Fee Rate multiplied by Facility Limit or Flat amount
generated on scheduled post date

Client Limit Amount Annual Fee Rate multiplied by Client Limit or Flat amount
generated on scheduled post date

Other Limit Amount Annual Fee Rate multiplied by Other Limit or Flat amount
generated on scheduled post date

Minimum Amount Minimum fee amount less Sum of Selected Fee Type
Amounts when greater than zero. (minimum not met)

Reimbursement Amount Flat Amount

Unused Line - Facil-
ity Limit

Amount Unused Line Fee Rate multiplied by (Average Loan Balance
less Facility Limit)

Unused Line - Cli-
ent Limit

Amount Unused Line Fee Rate multiplied by (Average Loan Balance
less Client Limit)

Unused Line -
Other Limit

Amount Unused Line Fee Rate multiplied by (Average Loan Balance
less Other Limit)

Tiered Amount Sum the Average Loan Balance Tiered Amount multiplied by
the tier rate or Sum the Average Loan Balance Tiered Flat
Amount

Over Under Amount Sum the Average Loan Balance Threshold Amount mul-
tiplied by the Over/Under rate or Sum the Average Loan Bal-
ance Threshold Flat Amount

Exception Amount Flat Amount

Facility Level Cur-
rency Conversion

Amount Collateral Data Element (when the collateral currency type
is different than the facility Currency type) multiplied by the
Facility Currency exchange rate. The amount of the facility
level data element is the sum of all converted collateral
level data elements

Participation
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Settlement Due To
Participant -when
settlement
amount is neg-
ative

Amount Settlement Amount = Current loan balance multiplied by
Participating Rate (%) less Participant's Current Investment.

Settlement Due
From Participant -
when settlement
amount is positive

Amount Settlement Amount = Current loan balance multiplied by
Participating Rate (%) less Participant's Current Investment.

LB Detail Ineligible

Calculated / Avail-
able

Amount Lower of UPB or Purchase Price multiplied by Purch Rate and
Available (appraised) multiplied by Decreasing Value Rate

Total Aging
Amount

Amount Sum loan record Note Amounts less all payments on all
loans (UPB)

Current Collateral
Value

Amount Sum loan record Note Amounts less all payments on all
loans (UPB)

Over Calculated
Availability
(ineligible type)

Amount Sum each loan record UPB less (calculated) Available

Eligible Collateral Amount Gross Collateral less ineligibles, less reserves, less set
asides.

Net Collateral Amount Eligible Collateral multiplied by Advance Rate

Available Col-
lateral

Amount Lower of Net Collateral and Available Limit (collateral limit)

Bulk Purchase

Purchase Trans-
action: Purchase
(amount)

Amount Equal to the input amount in the bulk purchase Gross Receiv-
able field

Uncollectable
Reserve

Amount Uncollectable RSC % multiplied by The Gross Receivable
amount

Advance Reserve Amount Advance RSC % multiplied by The Gross Receivable amount
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(escrow)

Credit Reserve Amount Credit RSC % multiplied by The Gross Receivable amount

Discount Fee -
Purchase

Amount Discount Fee % multiplied by The Gross Receivable amount

Limit Available Amount Facility Limit less Eligible Collateral

Reserves Earned
(cash reserve)

Amount Reserve Earned % multiplied by The Gross Receivable
amount

Reserve Earned %
multiplied by The
Gross Receivable
amount

Amount Cash Reserve Balance = sum of all Reserve Earned activity.

True-up Adjustment Transaction

Gross Receivable
Adjustment
Amount

Amount Gross Receivable (AR Collateral Total) less Gross Receivable
(Facility AR Balance.

Uncollectable
Reserve

Amount Gross Receivable (AR Collateral Total) multiplied by Uncol-
lectable RSV Rate less Gross Receivable (Facility AR Bal-
ance) multiplied by the Uncollectable RSVP Rate.

Advance Reserve
(escrow)

Amount Gross Receivable (AR Collateral Total) multiplied by
Advance RSV Rate less Gross Receivable (Facility AR Bal-
ance) multiplied by the Advance RSVP Rate.

Credit Reserve Amount Gross Receivable (AR Collateral Total) multiplied by
Advance RSV Rate less Gross Receivable (Facility AR Bal-
ance) multiplied by the Advance RSVP Rate.

Post Discount Fee
- True Up Adjust-
ment

Amount Discount Fee % multiplied by The Gross Receivable Adjust-
ment amount

Tracked AR Ineligible

Cross Age Amount Total Receivables less Receivables Over Age when Receiv-
ables Over Age is greater than " X" percent of the Total
Receivable.
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Item Value Calculation

REPORTS

AR Analysis

Cash Turn # of Days Total End of period Accounts Receivable Balance divided by
the period total Collections multiplied by the actual number
of days in the period.

Sales Turn # of Days Total End of period Accounts Receivable Balance divided by
the period total Sales multiplied by the actual number of
days in the period.

Dilution - AR Bal Percentage Period Total Credits divided by the end of period Accounts
Receivable Balance

Dilution - Sales Percentage Period Total Credits divided by the end of period Total Sales

Dilution - Col-
lections

Percentage Period Total Credits divided by the end of period Total Col-
lections

Facility Analysis

Loan Turn # of Days Total End of period Loan Balance divided by the period total
Collections multiplied by the actual number of days in the
period.

Yield Percentage Period Ending Loan Balance plus Total Facility Posting
Amount divided by the period Total Revenue Amount (fee
column) divided by the actual number of days in the period
multiplied by 365.

Facility Trend Card

Cash Turn # of Days Total End of period Accounts Receivable Balance divided by
the period total Collections multiplied by the actual number
of days in the period.

Sales Turn # of Days Total End of period Accounts Receivable Balance divided by
the period total Sales multiplied by the actual number of
days in the period.

Dilution - AR Bal Percentage Period Total Credits divided by the end of period Accounts
Receivable Balance
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Dilution - Sales Percentage Period Total Credits divided by the end of period Total Sales

Dilution - Col-
lections

Percentage Period Total Credits divided by the end of period Total Col-
lections

Loan Turn # of Days Total End of period Loan Balance divided by the period total
Collections multiplied by the actual number of days in the
period.

Yield - All Percentage Average Daily Loan Balance for the period divided by the
period Total Revenue Amount divided by the actual number
of days in the period multiplied by 365

Yield - Statement Percentage Average Daily Loan Balance for the period divided by the
period Statement Posted Revenue Amount only divided by
the actual number of days in the period multiplied by 366

Average (daily)
Loan Balance

Amount Sum of the EOD loan balances for each day in the period
divided by the actual number of days in the period.
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